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Cisco Configuration Assistant Basics

Welcome to Cisco Configuration Assistant!

• Click here for instructions on using the help system.

• See Getting Started with the Configuration, page 73 for instructions on 

creating customer sites and using built-in device configuration wizards.

• See Resources for Planning and Implementing Your SBCS Solution, 

page 112 for information about SBCS support community and partner 

resources.

If you are new to Cisco Configuration Assistant (CCA), the information in these 

sections will help you get started:

• What is Cisco Configuration Assistant?

• System Requirements

• Downloading and Installing CCA

• Checking for CCA Application Updates

• CCA Version Compatibility Checking

• User Interface

• Applying and Saving the Configuration

• Viewing and Managing Errors

• Voice Warning Messages

• Setting Preferences

• System Message Notifications

• Using Online Help

• Printing CCA Windows, Reports, and Graphs



Cisco Configuration Assistant Basics
What is Cisco Configuration Assistant?

16 Cisco Configuration Assistant SBCS Administrator Guide

1

What is Cisco Configuration Assistant?

Configuration Assistant is an application for managing Cisco Small Business Pro 

platforms and devices. Devices can be managed standalone or in device groups, 

called customer sites, from anywhere in your intranet. Using its graphical interface, 

you can:

• Set up a Cisco Smart Business Communications System (SBCS)

• Configure port connections

• Configure the telephony features of your customer site

• Manage telephony licenses on IP voice devices

• Set up network address translation, virtual private networks, and firewalls

• Configure the wireless LAN features of your customer site, including 

wireless security and wireless guest access

• Manage and audit network security

• View the entire customer site on a topology map

• View the front panels of managed devices

• Monitor device status, bandwidth, and links

• See inventory and status reports

• Upgrade software on devices

• Restart devices and reset devices to factory default configuration

• Back and restore site configuration

To perform any of these tasks, you select the appropriate feature from the CCA 

feature bar, as shown in the “Feature Bar” section on page 26.
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System Requirements

The PC on which you install CCA must meet these minimum requirements.

System Requirements

Operating 

Systems 

Supported 

(Windows)

Microsoft Windows Vista Ultimate (32-bit or 64-bit edition)

Microsoft Windows XP Professional, Service Pack 2 or later

Microsoft Windows 7 (64-bit and 32-bit)

You must have write permission to your home directory 

and to the CCA installation directory so that CCA can 

create the necessary log files and preference files.

For PCs running Windows Vista and Windows 7, 

Administrator privileges are required in order to update, 

install, and use CCA.

When using CCA, on PCs running Microsoft Windows 7, set 

the auto sleep function to Never. To change the PC’s 

setting follow these steps:

• Go to Control Panel > Power Options.

By default, it is set to Balanced.

• Click Change when computer sleeps

• Increase “Put computer to sleep” from 15 minutes 

(default) to Never

Mac OS Support

(requires 

virtualization 

software)

Mac OS: 10.5 and later

Virtual OS: Parallels Desktop 3.0 and later or VMware 

Fusion 1.0 and later.

Guest OS: Microsoft Windows XP (Service Pack 2 or later), 

Microsoft Windows Vista Ultimate. CCA also supports 

remote control via Virtual Network Computing (VNC) 

clients.

Hardware PC with FastEthernet or higher LAN port

Processor 1.8 GHz Intel Core 2 Duo or higher
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Downloading and Installing CCA

To install CCA on your PC, follow these steps:

STEP 1 Go to this web address: www.cisco.com/go/configassist.

You must be a registered Cisco.com user, but you need no other access 

privileges.

STEP 2 In the Support information box, click the Download Software link.

STEP 3 If you are not already logged in, you will be redirected to the Cisco.com Log In 

page. Enter your Cisco.com username and password to log in.

STEP  4 Find the CCA installer file, for example,

Cisco-config-assistant-win-k9-3_0-en.exe.

STEP  5 Download the CCA installer and run it. You can run the installer directly from the 

web if your browser offers this choice.

Disk Space 400 MB recommended

Memory 2 GB minimum recommended for Windows 7, Windows XP, 

and Windows Vista.

Display Screen resolution: 1280 x 1024 or higher recommended

Browser Microsoft Internet Explorer 8.0 or later is recommended, 

with Javascript enabled.

The Adobe Flash Player 10 or later plug-in for Microsoft 

Internet Explorer must also be installed (in addition to any 

other version of the Flash plug-in that you may have 

installed for different Web browsers).

Javascript must be enabled for the Microsoft Internet 

Explorer browser.

System Requirements

http://www.cisco.com/go/configassist
http://www.cisco.com/go/configassist
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CCA is free; there is no charge to download, install, or use it.

When you run the installer, follow the onscreen instructions. On the final page, click 

Finish to complete the installation.

If you are using an older version of CCA, use the Application Update feature to 

upgrade to the latest version. See the “Checking for CCA Application Updates” 

section on page 19.

After CCA is installed, choose Start > All Programs > Cisco Configuration 

Assistant > Cisco Configuration Assistant or use the installed shortcut to launch 

CCA.

Since CCA is not connected to a customer site or device, only a few menu items 

and the Connect window are available after you first launch CCA. When CCA is not 

connected to a device or customer site, the menu bar and toolbar support only the 

tasks that customize CCA itself. The feature bar, which usually lists device 

features, is empty.

To connect to a device or create a customer site, see Creating and Managing 

Customer Sites, page 74 and Connecting to a Site or Standalone Device, 

page 83.

Checking for CCA Application Updates

You can keep CCA up-to-date by searching for and installing updates on 

Cisco.com.

In order to use the auto-update feature, you must a Cisco.com login on Cisco.com.

You are prompted to search for an update if:

• CCA finds a new device type or a device with upgraded software among 

the devices it manages.

• You set up a periodic search in the Preferences window and the time 

interval has expired.

• The version of CCA you are using is older than the version that was 

previously used to configure the device or customer site to which you are 

connecting.

You can also search for an update on demand by choosing System > 

Application Updates from the menu bar.
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If CCA finds an update, you can read a description of its contents and decide 

whether to install it.

CCA Version Compatibility Checking

When you launch CCA and connect to a device or customer site, and the version of 

CCA you are using is older than the version of CCA that was previously used to 

configure that device or customer site, the CCA Version Conflict dialog appears.

The message “The version of CCA that you are using is older than the previous 

version that was used to configure this device. This may cause errors. Cisco 

strongly recommends that you upgrade to CCA version X.x or later. Do you want to 

upgrade now?”

If you choose Yes, you are prompted to enter your Cisco.com username and 

password to access CCA application updates.

User Interface

The CCA user interface makes it easy to manage networking features and to 

request services from CCA itself. These are the main parts of the user interface:

• Menu bar. The row of menus across the top of the CCA window. It offers 

application services, a list of open windows, and online help. To learn more 

about the menu bar, see Menu Bar, page 21.

• Toolbar. The row of icons directly below the menu bar. They represent the 

most often used application services and most often configured networking 

features. To learn what each icon represents, see Toolbar, page 24.

• Workspace. The main area of the CCA window—everything between the 

toolbar and the status bar. It has two parts, the feature bar and the CCA 

desktop.

• Feature bar. The scalable panel on the left side of the CCA workspace in 

which you select features to configure and tasks to perform. If you do not 

know the name of a feature, you can search for it. To learn more about the 

feature bar, see Feature Bar, page 26.

• Desktop. The right side of the CCA workspace, in which the Dashboard, 

configuration windows, and wizards appear. You view reports here and 
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enter information that configures networking features. To learn more about 

the desktop, see CCA Desktop, page 27.

• Status bar. The bar at the bottom of the CCA window. When CCA starts up, 

the status bar appears and progresses to the right as the devices in the 

network are learned. The status bar also indicates when voice data is 

loading. When this process ends, CCA is ready to use.

It repeats this learning process for every network polling interval. If you lose 

connectivity to the customer site or standalone device the status bar shows 

No connectivity.

• Topology view. A map of your network and much more, depending on the 

options that you select in the view. To learn more, see Topology View, 

page 32.

• Front Panel view. A hierarchical list of the devices in your network, a wiring-

closet graphic of the devices, and the status of each device and its ports. To 

learn more, see Front Panel View, page 41.

Menu Bar

The menu bar has features to help you use CCA. The features are grouped into 

these menus: System, Window, and Help.
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Menu Feature What You Can Do

System Connect Connect to a customer site or standalone 

device.

Refresh Refresh the Front Panel view and the 

Topology view by polling the site members.

Application 

Updates 

Check for application updates.

System Message 

Notification 

Receive email notifications of system 

messages.

Page Setup, Print 

Preview, Print 

Use standard printing options to print views, 

windows, and graphs.

Preferences Set CCA user preferences.

Feature Bar Set the feature bar viewing mode (Standard 

or Autohide).

Window Choose a window 

from the list of open 

windows

Navigate to a window in a list of open 

windows.
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Help Contents See the help topic that introduces CCA.

What's New? See a list of the new features and 

enhancements that were added to CCA 

from release to release.

Help For Active 

Window

See the help topic for the window or view 

that is active. You can also access help for 

the current window by pressing F1.

Feedback Send your feedback on CCA to Cisco.

Startup Information See a summary of new and changed 

features for the current release.

Support Information See how to contact the Small Business 

Support Center and how to generate a 

troubleshooting log file.

About See end user license information and the 

identifier for the version of CCA that you are 

using.

Menu Feature What You Can Do
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Toolbar

The toolbar contains icons for the tasks that you perform most often. This table 

describes the actions that CCA takes when you click icons. Roll the mouse over 

the icons in the toolbar to display a tooltip that identifies each item.

Icon Action

Connect Opens the Connect window, where you identify a customer 

site or a standalone device for CCA to manage.

Refresh Refreshes the Front Panel view and the Topology view by 

polling the customer site members. CCA updates the status 

of the devices and ports, and displays any new members.

Print Sends a print file for a graph, a report, or online help 

selections to a printer.

Preferences Opens the Preferences window, where you can set user 

preferences.

Save 

Configuration

Makes permanent the changes that you make to the device 

configuration; that is, your changes remain in effect after the 

device is powered off and powered on again.

Users and 

Phones

Opens the Users and Phones window, where you configure 

options for voice communication.

VPN Server Opens the VPN Server window, where you configure a VPN 

server to send security policies to a device.

Firewall and 

DMZ

Opens the Firewall and DMZ window, where you configure a 

firewall or create a DMZ.

Wireless 

Networks

Opens the Wireless Networks window, where you configure 

security features on a WLAN controller and its associated 

access points.

Smartports Opens the Smartports window, where you configure ports 

and devices by applying roles.
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You can also enter terms in field at the right of the toolbar and click Search to 

search the online help topics for the terms.

Switch Port 

Settings

Opens the Switch Port Settings window, where you can view 

the status of ports on a selected device and modify port 

settings.

Inventory Opens the Inventory window, which displays the inventory for 

the community—device types, serial numbers, IP addresses, 

and software versions—or the inventory for a single device.

Health Opens the Health window, where you can monitor a number 

of device health measurements to avoid downtime and to 

ensure that your network is running efficiently.

Event 

Notification

Opens the Event Notification window, which describes 

network conditions that you should be aware of and that 

might require your action.

Dashboard Opens the Dashboard window, which provides a graphical 

view of system health and status, including storage utilization 

on the UC500 flash, PoE utilization, temperature, events, voice 

mail, memory, and CPU utilization.

Topology Opens the Topology view, which shows a network map of the 

community members, and much more, depending on the 

topology options that you choose.

Front Panel Opens the Front Panel view, which shows a hierarchical list of 

the devices in the community, a wiring-closet graphic of the 

devices, and the status of each device and its ports.

Legend Opens the online help to an explanation of the graphic 

conventions used in CCA.

Help for 

Active 

Window

Opens the online help to an explanation of the active window. 

If no window is active, the Introduction topic is shown.

Feedback Opens a Web page where you can leave feedback on your 

experience with CCA.

Icon Action



Cisco Configuration Assistant Basics
User Interface

26 Cisco Configuration Assistant SBCS Administrator Guide

1

Feature Bar

The feature bar is on the left side of the CCA desktop. 

The features are grouped into these menus to identify categories of tasks:

• Home, for opening Dashboard, Topology, and Front Panel views, and 

running device, telephony, phone VPN, wireless, and other setup wizards.

• Configure, for configuring devices, ports, network routing, wireless LANs, 

security, and telephony features.

• Applications, for enabling and configuring setup options for Smart 

Applications or third-party applications.
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• Monitor, for monitoring your network, viewing system and telephony status 

reports, and entering Cisco IOS and Cisco Unity Express (CUE) debug 

commands.

• Troubleshoot, for troubleshooting network and voice problems and 

creating logs that can be used by the Cisco Small Business Support Center 

to assist in troubleshooting and resolving system and network issues.

• Maintenance, for maintaining your network, upgrading software, managing 

licenses, managing phone loads, and managing files on the UC500.

• Partner Connection, for accessing the Cisco Small Business Support 

Community, UC500 product page, RSS feeds, UC500 software downloads, 

CCA VODs (video on demand), and the Partner Central site on Cisco.com.

When you select a feature on one of these menus, the content appears in a 

separate browser window.

Standard Mode and Autohide Mode

The feature bar display can be set to standard mode or autohide mode:

• When the feature bar is in standard mode, you can narrow it to increase the 

space for windows on the CCA desktop. To do this, put the cursor on the 

right edge of the feature bar and drag the cursor to the left.

• When the feature bar is in autohide mode, it appears only when you move 

the cursor to the left edge of the CCA workspace. It disappears again when 

you move the cursor anywhere in the workspace outside the feature bar 

boundary.

To set the display mode for the feature bar, choose System > Feature Bar from 

the menubar and choose either Standard Mode or Autohide Mode.

CCA Desktop

The CCA desktop is the focal point of the user interface. It is where you perform 

these tasks:

• Display the Dashboard, a graphical view of system health and status, 

including CPU utilization, PoE utilization, storage utilization on the UC500 

flash, temperature, event alerts, VPN status, and voice mail.

• Display the Topology View, a network map of the customer site that CCA is 

managing. The view shows node information, link information, and 

neighboring devices.
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• Display the Front Panel View, a picture of the front panels of the devices in 

the community. You can click the depicted devices and ports, and choose 

configuration options from a popup menu.

• Display setup wizards. Some setup wizards, such as the Telephony Setup 

Wizard, and the SR520-T1 Connectivity Wizard, are launched automatically 

when you connect to a device that is in factory default state.

• Enter information to configure networking features. You perform this task by 

using feature windows or guide-mode steps.

• Display reports and graphs. Look for the words Reports and Graphs in the 

menus on the feature bar. They accompany many of the networking and 

voice features offered there.

Launching a view by default when CCA connects to a device is preference that 

you can set. You can launch either view, both views, or neither. See Setting 

Preferences, page 51.

Dashboard

The Dashboard View requires Version 10.0.0.0 or later of the Adobe Flash Player 

and Microsoft Internet Explorer to be installed on the PC running CCA. Javascript 

must be enabled for the Microsoft Internet Explorer browser.

Overview

The Dashboard displays in the main window area when you initially connect to a 

device or customer site with CCA. It provides an intuitive, at-a-glance, graphical 

display of system health and status for the Cisco Unified Communications 500 

Series and other managed devices.

If you closed the Dashboard window, you can always reopen it by navigating to 

Home > Dashboard.

You can specify whether the Dashboard is automatically displayed when 

connected to the network. To access this setting, navigate to System > 

Preferences, click the General tab, and check or uncheck the Show Dashboard 

When Connected to Network option.

Using the Dashboard

The Dashboard user interface consists of a series of windows and a palette from 

which you can drag and drop windows onto the main viewing area:

• Click Show Palette to display the palette. By default it is hidden.
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• Use the left and right arrow buttons on the palette to cycle through available 

windows.

• Drag and drop or double-click icons on the palette to place windows on the 

display area.

• Position the mouse over items in the graphic display to view tooltips with 

numeric or percentage values.

Each Dashboard item window provides controls for:

• Minimizing and maximizing the window in the view.

• Selecting a different device to view, if applicable.

• Slideshow browsing mode, with pause and play controls.

In slideshow mode, the display updates to display snapshot status 

information for each device at the specified browsing interval. If there is only 

one device, selecting slideshow mode has no effect on the display.

• Closing the window and moving it back to the palette.

• Configuring window settings.

For example, the Temperature dashboard window can be configured to 

display temperature in either degrees Celsius or Fahrenheit. Data refresh 

and slideshow browsing intervals can be configured for all windows.

To access configuration settings for dashboard windows, click the settings icon on 

the window bar.

Changes to the Dashboard view are saved across sessions.
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Available System Health and Status Displays

The table below lists and describes available system health and status windows.

Window Description

System Status Displays general information for the selected device:

• Hostname and device type

• WAN IP address, subnet mask, and gateway IP 

address

• DNS Server IP addresses

• Cisco IOS version

• Uptime

• Date last updated

CPU Usage Percentage of CPU capacity in use in the last 5 seconds, 

1 minute, and 5 minutes for the selected device.

PoE Usage Percent available and percent used power for PoE ports 

on the device.

Position the mouse over the pie chart to view power 

consumption in watts.

NOTE:  PoE usage is not currently displayed for ESW500 

Series switches with PoE.

Flash Usage Percent available and percent used storage for flash 

memory on the selected device.

Position the mouse over the pie chart to view storage 

utilization in Mbytes.

Memory Usage Percent available and percent used memory capacity for 

the selected device. Position the mouse over the pie chart 

to view memory allocation in megabytes.
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Events Type and description for recent event notification alert 

messages.

For more detail, navigate to Monitor > Event Notification.

You can also position the mouse over the event to view a 

tooltip with extended description and recommendation 

action.

Temperature For devices that can measure precise temperature, 

temperature in degrees Celsius or degrees Fahrenheit.

Voicemail Status Displays system and per-mailbox voicemail storage 

information and status, including:

• Cisco Unity Express (CUE) version

• Percent (%) used across the system

• Per-mailbox information

- User ID/hunt group name associated with the 

mailbox

- Extension

- Type—Personal or GDM (General Delivery 

Mailbox)

- Size—Amount of storage allocated, in minutes

VPN Status If EZVPN is configured, displays the public IP address, 

VPN IP address, and current status: Up - Active; Up - Idle, 

Up - No IKE, Down - Negotiating, or Down.

VPN status can also be viewed by navigating to Monitor > 

Security > VPN Status.

Wireless Client 

(AP541N)

For a quick view of wireless client status, choose Home > 

Dashboard to display the system dashboard, then drag 

and drop the Wireless Client item from the palette onto 

the main dashboard area. The Wireless Client dashboard 

item displays the MAC address, IP address, SSID, security 

type, and device type for associated wireless clients for 

AP541N access points. Wireless LAN controller status 

and AP521 status are not displayed on the dashboard. 

Window Description
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Topology View

This view appears when you take any of these actions:

• Connect CCA to the devices that you want to manage.

• Choose Home > Topology on the feature bar.

• Click the Topology View icon on the toolbar.

Overview

Use this view to see the topology of the devices that you manage and their 

connections. Use its parts—the Toolbar, the Left Frame — Site Member Devices 

and Neighbors, and the Right Frame — Topology Map—to perform Tasks that 

manipulate the view, save it, and give you information about the devices in it.

Right-click on icons in the Topology view to locate options for adding or removing 

a device from the customer site, opening the native device configuration utility, or 

performing other management tasks. See Tasks, page 36.
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Toolbar

The Topology view has its own toolbar. This table describes the actions that CCA 

takes when you use the toolbar options.

Option How to Use It

Discover Bonjour 

Devices

Click to discover Cisco PVC2300 and WVC2300 video 

cameras and third-party printers with Bonjour support. 

Right-click on a Bonjour device and choose the 

Configuration Utility option to manage these devices 

using their built-in web management tools.

Automatic Layout Click to redistribute the spacing and information in the 

view.

Save Layout Click to save the locations of the devices in the topology 

map.

Topology Options Click to launch the Topology Options window, in which 

you control what you see in the view. For example, you 

can control how much information is shown about links 

and nodes by using the check boxes on the Show 

Information tab. See Topology Options, page 39.
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You can choose any of the first three options from the menu that appears when 

you right-click anywhere in the background of the right frame.

Left Frame — Site Member Devices and Neighbors

The left frame is a tree diagram. It shows an expanded list with the name of the 

customer site and each of the site members. There is also a list of neighbor 

devices of site members.

For a standalone device, the list shows only that device and its neighbors.

If you do not use a mouse, use the Tab key to select the tree, and then use the up 

and down arrow keys to move within it.

When you select a device in the tree view, the corresponding device is selected in 

the right frame, and the frame automatically scrolls to make the device visible.

Zoom Controls Whenever the view is launched, the right frame appears 

at 100% magnification. To zoom out:

• Click or hold down the “–” magnifier icon, or

• Press “–” on the keyboard, or

• Select a lower magnification from the drop-down 

list, or

• Enter a number less than 100 in the text field.

To zoom in again, use one of these methods:

• Click or hold down the “+” magnifier icon.

• Press “+” on the keyboard.

• Select a higher magnification from the drop-down 

list.

• Enter a higher number, up to 100, in the text field.

Option How to Use It
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Device Status

The tree shows the status of devices by using these colors:

Using the Popup Window

Right-clicking a device or pressing Shift-F10 in the left frame opens a popup 

widow. Its menu is a list of tasks—for example, viewing properties, changing the 

hostname, restarting a device, or seeing a bandwidth graph—that you can perform 

with the device. This is the same popup window that opens when you right-click a 

device in the right frame.

Right Frame — Topology Map

The right frame is the topology map. It shows the links among the devices and 

gives link information. The rules that apply to it are the same as for the left frame:

• Its contents depend on whether you are managing a CCA customer site 

with multiple devices or a standalone device and whether you have asked 

to see neighboring devices in the Topology Options window.

Color Status

Red  Down or not connected

Green Connected and operating

Blue  Unknown
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• Right-click on a device icon in the Topology view to open windows for 

performing tasks with the selected device. You can also perform device-

independent tasks that manipulate the view in this frame.

For example, the following menu is displayed when you right-click on the 

UC500 in the Topology view.

• Device status is shown by the same colors.

Tasks

This table lists the tasks that you can perform from this view and tells you how to 

do them.

Task How to Do It

Rearranging the 

layout

To make devices, links, and information more visible in the 

view:

• Drag devices to places that you prefer.

• Rubberband devices that you want to move as a 

group; that is, hold down a mouse button, and draw 

a rectangle around them. When you drag one 

device, you then drag them all.
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Displaying device 

and link 

information

To display the properties of a device or link, right-click or 

double-click it, and choose Properties from the popup 

menu. The properties of a device are its name, type, IP 

address, MAC address, and the Cisco IOS release running 

on it. The properties of a link are the identities of the 

connected ports and the state of the link.

To monitor the bandwidth that a device is using, right-

click or double-click it, and choose Bandwidth Graphs 

from the popup menu. To monitor the use of a link, right-

click or double-click it, and choose Link Graphs from the 

popup menu.

Showing VLANs If you are managing multiple devices as part of a 

customer site, you can show VLAN links on the topology 

map. Click the options icon to open the Topology Options 

window, and use the Show VLANs tab.

Adding devices to 

a customer site

To add a device to a customer site, right-click or double-

click any candidate, and choose Add To Site from the 

popup menu.

Removing devices 

from a customer 

site

To remove a device from a customer site, right-click any 

device, and choose Remove From Site from the popup 

menu.

Refreshing the 

view

When network polling is enabled, CCA periodically polls 

managed devices and re-displays the network topology 

when devices are removed or added. If you know that a 

change has occurred and you want to see the change 

between polling intervals, click the Refresh icon on the 

toolbar.

NOTE: To enable or disable network polling and change 

the polling interval, use the Preferences window. See 

Setting Preferences, page 51.

Resetting voice 

configuration 

(CNF) files

Choose Reset Voice CNF Files to have CCA regenerate 

the eXtensible Markup Language (XML) configuration files 

for IP phones so that they can refresh and recognize new 

settings. This may be needed after changing phone 

localization files.

Task How to Do It
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Removing unused 

voice 

configuration

Choose Remove Unused Voice Config to remove phone 

load CLI that is not used from the configuration.

Refreshing MWIs 

on all phones

Choose MWI Refresh All to refresh the MWI (Message 

Waiting Indicator) on all phones to reflect the current state 

of voice mailboxes.

Changing a 

hostname

Right-click the device, choose Hostname from the popup 

window, and use the Hostname window.

Annotating 

objects and links

You can add a field of text, referred to as an annotation, 

below devices and network clouds, and at the end points 

of links. An annotation is useful for displaying descriptive 

information that does not otherwise appear on the 

topology map.

When you add a network cloud or link, the Annotation 

window opens. To annotate a device that is already on 

the map, right-click it, choose Annotations from the 

popup window, and use the Annotation window. See 

Annotations, page 41.

If you want to hide the annotations in the Topology view, 

open the Topology Options window, and uncheck 

Annotations on the Show Information tab.

Upgrading 

software

Drag and drop a software-image file from your PC to a 

device icon. (The device must be a member of the 

customer site.) The file can be on a mapped drive or a 

network drive, as well as on a local drive.

To upgrade the software on more than one device at a 

time, use the Software Upgrade window.

Discovering 

Bonjour Devices

Click the Bonjour icon on the Topology toolbar or right-

click on the Topology view background and choose 

Discover Bonjour Devices to discover Cisco PVC2300 

and WVC2300 video cameras and third-party printers 

with Bonjour support. Choose the Configuration Utility 

option to manage these devices using their built-in web 

management tools.

Task How to Do It
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Topology Options

This window appears when you select the Topology Options icon in the toolbar in 

the Topology view. Use the window to specify what you want to see in the 

Topology view.

Any device that runs the Cisco Discovery Protocol (CDP) will appear on the 

topology view. Not all of these devices can be managed with Configuration 

Assistant.

CCA has the ability to cross-launch the native device manager or configuration 

utility for certain devices, such as the SA500 Series secure routers and ESW500 

Series switches. To launch the native device manager, right-click on the device in 

the Topology view and choose Configuration Utility from the drop-down list 

menu.

The window has these tabs:

• Show Neighbors, to select the neighbor devices that you want to see

• Show Information, to select the information about links and nodes that you 

want to see

• Show VLANs, to show VLAN links in the community and to select the colors 

that represent them

When you finish with the window, click OK.

Adding a network 

cloud

Right-click the background of the topology map, and 

choose Add Network Cloud from the popup window. 

Give the cloud a label in the Annotation window that 

appears, and drag it to any map area that you like.

You can change the label or remove the cloud by right-

clicking it and choosing an action from the menu.

Adding a link You can manually add a link to the map. Point at the node 

that you want to link from, press Ctrl and click, point to the 

node that you want to link to, and press Ctrl and click 

again. Then right-click either node and choose Add Link 

from the popup window. A link is drawn between the 

nodes, and the Annotation window appears. In its fields, 

enter labels for the end points of the link.

Task How to Do It
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Show Neighbors

These check boxes control the neighbors that you can see:

• IP Phones—check to see full-featured telephones that provide voice 

communication over an IP network.

• Other Neighbors—check to see neighbor devices that are detected by 

CDP (Cisco Discovery Protocol) for example, access points and devices 

that CCA does not support as site members.

Show Information

These check boxes control the information that is shown for links and nodes on the 

topology map:

• Interface ID—check to see the IDs of the interfaces to which the links are 

attached.

• Actual Speed—check to see the link speed information, as opposed to the 

administrative speed of a link.

• Hostname—check to see the hostnames of nodes.

• IP Address—check to see the IP addresses of nodes.

• MAC Address—check to see the MAC addresses of nodes.

• Annotations—check to see the annotations of links and nodes.

Show VLANs

Follow these steps to show VLAN links on the topology map:

STEP 1 In the VLAN folder, click Assign Color for the VLAN whose links you want to 

highlight.

STEP 2 In the Color Selection window, click the highlighting color that you want to use, and 

click OK. The VLAN number moves above the VLAN folder to the list of VLANs that 

have a highlighting color. The Assign Color button becomes the Modify Color 

button and shows the color that you selected.

STEP 3 Check the box beside the VLAN number to turn on the highlighting color in the 

Topology view. If you uncheck the box later, the highlighting is turned off.
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Notes:

• To change the highlighting color of a VLAN, click its Modify Color button, 

and select a different color in the Color Selection window.

• To remove the highlighting for a VLAN, click its Remove Color button. The 

VLAN's Modify Color and Remove Color buttons disappear, and the VLAN 

number returns to the VLAN folder with its Assign Color button.

Annotations

This window appears when you:

• Right-click a device on the topology map and choose Annotations in the 

popup menu.

• Add a network cloud.

• Add a link between nodes on the topology map; for example, between a 

device and a network cloud or between devices.

If you are annotating a node, enter descriptive information—for example, a device 

location—in the text field. The information appears below the node icon. If you are 

annotating a link, enter identifying information for each of the link endpoints. Click 

OK when you finish.

You can hide annotations on the topology map by unchecking Annotations on the 

Show Information tab of the Topology Options window.

Front Panel View

This view appears when you take any of these actions:

• Specify in the Preferences window that you want the Front Panel view to 

open when CCA is connected. See Setting Preferences, page 51.

• Choose Home > Front Panel on the feature bar.

• Click the Front Panel View icon on the toolbar.

The view has two interrelated parts: the Left Frame and the Right Frame. Use 

them to Select Devices and to Select Ports so that you can check and change 

settings. You can also Arrange Devices in the view. To see the effect of changes, 

you can Refresh the View.
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Left Frame

The left frame is a tree diagram that shows member devices indented below a 

customer site name. Each device name has a box beside it. Check the box to see 

the front panel of the device in the right frame.

Not all devices have a front panel view. Also, unknown devices do not show a front 

panel view.

The tree diagram use these colors to show the device status:

• Green. The device is connected and operating.

• Yellow. A fault condition is detected. Move the mouse pointer over the 

device icon to see the fault-condition message.

• Red. The device is down or is not connected.

Right Frame

The right frame displays the front panel view for the devices that you selected in 

the left frame. You see their ports and module slots as you would in a wiring closet.

Select Devices

You can select a device in two ways:

• Click its front panel.

• Select the device icon in the tree diagram.

When you click a device, a yellow rectangle appears around it, showing that it is 

selected. To select multiple devices, hold down Ctrl, and click the devices that you 

want to select. To deselect a device, hold down Ctrl, and click the device that you 

want to deselect.

You can select a group of devices and then right-click a device to display a popup 

menu. Use the popup menu to check or change device settings. The popup menu 

options apply only to the selected devices. You can also use feature-bar options 

to check or change device settings. If a feature-bar option is not applicable to the 

selected devices, the selection is ignored.

Select Ports

This table shows the options for selecting ports.

NOTE: The ports on a WLAN controller cannot be selected.
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To deselect a port, hold down the Ctrl key and click the port that you want to 

deselect.

When you right-click to select a single port, a popup menu appears. To see a 

popup menu when you select more than one port, you must right-click one of the 

ports. Use the popup menu to check or change port settings. The popup menu 

items apply only to the selected ports. You can also use feature-bar items to check 

or change port settings. If a feature-bar item is not applicable to the selected ports, 

the selection is ignored.

Arrange Devices

You can change the order of the devices to reflect the physical setup in your 

wiring closet. To reposition a device, drag its icon in the tree diagram to a new 

position.

Refresh the View

To refresh the Front Panel view, click the Refresh icon on the toolbar. This action is 

useful if you know that a change has occurred in the site and you want to see it 

immediately.

If you want to... Then...

Select a single port Right-click or left-click the port. Right-clicking pops up a 

menu as well.

Select all the ports 

on a device

Right-click any port, and choose Select All Ports from 

the popup menu.

Select multiple 

ports on the same 

device or on 

different devices

Use either of these methods:

• Hold down the Ctrl key, and click the ports that 

you want to select.

• Rubberband the ports that you want to select; 

that is, hold down a mouse button and draw a 

rectangle around a group of ports. If you also hold 

down the Ctrl key, you can add non-adjacent 

groups of ports to the selection.
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Device and Link Status Icons and Graphics

This section explains the graphics and colors that appear on the Topology view, 

on the Front Panel view, and in the configuration windows. The explanations are 

divided into these categories:

• Device Icons

• Device Status Icon and Label Colors

• Port Types

• Link Types

• Link Status

Device Icons

These device icons commonly appear in CCA views and windows.

• A device icon is red when the device is down.

• An Unknown device icon appears when CCA does not support a device or 

does not support the Cisco IOS version that the device is running.

 

Icon Device Icon Device

Customer Site 800 Series access router

Unified Communications 

500 Series Platform

IP phone

Switch (ESW500 Series or 

Catalyst Express CE520)

Wireless LAN controller

Autonomous Access Point Lightweight Access Point
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You might also see these icons in the topology map:

 

Device Status Icon and Label Colors

Port Types

 

Icon Device Icon Device

Stack Modular switch

Layer 3 switch LRE Switch

Unknown Network Cloud

Icon 
Color

Up Down Unknown

Label 
Color

Member or 
Standalone 
Device

Candidates Edge Device

RJ-45 RJ-45 RJ-11

Small form-factor pluggable (SFP) module (empty)

SFP fiber-optic module (LX, SX, ZX, CWDM, 100BASE-FX)
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Link Types

NOTE The two pipes represent two or more links. If one pipe is gray and the other is 
green, one or more links are blocked, and one or more are up.

Link Status

Icon/Link Type Icon/Link Type

10 Mbit (blocked) Gigastack

100 Mbit Trunk

1 Gbit Routed

10 Gbit Edge

Etherchannel Multiple Links

Manually Added 
Link

Link color Up Blocked
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Applying and Saving the Configuration

The Save Configuration window appears when you exit CCA or choose 

Configure > Save Configuration on the feature bar.

Overview

When a network device with Cisco IOS is running, it has two sets of configuration 

settings. One is its startup configuration, which is stored in flash memory. The 

other is its running configuration, which is stored in RAM. The device uses the 

running configuration to determine its behavior.

• When you click OK or Apply in a configuration window, you make changes 

to the running configuration. These changes go into effect immediately.

• When you choose Configure > Save Configuration or click OK when 

prompted to save the configuration on exit, you are saving changes to the 

startup configuration for the selected devices. This ensures that the 

changes are preserved if the device is restarted.

You can use CCA to save the running configuration as the startup configuration, 

which makes permanent any changes that you make to the running configuration.

Saving the running configuration does not save the changes you make in the 

Topology view. To save the settings in the Topology view, go to Home > Topology 

and choose Save Layout on the Topology view toolbar.

Procedures

• To save the running configuration of a managed device to its startup 

configuration, select the device from the Hostname list and click Save.

• To save the running configurations of all the managed devices, select All 

Devices and click Save.
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Viewing and Managing Errors

CCA lets you know when you enter valid information by putting a green border 

around it.

• Any changed information appears in the status bar.

• When you apply a change, the green border disappears.

Error Management

If you enter invalid information when configuring fields in CCA:

• You see a red border around the fields that contain errors.

• In tabbed windows, the number of errors on each tab is displayed in the tab 

heading in red.

• The error management bar automatically displays at the bottom of the 

window.

The error management bar provides a central location for viewing and handling 

errors as you enter and apply configuration in CCA.

All current errors in open windows are listed, along with the window name, 

associated dialog (if the error is displayed in a popup dialog), and the associated 

error message details. The total number of errors in all open windows is displayed 

at the bottom of the error management bar.

As you resolve errors, the error management bar updates to indicate that the error 

has been resolved. When all errors are resolved, it closes automatically.

When working with the error management bar:

• Click the arrow buttons in the window hierarchy to navigate the list of errors 

in each window.

• Click on an error message to bring the associated window into focus and 

highlight the field with the error.
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• To resize the error management bar, left click and drag the mouse over the 

top border of the bar.

• To show or hide the error management bar, click the error icon at the 

bottom of the window.

If CLI Postview is enabled (see the Advanced tab in the Preferences dialog), the 

configuration commands sent to the UC500 or SR500 are displayed in a pop-up 

window. See Setting Preferences, page 51.

Voice Warning Messages

The Voice Warning Messages window is displayed when you attempt to access 

or configure voice features, but your system does not meet one or more required 

conditions.

Before continuing, make sure that the following conditions are met.

Warning 

Message

Required Action Related Feature or 

Window

Reset the 

system to 

factory default 

configuration

To run the Telephony Setup Wizard, you must first reset 

the UC500 to factory default configuration. This can take 

up to 20 minutes.

To reset the UC500 to factory default configuration:

1. From the feature bar on the left, choose Maintenance > 
Restart/Reset.

2. In the Restart/Reset window, select the Cisco UC500, 
check the Reset to Factory Default Configuration 
option, and click OK.

3. When the reset is completed, re-launch the Telephony 
Setup Wizard.

Telephony Setup 

Wizard

Make sure that 

your PC is 

directly 

connected to a 

LAN port on the 

UC500

To run the Telephony Setup Wizard, the PC running CCA 

must be directly connected to a LAN port on the UC500 

and obtain an IP address from the UC500 using DHCP.

Telephony Setup 

Wizard
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Disable any 

third-party TFTP 

service running 

on your PC

If the feature that you are trying to access requires CCA to 

use the built-in TFTP or FTP service to transfer files to or 

from the UC500, you must first disable any other third-

party TFTP or FTP services running on your PC before 

continuing.

If you are using a Windows-based PC, you can use 

Windows Task Manager to locate these applications and 

close them. However, these services might not be shown 

on the Applications tab in the Task Manager.

You can also open a command window on your PC and 

issue the netstat command to see if these services are 

running and identify them by executable name and 

process ID. For example:

c:\ netstat -a -b

After you locate the third-party TFTP or FTP process, you 

can go to the Processes tab on the Windows Task 

Manager and manually shut it down by highlighting the 

process in the list and choosing End Task.

For more information, consult the documentation for your 

operating system, TFTP application, or FTP application.

If there are no third-party TFTP services running, check 

the firewall and network security settings on your PC to 

make sure that TFTP traffic is allowed between the PC 

and the UC500 or try restarting your PC to release TFTP 

ports from a prior CCA session.

Drag and drop files 

from PC onto the 

Topology View (Cisco 

IOS images, MoH files, 

Basic ACD scripts, 

Auto Attendant 

scripts)

Telephony Setup 

Wizard

Configure > Telephony 

> Call Handling > Auto 

Attendant

Configure > Telephony 

> Call Handling > Basic 

ACD

Configure > Telephony 

> Users and 

Extensions > System 

Speed Dial

Maintenance > 

Configuration Archive

Maintenance > 

Software Upgrade

Maintenance > 

License Management

Maintenance > 

Restart/Reset (Reset 

to Factory Defaults 

option only)

Warning 

Message

Required Action Related Feature or 

Window
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Setting Preferences

To configure preference settings for CCA:

• Choose System > Preferences on the menu bar.

• Click the Preferences icon on the toolbar.

Overview

You can customize much of what CCA does. For example:

• Choose whether to display the Topology view, Front Panel view, or 

Dashboard windows when you connect to your network using CCA.

• Enable or disable network polling and specify how often CCA polls the 

devices it manages to provide up-to-date information.

• Specify how often to check Cisco.com for a newer version of CCA.

• Choose whether you want to use a proxy server to download CCA 

application updates from Cisco.com.

• Specify the location for archiving saved configurations on the devices that 

you manage.

• Specify options for system health monitoring.

• Enable or disable display of Cisco IOS commands sent to the router for 

telephony configuration changes (CLI Postview window).

• Choose whether or not the Cisco.wav file is played at startup.

• Choose the desktop background image.

• Enable or disable collection and upload of CCA usage activity to Cisco.

• Enable or disable the display of CLIs which are sent to the devices and the 

display of timestamp in the console window.

When you exit from CCA, your preferences are saved to your PC in a file named 

.user_preferences. It is stored in this location:

C:\Documents and Settings\<username>\.configuration assistant

You can copy it to other PCs.
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The settings on each of the tabs in the Preferences window are explained in the 

next sections, with their defaults. If you change the defaults, click Set Defaults to 

restore them.

General

On the General tab, you can set these polling and start-up preferences.

Setting Description

Enable Periodic Network 

Polling

By default, network polling is disabled.

When this option is enabled, CCA periodically 

polls the network to determine device status and 

discover new devices. The polling information is 

used to refresh the Topology view, the Front Panel 

view, and many of the feature windows.

When network polling is disabled, click the 

Refresh icon on the CCA toolbar to manually 

trigger network polling.

Network Polling Interval When network polling is enabled, this setting 

specifies how often CCA polls the network. The 

default setting is 5 minutes. This setting is inactive 

when network polling is disabled.

LED Polling Interval How often CCA polls the LEDs of the managed 

devices. At each interval, CCA displays interface 

and RPS information using colored LED icon in the 

Front Panel view. You can click the button on the 

left of the view to specify the kind of information 

that each color represents—link status, port 

speed, duplex state, or power state. The default is 

3 minutes.

Graph Polling Interval How often CCA queries the managed devices to 

obtain device and link-utilization data. This 

information is used to update the link and the 

bandwidth graphs. The default is 5 seconds.

Show Front Panel View 

when connected to 

network

Whether the Front Panel view appears when CCA 

is connected to a device. It is unchecked by 

default.
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Application Updates

Specify how often to search for a newer version of CCA.

In the Check for application updates list, select Monthly, Weekly, or Never. If you 

select Never, CCA makes no periodic checks. However, you can check on 

demand by selecting System > Application Updates on the menu bar.

Proxy Servers

On this tab, you show whether you want to use proxy servers to communicate with 

with Cisco.com to look for a newer version of CCA.

To upgrade CCA to a newer version, follow these steps.

STEP 1 Check Enable proxy servers to enable communications through proxy servers. 

When you check this box, you can use the other fields on the tab.

STEP 2 Check Use proxy servers to manage devices to communicate with your network 

through proxy servers.

STEP 3 To show that HTTP traffic will use a proxy server, enter these values in the HTTP 

fields:

• The IP address or hostname of the proxy server.

You can use a hostname to identify a proxy server only if a DNS server has 

been set up to resolve the hostname.

• The number of the HTTP port.

STEP 4 To show that HTTPS traffic will use a proxy server, enter the appropriate values in 

the HTTPS fields.

Show Topology View 

when connected to 

network

Whether the Topology view appears when CCA is 

connected to a device. It is checked by default.

Show Dashboard when 

connected to network

Whether the Dashboard view appears when CCA 

is connected to a device. It is checked by default.

Setting Description
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Configuration Archive

On this tab, you set preferences for backing-up a saved configuration on a device.

Follow these steps:

STEP 1 Check Save configuration on the device before backup if you want CCA to save 

the running configuration on the device before it backs it up as the saved 

configuration.

STEP 2 In the Backup Directory field, replace the path that is used for backing up 

configurations if you want them to be backed-up on some other path.

Health

Check the boxes for the health categories that you want CCA to monitor.

The Health Polling Interval determines how frequently you want updates to the 

measurements in the Health window and the Health Details window.

Usage Activity

The usage activity tracking feature is designed to automatically provide feedback 

on how CCA is being used to deploy Cisco SBCS devices. The data shared by this 

feature helps Cisco to improve the quality of the software.

Usage activity tracking is enabled by default, as described in the End User License 

Agreement (EULA) for CCA. To view the EULA, choose Help > About from the CCA 

main menu and click the End User License Agreement link.

Uncheck the Enable usage activity collection option to disable collection and 

transmission of CCA usage data to Cisco.

When this option is enabled, only these usage activity statistics are collected:

• CCA version and internationalization

• Types of devices being managed by CCA

• Software version for each managed device (for example, Cisco IOS version, 

switch firmware version, and Cisco Unity Express (CUE) software version)

• User actions

- Feature window launch

- Tab navigation events in feature windows and dialogs
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• When CCA applies a configuration to a device

No details of the configuration are recorded, only that the user applied a 

change to the configuration.

• Public IP address of the PC on which CCA is installed and from which the 

data is sent.

This is the WAN or Internet IP address maintained and allocated by your 

Internet Service Provider (ISP) to the router or firewall at your site.

• Timestamp for each event

• VLAN usage

- Whether or not the default IP address is used for VLAN1 on the UC500 

(192.168.10.x). CCA does not record the VLAN1 IP address; it only checks 

to see if the default value is being used.

- Total number of VLANs

• Smartport usage: Type of Smartport roles applied

• VPN usage: Types of enabled VPNs (EasyVPN, SSL VPN, or site-to-site VPN). 

Phone VPNs are not tracked.

• SIP trunk usage

- Whether or not SIP trunking is enabled

- If enabled, the selected SIP trunk provider

• Wireless usage

- Whether or not wireless is enabled

- Type of wireless security used

- Total number of SSIDs configured

• UC500 flash usage: Available flash space and total flash space in Mbytes

The following information is NOT collected:

• Customer names, addresses or other identifying information

• Product serial numbers or other unique identifiers

• Hostnames or IP addresses for devices that are behind the router or firewall 

at your site
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• Phone numbers or any other information that could be used to uniquely 

identify a customer or VAR

• Cisco.com usernames or passwords

• Usernames or passwords configured on the device

Usage activity data is stored in a text file on the PC running CCA and is sent to a 

server hosted by Cisco on a per-session basis. After the information is sent, it is 

removed from the user's PC.

An Event Notification alert is generated each time usage activity data is sent.

Logging

On the Logging tab, you can set the preferences for the type of information that is 

displayed in the CCA log files and in the CCA Console window.

Advanced

Configure these settings from the Advanced tab.

Setting Description

Logging Contents These settings control display of CLI information in log 

files and timestamp information in the CCA Console 

window.

• CLI information is displayed in CCA log files by 

default. This option is enabled by default at 

application launch. To disable display of CLI 

information in log files, uncheck the Check Enable 

Display of CLI in Log option. If the user exits CCA 

and relaunches it, this option will be enabled by 

default.

• This option is enabled by default at application 

launch. To disable display of timestamp 

information in the CCA Console window, uncheck 

Enable Display of Timestamp in Console (to open 

the CCA Console window, press F2). If the user 

exits CCA and then relaunches it, this option will be 

enabled by default.
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System Message Notifications

The System Message Notification window appears when you choose System > 

System Message Notification from the CCA menubar.

You can receive e-mail notifications of system messages that you want to know 

about. The system messages can be about any customer site events, from 

emergencies and alerts (severity levels 0 and 1) to informational or debugging 

messages (severity levels 6 and 7).

To activate this feature, you must:

• Enable a SMTP server to send e-mail notifications of system messages.

• Create a notification name.

To set up system message notifications, follow these steps.

STEP 1 In the E-mail Server (SMTP) field, enter the name of the SMTP server that will 

send out notifications.

Setting Description

Enable startup 

sound

Check Enable startup sound if you want to hear the 

Cisco .wav file at startup.

Enable CLI 

postview of IOS 

voice features

Check Enable CLI postview of IOS voice features if you 

want to view a list of Cisco IOS commands sent to the 

router after configuration changes are made in a 

configuration window. The commands are displayed in a 

popup window after the changes are applied.

Desktop 

Background 

Image

To select a different background image click Browse and 

navigate to the location of the desired file on the local PC, 

then click OK or Apply.

Image types supported include .gif, .png, and .jpg

If the image exceeds the desktop size it will be clipped. If 

the image is too small it will use a “Tile” style display.
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STEP 2 In the Sender E-mail Address field, enter an e-mail address for SMTP to show as 

the sender of the notifications. In SMTP terminology, this address is the return 

address.

STEP 3 Click Test E-mail to test the connection between the SMTP server and the sender 

e-mail address. If the sender receives the test e-mail, the connection is verified.

STEP 4 Click Create and use the Create Notification window. See Create or Modify 

System Notification, page 58.

When you are done, the new notification name appears in the Notification List and 

its Active box is checked.

STEP 5 Click OK or Apply.

To modify the information for a notification name, select the name, click Modify, 

and use the Modify Notification window.

To delete a notification name, select it, then click Delete.

Create or Modify System Notification

This window appears when you click Create or Modify on the System Message 

Notification window. Use it to specify:

• A notification name

• The e-mail address of recipients

• The kinds of messages, by severity level, that the recipients want to know 

about

To create or modify a system notification, follow these steps:

STEP 1 Enter or edit the name in the Notification Name field.

STEP 2 Enter or edit the e-mail address in the E-mail Address field. This is the address at 

which recipients will receive notifications.

STEP 3 Specify the kinds of messages that the recipients want to know about by checking 

the boxes beside the severity levels of those messages.

Checking a severity level number greater than 3 might cause recipients to receive 

more notifications than they want.
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STEP 4 Click OK.

Using Online Help

CCA online help displays in a separate Web browser window that provides:

• Toolbar with Back, Forward, and Home navigation buttons, Print PDF button, 

and Search text box.

• Contents and Index links on the left

- By default, the Contents list is displayed. Click the Index link to go to the 

help index.

- Click the Book icons to expand and collapse the topic list.

- While in the Index view, you can enter a word or phrase in the search 

box above the Index list to search the Index entries.

• Current help topic on the right

For best results, enable JavaScript in your Internet Explorer browser. If prompted 

in the Information Bar, choose the option to allow blocked content so that you can 

view and use the help navigation and interface controls.

Access Online Help

To access online help:

• Click Help in a window or dialog

• Press F1 to access help for the active window

• Choose one of these Help menu options from the menubar at the top of the 

main window:

- Contents. Displays the introduction to CCA topic.

- What’s New. Displays links to information about new features in the 

current release and recent releases.

- Help for Active Window. Displays online help for the active window. If 

multiple windows are open, the active window is the window that 

currently has focus.
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Search Online Help

To search the online help, enter a word or phrase in the search box in the top right 

corner of the online help window, then click Go. Partial matches are supported, but 

wildcard search characters and patterns such as (*) and (.) are not supported.

After you click Go, the page updates to display the search results.

• Click on a topic link to display the topic that contains matches for the 

specified keyword. Matches are highlighted on that page.

• Click the icon to open the topic in a new window, allowing you to easily 

return to the search results page.

Open a PDF of the Online Help

Click the PDF button on the Help window toolbar to open a PDF that contains the 

entire contents of the online help in PDF format.

This allows you to save or print a copy of the Help for offline viewing.

Print Help Topics

Click the Print button on the Help window toolbar to print the current topic.

To print information in CCA windows, you can use the Java printing system. See 

Printing CCA Windows, Reports, and Graphs, page 60.

Printing CCA Windows, Reports, and Graphs

To print a CCA window, view, or graph, follow these steps.

STEP 1 Make sure that the object that you want to print is active.

STEP 2 Choose System > Print from the menubar to send a print file to a printer.

When you print a window, the printout is in a report format. In this format, none of 

the window information is truncated, as can happen if you use the PrtSc key to 

print the screen. The report format is also time-stamped, and pages are 

numbered.
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Notes

• The Telephony Setup Wizard, Wireless Setup Wizard, Multisite Manager, 

Video Monitor Setup Wizard, Security Setup Wizard, Phone VPN Setup 

Wizard, and Dashboard windows cannot be printed.

• If the object that you want to print becomes inactive because of a popup 

error message, you cannot print it until you close the error dialog and make 

it active again.

• To print a child window (a secondary window that opens when you click a 

button on the parent window), it must be open and active.

• When you print the Topology view or the Front Panel view, the Print Preview 

window (System > Print Preview) has a Fit To Page option. Check this if 

you want the view to be printed on a single page.
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What’s New

For information about new features and supported devices in Cisco Configuration 

Assistant, see these topics:

• Current Release, page 63

• Recent Releases, page 65

Current Release

Release 3.2.1

Release 3.2.1 of CCA is a minor release of the software that includes the following 

new features and user interface changes.

See the Release Notes for Cisco Configuration Assistant Release 3.2.1 for a list 

of known issues that were resolved in this release and current information about 

UC500 software packs and locale packs.
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Feature Description.

SIP Phones Two types of SIP Phones are supported:

• SIP Phones — CP-8961, CP-9951, CP-9971

These features are supported:

- Topology View
- Voicemail
- Auto Attendant
- Dial by name
- Blast group
- Dial Plan
- Normal Lines

These phones are not supported with Teleworker nor 
Multisite environments.

There is no support for these phones in the Telephony 
Setup Wizard.

• Mobile clients on the iPhone (Cisco Jabber)

The feature set of this application is limited when used with 
the UC500. A shared line cannot be created between Cisco 
Jabber and a desk phone.

These features are supported:
- Voicemail
- Auto Attendant
- Dial by name
- Blast group
- Dial Plan
- Normal Lines

This application is not supported with Multisite 
environments.

A Cisco ASA is required for Teleworker deployment.

There is no support for this application in the Telephony 
Setup Wizard.

For more information on Cisco Jabber for iPhone, see 
https://supportforums.cisco.com/docs/DOC-24508.

FXS Gateways Support for SPA8000 and SPA8800 (FXS only) gateways.

https://supportforums.cisco.com/docs/DOC-24508
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Recent Releases

Release 3.2

Release 3.2 of CCA is a major release of the software that includes the following 

new features and user interface changes.

See the Release Notes for Cisco Configuration Assistant Release 3.2 for a list of 

known issues that were resolved in this release and current information about 

UC500 software packs and locale packs.

Feature Description.

Voice Feature Configuration

Generic SIP 

Trunking

Allows new service providers to be added in CCA 

without the requirement to import XML template.

Allows modification of service providers, including 

options for voice codec, fax protocol, registration, DTMF, 

call transfers, and call forwards.

Additional SIP 

Trunk Providers

Support for Integra, Keyyo, and OpenIP.

Disable Call-

waiting Beep
Audible rings are suppressed for incoming calls. Call-

waiting beeps are disabled during active calls. Visible 

cues are the same as those described for a normal ring.

Silent Ring and 

Feature Ring 

button mapping

Silent Ring; Audible ring and call-waiting beep are 
suppressed for incoming calls. The only visible cue is a 
flashing (< icon in the phone display).

Feature Ring: Differentiates incoming calls, on a special 
line, from incoming calls on other lines of the phone. The 
featuring cadence is a triple pulse; as opposed to a 
single pulse for normal internal calls, and a double pulse 
for normal external calls.

Time management 

for SIP Trunks

Allows configurations of timers and retries for the SIP 

user agent.
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Support 

Distinctive Ring 

pattern for 

incoming call

Distinctive ring is used to identify internal and external 
incoming calls. An internal call is defined as a call 
originating from any Cisco Unified IP phone that is 
registered in Cisco Unified CME or is routed through the 
local FXS port.

Support unknown 

plan type for 

International calls 

for ISDN carrier

Allows to map all outgoing calls to unknown numbering 

type and plan.

Ability to apply 

Service URLs 

under Telephony 

Service

Allows configuring URL information under telephony 

service. Specific URLs are provisioned on the Cisco IP 

phone; these URLs point to XML-based web pages 

formatted with XML tags that the Cisco IP phone 

understands and uses.

SSL VPN Configuration

Provide an option 

to enter SSL VPN 

Port

Provides the option to configure SSL VPN port during 

SSL creation on UC500.

Ability to accept 

the DHCP 

assigned IP 

address on the 

WAN for SSL VPN

Allows creation of SSL VPN using DHCP Wan IP and also 

warns the user of any changes to the WAN IP that will 

cause SSL VPN to not work.

Multisite Configuration

Site-to-Site VPN 

Only and Site-to-

Site Dialing only

Allows users of CCA multisite to have Site-to-Site dialing 

only, or Site-to-Site VPN only, or both.

Security

ACL Management/

Editing

Allows new ACLs to be added to the list of already 

existing ACLs generated by the CCA.  ACLs used by 

CCA are not editable.

Ability to backup current ACL configuration.

Ability to restore a backed-up ACL configuration.

Feature Description.
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Release 3.1

Release 3.1 of CCA is a major release of the software that includes the following 

new features and user interface changes.

See the Release Notes for Cisco Configuration Assistant Release 3.1 for a list of 

known issues that were resolved in this release and current information about 

UC500 software packs and locale packs.

Feature Description.

System 

Requirements

Update minimum memory requirement to 2 GB for 

Windows 7, Windows XP, and Windows Vista.

Scalability Both the UC540 and UC560 platforms come with 24 user 

licenses.

The maximum number of users on the UC560 platform 

increased to 138.

NOTE: Software pack 8.2.0 or later is required.

Office Manager Office Manager can be used with Cisco SBCS systems 

that are configured using Cisco Configuration Assistant 

version 2.2 and later. Configuration changes made 

through Office Manager are read and recognized by 

CCA.

Device Support

Cisco Small 

Business 300 

Series Managed 

Switches

• SF 300 Series models

• SG 300 Series models

NOTE: Please use firmware version 1.1.0.73 or later. 

Use the switch’s configuration utility to upgrade the 

firmware.
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Cisco 200 Series 

Smart Switches

• SF 200 Series models

• SG 200 Series models

NOTE: SG200-08 and SG200-08P switches are not 

supported.

NOTE: Please use firmware version 1.1.0.73 or later. 

Use the switch’s configuration utility to upgrade the 

firmware.

UC500 Software Packs and Locale Packs

UC500 Software 

Pack Version 8.2.0 

Support

CCA 3.1 supports UC500 software pack version 8.2.0. 

For more information, see the Release Notes for Cisco 

Configuration Assistant Version 3.1.

UC500 Locale 

Pack Support

CCA 3.1 supports installation of localization files via 

UC500 locale packs. UC500 locale packs can be 

downloaded from Cisco.com at

http://www.cisco.com/go/uc500swpk

Each locale pack contains phone language files, voice 

mail language files, network tones, and cadences for a 

given locale.

Voice Feature Configuration

Phone Soft Key 

Customization

• Allows custom URL and softkey definition per template.

• Allows 10 templates to be defined on system.

• Allows template to be applied to any IP phone on the 
UC500, on a per phone basis.

• Allows bilingual phones. A system with 10 phones, 
can localize 5 phones into one language (e.g., 
Spanish), and 5 phones into another language (e.g., 
French).

Call-back Rules Redial with outgoing prefix (when user replies to a 

missed calls, the user can simply press dial).

Single digit 

extension support 

for floating 

extension

Allows to map a single digit to an extension.

Feature Description.
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AA script v4 with 

multiple 

enhancements

• Bilingual AA – Allows to configure the language 
attribute of each AA so that AA will play the standard 
greetings and associated prompts in the selected 
language.

• Bilingual Prompt Management - Added language 
support for displaying, recording and adding a new 
prompt.

• Support up to 5 Standard AA - The number of 
standard AA increased from 3 to 5.

• Dial by First Name (AA script v4 required) - A 
variation of the Dial-by-Name feature allows the caller 
to enter the first name before the last name.

• Alternate Greeting (AA script v4 required) - When 
recording a prompt using the AVT (Administration Via 
Telephone) feature the user can designate the newly 
recorded prompt as the alternate greeting.

• Configurable No Option Transfer retries  - Allows to 
specify Maximum Menu Prompt Attempts setting. 
This parameter dictates the number of times AA 
replays its greeting before terminating, or transferring 
an idling call (i.e., a call without any key input) to a 
No-Option-Transfer-To number.

Bilingual Voicemail Allows the caller to the mailbox to hear the voicemail 

greetings in one of two languages installed on the CUE.

Voicemail Zero-out 

Options

Allows to customize how the call flow should proceed in 

response to keys pressed at the mailbox greeting for 

leaving a voicemail.

DTMF 

Configuration (for 

SIP Trunk and 

CUE)

CUE is updated to support DTMF RFC 2833 for improved 

compatibility.

Meet-me 

Unlocked

Allows external callers to initiate a meet-me conference.

Feature Description.
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Release 3.0(1)

Release 3.0(1) of CCA is a maintenance release that resolves known issues found 

in CCA 3.0.

Ability to select 

inbound Caller 

Name ID delivery 

method

Allows Inbound Caller Name ID display via “Display IE”  

and “Facilities IE” format.

Local Directory 

Support/Hunt 

Group Name 

Display

Allows to search for company’s internal phone numbers, 

hunt groups, call blast groups, and external numbers in 

the Local Directory.

Customizable 

phone 

backgrounds and 

ringtones

• Allows backgrounds to be customized on SCCP 
based phones, that have LCD screens which support 
16-bit color depth. This feature also supports drag-
and-drop of background image files (.png extension) 
onto the UC500 image on the topology screen.

• Allows ringtones to be customized on SCCP based 
phones. This feature also supports drag-and-drop of 
ringtone (.raw extension) files onto the UC500 image 
on the topology screen.

Additional SIP 

Trunk Providers

Support for CableVision and  Megapath.

Network Configuration

Disable DHCP 

Server on UC500

Allows users to disable DHCP server on UC500 series 

routers.

Maintenance and Troubleshooting

Troubleshooting: 

Gather Crash 

Information

Allows you to download crash information files from the 

UC500 and save them to a file on your local machine in a 

standard text format.

Feature Description.
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Feature Description

Voice Feature Configuration

Extension Mobility 

Status

This is a new window for viewing Extension Mobility 

phone information, profile information, and status 

(Monitor > Telephony > Extension Mobility Status).

This information is read-only; to configure these 

settings please see Extension Mobility, page 324.

User Interface Changes and Enhancements

Custom Desktop 

Background

Enables the user to specify a customer CCA desktop 

background image from the System menu (chose 

Preferences... then click the Advanced tab).
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Getting Started with the Configuration

Read the topics in this section to learn about how to use Cisco Configuration 

Assistant (CCA) to connect to a customer site or standalone device and get 

started with the configuration. These topics are covered:

• Creating and Managing Customer Sites

• Connecting to a Site or Standalone Device

• Using CCA Setup Wizards

- Which Wizard Should I Use and When?

- Telephony Setup Wizard

- Security Setup Wizard

- Wireless Setup Wizard

- Device Setup Wizard

- SR520-T1 Configuration Utility

- Phone VPN Setup Wizard

- Video Monitor Setup Wizard

• Backing Up and Restoring Device Configuration

• Using CCA with Cisco Small Business Office Manager

• Resources for Planning and Implementing Your SBCS Solution

• Cisco SBCS Features Supported Within CCA



Getting Started with the Configuration
Creating and Managing Customer Sites3

74 Cisco Configuration Assistant SBCS Administrator Guide

 

Creating and Managing Customer Sites

Read this section to learn about how to create and manage customer sites using 

CCA:

• About Customer Sites

• Customer Site Planning

• Creating a New Customer Site

About Customer Sites

Create a customer site to manage multiple Cisco Smart Business Communications 

System (SBCS) devices in the same logical group, regardless of their physical 

locations and the software installed on the devices. You can create, modify, delete, 

and manage multiple customer sites.

The benefit of creating a customer site is that you can manage and monitor 

multiple devices such as a UC500 and SR500 in a single session without having to 

reconnect to each device separately. Using a customer site allows CCA to 

implement solution-level features, such synchronizing VLANs across multiple 

platforms and multisite deployments.

A customer site can contain up to 25 connected network devices. Each device 

must have an assigned IP address. Cisco Configuration Assistant uses the 

automatic discovery capability of Cisco Discovery Protocol (CDP) and the Bonjour 

protocol to find eligible network devices and to add them to a site. If devices do 

not have CDP enabled, you can still create a site and manually add the devices.

With CCA, you can communicate securely with every member in a customer site. If 

a site member fails, you can continue to manage the other members.

Most types of network devices—routers, switches, wireless LAN controllers—can 

belong to a customer site. For a specific list of eligible devices, see the Release 

Notes for Cisco Configuration Assistant.

The following basic networking tasks are supported for customer site members, 

including routers and access points:

• Managing user access

• Upgrading software

• Saving a running configuration
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• Backing up and restoring a configuration

• Managing the system time

• Getting system message notifications

• Changing the HTTP port number

• Getting an inventory report

Customer Site Planning

This section describes the guidelines, requirements, and caveats that you should 

understand before you create a customer site.

Member and Candidate Characteristics

Members are network devices that belong to a customer site. Candidates are 

network devices that are not yet part of a customer site.

To join a customer site, a candidate device must

• Be supported by CCA

• Have an IP address that is reachable from the PC running CCA

• Have HTTP or HTTPS enabled on the default ports

Access to these ports must be open if the device is behind a firewall.

Customer Site Device Limits

The combined number of these device types cannot exceed 25:

• UC500 Series platforms (UC520, UC540, and UC560)

• Cisco Small Business Pro ESW500 Series switches (all models and SKUs)

• Cisco SF 200/300 Series, and SG 200/300 Series switches

• Cisco AP541N Wireless access points

• Catalyst Express CE520 switches

• Cisco 800 Series routers

• Cisco 870 Series router

• Cisco SR500 Series Secure Routers

• Cisco SA500 Series Security Appliances
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• Cisco 526 Wireless Express Controllers

• Cisco AP521 Wireless Express autonomous access points. These are fully 

featured standalone access points that do not require a Cisco 526 Mobility 

Controller.

There is no limit on the number of IP phones or lightweight access points—access 

points managed by a WLAN controller—in a customer site. There is no limit on the 

number of customer sites that CCA can manage.

In addition to the overall limit of 25 devices, there are these device-type limits:

• Catalyst Express CE520 and Cisco Small Business Pro ESW500 Series 

switches—no more than 15.

• Cisco 800 Series routers plus Unified Communications 500 Series 

platforms—no more than 5.

• Cisco 526 Wireless Express Controllers—no more than 2.

• Cisco AP541N wireless access points and Cisco AP521 autonomous 

access points plus built-in HWIC access points—no more than 10.

If the overall limit or a device-type limit is exceeded, you cannot manage the 

customer site. You must remove devices until the limit is no longer exceeded.

Automatic Device Discovery

Beginning with the IP address for a starting device and the port numbers for 

HTTPS and HTTP, CCA uses Cisco Discovery Protocol (CDP) to compile a list of 

customer site candidates that are within four CDP hops of the starting device. 

Cisco Configuration Assistant can discover candidate and member devices across 

multiple networks and VLANs if they have valid IP addresses. See the “Member 

and Candidate Characteristics” section on page 75 for a list of requirements 

that network devices must meet to be discovered.

IMPORTANT Do not disable CDP on candidates, members, or any network 

devices that you might want CCA to discover.

You can edit the list of discovered devices to fit your needs and to add them to the 

customer site. If CCA does not discover a network device, you can manually add 

the device.

For instructions on adding discovered devices to a customer site or manually 

adding devices to a customer site, see the “Adding a Device to an Existing 

Customer Site” section on page 82.
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Customer Site Names

When you create a customer site, CCA requires that you assign a name to it. The 

name can contain up to 64 alphanumeric characters and is not case sensitive.

Hostnames

You can edit the default hostname for a customer site member. This is useful if you 

are configuring a multisite deployment or if there are multiple devices of the same 

type, for example, AP541N access points or switches. To edit the hostname of a 

managed device, go to Configure > Device Properties > Hostname.

Passwords

When connecting to a customer site, CCA prompts you for each unique password 

that has already been assigned for members of the site. Cisco Configuration 

Assistant attempts to use these passwords to connect to other devices. You are 

prompted for a password only if the previously entered password does not work 

for a device.

IMPORTANT For Cisco IOS devices, the enable password for the device must 

be the same as the password used to log in to the device using CCA.

For example, if a customer site has ten members, and five members share one 

password and the other five share a different password, CCA prompts you twice, 

once for each password. Cisco Configuration Assistant does not save the 

passwords to your PC, so it prompts you for the passwords each time you attempt 

to connect to a site.

Communication Protocols

Cisco Configuration Assistant uses HTTPS, HTTP, Telnet, and SSH to 

communicate with devices. It tries to use HTTPS when discovering neighboring 

devices and when devices are manually added to a customer site. If HTTPS fails, it 

tries HTTP.

The HTTPS port is fixed at 443; the HTTP port defaults to 80. You can specify a 

different HTTP port when you create a customer site. Afterward, you use the HTTP 

Port window to change the HTTP port. The port settings for both HTTPS and 

HTTP must be the same for all the members of a customer site.

Customer Site Information 

Cisco Configuration Assistant saves all individual device information, such as the 

IP address, the hostname, and the communication protocol, to your local PC. When 

CCA connects to a customer site, it uses the locally saved data to rediscover the 

member devices.
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If you try to use a different PC to manage an existing customer site, none of the 

member device information is available. You need to create the customer site 

again and add the same member devices.

Creating a New Customer Site

The Create New Customer Site window appears when you click Add New Site 

from the Customer Sites tab in the Customer Sites window or the Connect 

window.

If you are new to CCA, or if you are creating a customer site for the first time, see 

Creating and Managing Customer Sites, page 74 to learn more about the 

purpose and benefits of creating customer sites to manage devices using CCA.

Use this window to create a new customer site and discover devices that you can 

add to a customer site.

Procedures

To create a new customer site, follow these steps.

STEP 1 In the Customer Site Information section, enter a site name and description for 

the customer site.

The site name can be up to 64 characters long. You can use the characters A-Z,

a-z, 0-9, - (hyphen), and _ (underscore).

In the optional Site Description field, enter your company name, your organization 

name, or any other identifying text. The text appears as part of the recommended 

SSID (Service Set Identifier) when you create an SSID for your network.

STEP 2 Optional. Click Connection Options if you want to:

• Enter an HTTP port number (because the devices in the customer site do not 

use the default port of 80).

• Specify the access mode for discovering devices and connecting to the 

customer site for the first time. The default is Read-only if you are already 

connected to site whose access mode is Read-only; otherwise, it is 

Read/Write. See Connection Options, page 80.



Getting Started with the Configuration

Creating and Managing Customer Sites

Cisco Configuration Assistant SBCS Administrator Guide 79

3
 

STEP 3 In the Add Devices to Site section, choose either Specify a Device IP Address or 

Discover Devices.

a. To discover and add a single, standalone device to the site, choose Specify a 

Device IP Address, then enter the IP address of the device you want CCA to 

discover.

b. To discover and add multiple devices at the site, choose Discover Devices. 

This table lists the options displayed in the Discover Devices menu, explains 

additional settings, and describes what CCA discovers and displays in the 

Devices table.

STEP 4 Click Start.

STEP 5 When the discovery begins, the Start button becomes a Stop button. Click it any 

time that you want to interrupt the discovery process.

See Automatic Device Discovery, page 76 for more information about the device 

discovery process.

STEP 6 Enter login credentials for each device when prompted. You may also be 

prompted to accept security certificates for some devices.

IMPORTANT For Cisco IOS devices, the enable password for the device must 

be the same as the password used to log in to the device using CCA.

For more information, see Passwords, page 77.

Option What to Enter What CCA Displays

Discover Devices > 
Using a Starting IP 
Address

The IP address of a 
device with neighbors 
that you want to add to 
your site.

Information about the device that 
you identified and about the 
neighbors that Cisco Discovery 
Protocol discovered by using a 
hop count of 4.

Discover Devices > 
On a Subnet

An IP address and a 
subnet mask that identify 
a subnet whose devices 
you want to add to your 
site.

Information about the devices that 
it discovers on the subnet.

Discover Devices > 
Within a Range of 
IP Addresses

The start and end IP 
addresses whose range 
delimits the devices that 
you want to add to your 
site.

Information about the devices that 
it discovers in the IP address 
range.
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NOTE: After three failed authentication attempts, the device icon is displayed in 

red in the Topology view with the message “Unreachable: Authorization Failed.” 

To retry the connection, choose System > Connect. You are prompted to close 

the session and restart CCA.

STEP 7 If CCA does not discover a device that you want in your customer site, try Step 3 

again with a different Discover option.

STEP 8 Find the rows in the Devices table for the devices that you do not want to add to 

the customer site, and uncheck them.

Up to 25 devices can be selected for a customer site. There are also limits on the 

number of certain device types that can be in a customer site. See Customer Site 

Device Limits, page 75.

IP phones do not need to be explicitly added to a customer site.

STEP 9 Click OK to add the selected devices to the customer site.

The new customer site is listed on the Customer Sites tab.

Connection Options

This window appears when you click Connection Options in the Create New 

Customer Site window or the Modify Customer Site window.

• When you create a customer site and discover devices using a starting IP 

address, subnet, or range of IP addresses, CCA first uses HTTPS protocol 

to connect. If connection via HTTPS fails, CCA retries the connection using 

HTTP.

• When you use the Hostname/IP Address option to connect to a single 

device, CCA connects to the device using the protocol selected in the 

Advanced Options tab. The default is HTTPS.

• On subsequent connections to a customer site or standalone device, CCA 

uses the same protocol that was used during device discovery.

You can modify the HTTP Port field only if you are creating a customer site. The 

field must contain the number of the HTTP port that CCA will use to communicate 

with devices in the community.

If you enter an HTTP port number other than 80, the default, add and configure the 

port before you add any devices to the site. To change the port number afterward, 

use the HTTP Port window.
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The port number used for HTTPS connections cannot be changed; it must be 443.

You can select an access mode and a privilege level only if you are creating a 

customer site. Your selection is used when discovering devices and connecting to 

the site for the first time.

Click OK when you are finished with this window.

Modify a Customer Site

This window appears when you select a customer site and click Modify on the 

Customer Sites tab in the Connect window or the customer sites window.

From the Modify a Customer Site window, you can add or remove devices to or 

from a customer site. You can also:

• Click Advanced to enter a new HTTP port number if the HTTP port for the 

devices in the customer site changes.

• Enter or modify your company name, your organization name, or other 

identifying text in the Site Description field. The text appears as part of the 

recommended SSID (service set identifier) when you create an SSID for 

your network.

Procedures

To add or remove devices to a customer site, follow these steps.

STEP 1 From the Discover list, choose an option. Then fill in the fields below the list, and 

click Start. See Creating a New Customer Site, page 78 for information about 

the options for discovering and adding devices to a site.

STEP 2 When the discovery begins, the Start button becomes a Stop button. Click it any 

time that you want to interrupt the discovery process.

STEP 3 If CCA does not discover a device that you want in your customer site, try Step 1 

again with a different Discover option.

STEP 4 Find the rows in the Devices table for added devices that you do not want in the 

customer site, and uncheck them. Up to 25 devices can be in a customer site. 

There are also limits on the number of certain device types that can be in a 

customer site. See Customer Site Device Limits, page 75 for more information.

STEP 5 To remove devices that are already in the customer site, uncheck the entries for 

them in the Devices table.
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STEP 6 Click OK to save your changes and close the window.

STEP 7 Choose Home > Topology View to open the Topology view. Icons of the newly 

discovered devices are displayed in the Topology view.

STEP 8 To add a new device to an existing customer site, right-click on the icon in the 

Topology view and choose Add to Site from the pop-up menu.

Adding a Device to an Existing Customer Site

You can also add a device to an existing customer site. To do this, right-click a 

candidate icon in the Topology view, and select Add to Site. You are prompted to 

enter the administrator username and password to authenticate.

Viewing and Listing Devices in a Customer Site

Follow these steps to view and list devices in a customer site and verify that the 

site contains the expected devices:

STEP 1 Choose Home > Topology to display the Topology view.

STEP 2 Choose Monitor > Inventory to display an inventory of the devices in the 

customer site.

This summary includes device model numbers, serial numbers, software versions, 

IP information, and location.

STEP 3 Choose Home > Front Panel to display the Front Panel view.

STEP 4 Choose Home > Dashboard to display the system dashboard view.

Managing Customer Sites

To manage customer sites, choose Home > Customer Sites from the feature bar.

From the Customer Sites window you can see a list of existing customer sites, 

create customer sites, modify customer sites, and delete customer sites.
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Procedures

• To create a customer site, click Add a New Site to open the Create New 

Customer Site window. See Creating a New Customer Site, page 78.

• To modify a customer site, select the customer site from the list and click 

Modify Site to open the Modify Customer Site window. See Modify a 

Customer Site, page 81.

• To delete a customer site, select the customer site from the list and click 

Delete Site.

When you are done with this window, click OK.

Connecting to a Site or Standalone Device

When you launch CCA, two windows open: the Cisco Configuration Assistant main 

window, which contains the user interface, and the Connect window.

You can also open the Connect window by choosing System > Connect from the 

menu bar.

Cisco Configuration Assistant starts in disconnected mode; that is, it is not 

connected to a customer site or a standalone device. In this mode, you see the 

menu bar in the CCA window but only a small number of items in the feature bar. 

The feature bar is created and populated with device features only when CCA is 

connected.

The following sections describe how to use each of the tabs in the Connect 

window:

• Customer Sites Tab, page 83

• Hostname/IP Address Tab, page 85

• Advanced Options Tab, page 86

Customer Sites Tab

To manage and configure multiple devices on your network in a single session, 

create a customer site.

TIP If you are new to CCA or are creating a customer site for the first time, see 

Creating and Managing Customer Sites, page 74 to learn more about the 

purpose and benefits of creating customer sites to manage devices using CCA.
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From the Customer Sites tab, you can:

• Create a new customer site and connect to it.

• Connect to an existing customer site by selecting it from a list.

• Modify or delete an existing customer site.

To create and connect to a new customer site, follow these steps.

STEP 1 Select the Customer Sites tab in the Connect window and click Add a New Site. 

The Create a New Customer site dialog appears.

STEP 2 Complete the fields in the Create a New Customer Site dialog, discover devices, 

and add devices to the site as described in the section Creating a New Customer 

Site, page 78.

STEP 3 After you have successfully created the customer site, it is displayed in the list of 

sites on the Customer Sites tab in the Connect window.

STEP 4 Click Connect.

When you connect to a customer site, CCA displays an Authentication: Device 

dialog that prompts you for each unique password that has been assigned to 

members of that site.

STEP 5 Enter login credentials for each device when prompted. You may also be 

prompted to accept security certificates for some devices.

IMPORTANT: For Cisco IOS devices, the enable password for the device must 

be the same as the password used to log in to the device using CCA.

For more information, see Passwords, page 77.

NOTE: After three failed authentication attempts, the device icon is displayed in 

Red in the Topology view with the message “Unreachable: Authorization Failed.” 

To retry the connection, choose System > Connect.You are prompted to close the 

session and restart CCA.

When you have successfully authenticated, a CCA session is established. Only 

one session at a time can run on a PC.

When you are connected to the customer site, the status bar at the bottom of the 

window displays the message “Discovering topology” while CCA discovers 

devices and builds the Topology view. See Topology View, page 32.
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After the network topology information has been loaded, any voice configuration 

data on the system is read in. The status bar at the bottom of the page displays the 

message “Loading voice-related data.”

Wait until voice configuration data is finished loading before you can open any 

Voice or Telephony feature-related windows.

Devices that are part of the site are listed in the left frame of the Topology view 

(switches, access points, and so on). IP phones and devices that are not part of the 

customer site are listed under Neighbors in the left frame. Although IP phones are 

listed under Neighbors, they are configured through CCA.

To end a session, close the CCA main window, or choose System > Exit. You will 

be prompted to save any configuration changes made during that session to a 

single device or to all devices.

To modify settings for an existing site, select a customer site from the list and click 

Modify. See Modify a Customer Site, page 81.

To delete a customer site, select the customer site from the list and click Delete.

Hostname/IP Address Tab

Use the Hostname/IP address tab when you want to connect to and manage a 

single, standalone device by specifying its hostname or IP address.

To connect to a single device, follow these steps.

STEP 1 Click the Hostname/IP Address tab, enter or select a hostname or IP address to 

connect to the device.

STEP 2 Click Connect.

Customer site members

Neighbor devices and IP phones
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STEP 3 Enter the administrator username and password for authentication.

IMPORTANT For Cisco IOS devices, the enable password for the device must 

be the same as the password used to log in to the device using CCA.

When you have successfully authenticated, a CCA session is established. Only 

one session at a time can run on a PC.

NOTE: After three failed authentication attempts, the device icon is displayed in 

Red in the Topology view with the message “Unreachable: Authorization Failed.” 

To retry the connection, choose System > Connect.You are prompted to close the 

session and restart CCA.

Advanced Options Tab

On the Advanced Options tab, you can choose whether to grant Read/Write 

permission for this connection.

When you choose Read/Writer, you have permission to configure networking 

features with CCA. Otherwise, select Read Only and choose an access level, from 

1 to 15.

The default access mode is Read/Write.

Using CCA Setup Wizards

In addition to the expert mode configuration GUI, CCA provides several setup 

wizards to assist you in configuring Cisco SBCS solutions, features, and devices.

To access CCA setup wizards, choose Home on the CCA feature bar.

Some wizards are only available if the required devices are members of the 

customer site to which you are connected. For example, if the customer site does 

not have wireless capabilities, the Wireless Setup Wizard option is not displayed.

See the following sections:

• Which Wizard Should I Use and When?, page 87

• Telephony Setup Wizard, page 89

• Security Setup Wizard, page 92

• Wireless Setup Wizard, page 95
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• Device Setup Wizard, page 98

• SR520-T1 Configuration Utility, page 99

• Phone VPN Setup Wizard, page 99

• Video Monitor Setup Wizard, page 102

Which Wizard Should I Use and When?

Each of the CCA setup wizards is designed to automate configuration and 

maintenance for specific devices, features, and types of deployments. Available 

setup wizards are summarized in the following table.

Wizard What this wizard does When to use this wizard To learn more

Telephony 
Setup 
Wizard

For a Cisco SBCS/UC500 system, the 
Telephony Setup wizard configures 
basic WAN and LAN settings, system 
locale, telephony system settings, 
voice trunks (except SIP trunks), voice 
ports, Auto Attendant, schedules, 
phone users and extensions, inbound 
call routing, and hunt groups.

The wizard supports all UC500 
platforms. If the UC500 is behind an 
SR500 Series secure router or SA500 
security appliance, the wizard 
automatically adjusts static routes and 
ACLs and removes the firewall on the 
UC500.

Use this wizard for first-time setup 
only. This wizard requires a UC500 
with factory default configuration.

Run the Telephony Setup Wizard 
before running other CCA setup 
wizards.

If an SR520-T1 secure router provides 
the WAN connection, you must also 
run the SR520-T1 Configuration Utility. 
Run the SR520-T1 Configuration 
Utility before running the Telephony 
Setup Wizard. See SR520-T1 
Configuration Utility, page 99.

For SR520 ADSL/Ethernet secure 
routers and SA500 Series Secure 
routers, configure the WAN 
connection before running the 
Telephony Setup Wizard. 

Telephony Setup 
Wizard, page 89
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Security 
Setup 
Wizard

The Security Setup wizard is used for 
configuring data-only small business 
deployments with an SA500 Series 
Security Appliance as the WAN edge 
device, along with Cisco Small 
Business Pro switches and wireless 
access points.

This wizard configures basic WAN, 
LAN, and wireless network setting on 
the SA500 Series Security Appliance. 
It also automates trunk configuration 
for attached Cisco Small Business Pro 
ESW500 Series or CE520 switches 
and synchronizes wireless profiles on 
SA500 integrated and external 
AP541N access points that are 
members of the same customer site.

Use this wizard for first-time setup of 
an SA500 data deployment.

You can also re-run the wizard to 
update these settings for an existing 
deployment.

This wizard also supports a staging 
mode that allows you to pre-configure 
settings without the SA500 and other 
devices physically connected to the 
network. In staging mode you can 
export and import the configuration to 
and from a local file before applying 
the final configuration.

Run this wizard before configuring 
security features with the SA500 
Configuration Utility.

Security Setup 
Wizard, page 92

Device 
Setup 
Wizard

The Device Setup wizard provides 
instructions for connecting and 
configuring basic device settings such 
as hostname and IP address so that 
they can be managed by CCA.

These devices are supported:

Cisco Catalyst Express CE520 
switches
Cisco AP521 autonomous access 
points Cisco WLC526 wireless LAN 
controllers
Cisco SR520 ADSL/Ethernet secure 
routers.

Use this wizard for first-time setup of 
these devices from their factory 
default configuration.

Device Setup 
Wizard, page 98

Wireless 
Setup 
Wizard

The Wireless Setup Wizard 
configures and synchronizes wireless 
network and profile settings for voice-
over-wireless deployments or data-
only wireless deployments with 
multiple access points.

The wizard supports UC500 
integrated APs, AP521 autonomous 
access points, SPA525G and 
SPA525G2 IP phones operating in 
wireless-G mode, and AP541N APs.

Use this wizard for first-time setup 
and synchronization of wireless 
profiles for wireless voice and data 
deployments with SPA525G IP 
phones and supported APs.

You can re-run the wizard to update 
wireless network and profile settings.

Wireless Setup 
Wizard, page 95

Wizard What this wizard does When to use this wizard To learn more
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Telephony Setup Wizard

To launch the Telephony Setup wizard, choose Home > Telephony Setup Wizard 

from the feature bar. If the UC500 at the customer site is in factory default 

configuration, this wizard is launched automatically.

The Telephony Setup Wizard walks you through the steps required to configure a 

basic telephony solution.

Phone VPN 
Wizard

The Phone VPN Setup Wizard 
configures VPN client settings on 
Cisco SPA525G or SPA525G2 IP 
phones to be deployed for use at 
remote sites.

The Phone VPN Setup wizard cannot 
be used in deployments where the 
UC500 is behind an SA500 Security 
Appliance.

Run this wizard at the main site to 
automate phone VPN client 
configuration for SPA525G IP phones 
that will be deployed at remote sites.

You can re-run the wizard to update or 
remove existing VPN configuration 
from phones.

It is recommended that you run the 
Telephony Setup wizard before 
running the Phone VPN wizard.

Phone VPN 
Setup Wizard, 
page 99

Video 
Monitor 
Setup 
Wizard

The Video Monitor Setup wizard 
configures camera settings and 
associates Cisco PVC2300/
WVC2300 Series Business Internet 
Video Cameras with SPA525G and 
SPA525G2 IP phones. This enables 
users to monitor video from these 
cameras using the built-in video 
monitor on the SPA525G and 
SPA525G2 IP phones.

This wizard can be used for first-time 
setup of the video monitoring feature 
on SPA525G phones and Cisco 
PVC2300/WVC2300 Series IP 
cameras.

You can re-run the wizard to update an 
existing installation.

Run the Telephony Setup Wizard 
before running the Video Monitor 
Setup wizard.

Video Monitor 
Setup Wizard, 
page 102

Multisite 
Manager

Use the Multisite Manager to 
configure and manage Cisco SBCS 
multisite voice and data deployments.

Use the Multisite Manager for first-
time configuration of a Cisco SBCS 
multisite deployment. Existing out-of-
band multisite configurations are not 
recognized by CCA.

You can also use the Multisite 
Manager to add, remove, or edit sites 
or to update settings for an existing 
deployment.

It is recommended that you run the 
Telephony Setup wizard before 
running the Multisite Manager.

Multisite 
Manager, 
page 467

Wizard What this wizard does When to use this wizard To learn more
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The wizard is intended for initial installations and for cases in which you want to 

reset the Cisco UC500 to factory defaults and completely replace the current 

configuration.

These settings are configured through the wizard:

• Basic network settings such as WAN connection type

• Phones, users, and primary extensions

• Hunt groups and blast groups

• Trunk settings (ISDN BRI, ISDN PRI, and analog trunks) and phone numbers

• Locale-specific dial plan

• Inbound call routing

• Business schedules

• Auto Attendant actions and prompts

• The primary extension assigned to the phone will be enabled for the Auto 

Attendant  Dial-by-Name service.

When you launch the Telephony Setup Wizard, CCA detects the number of 

software licenses installed and the currently installed UC500 software pack and/

or Cisco IOS software version.

The Telephony Setup Wizard also supports bulk import of user and phone data. 

For information about how to prepare the data for import, see Importing Phone 

Data for Multiple Users (Bulk User Import), page 317.

Buttons for accessing the CCA expert mode Software Upgrade and License 

Management windows are provided to allow you to perform software and/or 

license upgrades before continuing with the wizard. Clicking these buttons closes 

the wizard.

Before You Begin

Before running the Telephony Setup Wizard

• If the PC running CCA has more than one network interface (for example, a 

dual-NIC for wired and wireless network connection), make sure that only 

one is enabled.

• Disable any third-party firewall or TFTP services on the PC running CCA.

• Check the firewall and network security settings on your PC to make sure 

that TFTP traffic is allowed between the PC and the UC500.
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• Ensure that the PC running CCA is directly connected to a LAN port on the 

UC500 and has obtained an IP address from the UC500 using DHCP.

• Make sure that the UC500 system is at factory default configuration.

• For non-US locales, download and install localization files in the appropriate 

location.

• Make sure that you have gathered all the information listed on the Welcome 

page of the wizard.

• If the UC500 will be behind an SA500 Series Security Appliance or SR500 

Series Secure Router, connect the UC500 WAN to the SA500 or SR500 LAN 

before running the Telephony Setup Wizard.

Using the Telephony Setup Wizard

To access this wizard from the feature bar, navigate to Home > Telephony Setup 

Wizard.

The configuration you set up via the wizard is not applied until the final page of the 

wizard. To go back to previously visited pages of the configuration:

• Use the Back button.

• Use the navigation panel on the left side of the page to go to specific pages 

within a configuration section.

• Use the Summary page links, then click Resume to return to the summary 

page.

If the changes you make affect other settings configured through the wizard, 

navigation menu items highlighted in Red indicate errors that must be corrected 

before continuing.

After you click Apply Configuration, the settings chosen in the wizard are applied. 

If you exit the wizard before applying the configuration, all settings entered 

through the wizard are discarded.

After the initial configuration is established through the wizard and you have 

verified that basic networking and voice features are working properly, continue 

configuring additional network, security, and voice features through the main 

Cisco Configuration Assistant GUI.

Next Steps

These telephony features are not configured through the Telephony Setup wizard:
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• Calling permissions for individual phones (call permissions are unrestricted 

for phones added through the wizard)

• Call blocking for individual phones (call blocking is disabled for phones 

added through the wizard)

• Intercoms, shared lines, overlays, and octal lines

• Monitor mode and Watch mode lines

• SIP trunk interface

• Basic ACD (automatic call distribution)

• Multi-party conferencing (AdHoc/MeetMe)

• Night service

• Custom outgoing dial plan numbers

• Trunk groups and priorities

• System speed dials

• Paging groups

• Call Pickup groups

• Call Park extensions

• Conferencing

• Extension Mobility

• SIP Phone

See the CCA online help or other sections in this guide for information about how 

to configure these features in expert mode using CCA.

Security Setup Wizard

To launch the Security Setup Wizard, choose Home > Security Setup Wizard 

from the feature bar.

NOTE: The Security Setup Wizard is intended for use in data-only deployments 

with SA500 Series Security Appliances, ESW500 Series switches, and AP541 

access points. If you are deploying a UC500 telephony solution, run the Telephony 

Setup Wizard to set up the network.
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The Security Setup Wizard can be used for first-time set-up or to edit existing 

configuration, as described in these sections:

• Overview

• Staging the Configuration

• Downloading and Installing the Latest Firmware for SA500, ESW500, 

and AP541N Devices

• Using the Security Setup Wizard

• Next Steps

Overview

Cisco SA500 Series Security Appliances provide WAN connectivity, routing, 

firewall, security, remote access, and wireless access for small business 

networks.

The Security Setup Wizard guides you through the steps required to configure 

wireless network settings for a Cisco SA500 Series Security Appliance in a small 

business data-only network. The wizard also synchronize wireless profile 

information for integrated SA500 wireless and AP541N access points that are 

members of the CCA customer site.

When you apply the configuration through the wizard, CCA automatically sets up 

802.1q trunking and synchronizes wireless LAN (WLAN) data and guest profile 

settings for connected Cisco Small Business Pro devices such as ESW500 Series 

switches and AP541N access points.

Staging the Configuration

If CCA detects that the customer site that you are connected to does not contain 

an SA500, the wizard automatically runs in staging mode.

In staging mode, you can pre-configure settings and save your progress at any 

point in the wizard by choosing Export Configuration to File. To resume 

configuration, re-run the wizard and choose Import Configuration From File.

When the equipment is available and you are connected to the customer site, re-

launch the wizard, import your previously saved configuration, make any needed 

changes, and apply the configuration.
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Downloading and Installing the Latest Firmware for SA500, ESW500, and 

AP541N Devices

If you are connected to a CCA customer site with an SA500, the current SA500 

device firmware version is displayed. Version 1.1.21 or later of the SA500 firmware 

is required.

To obtain the latest firmware from Cisco.com, follow these links. A Cisco.com login 

is required.

• Software downloads for SA500 Security Appliances are available at 

www.cisco.com/go/sa500software.

• For ESW500 Series switches, a link to the software downloads is available 

at www.cisco.com/go/esw500help. Click the Resources tab and choose 

the Firmware link under Firmware and Release Notes.

• For AP541N access points, software downloads are available at 

www.cisco.com/go/ap500software.

When you have finished downloading the software, click the Upgrade Software 

button in the wizard or choose Maintenance > Software Upgrade from the 

feature bar in CCA to open the CCA Software Upgrade window.

Follow the instructions in the CCA online help to upgrade firmware for these 

devices. See Software Upgrades, page 538.

Using the Security Setup Wizard

To launch the wizard, choose Home > Security Setup Wizard from the feature bar.

Follow the onscreen instructions in the wizard to configure these settings:

• Administrator password (for security reasons, this must be changed from 

the default cisco password)

• Timezone, daylight savings time option, and NTP servers

You cannot directly set the system time on the SA500. Therefore, a NTP 

server is required. The default servers (0.us.pool.ntp.org and 

1.us.pool.ntp.org) are scoped to the United States, rather than the global 

zone.

• WAN connection (DHCP, Static IP, or PPPoE)

• Data VLAN

• Static routes

• Wireless guest network

http://www.cisco.com/go/sa500software
http://www.cisco.com/go/ap500software
http://www.cisco.com/go/esw500help
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• Wireless SSID, VLAN ID, and profile information for data and guest 

networks.

When you apply the configuration, the wizard synchronizes these wireless 

profile settings with the integrated SA520W access point and all AP541N 

access points on the network. To be synchronized, these access points must 

be members of the CCA customer site to which you are connected.

Existing configuration is replaced with the new configuration.

WPA2 security with TKIP + CCMP encryption is automatically configured for 

the wireless security type.

You can re-run the wizard at any time to modify these settings.

Next Steps

When you have completed the Security Setup Wizard, you can right-click on the 

SA500 icon in the Topology view and choose Configuration Utility to run the 

Web-based SA500 management software.

From the SA500 Configuration Utility you can configure security features for the 

customer site, such as firewall and DMZ, URL filtering, Intrusion Prevention System 

(IPS), port forwarding, and SSL VPN. These features are not configured through 

CCA.

Cisco ProtectLink Gateway is a hosted security service that blocks spam and 

filters URLs to prevent unwanted content from passing into your business network. 

Follow the instructions in the Cisco SA500 Series Security Appliances 

Administration Guide to obtain an Activation Code and enable ProtectLink 

services on the SA500. To learn more, visit www.cisco.com/go/protectlink.

For more information, see the Cisco SA500 Series Security Appliances 

Administration Guide, available on Cisco.com at the following URL:

www.cisco.com/go/sa500

Click the Resources tab and scroll to the Technical Documentation section to 

locate the administration guide and other relevant links.

Wireless Setup Wizard

To launch the Wireless Setup wizard, choose Home > Wireless Setup Wizard 

from the feature bar. The Wireless Setup Wizard menu option is only available if 

the customer site to which you are connected has wireless capability.

• Overview

http://www.cisco.com/go/sa500
http://www.cisco.com/go/protectlink
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• Before You Begin

• Using the Wireless Setup Wizard

Overview

Use the Wireless Setup Wizard to automate configuration of wireless settings for 

multiple access points or to configure Cisco SBCS voice-over-wireless solutions 

with Cisco SPA525G or SPA525G2 IP phones operating in wireless-G mode. 

Wireless network and profile settings are synchronized among access points and 

SPA525G and SPA525G2 phones that are members of the customer site. All 

UC500 models are supported.

These wireless devices are supported:

• Integrated UC500 access points

• Cisco Small Business Pro AP541N access points

• Cisco AP521 autonomous access points

IMPORTANT If clustering is enabled for AP541N access points that are part of a 

CCA customer site, do not run the Wireless Setup Wizard to configure these 

access points.

If you are using Cisco AP541N access points with SPA525G/SPA525G2 phones, 

follow the SBCS deployment guidelines described in the Cisco SBCS 2.0 Voice 

Over Wireless Deployment Guide. This guide is available on Cisco.com at the 

following URL:

www.cisco.com/en/US/docs/voice_ip_comm/sbcs/deployment_guides/

voice_over_wireless/sbcs_20_vowifi_deployment_guide.pdf

Cisco Model 7921 and 7925 phones can be used with SBCS 2.0 voice over 

wireless solutions that use AP541N access points. However, the Wireless Setup 

Wizard does not automatically synchronize wireless profile settings for these 

phones.

If you are using older Cisco AP521 autonomous access points with SPA525G/

SPA525G2 IP phones, follow the reference designs and guidelines specified in the 

Cisco SPA525G Wireless Deployment Guide for Cisco SBCS. This guide is 

available on Cisco.com at the following URL:

www.cisco.com/en/US/docs/voice_ip_comm/sbcs/deployment_guides/

spa525g_phone/sbcs_spa525g_wireless_deployment_guide.pdf

Before You Begin

Your system must meeting the following requirements:

http://www.cisco.com/en/US/docs/voice_ip_comm/sbcs/deployment_guides/spa525g_phone/sbcs_spa525g_wireless_deployment_guide.pdf
http://www.cisco.com/en/US/docs/voice_ip_comm/sbcs/deployment_guides/voice_over_wireless/sbcs_20_vowifi_deployment_guide.pdf
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• CCA version 2.2(2) or later is required for AP541N support via the Wireless 

Setup Wizard.

• SPA525G IP phones must be running firmware version 7.1.3 or later

• UC500 software pack 7.0 or later

• AP541N access points must be running firmware version 1.8.0 or later.

• SPA525G/SPA525G2 phones that will be connected wirelessly must have 

a Model PA100 external power supply.

Before running the Wireless Setup wizard, you must:

• Gather the following information: SSIDs and passwords (pre-shared keys) 

that you want to use for the wireless data, voice, and guest networks.

• Connect any external access points (AP541Ns or AP521s) to the UC500.

• Connect any SPA525G/SPA525G2 phones directly to the LAN side of the 

UC500 for wireless profile synchronization.

• Create a CCA customer site for the UC500, phones, and access points.

• Connect to the customer site and verify that the external access points are 

members of the customer site.

Using the Wireless Setup Wizard

To run the Wireless Setup Wizard, connect to the customer site you created and 

choose Home > Wireless Setup Wizard from the feature bar.

Follow the onscreen instruction to configure these settings:

• Enable wireless mode on the SPA525G/SPA525G2 phones.

• Configure SSIDs, passwords (pre-shared keys), for wireless data and voice 

networks.

• Choose whether or not to enable SSID broadcast.

• Enable the guest network, if needed, and configure the SSID, password 

(pre-shared key), and choose whether to enable SSID broadcast.

The following notes apply to VLAN IDs configured by the Wireless Setup Wizard:

• The voice network VLAN ID is set to 1 (the value reserved by CCA).

• The data network VLAN ID is set to 100 (the value reserved by CCA).
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• The guest network VLAN ID is set to 25 (the value reserved by CCA).

- If the cisco-guest SSID already exists on a device in the customer site 

and its VLAN ID is not set to 25, the existing cisco-guest SSID is deleted 

and re-created, and its VLAN ID is set to 25.

- If the cisco-guest SSID already exists on a device in the customer site 

and its VLAN ID is already set to 25, its configuration is not modified.

The wizard automatically configures QoS settings on AP541N access points and 

WPA2-PSK encryption for wireless security. You do not need to specify these 

options.

You can re-run the wizard at any time to modify these settings. Each time you run 

the wizard, it overwrites existing values with the new settings.

Device Setup Wizard

New devices or devices that have been reset to their factory defaults must be set 

up. Use the Device Setup Wizard to make these devices ready for CCA to manage. 

To start the wizard, choose Home > Device Setup Wizard on the feature bar. 

Follow the step-by-step onscreen instructions to set up the device.

NOTE: The Cisco SR520-T1 secure router has its own setup utility, the SR520-T1 

Configuration Utility. This setup utility is launched automatically if the SR520-T1 

device is connected to a UC500 and is at factory default configuration. See 

SR520-T1 Configuration Utility, page 99.

You can configure these devices using the Device Setup Wizard:

• Cisco SR520 ADSL/Ethernet secure routers

• Cisco CE520 switches

• Cisco AP521 autonomous access points

• Cisco WLC526 wireless LAN controller

The Cisco AP541N Dual-band Single-radio wireless access point cannot be 

configured though the Device Setup Wizard.
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SR520-T1 Configuration Utility

If your site includes an SR520-T1 Secure Router and the SR520-T1 is at factory 

default state, choose Home > SR520-T1 Configuration Utility to:

• Set up the T1 WAN connection

• Modify the default the LAN0 IP address during the initial setup (optional)

• View diagnostic information and execute ping tests to verify connectivity

• Upgrade SR520-T1 software

For important information about prerequisites and step-by-step procedures, see 

the Cisco Small Business Pro SR520-T1 Secure Router Quick Start Guide and 

the UC500 and SR520-T1 Secure Router Setup application note, available on 

Cisco.com.

After you have configured the T1 connection, use CCA in expert mode to 

configure additional settings and features such as NAT, FIrewall and DMZ, 

administrator accounts, DNS, hostname, NTP, SNMP, static routes, and licensed 

security features (IPS, SSL VPN, and URL filtering).

Phone VPN Setup Wizard

NOTE:  The Phone VPN Setup wizard cannot be used in deployments where the 

UC500 is behind an SA500 Security Appliance.

To launch the Phone VPN Setup Wizard, choose Home > Phone VPN Setup 

Wizard from the feature bar. The Phone VPN Setup Wizard menu item is only 

available if the customer site to which you are connected contains at least one 

SPA525G or SPA525G2 IP phone.

• Overview

• Before You Begin

• Launching and Using the Phone VPN Setup Wizard

• Enabling the Phone VPN at the Remote Site

• Modifying Phone VPN Settings After the Initial Installation
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Overview

Use the Phone VPN Setup Wizard to configure VPN client settings on Cisco 

SPA525G or SPA525G2 IP phones to be deployed for use at remote sites.

• At the office — Connect the IP phones to the UC500, configure user 

extensions using CCA, and run the wizard to configure VPN client settings 

on the phone and set up VPN user accounts on the server. After configured, 

the phone can be unplugged and sent to the remote site.

• At the remote site — The remote user connects the phone to the network 

at the remote site and enables the VPN client on the phone. The phone 

initiates a connection to the UC500 over a secure VPN tunnel using the pre-

configured settings. After connected to the VPN, the phone appears just like 

any other phone at the main site, and calls between the main site and the 

remote site go over the VPN.

You can re-run the Phone VPN Setup wizard as needed to add, edit or remove 

phone VPN client settings on phones, for example, to re-deploy a phone at the 

main site, configure additional VPN-enabled phones, or change the user 

associated with the phone.

Before You Begin

Before launching the Phone VPN Setup Wizard, your system must meet the 

following requirements:

• SSL VPN Server and Anyconnect client settings must be configured for the 

site. If SSL VPN is not configured, you are asked to configure it before 

continuing.

A static IP address for the WAN connection is required for SSL VPN server 

configuration. Also, you must enable Full Tunnel mode and install the SSL 

VPN Anyconnect client package for Microsoft Windows. Split Tunnel mode 

is not supported for phone VPN.

• All IP phones to be configured for VPN must have the latest phone firmware 

installed. Version 7.4.2 or later is required.

• The IP phones must be powered on and connected to the UC500 through a 

LAN port on the UC500 or through a switch or wireless AP that is connected 

to the UC500.

• When calculating the total number of simultaneous VPN connections 

required for a customer site, be sure to include the VPN connections that are 

used for IP phone VPNs.
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The UC520 and UC540 platforms support a maximum of 10 simultaneous 

VPN connections. The UC560 platform supports a maximum of 20 

simultaneous VPN connections.

• The IP phones must be registered to the UC500 and display an extension.

• Basic network and telephony settings must be configured for the customer 

site, using either the Telephony Setup Wizard or the CCA expert mode GUI.

• For ease-of-use, user extension settings such as phone user ID, password, 

and phone buttons should be configured before running the VPN Phone 

Setup wizard. This is recommended, but not required. User extension 

settings can still be edited after you run the Phone VPN Setup Wizard.

Launching and Using the Phone VPN Setup Wizard

To launch the Phone VPN Setup Wizard, choose Home > Phone VPN Setup 

Wizard.

The wizard discovers SPA525G and SPA525G2 IP phones connected to the 

UC500 and displays the MAC address, extension, and phone user ID to help you 

identify the phones.

Follow the on-screen instructions in the wizard to select phones and enter a VPN 

username and password for the VPN account to associate with the phone.

As each phone is configured, the Status column updates to indicate success or 

failure. If the configuration fails for a phone, the wizard continues with the next 

phone in the list.

Enabling the Phone VPN at the Remote Site

At the remote site, the phone user must follow these steps to set up their IP phone 

and connect it to the VPN.

STEP 1 Connect the IP phone to power.

STEP 2 Connect the phone to the network at the remote site (home or remote office).

STEP 3 Wait for the phone to initialize and obtain an IP address from the network at the 

remote site.
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The phone automatically connects to the VPN server.

If you do not want the phone to automatically connect to the VPN server, set the 

Connect on Bootup option on the SPA525G/SPA 525G2 IP phone to OFF. To 

access this setting, press the settings button on the phone and go to Information 

and Settings > Network Configuration > VPN.

For more information on the Cisco SPA525G/SPA525G2 IP phones, go to this URL:

www.cisco.com/go/500phones

Modifying Phone VPN Settings After the Initial Installation

You can re-run the Phone VPN wizard to configure VPN settings for additional 

supported IP phones, edit existing VPN settings, or remove VPN settings from the 

configuration for phones.

To remove existing VPN configuration from phones, re-run the Phone VPN Setup 

Wizard and deselect (uncheck) those phones in the list of available phones before 

applying the configuration.

Video Monitor Setup Wizard

To access the Video Monitor Setup Wizard, choose Home > Video Monitor Setup 

Wizard from the feature bar.

The Video Monitor Setup Wizard menu item is only available if the customer site to 

which you are connected has at least one SPA525G or SPA525G2 IP phone and 

one Cisco PVC2300 or WVC2300 Business Internet Video Camera.

• Overview

• Before You Begin

• Preparing IP Cameras and Phones for Video Monitoring

• Launching and Using the Phone VPN Setup Wizard

• Configuring PVC2300/WVC2300 Video Settings

• Viewing Video on SPA525G/SPA525G2 IP Phones

• Modifying Video Monitor Settings After the Initial Installation

www.cisco.com/go/500phones
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Overview

The Video Monitor Setup wizard guides you through the steps required to 

configure camera settings and associate Cisco 2300 Series Business Internet 

Video Cameras with SPA525G/SPA525G2 IP phones. This enables users to 

monitor video from the cameras using the built-in camera viewer on the SPA525G/

SPA525G2 IP phones.

Each SPA525G/SPA525G2 IP phone can receive video from up to four Cisco 

2300 Series Business Internet Video Cameras. Model PVC2300 (wired, PoE) and 

WVC2300 (wireless, non-PoE) cameras are supported.

The following limitations apply to video monitoring on SPA525G/SPA525G2 IP 

phones:

• While monitoring video from the SPA525G/SPA525G2 phone, the phone 

can still make and receive calls. However, inbound calls do not change the 

display focus, and the only visual indication will be a flashing light associated 

with the line being called. To answer inbound calls, simply press the line 

button.

• If you are viewing video on the phone, the video application stops when you 

make an outbound call and does not automatically resume.

• There is no audio integration between the IP phone and the cameras.

• You cannot simultaneously enable the VPN client and video monitoring on 

SPA525G/SPA525G2 phones.

• Door Access Control from the SPA525G/SPA525G2 phone using the GPIO 

ports on the back of the camera is not supported.

Before You Begin

Before launching the Video Monitor Setup wizard, make sure that your system 

meets these requirements:

• Basic network and telephony settings are configured for the customer site, 

using either the Telephony Setup Wizard or the CCA expert mode GUI.

• Cisco SPA525G/SPA525G2 IP phones must be running phone firmware 

version 7.4.3 or later and must be members of the CCA customer site to 

which you are connected. See Preparing IP Cameras and Phones for 

Video Monitoring, page 106.
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• The Cisco 2300 Series Business Internet Video Cameras must be running 

camera firmware version 1.1.1.4 or later and must be members of the CCA 

customer site to which you are connected. The cameras must be assigned a 

static IP address.

If you are using WVC2300 (wireless, non-PoE) cameras, the default SSID 

(ciscosb) and wireless profile settings must be configured to match those on 

the access points and the UC500.

For information about where to download the latest camera firmware and 

how to upgrade camera firmware, see Preparing IP Cameras and Phones 

for Video Monitoring, page 106.

• The PC running CCA must be connected to a CCA customer site that 

contains the UC500, SPA525G/SPA525G2 IP phones, and Cisco PVC2300/

WVC2300 Series cameras.

Launching and Using the Video Monitor Setup Wizard

STEP 1 When all of the cameras are added to the customer site, choose Home > Video 

Monitor Setup Wizard to start the wizard.

STEP 2 Follow the onscreen instructions in the wizard to configure camera settings and 

associate IP phones with the cameras.

a. For each camera in the list, you can edit the camera name and location 

description, specify a username and password, and specify an extension to 

call. 

The username and password configured through the wizard provides 

administrative access to the camera by CCA for creating accounts with 

Monitor privileges on the cameras that are used by the IP phones. The phone 

number specified in the Extn to Call field is the extension or phone number that 

is dialed when a phone user presses the Call softkey on their IP phone while 

viewing video from the camera.

b. Associate SPA525G/SPA525G2 IP phones with IP cameras. Each IP phone can 

be associated with up to 4 cameras.

STEP 3 Review the settings and apply the configuration.

The video cameras and associated IP phones are restarted after the configuration 

is applied.
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IMPORTANT Follow the instructions in the section Configuring PVC2300/

WVC2300 Video Settings, page 105 to configure video settings for the cameras 

that will be sending video to the phones.

Configuring PVC2300/WVC2300 Video Settings

You must change the MJPEG video settings on the WVC2300/PVC2300 cameras 

to the format required for SPA525G integration.

For each camera, perform these steps to configure the video settings.

STEP 1 From the Topology view in CCA, right-click on the camera icon and choose 

Configuration Utility.

STEP 2 From the left navigation menu in the camera configuration utility, choose Audio/

Video > Video.

STEP 3 In the MJPEG Settings section, configure these settings:

Resolution: 320*240

Max Frame Rate: 10 fps

Video Quality Control: Select Fixed Quality and set it to Normal.

STEP 4 Save the configuration and exit the PVC2300/WVC2300 Configuration Utility.

IMPORTANT The MJPEG settings for the camera cannot be changed if the 

camera is integrated with the SPA525G/SPA525G2 phone. Changing these 

settings will prevent the video stream from being displayed on the phone.

Viewing Video on SPA525G/SPA525G2 IP Phones

After the phones and cameras have restarted, follow these steps to view video on 

the SPA525G IP phones.

STEP 1 On the SPA525G/SPA525G2 IP phone, press the settings button.

STEP 2 Use the up and down arrow keys on the phone to navigate to Information and 

Settings > Video Monitoring and click the center select button.

STEP 3 Choose a camera from the list and click the Monitor softkey.
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STEP 4 When the phone is connected to the camera and displays video, press the Call 

softkey to dial the phone extension you configured through the wizard.

Modifying Video Monitor Settings After the Initial Installation

To add or remove phones and cameras or change settings, you can re-run the 

wizard.

If wireless IP cameras are used, they must be configured with the same SSID as 

the data network on the UC500 and access points. Wireless SSID settings can be 

edited using the PVC2300/WVC2300 Configuration Utility or by using CCA in 

expert mode. Choose Configure > Wireless > WLANs (SSIDs) from the feature 

bar to access these settings in CCA.

You can also view or modify camera device properties such as users and 

passwords using CCA.

Preparing IP Cameras and Phones for Video Monitoring

See these sections for information updating camera and IP phone firmware and 

preparing phones and cameras for video monitoring:

• Obtaining the Latest SPA525G/SPA525G2 Phone Firmware

• Setting Up Cisco 2300 Series Business Internet Cameras

Obtaining the Latest SPA525G/SPA525G2 Phone Firmware

Version 7.4.3 or later of the SPA525G phone firmware is required for enabling 

video on SPA525G phones. Version 7.4.5 or later of the SPA525G2 phone firmware 

is required for SPA525G2 phones.

Version 7.4.3 of the SPA525G phone firmware is provided in the UC500 software 

pack version 8.0.1. To obtain the SPA525G software, you can either install the 8.0.1 

software pack on the UC500 or download the SPA525G version 7.4.3 or later 

phone firmware from Cisco.com and use the drag-and-drop method to upload the 

firmware to the UC500.

The SPA525G2 phones are shipped from the factory with version 7.4.5 phone 

firmware installed.

Setting Up Cisco 2300 Series Business Internet Cameras

Follow these steps to set up and prepare Cisco 2300 Series Business Internet 

Video Cameras for use with the CCA Video Monitor Setup wizard. You will need to:

• Unpack and set up the camera hardware.
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• Download the latest camera firmware from Cisco.com.

• Connect your PC to each camera and run the Setup CD that ships with the 

camera to configure basic settings.

• Assign a static IP address and upgrade the firmware on each camera.

• For WVC2300 (wireless) IP cameras, you must configure the wireless 

network SSID settings cameras to match those on the data SSID for access 

points and the UC500.

• Create a CCA customer site and add the cameras to the site so that you can 

use CCA to configure video monitoring on Cisco SPA525G/G2 IP phones.

STEP 1 Download version 1.1.1.4 or later of the Cisco 2300 Series Business Internet Video 

Cameras to the PC running CCA.

Version V1.1.1.4 or later of the camera firmware is required.

This software is available on Cisco.com in the following locations:

• Cisco PVC2300 and WVC2300 product pages (Cisco.com U.S. site only).

- PVC2300: www.cisco.com/go/pvc2300software

- WVC2300: www.cisco.com/go/wvc2300software

On the Resources tab, scroll down to the Firmware section and click 

Download Firmware and Accept License Agreement for Cisco PVC2300 

Business Internet Video Camera - Audio/PoE, or 

Download Firmware and Accept License Agreement for Cisco WVC2300 

Wireless-G Business Internet Video Camera - Audio.

The files are named PVC2300_Firmware.zip and WVC2300_Firmware.zip.

• Cisco Software Download Center (requires Cisco.com login), at

http://www.cisco.com/public/sw-center/index.shtml

In the Select a Product Category box, choose Security > Cisco Physical 

Security > Cisco Small Business Video Surveillance Cameras (Linksys 

Business Series) and select the camera model.

STEP 2 Unzip the camera firmware files that you downloaded: PVC2300_Firmware.zip, 

WVC2300_Firmware.zip.

www.cisco.com/go/pvc2300software
www.cisco.com/go/wvc2300software
http://www.cisco.com/public/sw-center/index.shtml
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When upgrading the camera firmware using CCA, you will need the 

WVC2300 FW_V111R04.bin file or the PVC2300 FW_V111R04.bin file, 

depending on the camera model you are using.

STEP 3 Unpack and set up the camera hardware as described in the Cisco PVC2300, 

WVC2300 Business Internet Video Camera with Audio Quick Start Guide. This 

guide is available on Cisco.com at the following URL:

http://www.cisco.com/en/US/products/ps9944/prod_installation_guides_list.html

STEP 4 Connect the cameras to the UC500 as described in the Quick Start Guide and 

apply power.

The Cisco PVC2300 camera can be connected to a PoE port on the UC500 or 

ESW500 Series switch. The Cisco WVC2300 camera uses a power adapter that is 

supplied with the camera.

STEP 5 Follow the instructions in the Cisco PVC2300, WVC2300 Business Internet 

Camera with Audio Administration Guide for using the Setup CD to install the 

software and configure basic network settings.

• Accept the license agreement.

• Log in as administrator (admin/admin is the default login).

• Configure basic camera settings (camera name, description, time zone, date, 

and time).

• On the Network Settings page of the Setup program, choose Fixed IP 

Address for the configuration type and enter a static IP address to use for 

the camera (192.168.10.x).

By default, the PVC2300 and WVC2300 cameras use DHCP to obtain an IP 

address. However, a static IP address must be configured on the cameras to 

ensure that IP address of the camera always matches the camera IP address 

configured on the phones. The Video Monitor Setup wizard reads in the IP 

address configured on the cameras.

• Confirm your settings and exit the setup wizard.

• If you are configuring WVC2300 (wireless, non-PoE) cameras, follow the 

instructions in the camera administration guide for configuring wireless 

settings. The wireless network name (SSID) and security settings 

configured on the cameras must match the SSID settings for the data 

network on the access points and UC500.

http://www.cisco.com/en/US/products/ps9944/prod_installation_guides_list.html
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STEP 6 Upgrade the camera firmware for each camera. Firmware version 1.1.1 or later is 

required.

a. From a PC connected to the local network (LAN), launch a web browser and 

connect to the camera using the static IP address you assigned to the camera 

(for example, 192.168.10.21).

b. Log in as administrator.

c. Click Setup on the toolbar. 

d. Click Administration > Firmware. The current version is displayed. If the 

version is prior to 1.1.1.4, click Upgrade and follow the onscreen instructions.

e. When prompted to choose an upgrade file, browse to the WVC2300 

FW_V111R04.bin file or the PVC2300 FW_V111R04.bin file on your local PC, 

depending on the camera model you are using.

f. Repeat these steps for each camera.

STEP 7 If you have not already done so, launch CCA and create a CCA customer site.

STEP 8 With the PC running CCA connected to the UC500 LAN, connect to the customer 

site that contains the UC500.

STEP 9 Choose Home > Topology to display the Topology view.

If the cameras you are connecting have already been upgraded to the correct 

software, they are displayed in the Topology view.

STEP 10 Click the Refresh icon in the Topology view, then right click on each camera and 

choose Add to Site.

You are now ready to launch the Video Monitor Setup Wizard. See Launching and 

Using the Video Monitor Setup Wizard, page 104.

Backing Up and Restoring Device Configuration

To access backup and restore options, choose Maintenance > Configuration 

Archive from the feature bar.
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Overview

This section provides instructions for backing up the startup configuration of all 

devices or a single managed device to your PC or a network drive and how to 

restore a previously backed up configuration.

In addition to the startup configuration, these files and directories on the UC500 

flash are also backed up and restored:

• System speed dial configuration

• vlan.dat file (VLAN configuration)

• Directories on the flash for BACD prompts, phone desktop images, media 

(Music On Hold files), and ringtones

- flash:bacdprompts/

- flash:Desktops/

- flash:ringtones/

- flash:media/

If the UC500 being backed up still has a flat directory structure retained from a 

prior release, only the startup configuration, VLAN configuration, and speed 

dials are backed up and restored.

Procedures

This section covers these topics:

• To Back Up a Configuration, page 110

• To Restore a Configuration from a Backup, page 111

• Backup Preferences, page 111

To Back Up a Configuration

Follow these steps to back up the startup configuration of managed device or all 

devices:

STEP 1 From the Configuration Archive window, click the Back Up tab.

STEP 2 From the Hostname list, select All Devices or the device with the startup 

configurations that you want to back up.

STEP 3 In the Backup Note text area, enter any information that will later help you to 

identify a backed-up configuration as the one that you want to restore.
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STEP 4 Click Back Up.

Configuration backups are archived to the directory shown in the Backup 

Directory field, and the event is recorded on the Restore tab.

TIP You can delete archived configurations that accumulate in the backup 

directory. The default directory is C:\Documents and 

Settings\<username>\.configuration assistant\backups.

STEP 5 Click OK.

To Restore a Configuration from a Backup

IMPORTANT You can only restore a UC500 configuration to a UC500 device with 

the same product SKU.

To restore a previously backed up configuration to the startup configuration of a 

managed device, follow these steps:

STEP 1 In the Configuration Archive window, select the device in the Hostname list that 

you want to restore to.

STEP  2 Click a button to determine the range of backed-up configurations shown in the 

Back-Up Configurations list.

The top button displays only the backed-up configurations from the device that 

you selected. The middle button displays the backed up configurations from the 

device that you selected and from any other devices in your customer site of the 

same device type. The bottom button displays all the backed-up configurations in 

the backup directory.

STEP  3 From the Backed-Up Configurations list, select a configuration to restore.

Look at the contents of the Backup Note text area to confirm that the selected 

configuration is really the one that you want.

STEP  4 Click Restore.

STEP  5 Click Restart to restart the device after a configuration has been restored to it.

Backup Preferences

To back up to a different directory, click Preferences from the Configuration 

Archive window or choose System > Preferences from the feature bar.
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In the Preferences window, choose the Configuration Archive tab and enter a 

different path and directory.

The tab also has an option to automatically save the running configuration before 

you back up. If you do not select it, CCA prompts you to save the running 

configuration if it differs from the startup configuration.

Using CCA with Cisco Small Business Office Manager

Cisco Small Business Office Manager is a no-cost desktop application that is 

designed for a small business office administrator or IT person. Office Manager 

provides the office administrator or IT person with the ability to independently 

perform routine operational tasks for the Cisco Smart Business Communications 

System.

A Cisco partner configures the system, using CCA, then customizes the Cisco 

Office Manager application and leaves it behind, enabling the site administrator to 

modify the system's voice and user settings, easily see video streams from IP 

cameras, and view network status. Cisco partners can work with their customers 

to determine what features the site administrator will be able to control.

Office Manager can be used with Cisco SBCS systems that are configured using 

Cisco Configuration Assistant version 2.2 and later. Configuration changes made 

through Office Manager are read and recognized by CCA. New features 

introduced in CCA 3.0 and later, such as Extension Mobility, Floating Extension, and 

Phone Customization, cannot be configured using Office Manager, but the 

configuration created through CCA is compatible with Office Manager.

When CCA is running, Office Manager must be closed, and vice versa. Concurrent 

access is not supported.

For product information and a link to download the Office Manager software, visit 

www.cisco.com/go/officemanager

Office Manager installation documentation is avail at the following URL:

www.cisco.com/en/US/products/ps11199/prod_installation_guides_list.html

Resources for Planning and Implementing Your SBCS Solution

These resources are provided by Cisco for planning and implementing your SBCS 

solution:

http://www.cisco.com/go/officemanager
http://www.cisco.com/en/US/products/ps11199/prod_installation_guides_list.html
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• Cisco Small Business Support Community, page 113

• Cisco Smart Designs, page 114

• Cisco UC540 and UC560 Platform Reference Guides, page 114

Cisco Small Business Support Community

The Cisco Small Business Support Community site provides resources to assist 

VARs and Partners with design, implementation, and maintenance for Cisco SBCS 

platforms.

To access the Cisco Small Business Support Community:

• From within CCA, choose Partner Connection > SB Support Community, 

or

• Open a Web browser and go to this URL:

www.cisco.com/go/smallbizsupport

These resources include:

• Support areas organized around a product, technology, or country

To go to the Cisco Smart Business Communications System/UC500 support 

area, select Support Areas > Voice and Conferencing > SBCS/UC500.

• Discussion forums (requires a Cisco.com login to post messages, but not to 

read messages)

• Training resources, including a library of support Video On Demand (VOD) 

and tutorials

• Links to Cisco support resources:

- Sales support tools

- Design and deployment tools

- Configuration guides and application notes

- UC500 software downloads

- SBCS warranty information

- Small & Medium Business (SMB) University

http://www.cisco.com/go/smallbizsupport
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Cisco Smart Designs

Cisco’s SBCS Smart Design documents provide best practices for network 

solution design and implementation. These simplified and pre-tested networking 

solutions are intended to minimize complexity and risk while maximizing partner 

success. A Partner login is required for access.

Visit this URL to view SBCS Smart Design documents:

www.cisco.com/go/partner/smartdesigns

Cisco UC540 and UC560 Platform Reference Guides

To learn more about the capabilities and features of the Model UC540 and UC560 

platform, refer to the following guides, available on Cisco.com.

• Cisco Unified Communications 500 Series Model 560 for Small Business: 

Platform Reference Guide

www.cisco.com/en/US/prod/collateral/voicesw/ps6788/vcallcon/ps7293/

reference_guide_c07-566560.html

• Cisco Unified Communications 500 Series Model 540 for Small Business: 

Platform Reference Guide

www.cisco.com/en/US/prod/collateral/voicesw/ps6788/vcallcon/ps7293/

C78-557768-00_540_platform_reference_guide_DS_v2a.html

These platform reference guides cover part numbers, available interfaces and 

modules, licensing, basic call center capabilities, voice resource utilization for 

conferencing and transcoding, localization support, and hardware specifications 

for the UC540 and UC560 models.

Cisco SBCS Features Supported Within CCA

The Cisco Smart Business Communications System Feature Reference Guide 

provides guidance to partners on the features that can be configured using the 

latest releases of CCA. The information is categorized by Voice, Switching, 

Wireless, and Security.

This guide is available on the Resources tab on the main Cisco Smart Business 

Communications product page (www.cisco.com/go/sbcs). From within CCA, you 

can choose Partner Connection > SBCS Feature Guide to access the guide.

http://www.cisco.com/go/sbcs
http://www.cisco.com/go/partner/smartdesigns
http://www.cisco.com/en/US/prod/collateral/voicesw/ps6788/vcallcon/ps7293/reference_guide_c07-566560.html
http://www.cisco.com/en/US/prod/collateral/voicesw/ps6788/vcallcon/ps7293/C78-557768-00_540_platform_reference_guide_DS_v2a.html
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Device Properties

This section covers configuration of these device properties:

• Hostname

• System Time

• Time Zone (SA500 Security Appliances Only)

• HTTP Port

• Users and Passwords

• Remote Device Access (Telnet)

• SNMP Management

Hostname

To modify the hostname for a device:

• Choose Configure > Device Properties > Hostname on the feature bar.

• Right-click on a device in the Topology view and choose Hostname from 

the popup menu.

Overview

You can give a hostname to an unnamed member of a customer site, or you can 

change its hostname.

The hostname is displayed in system prompts and in the drop-down Hostname 

menu in CCA configuration windows.

The name change does not take effect immediately. A message in the status bar 

shows when the change has occurred.
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Procedures

To modify the hostname for a device, follow these steps:

STEP 1 In the Hostname list, select the device whose name you want to change.

STEP 2 If you selected a device from the Topology view before opening the Hostname 

window, the Hostname is preset to your selection.

STEP 3 In the New Hostname field, enter a unique name for the device.

NOTE: The hostname must contain at least one alpha character.

For most devices the hostname length is limited to 31 characters, with exception 

of the following:

• ESW500 Switches – 54 Characters

• SF/SG 300/200 – 58 Characters

• AP541 – 20 Characters

• WVC2300 or PVC2300 Camera – 16 Characters

• SA500 – 32 characters

STEP 4 Click OK. The Topology view is redisplayed with the new name shown for the 

device.

STEP 5 Save the configuration (Configure > Save Configuration).

System Time

To configure system time settings, choose Configure > Device Properties > 

System Time.

IMPORTANT You cannot set system time options for the SA500 from this 

window. To configure time zone and NTP server settings for the SA500, choose 

Configure > Device Properties > Time Zone. See Time Zone (SA500 Security 

Appliances Only), page 122.

Overview

From the System Time window, you can:
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• Manually configure the time and daylight saving time on your network 

devices,

• Configure NTP (Network Time Protocol) so that the devices request time 

updates from an NTP server, or

• Synchronize the time on devices to the PC time or to the system time on a 

particular device.

Generally, you do not need to set the system clock if the system is synchronized 

by an outside timing mechanism such as NTP. If no other time source is available, 

you should manually set the time. The time specified is relative to the configured 

time zone.

See these sections for instructions:

• Display the Current Time

• Set the System Time

• Synchronize System Time

• Configure NTP

Display the Current Time

The System Time window automatically displays the current time: hours (in a 

24-hour format), minutes, time zone, month, date, and year for the all the devices in 

a community.

Here are some examples of date/time formats:

• Month, date, and year: August/2/2005.

• Hours and minutes: 9:00 (for 9 a.m.) or 13:00 (for 1 p.m.).

• Time zone: (GMT -10:00) Hawaii, meaning it is 10 hours behind Greenwich 

Mean Time.

Set the System Time

From the System Time window, you can:

• Manually set or modify the time on one or more devices.

• Synchronize the time across devices in a customer site.

To manually set or modify the system time on a device: 
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STEP 1 Select the row for the device.

STEP 2 Select the month, day, year, hour and minutes from the drop-down lists in the cells 

of the row.

Your hour selection must be based on 24-hour format. For example, for 9 a.m., 

enter 09; for 1 p.m., enter 13; for midnight, enter 24.

STEP 3 Select the correct time zone from the drop-down lists.

The full range of Universal Time Coordinated (UTC) offsets is supported. UTC is 

the same as Greenwich Mean Time. The offset (difference between UTC and the 

time zone of the switch) can be a negative or positive number.

For example, Central Standard Time has an offset of -6 hours, meaning it is 6 hours 

behind UTC. Each time zone is displayed with the UTC offset and the major cities 

or states in that region.

STEP 4 Select Automatic Daylight Saving Adjustment to configure automatic daylight 

saving time.

Automatic daylight saving is only supported in the U.SA, Australia, Canada, and 

Europe, and it begins on the day and time that is set in the local region.

STEP 5 Click OK.

To manually set or modify the system time on multiple devices:

STEP 1 Select the rows for the devices.

STEP 2 Click Modify.

STEP 3 Complete the Modify System Time window, and click OK to save your changes. 

See Modify System Time, page 119.

STEP 4 Click Apply in the System Time window to put your changes in effect.

STEP 5 Click Refresh to update the window.
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Synchronize System Time

To synchronize the time settings across devices in a community:

STEP 1 Click Sync to synchronize all the devices in the site. To synchronize specific 

devices, select the rows of the devices and click Sync.

STEP 2 Complete the Synchronize System Time window, and click OK to save your 

changes.  See Synchronize System Time, page 121.

STEP 3 Click Apply in the System Time window to put your changes in effect.

STEP 4 Click Refresh to update the System Time window.

Configure NTP

To configure an NTP server:

STEP 1 In the System Time window, click NTP.

STEP 2 Complete the fields in the Network Time Server window. See Network Time 

Server, page 120.

STEP 3 Click Apply to put your changes in effect.

STEP 4 Click Refresh to update the System Time window.

For more information, see these topics:

• Modify System Time, page 119

• Synchronize System Time, page 121

• Network Time Server, page 120

Modify System Time

This window appears when you select one or more devices and click Modify in 

the System Time window.

NOTE: If you selected multiple devices that have different settings, the fields for 

those settings appear blank. If the selected devices have the same settings, the 

settings appear.
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STEP 1 In the Date and Time area, select the correct month, day, and year from the drop-

down lists.

STEP 2 Select the correct hour and minutes from the drop-down lists.

Your hour selection must be based on 24-hour format. For example, for 9:00 a.m., 

enter 09; for 1:00 p.m., enter 13.

STEP 3 Select the correct time zone from the drop-down lists.

The full range of Universal Time Coordinated (UTC) offsets is supported. UTC is 

the same as Greenwich Mean Time. The offset (difference between UTC and the 

time zone of the switch) can be a negative or positive number.

For example, Central Standard Time has an offset of -6 hours, meaning it is 6 hours 

behind UTC. Each time zone is displayed with the UTC offset and the major cities 

or states in that region.

STEP 4 Select Enable from the drop-down list to configure automatic daylight saving time. 

Select Disable to disable automatic daylight saving time.

Automatic daylight saving is only supported in the U.S.A., Canada, Australia, and 

Europe, and it begins on the day and time that is set in the local region.

STEP 5 When you have made your changes, click OK. The System Time window appears.

Network Time Server

This window appears when you click NTP in the System Time window.

Use this window to configure the NTP (Network Time Protocol) client if you want it 

to regularly send time-of-day requests to an NTP server. The NTP server then 

synchronizes the client system clock to the server clock when the device requests 

it. To enhance security, you can configure NTP authentication. When NTP 

authentication is set, the device updates the time only if a server provides the 

correct authentication. For authentication to work properly, you must first obtain 

the key information from the server administrator and enter it in the NTP 

Authentication fields.

To configure devices to receive time updates from an NTP server and to configure 

NTP authentication:
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STEP 1 In the IP Address field, enter the IP address of the time server.

STEP 2 Optional: In the Key ID field, specify the authentication key to use when sending 

packets to the server. Enter a number from 1 to 4294967295.

STEP 3 Optional: In the Key Value field, enter the secret key. Enter up to 32 printable 

characters, excluding spaces, !, ", #, $, }, |, and ~.

STEP 4 Optional: In the Encryption Type field, enter the number used to encrypt the key 

value. Enter a number from 1 to 4294967295.

STEP 5 Click OK to close the Network Time Server window and return to the System Time 

window.

Synchronize System Time

This window appears when you click Sync or when you select one or more 

devices and click Sync in the System Time window.

Overview

This window displays the current time on the PC.

You can synchronize the system time on selected devices to the current time on 

the PC, or you can synchronize to the system time of a specific device. You can 

also overwrite the time zone setting on the selected devices.

For example, if you synchronize the system time of a device in New York with the 

time setting of a device in San Jose that has a time of 1 p.m. (PST), after the 

synchronization takes place, the device in New York displays the new time setting 

of 4 p.m. EST. However, if you select the checkbox Overwrite Local Time Zone, 

the device in New York has the new time setting of 1 p.m. PST (the same as the 

device in San Jose). The local time is overwritten.

Procedures

To synchronize the system time on selected devices to the current time on the PC:

STEP 1 Select Sync to PC.

STEP 2 Select Overwrite Local Time Zone setting if you want to overwrite the local time 

zone setting in the selected devices.
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STEP 3 Click OK to save changes and to return to the System Time window.

To synchronize the system time on selected devices to the system time of a 

specific device:

STEP 1 Select Sync to Device.

STEP 2 Select the device (that you want to use synchronize with) from the pull-down list.

STEP 3 Select Overwrite Local Time Zone setting if you want to overwrite the local time 

zone setting in the selected devices.

Click OK to save changes and to return to the System Time window.

Time Zone (SA500 Security Appliances Only)

The Time Zone Management window displays when you choose Configure > 

Device Properties > Time Zone from the feature bar. This option is available only 

if you are connected to a standalone SA500 Series Security Appliance or one is 

present in the CCA customer site.

Overview

From the Time Zone Management window, you can:

• Set the Time Zone on the SA500

• Choose whether you want to automatically adjust for daylight savings time

• Specify whether to use the default NTP servers for system time updates or 

enter up to 2 custom NTP servers

• View the current time on the SA500

You cannot manually set a system time on the SA500.
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Procedures

To manage Time Zone settings on the SA500, complete the settings as described 

in the following table, then click OK or Apply.

Setting Description

Hostname Hostname of the SA500 you are configuring. The default is 

SA500.

Time Zone Select the correct time zone from the drop-down lists.

The full range of Universal Time Coordinated (UTC) offsets is 

supported. UTC is the same as Greenwich Mean Time. The 

offset (difference between UTC and the time zone of the 

switch) can be a negative or positive number.

For example, Central Standard Time has an offset of -6 hours, 

meaning it is 6 hours behind UTC. Each time zone is displayed 

with the UTC offset and the major cities or states in that region. 

Automatically 

Adjust for 

Daylight 

Savings Time

When this box is checked, the system time on the SA500 is 

automatically adjusted for daylight saving time.

Automatic adjustment for daylight saving is only supported in 

the U.S.A., Canada, Australia, and Europe, and it begins on the 

day and time that is set in the local region.

Use Default 

NTP Servers

Configure the SA500 to receive time updates from the default 

NTP (Network Time Protocol) servers The default servers are 

0.us.ntp.pool.org and 1.us.ntp.pool.org.

Use Custom 

NTP Servers

When this option is checked, you can specify up to two 

custom NTP servers to use for time updates.

NTP Server 1

NTP Server 2

If Use Custom NTP Servers is checked, enter the hostname or 

public IP address of the NTP servers in these fields.

Current Time Read-only display of the current date and time on the SA500. 

For example, Saturday, January 01, 2010, 22:24:24 (GMT 

+0000).
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HTTP Port

To change the HTTP port number for all the devices in a customer site, choose 

Configure > Device Properties > HTTP Port from the feature bar.

Overview

Configuration Assistant connects to every device in a customer site through a 

HTTP or HTTPS port.

• You can change the HTTP port number but not the HTTPS port number.

• For HTTPS, the default of 443 is always used.

HTTPS ensures that communications between Configuration Assistant and the 

managed devices are encrypted. You can use HTTPS only with a crypto image of 

Cisco IOS.

The first time that you connect with HTTPS, you see an alert. It asks whether you 

will accept a certificate that asserts the connected device is a trusted site. Your 

choices are Yes, No, Always, and View Certificate.

Answer Yes or Always to continue. You will not be alerted in later Configuration 

Assistant sessions if you answer Always.

When HTTPS is in use, you see an icon in the status bar.

Procedures

To configure the HTTP port, follow these steps.

STEP 1 Enter a different port number in the HTTP Port field. The default port number is 80. 

The range of other valid port numbers is 1025 to 65535.

Click OK. The new HTTP port number is propagated to all the members of the 

customer site.
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Users and Passwords

To set up passwords and to associate passwords with usernames and privilege 

levels, choose Configure > Device Properties > Users and Passwords.

Overview

You can manage access to CCA by setting up passwords alone or passwords 

paired with usernames. You can also associate a privilege level with a password 

and username to manage access on a user by user basis.

Depending on the type of device being configured, different types of privileges 

can be assigned.

• For Cisco Small Business Pro SA500 Security Appliances privilege levels 

include Guest (read-only access), Admin, and SSL VPN User.

• For Cisco AP541N access points:

- You cannot create additional users or modify the default administrative 

username (cisco) and privilege level (Admin).

- You can only modify the default administrator password (cisco).

• For Cisco Model PVC2300 and WVC2300 Business Internet Cameras:

- Different privilege levels apply (Admin, Monitor, and Viewer).

- You cannot modify the default administrator username (admin), but you 

can create additional users with Admin privileges.

• For the UC500 and other Cisco IOS-based devices, privilege levels range 

from 1 to 15:

- Privilege level 15 gives read-write access. Users at this level can see and 

configure all the options in CCA.

- Privilege levels 1 to 14 give read-only access. Options on the feature bar, 

toolbar, popup menus, and feature windows that can change a device 

configuration are not shown.

To set up passwords and to associate passwords with usernames and privilege 

levels, use the Users and Passwords window.

Procedures

From the Users and Passwords window, you can:

• Give Access to All Site Devices
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• Give Access to a Specific Device

Begin by selecting All Devices or a specific device in the Hostname list.

Click OK when you finish configuring users and passwords.

Give Access to All Site Devices

To give access to all devices in the customer site, follow these steps:

STEP 1 In the Admin Username field, enter the username that an administrator will use to 

access all the devices in the community.

STEP 2 In the Password field, enter the password that the administrator will use. The entry 

is encrypted and shown as asterisks.

STEP 3 Enter the password again in the Confirm Password field.

Give Access to a Specific Device

NOTE: Username, password, and device access options vary, depending on the 

device or devices selected. If a tab is not displayed for a device, that device does 

not support that option.

Use these tabs to give access to a specific device:

• Local Username/Password, to associate usernames and passwords with 

privilege levels

• HTTP Authentication, to specify whether users enter both a username and 

password or only a password to access Configuration Assistant

• Enable Password, to associate passwords with privilege levels

• Console/Telnet Password, to associate passwords with the console line 

and Telnet sessions

Local Username/Password

This tab shows usernames, passwords, and their associated privilege levels. 

Users with a paired username and password on this tab have access to CCA at 

the associated privilege level.

Options for local username and password configuration vary, depending on the 

device you are configuring.
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For Cisco AP541N access points:

• You cannot create additional users or modify the default administrative 

username (cisco) and privilege level (Admin).

• You can only modify the default administrator password (cisco).

To enter a new user access record—a new username, password, and privilege 

level—click Create and use the Create Local Username/Password window. See 

Create User, page 128.

To modify the password or privilege level in a user access record, select it, click 

Modify, and use the Modify Local Username/Password window.

To delete a user access record, select it, and click Delete.

HTTP Authentication

On this tab, click Enable Password if you want users to access the selected 

device by entering only a password. Click Local User Name/Password if you 

want them to enter both a username and password.

Be sure to also use the Enable Password tab to set up passwords or the Local 

User Name/Password tab to set up usernames and passwords.

Enable Password

This tab shows privilege levels and passwords. Users who enter a password that 

is on this tab have access to Configuration Assistant at the associated privilege 

level.

To create a new password and an associated privilege level, click Create, and use 

the Create Enable Password window.

NOTE: If a password exists for every privilege level from 1 to 15, the Create 

button is disabled.

To modify a password, select it, click Modify, and use the Modify Enable 

Password window. See Modify Enable Password, page 129.

To delete a password, select it, and click Delete. Both the password and its 

privilege level are removed from the tab.

Console/Telnet Password

This tab shows the passwords that are associated with the console line and Telnet 

sessions.
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In a Telnet session, a Telnet password gives users read-only access to a device. 

They cannot configure the device. When they telnet to the device, they are 

prompted for the password, which they share. They are not prompted for a 

username. If you do not enter a Telnet password or remove it, users are prompted 

for their username and password on the Local Username/Password tab.

Entering a console password gives users read-write access. If you created an 

enable password, users must enter it instead of the console password to have 

read-write access.

To create passwords or to change them, enter them in the Password field, and 

enter them again in the Confirm Password field.

Create User

This window appears when you click Create on the Local Username/Password 

tab of the Users and Passwords window. Use it to specify a username, a 

password, and an associated privilege level.

Available options vary, depending on the device you are configuring.

Follow these steps:

STEP 1 In the Username field, enter the name that a user will use to access Configuration 

Assistant.

STEP 2 In the Password field, enter the password that a user will use. The entry is 

encrypted.

STEP 3 Enter the password again in the Confirm Password field.

STEP 4 From the Privilege Level list, select a privilege level. Depending on the device you 

are configuring, different options for Privilege Level are displayed.

For UC500 platforms and other IOS devices, Level 15 grants read-write access; 

levels 1 to 14 grant read-only access.

For SA500 Security Appliances, you can also set the Privilege Level to Guest (for 

read-only access) and SSL VPN User.
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For Cisco Model PVC2300 and WVC2300 Business Internet Cameras, choose one 

of these privilege levels:

• Admin — Allows the user to administer and control camera and video.

• Monitor — Allows the user to control camera video (manually pan/tilt, toggle 

between day/night vision, and trigger output ports). Camera users added 

through the Video Monitor Setup wizard are assigned Monitor privileges.

• Viewer — Allows the user to view video from the camera using a Web 

browser, IP phone, or other application.

STEP 5 Click OK. When you return to the Users and Passwords window, you see a new 

entry on the Local Username/Password tab.

Modify User Password

This window appears when you select an entry and click Modify on the Local 

Username/Password tab of the Users and Passwords window. Use it to modify 

the password and privilege level associated with a username.

Follow these steps:

STEP 1 If you want to change the password, enter a different password in the Password 

field. Your entry is encrypted and shown as asterisks.

STEP 2 Enter the password again in the Confirm Password field.

STEP 3 If you want to change the privilege level, select a different privilege level from the 

Privilege Level list.

STEP 4 Click OK.

Modify Enable Password

This window appears when you select a password and click Modify on the Enable 

Password tab of the Users and Passwords window. Use it to modify the password 

for the associated privilege level. 

Follow these steps:
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STEP 1 In the Password field, enter a different password for the displayed privilege level. 

Your entry is encrypted and shown as stars.

STEP 2 Enter the password again in the Confirm Password field.

STEP 3 Click OK.

Remote Device Access (Telnet)

Remote access through Telnet is always enabled, since CCA will not function 

properly without Telnet access. The Device Access window, that was included in 

prior releases of CCA, has been removed, and CCA no longer uses SSH.

SNMP Management

To configure SNMP (simple network management protocol) settings, choose 

Configure > Device Properties > SNMP Management.

Overview

Managing SNMP includes these tasks:

• Disabling or enabling SNMP on a standalone switch

• Setting system options

• Adding and removing community strings

• Adding and removing trap managers

• Creating views of MIB objects that are accessible to groups of users

• Associating views with the groups that can access them

• Associating groups with the users that belong to them

Procedures

The window has these tabs:

• System Options, to assign administrative information to a device to help 

identify it
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• Community Strings, to add and remove community strings

• Trap Managers, to add and remove trap managers

• Filter (Cisco SF 300 Series, SG 300 Series, and ESW500 Series 

Switches), to create sets of traps that can be sent to trap manager

• Views, to create views of MIB objects that are accessible to groups of users

• Groups, to associate views with the groups that can access them

• Users, to associate groups with the users that belong to them

Available tabs and SNMP configuration options vary among devices. Not all 

devices support all of these SNMP configuration options through CCA.

Begin by:

• Selecting a device from the Hostname list. The tabs and their settings apply 

to the selected device. You see the Views, Groups, and Users tabs only if 

the device supports SNMP Version 3 or later.

• Ensuring that Enable SNMP is checked.

When you have finished entering settings on the tabs, click OK.

System Options

Although SNMP allows a maximum of 255 characters for each field on this tab, 

Configuration Assistant truncates this information to shorter lengths. For this 

reason, we recommend shorter entries. See individual steps in the procedure 

below for guidelines.

To assign system options:

STEP 1 In the System Location field, enter the physical location of the device. The 

maximum length of an entry in the System Location field is 129 characters.

STEP 2 In the System Contact field, enter the name or organization responsible for the 

device. The maximum length of an entry in the System Contact field is 129 

characters.
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Community Strings

Community strings serve as passwords to authenticate SNMP messages. Each 

community string is either read-only (RO), which allows MIB-object information to 

be displayed, or read-write (RW), which allows MIB-object information to be 

displayed and modified.

The first read-only and first read-write community strings are listed on the SNMP 

Management window. Because they are necessary for SNMP packet routing, they 

should not be removed on any device.

The SNMP configuration can also contain user-defined community strings.

If your access mode is read-only, you do not see community strings in this list.

Adding Community Strings

The selected device supports an unlimited number of community strings of any 

length.

To add a new community string to a device: 

STEP 1 In the New String field, enter a character string.

STEP 2 Select RO (read only) or RW (read-write) to specify the string type.

STEP 3 Click Add to move the new community string to the Current Strings list.

Removing Community Strings

Do not remove the first read-only or the first read-write community string. These 

strings are required for SNMP functions.

To remove an existing community string:

STEP 1 In the Current Strings list, select the community strings to be deleted.

STEP 2 To remove all community strings, click Select All.

STEP 3 Click Remove.
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Trap Managers

A trap manager is a management station that receives traps, the system alerts 

generated by a device. By default, no trap manager is defined, and no traps are 

sent.

To enable the selected device to send traps, check Enable Traps. Then check the 

boxes for the trap types that you want to enable for each IP destination.

To add a new trap manager:

STEP 1 In the IP Address field, enter the IP address of the new trap manager.

STEP 2 In the Community String field, enter the community string for the new trap 

manager.

STEP 3 In the UPD-Port field, enter the UDP port of the trap manager to which the traps 

should be sent.

STEP 4 To send every trap type to the trap manager, check Send All Traps. Otherwise, 

check only the trap types that you want to send.

STEP 5 For a description of the trap types, refer to the documentation for the selected 

device.

STEP 6 Optional. If you are configuring a trap manager for an Cisco SF 300 Series, SG 300 

Series, and ESW500 Series Switches, you can select a filter to apply to this Trap 

Manager, if any have been defined.

STEP 7 Click Add to move your entry to the Current Managers list.

If your access mode is read-only, you do not see trap managers and their 

community strings in this list.

To remove a trap manager:

STEP 1 In the Current Managers list, select the trap managers to be deleted.

STEP 2 To remove all existing trap managers, click Select All.

STEP 3 Click Remove.
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Filter (Cisco SF 300 Series, SG 300 Series, and ESW500 Series Switches)

The Filter tab applies to Cisco SF 300 Series, SG 300 Series, and Cisco Small 

Business Pro ESW500 Series switches.

This tab enables you to create, modify, and delete SNMP filters. An SNMP filter 

defines a set of traps that are forwarded to a trap manager. Filters that you create 

on this tab can be selected on the Trap Managers tab.

To create a filter, follow these steps.

STEP 1 Click Create.

STEP 2 In the Create an SNMP Trap Filter window, enter a descriptive Filter Name, from 

1 to 30 characters (spaces are not allowed). After you apply changes, this name is 

displayed in the Select Filter menu on the Trap Managers tab.

STEP 3 Select one or more OIDs from the Available list and use the Add, Remove, and 

Select All buttons to move OIDs from the Available to the Selected list.

STEP 4 Click OK to close the Create an SNMP Trap Filter window.

STEP 5 In the SNMP Management window, click Apply or OK.

To delete a filter, select the filter to be deleted from the list and click Delete. You 

can only delete filters that are not being used. If the filter is currently being used by 

any Trap Managers, you will be prompted to remove the filter from the Trap 

Manager before it can be deleted.

To modify a filter, select the filter to be modified and click Modify.

Views

Please see Create SNMP View, page 136

Groups

Please see Create SNMP Group, page 137

Users

Please see Create SNMP User, page 139
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Create or Modify SNMP Filter (Cisco SF 300 Series, SG 300 
Series, and ESW500 Series Switches)

This window appears when you choose Create or Modify on the Filter tab in the 

SNMP Management window for Cisco SF 300 Series, SG 300 Series, and ESW500 

Series Switches.

From this window, you can create or modify SNMP filters. An SNMP filter defines a 

set of traps that are forwarded to a trap manager. Filters that you create in this 

window can be selected on the Trap Managers tab in the SNMP Management 

window.

To create or modify an SNMP filter, follow these steps.

STEP 1 Enter a descriptive Filter Name, from 1 to 30 characters (spaces are not allowed). 

After you apply changes, this name is displayed in the Select Filter menu on the 

Trap Managers tab.

STEP 2 Use the Add, Remove, and Select All buttons to move OIDs from the Available to 

the Selected list.

STEP 3 Click OK.

Views

This tab shows the names of the views, collections of MIB objects to which user 

groups can have:

• Read access

• Write access

• Notification privileges

To create a view and add its name to this tab, click Create, and use the Create 

SNMP View window. See Create SNMP View, page 136.

To modify a view, select it, click Modify, and use the Modify SNMP View window.

To delete a view, select it and click Delete.

You cannot delete or modify the v1default view.
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Create SNMP View

This window appears when you click Create on the Views tab of the SNMP 

window.

To create an SNMP view, follow these steps.

STEP 1 Enter a name for the view in the View Name field.

STEP 2 Select one or more OIDs-MIB object IDs-from the OIDs list. To select all the OIDs, 

click Select All.

STEP 3 Click Add to move the selected OIDs into the Included OIDs list. These are the 

OIDs that will make up the new view. To move OIDs back to the OIDs list, select 

them and click Remove.

STEP 4 Click OK. The name of the created view is listed on the Views tab of the SNMP 

window.

Modify SNMP View

This window appears when you select a view and click Modify on the Views tab of 

the SNMP window.

To modify the SNMP view, follow these steps.

STEP 1 From the OIDs list, select any OIDs that you want to add to the view. Then click 

Add.

STEP 2 From the Included OIDs list, select any OIDs that you want to remove from the 

view. Then click Remove.

STEP 3 Click OK.
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Groups

The columns on this tab have these meanings:

To create a group and add its attributes to this tab, click Create, and use the 

Create SNMP Group window. See Create SNMP Group, page 137.

To modify a group, select it, click Modify, and use the Modify SNMP Group 

window.

To delete a group, select it, and click Delete.

You cannot delete or modify the v1default group.

Create SNMP Group

This window appears when you click Create on the Groups tab of the SNMP 

window. Use it to specify the attributes of a group of SNMP users.

To create an SNMP group, follow these steps.

STEP 1 In the Group Name field, enter a name for the new group. 

You can enter the name of a group that already exists, so long as you select a 

different security level. A group name and security level identify a group uniquely.

Column Meaning

Group The name of a group of users

Security Level Whether users are required to enter a password 

(Authenticate) and whether the password is encrypted 

(Privacy)

Read View A view to which the group has read access

Write View A view to which the group has write access

Notify View A view to which the group has notification privileges
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STEP 2 From the Security Level list, select a security level.

• NoAuthenticate means that packet authentication is not required.

• Authenticate means packet authentication is required.

• Privacy means that packet encryption is required. This option is enabled 

only if a crytographic software image is installed.

STEP 3 Optional: From the Read View list, select a view to which the group will have read 

access.

STEP 4 Optional: From the Write View list, select a view to which the group will have write 

access.

STEP 5 Optional: From the Notify View list, select a view to be sent to the group with 

notifications.

STEP 6 Click OK. When you return to the SNMP window, you see a new entry on the 

Groups tab.

Modify SNMP Group 

This window appears when you select a group and click Modify on the Groups 

tab of the SNMP window.

These are the attributes of the group that you can modify:

• The view of MIB objects to which the group has read access.

• The view of MIB objects to which the group has write access.

• The view of MIB objects that is sent to the group with notifications.

For more information on these window options, see the Create SNMP Group 

topic.

Click OK when you finish.
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Users

This table explains what each of the columns on this tab contains.

To assign a user to a group and add the user to this tab, click Create, and use the 

Create SNMP User window. See Create SNMP User, page 139.

To modify the attributes of a user, including the group that the user belongs to, 

select the entry for the user, click Modify, and use the Modify SNMP User window.

To delete a user, select the entry for the user, and click Delete.

Create SNMP User

This window appears when you click Create on the Users tab of the SNMP 

window. Use it to specify the attributes of an SNMP user.

To create SNMP users, follow these steps.

STEP 1 In the User Name field, enter a name for the user.

STEP 2 From the Group Name list, select the group that the user belongs to. (The group 

must first be defined on the Groups tab.)

STEP 3 Optional: In the Authentication area, take these actions if the user will need an 

authentication password:

a. Select an authentication algorithm from the Authentication Algorithm list.

b. Enter a password in the Password field that the user will enter for 

authentication.

c. Enter the password again in the Confirm Password field.

Column Contents

User The names of users

Group The group to which the adjacent users belong

Authentication 

Algorithm

The type of algorithm that is used to encrypt the 

authentication password
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STEP 4 Click OK. When you return to the SNMP window, you see a new entry on the Users 

tab.

Modify SNMP User 

This window appears when you select a user and click Modify on the Users tab of 

the SNMP window.

These are the attributes of the user that you can modify:

• The group that the user belongs to, by selecting a different group name.

• The authentication algorithm, if any.

• The authentication password and confirm password, if any.

For more information on these window options, see the Create SNMP User topic.

Click OK when you finish.
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Port and Switch Settings

This section covers configuration of ports and switches. It includes these topics:

• Switch Port Settings

• Smartports

• VLANs

• Port Mirroring (ESW500, SF 200/300, and SG 200/300 Series 

Switches)

• Spanning Tree Protocol (CE520 Switches)

• IGMP Snooping (CE520 Switches)

• MAC Addresses (CE520 Switches)

• Port Search Window (CE520 Switches)

• EtherChannels (CE520 Switches)

Switch Port Settings

To configure switch port settings:

• Choose Configure > Ports > Switch Port Settings on the feature bar.

• Click the Switchports icon on the toolbar.

Overview

By default, all ports on a switch are enabled, and port parameters are set with 

initial values. The Port Settings window displays these values and lets you change 

them.
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Some port types automatically negotiate configuration settings. An auto-

negotiation mismatch can occur under these conditions: 

• When a manually set duplex parameter is different from that set on the 

attached port.

• When a port is set to auto-negotiate and the attached port is set to full 

duplex with no auto-negotiation.

The result of a mismatch on Fast Ethernet ports is reduced performance or link 

errors. On Gigabit Ethernet ports, the link does not come up, and no statistics are 

reported.

To correct mismatched port settings, do one of the following: 

• Let both ports auto-negotiate both speed and duplex.

• Manually set the speed and duplex parameters for the ports on both ends 

of the connection.

To connect to a remote Fast Ethernet device that does not auto-negotiate, you 

should explicitly set the duplex on the local device to a value other than Auto. 

Speed negotiation works even if the other device does not auto-negotiate. 

To connect to a remote Gigabit Ethernet device that does not auto-negotiate, 

disable auto-negotiation on the local device and set the duplex and flow control 

parameters to be compatible with the remote device.

Procedures

Begin by selecting a device from the Hostname list. Information about the device 

ports is on these tabs:

• Configuration Settings, page 143, which displays values that you can set 

and modify.

• Runtime Status, page 146, which displays the actual status of the ports.

To see a subset of the information on either tab, click Filter, and use the Filter 

Editor window. See Filter, page 148.
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Configuration Settings

This table explains the information on this tab.

Settings Explanation

Interface Identifies the port: Fast Ethernet, Gigabit Ethernet, or FDDI, the 

module or slot number (0, 1, or 2), and the port number.

Description Text description of the port. Click Describe in the Port Settings 

window to describe multiple ports.

You cannot use the ? and / characters.

If you selected more than one port, this field is not available.

Status Setting to enable or disable the port, which can be different from 

the runtime setting. For example, if no device is connected to a 

port, it can be administratively enabled with a runtime status of 

DOWN.

If you change other settings on a disabled port, they do not take 

effect until you enable the port.

When you disable a port, and if you configured an SNMP 

manager, a linkdown trap is sent to the management station.

Duplex Setting for duplex: full duplex, half duplex, or auto. The default 

setting for Gigabit Ethernet and GigaStack GBIC ports is auto. 

These ports automatically match the duplex capability of an 

attached device.

To set a duplex value other than auto, the speed value must be 

other than auto. The duplex value must be auto if the port speed 

is set to auto and if the port can run at a speed of 1000 Mbps.

GigaStack GBIC stack connections operate in half-duplex mode.

Point-to-point GigaStack GBIC port connections operate in full-

duplex mode.
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Speed Settings for the 10/100-Mbps and 10/100/1000-Mbps ports:

• 10 (Ports run at a forced speed of 10 Mbps.)

• 100 (Ports run at a forced speed of 100 Mbps.)

• 1000 (Ports run at a forced speed of 1000 Mbps.)

• auto (Ports auto-negotiate and advertise all available 

speeds.)

• auto 10 (Ports auto-negotiate and advertise a speed of 

10 Mbps to the other end of the link.) Not available on the 

ESW500 Series, SF 200/300 Series, and SG 200/300 

Series switches.

• auto 100 (Ports auto-negotiate and advertise a speed of 

100 Mbps to the other end of the link.) Not available on the 

ESW500 Series, SF 200/300 Series, and SG 200/300 

Series switches.

• auto 100 1000 (Ports auto-negotiate and advertise 

speeds of 100 and 1000 Mbps to the other end of the link.)

• auto 10 1000 (Ports auto-negotiate and advertise speeds 

of 10 and 1000 Mbps to the other end of the link.)

• auto 1000 (Ports auto-negotiate and advertise a speed of 

1000 Mbps to the other end of the link.)

• auto 10 100 (Ports auto-negotiate and advertise speeds 

of 10 and 100 Mbps to the other end of the link.)

• auto 10 100 1000 (Ports auto-negotiate and advertise 

speeds of 10, 100, and 1000 Mbps to the other end of the 

link.)

The default setting for 10/100 - and 10/100/1000-Mbps ports is 

auto. Ethernet ports can automatically match the transmission 

speed of an attached device.

NOTE You cannot modify the speed settings of these ports:

• 1000BASE-T, SX, LX/LH, ZX, DWDM, and CWDM GBICs 

• 1000BASE-SX, LX/LH, ZX, and CWDM SFPs

• XENPAK-10GB-LR, ER, CX4, SR, and LX4

• 100BASE-FX

Settings Explanation
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To modify port settings one port at a time, click the corresponding cell for the port 

that you want to modify.

To modify the settings of one or more ports:

STEP 1 Select the ports in the Interface column. Hold down the Ctrl key and make your 

selections, or hold down the Shift key, and select the first and last port in a range.

STEP 2 Click Modify to display the Modify Port Settings window. See Modify Port 

Settings, page 147.

STEP 3 Complete the fields in the Modify Port Settings window.

STEP 4 Click OK to close the window and return to the Port Settings window.

Power This setting applies to a single port on a Catalyst Express 500 

PoE, the ESW500 Series, SF 200/300 Series, and SG 200/300 

Series switches. Select auto if you want the port to detect a 

power device and supply power to it. Otherwise, select never.

Auto MDIX ESW500 Series, SF 200/300 Series, and SG 200/300 Series 

switches only.

Displays the Media Dependent Interface (MDI)/Media Dependent 

Interface with Crossover (MDIX) status on an the ESW500 Series, 

SF 200/300 Series, and SG 200/300 Series switches port. Hubs 

and switches are deliberately wired opposite the way end 

stations are wired, so that when a hub or switch is connected to 

an end station, a straight through Ethernet cable can be used, and 

the pairs are matched up properly. When two hubs or switches 

are connected to each other, or two end stations are connected 

to each other, a crossover cable is used to ensure that the correct 

pairs are connected. Choose one of the following settings:

• Auto. Use to automatically detect the cable type. This is 

the default setting.

• MDIX. Use for hubs and switches.

• MDI. Use for end stations.

Settings Explanation
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Runtime Status

This table explains the read-only information on this tab.

Column Explanation

Interface Identifies the port: Fast Ethernet, Gigabit Ethernet, or FDDI, the 

module or slot number (0, 1, or 2), and the port number.

Description The description of the interface.

Ethernet 

Link

The state of the port. The status of a port can be up, down, or 

administratively down.

Duplex The duplex state of the port (hybrid, half, full). Displays the port 

duplex mode.

For the ESW500 Series, SF 200/300 Series, and SG 200/300 

Series switches, Full indicates that the interface supports 

transmission between the device and the client in both 

directions simultaneously, and Half indicates that the interface 

supports transmission between the device and the client in 

only one direction at a time.

Speed The speed of the port.

For Gigabit Ethernet ports, this field is read-only and displays 

1000 (1000 Mbps).

State Shows whether inline power is being supplied to a connected 

device.

Budget Amount of power budgeted for the connected device.

Device Shows the type of device that is receiving inline power from 

the interface.

Class The powered-device IEEE classification. Many powered 

devices do not require the full 15.4 watts of power that is 

available with PoE.

The power classes range from 0 to 4. The default is 0. Power 

budgeted for the switch depends on the IEEE class.
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Modify Port Settings

The Modify Port Settings window appears when you select multiple ports in the 

Switch Port Settings window.

Enter or select values for the ports to be modified. See Configuration Settings, 

page 143 for descriptions of what to enter.

If you select multiple ports and specify a configuration setting that is not valid for a 

selected port, the current setting remains unchanged. For example, if you select a 

10BaseT Ethernet, a Fast Ethernet, and a Gigabit port, and then select a speed of 

100 Mbps, the 10BaseT Ethernet port remains set to 10 Mbps, and the Gigabit port 

remains set to 1000 Mbps.

Click OK to close the window. Your modifications appear in the Port Settings 

window.

For more information, see these topics:

• Configuration Settings, page 143

• Runtime Status, page 146

Modify Port Descriptions

To add or modify port descriptions:

Select one or more ports. If you select one port, click the cell in the Description 

column for the port that you want to describe. Enter text at the blinking cursor.

If you select more than one port:

STEP 1 Click Describe to display the Basic Port Description window.

STEP 2 Complete the settings in the window. From the Basic Port Description window, you 

can go to the Advanced Port Description window to specify automatic increment 

for of up to three descriptors.

STEP 3 Click OK to close the window.
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Filter

The Filter window appears when you click Filter in a Configuration Assistant 

window or wizard that contains a table. The column names in the table become the 

field names in this window. Enter selection criteria in the fields to filter out table 

rows and leave only those that interest you.

Follow these steps:

STEP 1 Leave a field blank if you do not want to filter its corresponding table column—that 

is, if you have no selection criteria for the column.

STEP 2 To use a field with a drop-down list, select an item for Configuration Assistant to 

match against entries in the corresponding column.

STEP 3 To use a text-entry field, enter characters for Configuration Assistant to match 

against entries in the corresponding column. Use a star (*) as a placeholder for a 

character string of any length. Use a question mark (?) as a placeholder for any 

single character. To match a string regardless of the characters that precede or 

follow it, enter *string*.

Examples

• To see only the interfaces in the LRE Software Upgrade window that are 

enabled for an upgrade, select enable in the Upgrade field of the Filter Editor 

window that serves the LRE Software Upgrade window.

• To see only the descriptions in the Port Settings window that contain the 

string 1234, enter *1234* in the Description field of the Filter Editor window 

that serves the Port Settings window.

STEP 4 Click OK. You return to the Configuration Assistant window or wizard that you 

were using and see the subset of information that you requested.

Smartports

To configure port connections, you apply roles to the ports. To open the 

Smartports window and access these settings:

• Choose Configure > Switching > Smartports on the feature bar.

• Click the Smartports icon on the toolbar.
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• Click Resolve in the Event Notification window to resolve a Smartports 

event.

Overview

Smartports is a solution that helps you to configure the essential security, 

availability, and manageability features of your network port connections.

The Smartports window shows you the front panels of devices; you select ports 

and apply roles to them. You can configure a port connection to these devices:

Procedures

The window shows a front-panel view of the devices in your network. If a port is 

connected to a device and a role has been applied to it, you see the icon for the 

connected device over the port. When you move your mouse pointer over the icon, 

Configuration Assistant identifies the type of device that is connected.

To apply roles to other connected ports or to correct a mistakenly applied role 

(shown by the Smartports conflict icon), take one of these actions:

• Click Suggest. The icons of the connected devices blink over the ports, and 

the Suggested Smartports window appears. It suggests the roles to apply 

to the ports. See Suggested Smartports, page 152.

• Select a port, and click Modify. The Modify Port Roles window appears. 

You can also use this window to remove Smartports roles or to apply 

Smartports roles to ports that do not have device connections. See Modify 

Port Roles, page 150.

Device Comment

Desktop An internal endhost with access to the Internet and to the 

internal subnets of an organization.

IP phone An endhost such as PC can be cascaded to an IP phone.

Switch A switch-to-switch connection.

Router An access router or a UC500 platform.

Access point An access point can connect to mobile endhosts. Depending 

on the access-point setup, the mobile endhosts can be either 

guest or desktop endhosts.
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Notes: 

• To select multiple ports, hold down the CTRL key, and click the ports that 

you want. You can also rubberband ports by holding down a mouse button 

and drawing a rectangle around a group of ports. Hold down the CTRL key 

to rubberband disjoined groups of ports.

• When you use CCA to apply a role, it replaces previously applied roles.

When you return to the Smartports window, you see device icons on top of the 

ports for which you made role selections. If you asked CCA to remove roles, the 

icons that were previously shown are gone.

To see details about configured ports, click Details to open the Port Roles Details 

window. See Suggested Smartports, page 152.

For more information, see these topics:

• Modify Port Roles, page 150

• Port Roles Details, page 152

• Suggested Smartports, page 152

Modify Port Roles

This window appears when you select one or more ports on the Port Setup tab of 

the Smartports window and click Modify. If you selected one port, the Interface 

field shows the port name. If you selected more than one, the Interface field 

shows Multiple.

To apply a role to the selected ports, follow these steps:

From the Role list, select a role that corresponds to the device that you want to 

connect to.

Device Comment

Desktop An internal endhost with access to the Internet and to the 

internal subnets of an organization.

IP Phone + 

Desktop

An endhost such as PC can be cascaded to an IP phone.

Switch A switch-to-switch connection.
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If you selected a 10-Gigabit Ethernet port, only the Switch and Router choices are 

available.

Complete the Attributes section according to the role that you selected.

Router An access router or a UC500 platform.

Access point An access point can connect to mobile endhosts. Depending 

on the access-point setup, the mobile endhosts can be either 

guest or desktop endhosts.

If you selected... Follow these steps...

Desktop Enter the number of a VLAN in the Access VLAN field. 

This is the VLAN that will send data between the port 

and the desktop.

IP Phone+Desktop • In the Access VLAN field, choose the data VLAN 

(usually VLAN1). This is the VLAN that will send 

data packets to and from the port.

• In the Voice VLAN field, choose the Voice VLAN 

(usually cisco-voice). This is the VLAN that will 

send voice packets to and from the port.

Router or Access 

Point

Enter the number of the native VLAN in the Native 

VLAN field. The port will be configured as a trunk port 

and the native VLAN will send untagged traffic.

Switch Enter the number of the native VLAN in the Native 

VLAN field. The port will be configured as a trunk port, 

and the native VLAN will send untagged traffic.

Check the Allow Internal VLANs Only check box to 

allow all traffic for all the VLANs except the Guest and 

DMZ VLANs. If the checkbox is unchecked, traffic for all 

VLANs is allowed. If no DMZ or Guest VLAN is 

configured, this checkbox is disabled. You must 

configure a Guest or DMZ VLAN to enable this 

checkbox.

Device Comment
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To remove a role from the selected ports, choose none from the Role list. The port 

is reset to its factory defaults.

Click OK when you finish with the window. The Smartports window returns.

Port Roles Details

This window appears when you click Details on the Port Setup tab of the 

Smartports window.

If you select ports before clicking Details, you see expanded headings for the 

devices with the selected ports. If you do not select any ports, you see expanded 

headings for all the devices in the Smartports window.

Under the device headings are expanded port headings, and under these are the 

role details. If a role is applied to a port, you see the role type and related 

configuration information. If no role is applied, you see none.

Click OK when you finish with the window.

Suggested Smartports

This window appears when you take either of these actions:

• Click Suggest in the Smartports window.

• Click Resolve in the Event Notification window to apply a Smartports role.

Use the window to:

• Configure VLANs for suggested port roles for IP phones, switches, routers, 

or access points.

• Correct mistakenly applied roles.

To apply a role to a port:

STEP 1 Accept the role in the Role Suggested column.

NOTES:

• Sometimes Configuration Assistant detects the connected device type as a 

switch when the real device type is a router, and the reverse. Modify the port 

role if the suggested device type is incorrect.
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• If the connected device is an access point, you can accept the suggested 

Access Point role or modify the port role.

• Configuration Assistant cannot detect a switch or a sniffer that is connected 

to a Cisco Express 500 switch port. Therefore, you will see no suggested 

roles for these connections.

STEP 2 Select a VLAN (two VLANs for IP phones). This table shows what VLAN selections 

are needed for each type of device connection.

The VLANs you select must correspond to the connections you are configuring. If 

you need a VLAN that is not listed, it does not exist. Close this window and the 

Smartports window, use the VLANs window to create the VLAN, and then use the 

Smartports feature again.

STEP 3 Click OK when you finish.

STEP 4 In the Smartports window, click OK to apply the roles for which you configured 

VLANs.

VLANs

This window appears when you choose Configure > Switching > VLANs on the 

feature bar.

When you select a device from the Hostname list, you see the following 

information for each VLAN:

• VLAN ID

For connections to You select

An IP phone + desktop An access VLAN and a voice VLAN

Desktop An access VLAN

A switch The native VLAN

A router The native VLAN

An access point The native VLAN
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• VLAN name

• IP Address, and Subnet Mask

• Default Voice VLAN (indicated by a Green checkmark)

If VLAN-synchronized devices such as a UC500, the ESW500 Series, SF 200/300 

Series, SG 200/300 Series switches, and Catalyst Express CE520 switches are 

part of the customer site, the Hostname device selector displays the value All 

UC5xx/CE5xx/ESW5xx/SFx00/SGx00.

See the following sections for more information about VLANs and VLAN settings:

• Overview

• Notes

• Procedures

Overview

You can create VLANs for the following devices:

• All UC500 devices

• All SR500 devices

• All C8xx devices

A VLAN (Virtual LAN) is a switched network that is logically segmented by 

function, project team, or application, without regard to the physical locations of 

the users. VLANs have the same attributes as physical LANs, but you can group 

end stations even if they are not physically located on the same LAN segment. Any 

switch port can belong to a VLAN, and unicast, broadcast, and multicast packets 

are forwarded and flooded only to the end stations in the VLAN.

VLANs define broadcast domains in a Layer 2 network. A broadcast domain is the 

set of all devices that receive broadcast frames originating from any device within 

the set. Broadcast domains are typically bounded by routers because routers do 

not forward broadcast frames. Layer 2 switches create broadcast domains based 

on the configuration of the switch. Switches are multiport bridges that allow you to 

create multiple broadcast domains. Each broadcast domain is like a distinct virtual 

bridge within a switch.

You can define one or many virtual bridges within a switch. Each virtual bridge that 

you create in the switch defines a new broadcast domain (VLAN). Traffic cannot 

pass directly to another VLAN (between broadcast domains) within the switch or 

between two switches. To interconnect two different VLANs, you must use routers 

or Layer 3 switches.
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By default, switches are configured with a single VLAN, VLAN 1. If you want to 

create additional VLANs, you can do this from the VLAN window. You can also use 

this window to change the name of a VLAN or to remove it.

When you create, modify, or delete a VLAN on a switch or a Unified 

Communications 500 Series platform, your action is automatically duplicated on all 

the devices of these types in your customer site. The duplication preserves VLAN 

consistency among the devices. If you add a device to the site that already has a 

VLAN associated with it, a VLAN conflict occurs with the devices that do not have 

this VLAN association. When this happens, you are prompted to use the VLAN 

Synchronization Window to restore VLAN consistency. See VLAN 

Synchronization, page 158.

Notes

The following notes apply to VLAN creation and modification:

• Up to 15 VLANs can be associated with a device. All devices are associated 

by default with VLAN 1.

• Only the VLAN Name and VLAN ID are synchronized to the ESW500 Series, 

SF 200/300 Series, and SG 200/300 Series switches and CE520 switches.

• In a multisite deployment, VLANs can only be configured on the local 

UC500. VLAN changes made on the local UC500 are not applied to other 

UC500s in the multisite deployment, and only local devices are 

synchronized.

Procedures

To create a VLAN, select a Hostname, click Create, and complete the settings in 

the Create VLAN window. See Create VLAN, page 156.

To change the name, IP address, or subnet mask of a VLAN, select the VLAN in this 

window, and click Modify. See VLAN Synchronization, page 158. VLAN 1 is 

reserved by CCA, so you cannot modify its name or VLAN ID.

To remove a VLAN, select it, and click Delete.

When you are finished making changes, click OK or Apply.

For more information, see these topics:

• Create VLAN, page 156

• VLAN Synchronization, page 158
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Create VLAN

This window appears when you click Create in the VLAN window (Configure > 

Switching > VLANs).

To create a VLAN, complete the fields in the Create VLAN window as described 

below, then click OK.
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Setting Description

VLAN ID Enter the ID of the VLAN. Use an ID in the range 2 to 1000. Do 

not enter 1; as this ID is reserved for the default Data VLAN.

VLAN Name The default name is VLANxxxx, where xxxx represents four 

digits (including leading zeros) equal to the VLAN ID number. 

You can use this value or enter a VLAN name from 1 to 32 

characters.

The VLAN name must be unique.

The default Voice VLAN must be named Cisco-Voice. The 

VLAN name Cisco-Voice is reserved by CCA.

Make Default 

Voice VLAN

When this option is checked, this VLAN is used for the default 

Voice VLAN.

The default Voice VLAN is VLAN100.

IP Address Enter the IP address for this VLAN.

If the IP address for the default Data or Voice VLAN is 

modified, its corresponding firewall, NAT and DHCP pools are 

also modified.

The IP address cannot be a duplicate of, or overlap with, other 

existing interface IP addresses.

Subnet Mask Enter the subnet mask for this VLAN or choose one from the 

drop-down list.

DHCP Relay Enter the IP address.

This setting is visible only if Make Default Voice VLAN is 

disabled (unchecked).

NOTE: DHCP Pool is not configured for default data VLAN. 

You cannot remove DHCP relay from default data VLAN. 

Create DHCP Pool for data VLAN and then remove DHCP 

Relay.
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After the new VLAN is created, you can choose Configure > Routing > DHCP 

Server to create DHCP pools, DHCP exclusion ranges, and DHCP bindings, if 

needed. See DHCP Server, page 185.

VLAN Synchronization

The devices in your community must have the same VLANs configured on them. If 

they do not, CCA displays an event icon on the status bar and records the conflict 

in the Event Notification window. When you acknowledge the event in that window 

and click Resolve, the VLAN Synchronization window appears. In this window you 

resolve the VLAN conflicts.

This table explains the columns in the window.

When you have chosen actions for each VLAN conflict, click Resolve. You see that 

your actions are reflected in the open VLAN window.

You cannot click Resolve until you chose an action for each VLAN conflict.

Click Apply in the VLAN window to save the actions and do other tasks there, or 

click OK to save them and close the window.

Column Explanation

VLAN ID The IDs of the VLANs that have a conflict.

Conflict A description of the conflict:

• Does not exist: The VLAN is not configured on all devices.

• Exists with different name: The VLAN IDs match on all 

devices, but the VLAN names do not match on all 

devices.

Resolution 

Action

A drop-down list of actions that will resolve the conflict. You 

choose the action that best suits your needs.
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Port Mirroring (ESW500, SF 200/300, and SG 200/300 Series 
Switches)

To configure port mirroring on Cisco the ESW500 Series, SF 200/300 Series, and 

SG 200/300 Series switches, choose Configure > Ports > Port Mirroring from 

the feature bar.

Overview

Port Mirroring monitors and mirrors network traffic by forwarding copies of 

incoming and outgoing packets from one port to a monitoring port. Port Mirroring 

can be used as a diagnostic tool and/or a debugging feature. It also enables switch 

performance monitoring.

Network administrators configure Port Mirroring by selecting a destination port to 

copy all packets, and up to 8 different source ports from which the packets are 

copied.

Important Guidelines

• Before you can configure port mirroring on the ESW500 Series, SF 200/300 

Series, and SG 200/300 Series switches, the Smartport role for the 

Destination Port must be set to Other.

• Do not use switch ports or uplink ports for port mirroring.

• You cannot use the same port as both a destination and a source port.

• Source and destination ports must reside on the same switch.

Procedures

To configure Port Mirroring, configure settings as described below, then click OK.

Setting Description

Destination Port Defines the port to which the source port traffic is 

mirrored.

Source Port Defines the port from which traffic is to be analyzed. Up to 

8 ports can be selected as source ports. 
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Spanning Tree Protocol (CE520 Switches)

To configure Spanning Tree Protocol (STP) for CE520 Switches, choose 

Configure > Switching > STP.

Overview

Spanning Tree Protocol (STP) is a standardized technique for maintaining a 

network of multiple bridges or switches. When the network topology changes, 

STP prevents the creation of loops by placing ports in a forwarding or blocking 

state and transparently re-configures bridges and switches. Each VLAN is treated 

as a separate network, and a separate instance of STP is applied to each.

This switch supports the per-VLAN spanning-tree (PVST+) protocol, based on the 

IEEE 802.1D standard and Cisco proprietary extensions.

STP parameters are set for each VLAN. For each spanning-tree instance, you can 

configure a set of global options and a set of port parameters. The switch 

supports up to 32 spanning-tree instances.

You can configure STP in these ways:

• Change the STP status to disable (or enable) on one more VLANs.

• Change spanning-tree parameters for the root switch.

Type Indicates the port mode configuration for port mirroring. 

The possible field values are:

• Receive Only. Defines port mirroring for receive 

traffic only on the selected port.

• Transmit Only. Defines port mirroring for 

transmitting ports. This is the default value.

• Transmit and Receive. Defines port mirroring on 

both receiving and transmitting ports.

Setting Description
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Procedures

The STP window has these tabs:

• STP Status, to disable (or enable) Spanning Tree Protocol (STP) on one or 

more VLANs

• Current Roots, to view the current spanning tree root settings

Begin by selecting a switch from the Hostname list. The information on the tabs 

applies to the selected switch.

To see a subset of the port information on the tabs, click Filter, and use the Filter 

Editor window (see Filter, page 148). Click Refresh to poll the device and to 

display the most current data.

When you finish configuring STP, click OK.

STP Status

This tab shows whether STP is enabled for each VLAN on the switch. STP is 

enabled by default. However, by disabling STP, you can avoid the 30-second 

delay in packet forwarding from a port when a switch re-configures.

This switch supports only the per-VLAN spanning-tree plus (PVST+) protocol, 

which is represented by pvst in the Spanning-Tree Mode list.

IMPORTANT Disable STP only if you are sure there are no loops in your network 

topology. If STP is disabled and loops are indeed present in the topology, network 

performance is degraded by excessive traffic and indefinite packet duplication.

To disable or enable STP:

STEP 1 In the VLAN ID column, select one or more VLANs on which you want to disable or 

enable STP.

STEP 2 In the Spanning-Tree Status column, select enable from the drop-down list to 

enable STP for each VLAN that you selected.

Select disable to disable STP for each VLAN that you selected.

Current Roots

For each VLAN, the Current Root tab (a read-only tab) displays the STP settings 

on the current port switch. These settings, which could be defined on another 

switch, define the parameters that take effect when the switch is acting as the 

VLAN root.
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These settings are described in the table below.

Field Description

VLAN ID The VLAN to which these settings apply when the switch 

acts as the root.

MAC Address The MAC address of the root switch.

Priority Identifies the root bridge. The switch with the lowest 

value has the highest priority and is selected as the root. 

The default is 32768.

Max Age Sets the number of seconds that a switch waits without 

receiving STP configuration messages before it attempts 

a re-configuration. The default for IEEE is 20 seconds; the 

default for IBM is 10 seconds.

Hello Time Sets the number of seconds between STP configuration 

messages. For IEEE and IBM, enter a number from 1 to 10. 

The default is 2 seconds.

Forward Delay Sets the number of seconds that a port waits before 

changing from its STP learning and listening states to the 

forwarding state. This delay time ensures that no loop is 

formed before the switch forwards a packet. The default 

for IEEE is 15 seconds; the default for IBM is 4 seconds.

Root Path Cost A relative measure used to determine the most favorable 

path to a destination. See the Path Cost Table, page 163 

for details.

Root Port The port to which these settings apply.

Root Bridge If the switch is actually the root of STP for that VLAN, the 

field displays Yes. Otherwise, the field displays No, and 

the root port of the device is listed in the Root Port 

column.

NOTE: Each switch in a spanning-tree instance adopts 

the hello, delay, and max age parameters of the root 

bridge, regardless of how it is configured.
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Path Cost Table

This table explains default path-cost settings for different speeds.

IGMP Snooping (CE520 Switches)

To enable and disable IGMP snooping and perform related configuration tasks on 

Cisco CE520 switches, choose Configure > Switching > IGMP Snooping from the 

feature bar.

Overview

Switches can reduce the unnecessary flooding of IP multicast packets by limiting 

the transmission of these packets to groups of clients that request them. When 

clients (end stations) automatically join and leave groups that receive IP multicast 

traffic, your switches can dynamically change their forwarding behavior according 

to join and leave requests. Internet Group Management Protocol (IGMP) snooping 

gives switches this control.

Procedures

The IGMP Snooping window has these settings:

• Settings to enable IGMP snooping generally and on individual VLANs

• Multicast Groups to view the multicast groups

• Multicast Router Port, to view the multicast router ports

Path Cost Speed

100 10 Mbps

19 100 Mbps

14 155 Mbps

4 1 Gbps

2 10 Gbps

1 Speeds greater than 10 Gbps
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Before you make selections on the Setting tab, select a device from the 

Hostnames list. All the choices that you make on this tab will apply to the selected 

device.

Follow these steps to change the settings:

STEP 1 Enable IGMP Snooping is checked by default. Uncheck it only if you want to 

disable IGMP snooping on the entire device.

STEP 2 The table shows the VLANs that switch ports belong to and the settings for the 

VLANs. By default, IGMP snooping is enabled on the VLANs. To change any of 

these defaults, click Modify, and use the Modify IGMP Snooping Settings window. 

See Modify IGMP Snooping, page 164.

STEP 3 When you return to the IGMP Snooping window, click OK.

The information shown in the Multicast Groups tab and Multicast Router Ports tab 

is read-only and cannot be modified.

Modify IGMP Snooping

This window appears when you select a VLAN and click Modify on the IGMP 

Snooping window while viewing its Settings tab. Use this window to enable or 

disable IGMP snooping on the selected VLAN.

Follow these steps:

STEP 1 Select either Enable or Disable from the Status list.

STEP 2 When you have made your changes, click OK to close the window and return to 

the IGMP Snooping window.

MAC Addresses (CE520 Switches)

Switches store the Media Access Control (MAC) addresses of attached devices in 

a MAC addresses table. You can manage the addresses in this table by choosing 

Configure > Switching > MAC Addresses from the feature bar.
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Overview

A switch learns the MAC addresses of attached devices, VLAN IDs, and interface 

numbers by reading the source address of arriving packets. After an entry is 

removed, the switch relearns it. If the switch encounters a packet for an unknown 

destination, it floods the packet to all ports of the VLAN.

As stations are added or removed from the network, the switch updates the table, 

adding new entries and aging those not in use. The switch also updates the table 

by deleting all addresses associated with a port on which a VLAN membership 

change occurred.

A switch can learn an address in more than one VLAN, and an address that it learns 

in one VLAN can be entered as a secure address in another VLAN. An address that 

the switch learns in one VLAN is unknown in another VLAN until the address is 

learned.

Procedures

To view or update the MAC address table, follow these steps.

STEP 1 From that Hostname list, select the switch whose stored MAC addresses you want 

to see.

The table columns have these meanings.

STEP 2 Optional. To delete the addresses and clear the table, click Remove All.

STEP 3 Click OK to close the window.

Column Meaning

MAC Address The MAC address of an attached device.

VLAN ID The VLAN ID that is configured on the sending interface.

Output Interface The interface to which received packets should be 

forwarded if the MAC address of the sender matches the 

one in the MAC Address column.
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Port Search Window (CE520 Switches)

To access the Port Search window, choose Monitor > Search from the feature 

bar. This option is only available if a Cisco CE520 switch is present in the customer 

site.

Overview

You can search for ports or devices in your network. Perhaps you want to know 

the type, status, and speed of a port, but you do not know its number or what 

device it is on. You can find the information quickly if you know something about 

the text description that was entered for the port. You can also search for devices 

that are connected to a specific device if you know the MAC address or IP 

address of that specific device. To search ports or devices, choose, and enter a 

search phrase, IP address, or MAC address in the Search window.

When you have the port search results, use them to browse the Port Settings 

window, which gives you configuration settings and run-time status information. 

When you have the device search results, use them to browse the Topology view, 

which helps you locate the connected devices.

Procedures

From this window, you can search for ports that have a descriptive word or phrase 

associated with them. You can also search for devices that are connected to a 

specific device by entering the IP address or MAC address of the specified 

device.

Follow these steps:

STEP 1 In the Find Ports With Description/IP Address/MAC Address field, enter a 

descriptive word or phrase, a MAC address, or an IP address. What you enter is 

matched against all the devices in the community or cluster.

Enter the MAC address in the format xxxx.xxxx.xxxx.xxxx or xx:xx:xx:xx:xx:xx, 

where x is a hexadecimal character (0-9, a-f, A-F).
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STEP 2 Click Search.

If you entered a port description in the Search field, ports that match the 

description appear in the Search Results area. This information appears in a table.

If you click Search with no text in the search field, Configuration Assistant shows 

you a list of all the community members, excluding WLAN controllers, and their 

ports.

If you entered an IP address or MAC address in the Search field, this information 

appears in a table:

STEP 3 Click OK when you are done with this window.

Column Explanation

Ports Device name and port number of the ports that match the 

description.

Description Description of the port.

Column Explanation

Host Name of the device whose IP address or MAC address was 

entered in the search field.

MAC Address MAC address of the device.

IP Address IP address of the device.

Description Type of device.
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EtherChannels (CE520 Switches)

To view or configure port groups on CE520 switches, choose Configure > Ports > 

EtherChannels from the feature bar.

Overview

Fast EtherChannel and Gigabit EtherChannel port groups are logical high-speed 

connections between switches or between switches and servers. Port groups can 

also provide redundant links between switches. The switch treats the port group 

as a single logical port; therefore, when you create a port group, the switch uses 

the configuration of the first port for all ports added to the group. After the group is 

created, changing STP or VLAN membership parameters for one port in the group 

automatically changes the parameters for all ports.

One port in each group carries all unknown multicast, broadcast, and STP packets.

The EtherChannels window displays port groups and enables you to:

• Create Fast EtherChannel and Gigabit EtherChannel port groups

• Remove ports from a port group

• Change the forwarding method for a group

Procedures

This window appears when you choose on the feature bar. You can also click here 

to launch it. Use it to display EtherChannel port groups and to:

• Create Port Groups

• Modify Port Groups

• Delete Port Groups

Begin by selecting a local device from the Hostname list. The information in the 

Channel Groups area applies to the selected device.

The Load Balance field is set to Source-Destination IP Address by default. This 

field cannot be modified.

Your choice applies to every port group that you create on the switch.
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This table explains the columns in the Channel Groups area.

Create Port Groups

You can create up to 6 port groups. The ports that form a group must be of the 

same type.

Review Port Group Restrictions, page 170 before you use this procedure.

A port group can both contain up to 16 members if they are in LACP mode. 

Otherwise, it can contain up to 8 members.

By default, a switch forwards traffic to a port group based on the packet source 

address. If you configure a static address for a port group, configure the switch to 

forward packets from the static address to all ports in the group to eliminate the 

chance of lost packets. If you set the port group to forward packets based on the 

destination address, configure the switch to forward packets destined for the 

static address to only one port in the port group. Otherwise, the destination 

address receives duplicate packets.

To create a port group:

STEP 1 Click Create, and use the Create EtherChannel window. See Create Port Groups, 

page 171.

You can create a port group on the local device that you selected and, optionally, 

on a remote device.

Click OK to put your changes into effect and to close the window.

STEP 2 Click OK to close the EtherChannels window.

Column Explanation

Group The number assigned to the port group.

Ports The ports that belong to the group.

Status Either Down or In use. You also see that the group contains Layer 2 

interfaces.



Port and Switch Settings
EtherChannels (CE520 Switches)

170 Cisco Configuration Assistant SBCS Administrator Guide

5

Modify Port Groups

You can modify a port group by:

• Adding a member port

• Removing a member port

• Changing the LACP mode of a member port

To perform any of these tasks, follow these steps:

STEP 1 In the Channel Groups area, select the row for the group that you want to modify.

STEP 2 Click Modify, and use the Modify EtherChannel window. See Create Port Groups, 

page 171.

You can modify a port group on the local device that you selected and, optionally, 

on a remote device.

STEP 3 Click OK to put your changes into effect and to close the window.

STEP 4 Click OK to close the EtherChannels window.

Delete Port Groups

To delete a port group, follow these steps.

STEP 1 In the Channel Groups area, select the row for the group that you want to delete.

STEP 2 Click Delete.

STEP 3 Click OK to close the window.

Port Group Restrictions

Any port can belong to a port group, but these restrictions apply:

• The Switch role must be applied to the port group member.

• No port group member can be configured for port monitoring.

• No port group member can be enabled for port security.

• Port group members must belong to the same set of VLANs and must be all 

static-access, all multi-VLAN, or all trunk ports.
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• Dynamic-access ports cannot be grouped with any other port, not even 

with other dynamic-access ports.

• A network port cannot be in a destination-based port group.

Create Port Groups

This window appears when you click Create in the EtherChannels window. Use it 

to assign local ports to a port group on the selected device, and optionally, to 

assign remote ports to a port group on a remote device.

Only ports that are assigned the switch port role appear in this window.

Follow these steps:

STEP 1 If you are creating port groups on a local and a remote device, select the remote 

device from the Remote Device list. Under the Remote Ports side of the window, 

you see the remote ports that are connected to the ports of the local device.

Notice that the options for the remote device are the same as for the local device. 

When you select options for the local device, do the same for the remote device.

STEP 2 In the Group field, enter the number of the port group that you are creating.

STEP 3 Check the box under In Group for each port that you want to be a group member.

STEP 4 Bypass the Status column. It shows the status of the ports only in the Modify 

EtherChannel window.

STEP 5 Click in the Mode cells for the selected ports, and select one of these values:

• LACP. The port can form a link aggregate and initiate the channel. The 

aggregate is formed if the other end is running LACP in active mode.

• On (No LACP). The port does not use LACP. A usable EtherChannel only 

exists if the port group is connected to another group in this mode.

STEP 6 Click in the Priority cells for the selected ports, and enter a LACP priority if you do 

not want the default (32768 for LACP).

The port with the highest priority sends the packets.

STEP 7 Click OK to close the window.

The new port group appears in the EtherChannels window.
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Modify Port Group

This window appears when you select a port group and click Modify in the 

EtherChannels window.

These are the options of a local and remote port group that you can modify:

• The ports that belong to a port group

• The mode of a port

• The priority of a port

The Status column displays information about the ports that might help you decide 

whether to make modifications. These statuses can be displayed:

STEP 8 Click OK when you finish.

Status Meaning

in port-group The port is working in the port group.

hot-standby A maximum of 8 LACP ports are already active. 

suspended The port is temporarily not working, perhaps due to an 

inconsistency with other ports.

standalone The port is connected to a remote port that is not 

participating in a port group.

down The port is not working. It might be unconnected or 

administratively down.
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Routing and Network Connections

This section covers network routing configuration and includes these topics:

• IP Addresses

• Internet Connection

• DHCP Server

• Static Routing

IP Addresses

To manage IP addresses, choose Configure > Routing > IP Addresses from the 

feature bar.

NOTE: If the device you are configuring is an Internet Video Camera, the 

configuration options are different. See Configuring IP addressing for Internet 

Video Cameras, page 178.

See these topics for information about enabling and configuring IP addresses:

• Overview

• Modifying Default VLANs

• Interface Configuration

• Device Configuration

• Configuring IP addressing for Internet Video Cameras

!
CAUTION We do not recommend that you configure IP addressing over a remote WAN 

connection. If the connection to the WAN is interrupted, the operation will fail and 

the system may become unusable.
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Overview

The IP Addresses window has these tabs, unless the Hostname you select is an 

Internet Video Camera:

• Interface Configuration, to assign or modify an IP address and subnet 

mask for a VLAN. When you do this, the VLAN becomes a Switched Virtual 

Interface (SVI). Creating an SVI does not enable routing on the device.

• Device Configuration, to associate a domain name with the selected 

device.

Modifying Default VLANs

Default VLANs are part of the factory configuration for these devices:

• For the UC500, these default VLANs are created:

- VLAN 1: Default data VLAN for the UC500.

- VLAN 100: Default voice VLAN for the UC500.

- BV175: UC500 wireless data VLAN.

• For the SR520, the default data VLAN is VLAN75.

• For the SR520-T1, the default data VLANs are LAN0 (FastEthernet0) and 

LAN1 (FastEthernet1).

You can modify the IP address and subnet mask for these default VLANs on the 

Interface Configuration tab in the IP Addresses window.

The default data and voice VLAN configuration for the UC500 can also be 

modified through the Telephony Setup wizard, which must be run on a system that 

is at factory default state or through the Multisite Manager.

!
CAUTION Modifying IP address of the default data and voice VLANs after initial system 

configuration results in changes to other system configuration settings. After you 

change this configuration, verify that the system functions as expected. 

Do not modify these settings over a remote WAN connection.
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Editing the Network/Mask/Default Router field for the VLAN100 or VLAN1 

interface on the DHCP Pools tab in the DHCP Server window (Configure > 

Routing > DHCP Server) and editing IP Address/Mask of VLAN in the VLAN 

window (Configure > Switch > VLANs), will have the same effect as changing the 

IP address of the data and/or voice VLAN on the device.

IMPORTANT:

• After changing the default data VLAN IP address, you must manually adjust 

any custom NAT port mappings rules defined under Configure > Security > 

NAT.

• After changing the default data VLAN IP address on the UC500, you must 

restart any ESW500 Series switches in the customer site in order to renew 

the DHCP lease on the ESW500. This issue could also apply to other 

devices in the site.

The following table describes configuration settings that are automatically 

updated by CCA when you configure the IP address of each of these default 

VLANs for these devices.
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Device Default VLAN Settings that are updated when this VLAN is modified

UC500 Data VLAN 
(VLAN1)

The IP address of the data VLAN (VLAN1 / BVI1) is set to 
the new value.

The existing DHCP address exclusion range is removed 
and a new DHCP address exclusion range is added, based 
on the new data VLAN IP.

The existing VPN IP address pool is removed, and a new 
VPN IP address pool is added, based on the new data 
VLAN IP address.

Dial peers that use session target to point to the route for 
the existing data VLAN IP address are modified to point to 
the new one. For example, if the new data VLAN IP 
address is 192.168.20.1, the dial peer uses session target 
ipv4:192.168.20.1.

All ACLs (access control lists) are modified to use the new 
data VLAN IP address.

If the UC500 is behind an SR500:

• All ACLs that refer to the existing subnet are 
modified to refer to the new one.

• Static routes from the SR500 to the UC500 that 
refer to the existing data VLAN IP address are 
modified to use the new data VLAN IP address.

If the UC500 is behind an SA500 security appliance and 
the SA500 has static routes to the existing data VLAN on 
the UC500, these are modified to point to the new data 
VLAN.

UC500 Voice VLAN 
(VLAN100)

The UC-500 wireless data VLAN is modified (VLAN75/
BVI75) to use the new value.

SCCP control application settings are modified to refer to 
the new voice VLAN IP address.

ACLs on the UC500 that refer to the existing voice VLAN IP 
address are modified to refer to the new one.

If the UC500 is behind an SR500 or SA500, ACLs on the 
SR500 or SA500 that refer to the existing voice VLAN IP 
address are modified to refer to the new one.
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Interface Configuration

Begin by selecting a device from the Hostname list.

In the Interface Name column, you see the names of the VLANs that are 

configured on the selected device. These can be default VLANs that are part of 

the factory default settings for a device or VLANs that you added.

• To assign a new IP address, click in the IP address column for the selected 

device, and enter the new IP address.

• To assign a new subnet mask, click the Subnet Mask column for the 

selected device, and enter a new value.

Click OK or Apply when you are finished.

If you are connected to the default data VLAN on the UC500 or SR500, you will 

lose the connection to the UC500 when data VLAN IP address for the UC500 or 

SR500 data VLAN is modified. Close CCA, then re-launch CCA and connect to the 

device or site using the new IP address.

SR500 and 
SR520-T1

Data VLAN 

VLAN75 for the 
SR500

FastEthernet0/0, 
FastEthernet0/1 
for the SR520-T1)

The IP address of the data VLAN (VLAN75) is set to the 
new value.

The existing DHCP address exclusion range is removed 
and a new DHCP address exclusion range is added, based 
on the new data VLAN IP.

The existing VPN IP address pool is removed, and a new 
VPN IP address pool is added, based on the new data 
VLAN IP address.

All ACLs (access control lists) are modified to use the new 
data VLAN IP address.

If a UC500 is behind the SR500:

• All ACLs that refer to the existing data VLAN IP 
address are modified to refer to the new subnet.

• Static routes on the UC500 that refer to the data 
VLAN IP address of the SR500 modified to use the 
new data VLAN IP address.

Network Address Translation (NAT) rules on the SR500 for 
forwarding traffic on ports 5060 (SIP) and 1720 (H323) are 
modified to use the new data LAN IP address.

Default routes for the UC500, if it is connected to an SR500 
and connected to a customer site, are also adjusted to 
reflect the new value.

Device Default VLAN Settings that are updated when this VLAN is modified
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Device Configuration

STEP 1 Begin by selecting a device from the Hostname list.

STEP 2 In the Domain Name field, enter a name that identifies an administrative region in 

the IP network. You might need to ask your network administrator for this 

information. When network traffic contains no domain name, the name that you 

enter is appended to the name of the device, and the fully qualified name is added 

to the devices hostname table.

STEP 3 Check Enable Domain Lookup to enable servers to translate device names to IP 

addresses.

STEP 4 In the New Server field, enter the name of a device that you want to use as a DNS 

server (domain name server), and then click Add. The device is added to the 

Current Servers list.

STEP 5 To stop using a device as a DNS server, select it in the Current Servers list, and 

click Remove.

STEP 6 Click OK or Apply.

Configuring IP addressing for Internet Video Cameras

To enable and configure the IP Address for Internet Video Cameras, complete the 

settings as described below, then click OK or Apply.

Setting Description

Hostname Select the hostname from the pull-down menu.
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Internet Connection

The Internet Connection Window appears when you choose Configure > Routing 

> Internet Connection from the feature bar.

Overview

The Internet Connection window has two tabs:

• Connection Settings: For enabling and configuring the Internet WAN 

connection and configuring optional DDNS (Dynamic Domain Name 

Service) settings.

• Traffic Shaping: For enabling traffic shaping and configuring Quality of 

Service (QoS) settings (recommended for multisite deployments).

Connection Settings

From this tab, you enable and configure the Internet connection. These connection 

types are supported:

• PPPoE or PPPoE with a negotiated IP address: PPPoE can be used by 

multiple hosts on a shared Ethernet interface to open PPP sessions to 

multiple destinations with one or more bridging modems. If you choose a 

Static IP Click Static IP to use a static IP address obtained from your 

service provider.

If you choose Static IP, you must also enter these settings. 

These are obtained from your service provider.

• Internet IP Address

• Subnet Mask

• Default Gateway—IP address of the default gateway

• Server 1—IP address (required)

• Server 2—IP address (optional)

DHCP Click DHCP to have the router lease an IP address from a 

remote DHCP server.

Setting Description
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negotiated IP address, the router obtains an IP address through PPP/IPCP 

(Point-to-Point Protocol/IP Control Protocol) address negotiation.

• Static IP address: Configure the interface to use a static IP address.

• DHCP: Configure the interface to obtain an IP address from a DHCP server.

You can also configure optional settings for Dynamic DDNS.

To enable and configure the Internet connection, follow these steps.

STEP 1 Choose a device to be configured from the Hostname list.

STEP 2 Choose an interface from the WAN Interfaces list.

STEP 3 Click Modify to open the Modify Internet Connection window. See Modify 

Internet Connection, page 181.

STEP 4 To save your changes and to close the window, click OK.

Traffic Shaping

From this tab, you enable Traffic Shaping and configure QoS settings.

These settings are primarily used in conjunction with configuring the maximum 

number of simultaneous calls for multisite deployments.

• See Configuring Quality of Service (QoS), page 486 for more information 

and guidelines for configuring QoS for multisite deployments.

• See Maximum Calls (Call Admission Control), page 494 for information 

about configuring call admission control based on these settings.

Configure settings as described in the following table. Click OK or Apply when 

finished.

Setting Description

Traffic Shaping Check this setting to enable QoS and traffic shaping.
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For more information, see Modify Internet Connection, page 181.

Modify Internet Connection

This window appears when you click Modify on the Internet Connection window.

Modify Internet Connection window has two tabs:

• Connection Settings: For enabling and configuring the Internet WAN 

connection and configuring optional DDNS (Dynamic Domain Name 

Service) settings. See Connection Settings, page 182

• Traffic Shaping: For enabling traffic shaping and configuring Quality of 

Service (QoS) settings (recommended for multisite deployments). See 

Traffic Shaping, page 180

Upstream Bandwidth 

[kbps]

When Traffic Shaping is enabled, enter the actual 

upstream bandwidth for the site in kbps, as 

determined by a connection speed test or the 

Committed Information Rate (CIR) specified in the 

Service Level Agreement (SLA) for the Internet 

service provider.

Valid values range from 384 to 100000 kbps.

For example, if the upstream bandwidth is 1.8 Mbps, 

enter 1800 for the upstream bandwidth.

If the CIR or the results of a connection speed test are 

not available, enter a value in kbps that is 80% 

(percent) of the upstream bandwidth advertised by 

the Internet Service Provider (ISP).

Media Reservation (%) Use the slider bar to specify the proportion of 

available WAN bandwidth to guarantee for voice 

traffic if it is present on the network.

Valid percentages range from 10 to 95 (the remaining 

5 percent covers signaling and other overhead). The 

default is 50%.

If no voice traffic is present on the system, all of the 

available bandwidth is used for data traffic.

Setting Description
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Connection Settings

To enable and configure an Internet connection on an interface or configure 

optional Dynamic DNS settings, complete the settings in this window as described 

below, then click OK.

Setting Description

Enable WAN 

Interface

When checked, this setting enables an Internet connection.

PPPoE Check the PPPoE check box to choose PPPoE for the Internet 

connection, if required by your service provider. If PPPoE is 

checked, configure these additional settings. These are 

obtained from your service provider.

• Username—Username required for PPPoE connection.

• Password—PAP/CHAP authentication password 

required for PPPoE connection.

• Re-enter Password—Re-enter password for 

confirmation.

IP Negotiated This option is only available with PPPoE encapsulation.

Enable the IP Negotiated option if required by your service 

provider.

When IP Negotiated is enabled, the router obtains an IP 

address by using PPP/IPCP address negotiation.
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Static IP Click Static IP to use a static IP address obtained from your 

service provider.

If you choose Static IP, you must also enter these settings. 

These are obtained from your service provider.

• Internet IP Address

• Subnet Mask

• Default Gateway—IP address of the default gateway

• Primary DNS Server IP Address (required)

• Secondary DNS Server IP Address (optional)

Later, if you want to modify the Internet connection to use 

DHCP instead of a static IP address, you are prompted to 

delete existing SSL VPN and VPN Server configuration 

settings before continuing.

DHCP Choose DHCP to have the router lease an IP address from a 

remote DHCP server.

Setting Description
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HTTP DDNS

Optional. Configure settings for Dynamic Domain Name Service (DDNS).

Site that use DHCP to dynamically obtain an IP address can use a Dynamic DNS 

(DDNS) hosting service to allow aliasing of dynamic (DHCP) IP addresses to 

static hostnames.

DDNS can also be configured for devices with an IP Negotiated WAN IP 

address.

Sites that use DHCP that are also part of a multisite deployment must configure 

HTTP DDNS.

Provider Choose a DDNS provider from the pull-down menu.

You must create your own DDNS account with one of these 

providers outside of the Configuration Assistant.

These DDNS hosting services are available.

• cgi.tzo.com

• dup.hn.org

• members.dyndns.org

• members.easydns.com

• www.dyns.cx

• www.justlinux.com

• www.zoneedit.com

Hostname Unique hostname for this site, obtained from your DDNS 

provider. This is usually a Fully Qualified Domain Name (FQDN) 

for example, myhost.mydomain.net, but might be different for 

some DDNS services. The hostname must be registered.

This field is not validated by the Configuration Assistant. Make 

sure that you have entered the hostname exactly as specified 

by your DDNS provider.

If you are configuring a multisite deployment, each site must 

have a unique DDNS hostname.

Setting Description
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For more information, see these topics:

• Configuring DDNS, page 485

• Configuring Quality of Service (QoS), page 486

• Voice Features Supported Across Multiple Sites, page 493

DHCP Server

To configure DHCP Server settings, choose Configure > Routing > DHCP Server 

from the feature bar.

Overview

A DHCP (Dynamic Host Configuration Protocol) IP address pool is a range of IP 

addresses that a DHCP server can dynamically issue to client devices. Because 

not all clients are connected all the time, providing IP addresses as needed 

reduces the number of IP addresses required to serve a group of clients by 

reusing the same IP address for different clients at different times.

To manage the DHCP IP address pool, you can:

• Create a DHCP IP address pool that identifies the range of IP addresses in 

the pool.

• Bind a specific IP address in the pool to a specific MAC address, creating a 

static IP address for that client device. (Some clients require static IP 

addresses to maintain connectivity to support running applications.)

• Exclude specific IP address from the pool so that they will not be assigned 

to a client by the DHCP server. (A few IP addresses in the range might have 

been assigned through other processes. To avoid conflicts, you can 

exclude them from the pool.)

Username Account user name, obtained from your DDNS provider.

Password Account password, obtained from your DDNS provider.

Confirm 

Password

Re-enter the password for confirmation.

Setting Description
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The range of the pool is calculated from the network number and subnet mask. All 

available node-level IP addresses are included in the pool and made available to 

the server unless they are specifically bound to a MAC address or excluded from 

the pool; the server ignores manual address bindings and exclusions.

The DHCP Server window has these tabs:

• DHCP Pools: Display, create, modify, or delete a DHCP pool of IP 

addresses.

• DHCP Bindings: Manually assign IP addresses in the DHCP pool to the 

MAC addresses of clients.

• DHCP Exclusions: Specify the IP address that the DHCP server should not 

assign to (exclude from) clients.

DHCP Pools

A DHCP (Dynamic Host Configuration Protocol) IP address pool is a range of IP 

addresses that a DHCP server can dynamically issue to client devices.

Two default DHCP pools are created for the UC500: phone and data. They can be 

modified, but the default pool names are reserved and cannot be modified.

• The phone pool is associated with the Voice VLAN (VLAN 100) on the 

UC500. IP addresses from the phone DHCP pool are assigned to IP phones 

during auto-registration.

• The data pool is associated with the Data VLAN (VLAN1) on the UC500. IP 

addresses from this pool are assigned to devices on the data VLAN that 

request an IP address from the DHCP server.

To display the properties configured for a DHCP pool, click on the DHCP pool 

name.

To create a new DHCP pool, click Create, and use the Create DHCP Pool window. 

See Create DHCP Pool, page 188.

To modify an existing DHCP pool, choose the DHCP pool, click Modify, and use 

the Modify DHCP Pool window. See Modify DHCP Pool, page 190.

To delete a DHCP pool, choose the DHCP pool name, then click Delete.

NOTE 1: A window appears, warning you that if you proceed, you will delete the 

DHCP pool.

NOTE 2: An error message appears if the DHCP relay is not configured on the 

default data VLAN. Without DHCP relay, devices on data VLAN will no longer get a 

DHCP IP Address.
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To configure DHCP Relay choose Configuration > Switching > VLAN window. 

See VLANs, page 153.

To close the window, click OK.

DHCP Bindings

After you create a DHCP pool, you can manually assign IP addresses from that 

pool to specific devices based on their MAC address.

To create a new DHCP binding, click Create, and use the Create DHCP Binding 

window. See Create DHCP Binding, page 190.

To modify an existing DHCP binding, choose the pool name, click Modify, and use 

the Modify DHCP Binding window. See Modify DHCP Binding, page 191.

To delete a DHCP binding, choose the DHCP binding name, then click Delete. A 

window appears, warning you that if you proceed, you will delete the DHCP 

binding.

To close the window, click OK.

DHCP Exclusions

From this tab, you specify individual IP addresses or ranges of IP address to be 

excluded from the DHCP address pool. These addresses cannot be assigned to 

DHCP clients.

To create a new DHCP exclusion, click Create, and use the Create DHCP 

Exclusion window. See Create DHCP Exclusion, page 188.

To delete a DHCP exclusion, choose the IP address, and click Delete.

By default, these IP addresses are excluded from DHCP pools:

• 10.1.1.1 through 10.1.1.10 (reserved for Cisco IOS and CUE)

• 192.168.10.1 through 192.168.10.10 (reserved for the UC500)

• 10.1.1.255 and 192.168.10.255 broadcast addresses

DHCP Pool Bindings

Two types of DHCP pool bindings can be used:

• Automatic binding — The DHCP server will create the binding. After the 

lease time expires, the device may get a new IP address.

• Manual binding — Use a manual binding if you want this device to use this IP 

address. The lease does not expire.
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Create DHCP Exclusion

This window appears when you click Create on the DHCP IP Exclusion tab of the 

DHCP Server window.

Use this dialog to add a range of DHCP IP address exclusions.

Follow these steps:

STEP 1 In the Start IP Address field, enter the first DHCP IP address in the range that the 

DHCP server should not assign to DHCP clients.

STEP 2 In the End IP Address field, enter the last DHCP IP address in the range that the 

DHCP server should not assign to DHCP clients.

STEP 3 Click OK.

Create DHCP Pool

This window appears when you click Create on the DHCP Pool tab of the DHCP 

Server window.

Use this dialog to create a DHCP pool and to optionally identify DNS servers, a 

domain name, a default router, the Windows Internet Naming Service (WINS) 

servers, and DCHP Lease Expiry Time.

To create a DHCP pool, configure the settings described below, then click OK.

Setting Description

DHCP Pool

Name Enter the DHCP pool name.

On the UC500, the phone and data DHCP pool names are 

reserved for the voice (VLAN100) and data (VLAN1) 

VLANs.
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Network Starting IP address of the DHCP pool.

If you edit the Network setting for the phone and data 

DHCP pools on the UC500, this has the same effect as 

changing the IP address for these default VLANs. See 

Modifying Default VLANs, page 174.

Subnet Mask Enter the subnet network mask.

DHCP Options

DNS Server1 In the DNS Server1 field, enter the IP address of a DNS 

server. DHCP clients query DNS servers to correlate 

hostnames to IP addresses.

DNS Server2 Optional. In the DNS Server2 field, enter the IP address 

of a second DNS server.

Domain Name Enter the name of the domain. The domain name of a 

DHCP client places the client in the domain.

WINS Server1, 

WINS Server2

Optional. In the WINS Server1, WINS Server2 fields, 

enter the IP address of the WINS servers. These fields 

specify the WINS servers that are available to a Microsoft 

DHCP client.

Default Router In the Default Router field, enter the IP address of the 

default gateway. When a DHCP client starts, the client 

begins sending packets to its default gateway. The IP 

address of the default gateway must be on the same 

subnet as the client.

DHCP Lease

DHCP Lease Expiry Time

• Specify - Use the up/down arrows to enter the 

value for days, hours, and minutes

Days can be 0-365

Hours can be 0-23

Minutes can be 0-59

• Infinite - for infinite time period click to enable, 

then press OK.

Setting Description
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Modify DHCP Pool

This window appears when you click Modify on the DHCP Pools tab of the DHCP 

Server window.

Use this dialog to modify an existing DHCP pool, including the DNS servers, a 

domain name, a default router, or the WINS servers, and DHCP Lease Expiry Time.

You cannot modify the name of the default phone and data DHCP pools. All other 

settings can be modified for these pools.

See Create DHCP Pool, page 188 for an explanation of the fields in this window.

Click OK when you are finished with this window.

Create DHCP Binding

This window appears when you click Create on the DHCP Bindings tab of the 

DHCP Server window.

To create a DHCP binding, configure settings as described below, then click OK.

Setting Description

Name Enter a name for the DHCP server address pool.

Host IP Address Enter the host IP address.

Netmask Enter the host subnet network mask.

MAC Address Enter the MAC address. It specifies a hardware address 

for the client or the distinct identification of the client in 

dotted hexadecimal notation. For example, 

01b7.0813.8811.66.

Client Name Enter the client name using standard ASCII characters.

The client name must not be the domain name. For 

example, do not specify the name mars as 

mars.cisco.com.
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Modify DHCP Binding

This window appears when you click Modify on the DHCP Bindings tab of the 

DHCP Server window.

Use this dialog to modify a DHCP binding.

See Create DHCP Binding, page 190 for an explanation of the fields in this 

window.

Click OK when you are finished with this window.

Static Routing

To configure static routes, choose Configure > Routing > Static Routing from the 

feature bar.

Use this window to add a static route to or delete a static route from a router.

Overview

You can add a static route to the static routing table in a router.

• A static route is hard-coded into the static routing table of the device, so any 

static route that you configure is not removed from the routing table until 

you delete it or replace it.

• A static route has priority over all dynamic routes and reduces processing 

time by quickly determining the path for a packet. Dynamic routes are 

learned by the device by using IP routing protocols such as RIP, require 

more processor time, and age out of the routing table if they are not 

refreshed.

On the UC500, a static route is created to 10.1.10.1, the Integrated-Service-

Engine-0/0 interface, which is the Cisco Unity Express (CUE) module. Do not delete 

this route.

Procedures

Begin by selecting the device to be configured from the Hostname list.

• To add a static route, click Add, and use the Add Static Route window. See 

Add Static Route, page 192.

• To delete a static route, choose the static route to be removed, then click 

Delete.
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• Click OK to close the window.

Add Static Route

This window appears when you click Add on the Static Routing window.

To add a static route to a router, configure settings as described below, then click 

OK to close the window and save your changes.

Setting Description

Destination/

Network IP field

Enter the IP address of the destination network.

Network Mask Enter the subnet mask of the destination network.

Gateway IP or 

Outgoing 

Interface

Choose an interface from Outgoing Interface list or 

choose Enter Gateway IP.

If you chose Enter Gateway IP, enter the IP address of 

the gateway or the outgoing interface in the text box 

below this field.
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Wireless

Configuration Assistant provides tools for configuring wireless access points and 

wireless LAN controllers on your system. This section includes these topics:

• Configuring Secure Wireless Settings

• Convert to LAP (Lightweight Access Point)

• Wireless LAN Controller Configuration

See Wireless Setup Wizard, page 95 for information on using the CCA Wireless 

Setup Wizard to configure wireless settings and synchronize wireless profile 

settings on access points and SPA525G IP phones.

Configuring Secure Wireless Settings

To configure security on wireless access points, choose Configure > Wireless > 

WLANs (SSID) on the feature bar.

From the WLANS (SSIDs) window, you can:

• Configure SSID settings for wireless security

• Choose whether or not to broadcast the SSID

• View the security settings that you configured on the access point

• Configure RADIUS servers

• Configure wirelesss radio settings for autonomous access points

• Configure MAC authentication for AP541N access points

• Enable or disable the wireless interface for UC500 and SR500 devices with 

integrated wireless capabilities
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NOTE: To disable wireless for UC500 and SR500 devices with integrated 

wireless capabilities, uncheck the Enable Wireless Interface option in the WLANs 

(SSIDs) window. By default, the wireless interface is enabled for these platforms.

Wireless settings vary, depending on the type of access point you are configuring:

• Wireless Settings for Cisco AP541N Access Points

• Wireless Settings for Cisco AP521 and UC500 or SR500 Built-in 

Access Points

Wireless Settings for Cisco AP541N Access Points

These sections explain the wireless configuration settings on each of the three 

tabs in the WLANs (SSIDs) window for Cisco AP541N single-radio, dual-band 

access points.

• SSIDs

• Radius

• MAC Authentication

NOTE: To configure features on the AP541N that are not currently managed 

through CCA such as clustering, use the AP541N Configuration Utility. To access 

this utility, right click on the AP541N icon in the Topology view and choose 

Configuration Utility from the pop-up menu.

SSIDs

From the SSIDs tab, you can view, create, or modify SSIDs and their associated 

settings for AP541N access points.

Up to sixteen SSIDs can be created on a single AP541N access point.

• To create new SSID, click Create to open the Create or Modify SSID 

window.

• To modify settings for an existing SSID, select the SSID from the list and 

click Modify.

For detailed information about SSID settings for AP541N access points, see 

Create or Modify SSIDs for Cisco AP541N Access Points, page 205.

This table explains the settings displayed in the SSIDs window.
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Setting Description

SSID The Service Set Identifier configured on the access point. 

The SSID name cannot be modified once it is created. To 

change the name, delete the SSID and create a new one with 

a different name.

The cisco-data (VLAN1) and cisco-voice (VLAN100) SSIDs 

are default SSIDs for data and voice traffic. By default, these 

SSIDs have security set to None. To access security settings 

for an existing default SSID, select the SSID and click Modify.

VLAN Displays the VLAN associated with the SSID.

Security Displays the type of wireless security and associated 

settings. For the AP541N, these security types are 

supported:

• None

• Static WEP

• Dynamic WEP

• WPA Personal

• WPA Enterprise

See Wireless Security Options for AP541N Devices, 

page 207 for a description of each of these options.

Encryption Displays one of these wireless encryption types, based on 

the selected security type: None, WEP, AES, or TKIP and 

AES CCMP.

Authentication Displays one or more of these authentication types, based 

on the selected security type.

• None

• open authentication

• open authentication with EAP

• network EAP
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Radius

From the Radius tab, you can enable and configure global settings for external 

RADIUS servers for accounting and authentication of wireless clients. The AP541N 

does not have a local RADIUS server.

MAC 

Authentication 

Type

You can configure a global list of MAC addresses that are 

allowed or denied access to the network. Choose one of the 

following MAC Authentication Types:

• Local—Use the MAC Authentication list that you 

configure on the MAC Authentication tab. See MAC 

Authentication, page 197.

• Radius—Use the MAC Authentication list configured 

on the external RADIUS server.

• Disabled—Do not use MAC authentication.

Setting Description

RADIUS IP Address Enter the address for the primary global RADIUS 

server.

When the first wireless client tries to authenticate 

with the AP, the AP sends an authentication request 

to the primary server. If the primary server responds 

to the authentication request, the AP continues to 

use this RADIUS server as the primary server, and 

authentication requests are sent to the address that 

you specify.

RADIUS IP Address-1, 

RADIUS IP Address-2, 

RADIUS IP Address-3

Enter up to three IPv4 addresses for the backup 

RADIUS servers.

If authentication fails with the primary server, each 

configured backup server is tried in sequence. The 

address must be valid in order for the AP to attempt 

to contact the server.

Setting Description



Wireless

Configuring Secure Wireless Settings

Cisco Configuration Assistant SBCS Administrator Guide 197

7
 

MAC Authentication

On the MAC Authentication tab, you specify a list of MAC addresses to control 

access to the network through the AP based on the MAC address of the wireless 

client. You also specify whether the clients with those MAC addresses are allowed 

or denied access to the network. This local list is used when MAC Authentication 

is set to Local for an SSID configured on the AP541N.

To configure MAC authentication settings, follow these steps.

RADIUS Key The RADIUS Key is the shared secret key for the 

primary global RADIUS server.

You can enter up to 63 standard alphanumeric and 

special characters for the RADIUS Key. The key is 

case-sensitive, and you must configure the same key 

on the AP and on your RADIUS server.

The RADIUS key is not displayed in plain text as you 

type it.

RADIUS Key-1,

RADIUS Key-2,

RADIUS Key-3

Enter the RADIUS key associated with each of the 

configured backup RADIUS servers.

The server at RADIUS IP Address-1 uses RADIUS 

Key-1, RADIUS IP Address-2 uses RADIUS Key-2, 

and so on.

You can enter up to 63 standard alphanumeric and 

special characters for the Radius Key. The key is 

case-sensitive, and you must configure the same key 

on the AP and on your RADIUS server.

The RADIUS key is not displayed in plain text as you 

type it.

Enable RADIUS 

Accounting

Enable this option to track and measure the 

resources a particular user has consumed such as 

system time, amount of data transmitted and 

received, and so on.

If you enable RADIUS accounting, it is enabled for 

the primary RADIUS server and all backup servers.

Setting Description
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STEP 1 Choose how you want to filter the clients with the MAC addresses specified in the 

list.

• Choose Allow Addresses in the List to only allow access to clients with the 

MAC addresses specified in the list.

• Choose Deny Addresses in the List to allow access to all clients except 

those with the MAC addresses specified in the list.

STEP 2 Click Add to open a new row in the table.

STEP 3 Click anywhere in the row and enter the 12-digit hexadecimal MAC address of the 

client to add to the list.

Enter MAC addresses using the format xxxx.xxxx.xxxx (for example, 

0101.FEFE.2345). The dot (.) characters are entered automatically as you type. 

Do not use colons to separate hexadecimal digits in the MAC address.

STEP 4 Continue adding MAC addresses to the list as needed.

STEP 5 Click Apply or OK when you are finished.

To remove a MAC address from the list, highlight the address in list and click 

Remove, then click Apply or OK.

Wireless Settings for Cisco AP521 and UC500 or SR500 Built-in Access Points

These sections explain the configuration settings on each of the three tabs in the 

WLANs (SSIDs) window:

• Wireless Network Names (SSIDs)

• RADIUS Servers

• Access Point Settings

NOTE: SR500 Series Secure Routers with built-in access points have similar 

settings, but the GUI for configuring these settings does not have separate tabs. 

See the Wireless Network Names (SSIDs) and RADIUS Servers sections for 

information about these settings.
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Wireless Network Names (SSIDs)

You can configure security features on your autonomous access point. The 

security features protect wireless communication between the autonomous 

access point and other wireless devices and prevent unauthorized entry. You can 

configure different levels of security and encryption on your autonomous access 

points. The security levels range from no security to high security.

This table explains the columns in this window.

Setting Description

SSID The Service Set Identifier configured on the access point.

VLAN The VLAN associated with the SSID.

Enable wireless 

interface

This option is only displayed for UC500 and SR500 

devices with integrated wireless capabilities. When this 

option is unchecked, the wireless interface on these 

devices is shut down. You can still configure SSIDs and 

settings when the wireless interface is shut down.

Security Type of wireless security and associated settings: 

• No Security

• WEP , page 211

• EAP, page 211

• WPA, page 212

• WPA-PSK, page 212 

• WPA2, page 212

• WPA2-PSK, page 213

• MAC, page 213

• MAC & EAP, page 213 

• Unknown—This appears if the security setting is 

configured by using the command-line interface 

and the security setting is not supported by 

Configuration Assistant.
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Follow these steps to configure SSIDs and enable security for your autonomous 

access points.

STEP 1 From the Hostname list, select an access point.

STEP 2 To create a Wireless LAN and select the security settings, select the Wireless 

Network Names (SSIDs) tab, click Create, and complete the Create WLAN 

window. See Create or Modify WLAN SSID, page 204.

Multiple WLANs allow users to access different networks through a single 

autonomous access point.

The number of SSIDs you can create varies, depending on the type of access 

point being configured. For example, SR500 devices support a maximum of four 

SSIDs.

STEP 3 To modify a configuration, select the WLAN, click Modify, and use the Modify 

WLAN window. See Create or Modify WLAN SSID, page 204.

STEP 4 To delete a configuration, select the WLAN, and click Delete.

STEP 5 To shut down the wireless interface for Cisco UC500 and SR500, uncheck the 

Enable Wireless Interface option. You can still create and modify SSIDs while the 

interface is shut down. The wireless interface is enabled by default.

Encryption Wireless encryption type: 

• None (not recommended)

• WEP

• Dynamic WEP

• TKIP

• AES CCMP

Authentication One or more of these authentication types: 

• open authentication

• open authentication with EAP

• network EAP

• WPA-PSK

Setting Description
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STEP 6 To apply your changes and to close the window, click OK.

RADIUS Servers

From this tab, you can

• Configure a local RADIUS server for wireless clients, add WLAN users, and 

configure user passwords,

or

• Enable and configure an external RADIUS server for accounting and 

authentication of wireless clients

Remote Authentication Dial-In User Service (RADIUS) server configuration options 

are only available if the UC500 has a built-in access point or the customer site has 

a wireless LAN controller.

Configure RADIUS server settings as described in this table, then click Apply or 

OK.

Column Description

Hostname Choose a hostname from the drop-down list.

External RADIUS Server

Enable External 

RADIUS Server

When this option is checked, enables configuration of 

an external RADIUS server for authentication of 

wireless clients.

IP Address IP address of the external RADIUS server.

Secret Key Shared secret key that the WLAN controller or access 

point uses to communicate with the external RADIUS 

server.

Authentication Port RADIUS server authentication port number. The 

default is 1812.

Accounting Port RADIUS server accounting port number. The default 

is 1813.
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Access Point Settings

Configure Access Point settings as described in this table, then click OK or Apply.

Local RADIUS Server

Enable Local RADIUS 

Server

When this option is checked, enables configuration of 

a local RADIUS server for authentication of wireless 

clients.

Secret Key Shared secret key that the WLAN controller or access 

point uses to communicate with the local RADIUS 

server.

Users Username and password for each client allowed to 

authenticate by using the local RADIUS server.

Click Add to insert a new row in the table and enter a 

username and password.

MAC Addresses The MAC addresses of the clients allowed to 

authenticate by using the local RADIUS server.

Click Add to insert a new row in the table and enter 

the MAC address in the format xxxx.xxxx.xxxx.xxxx. 

For example: 105b.aaab.99ac.0056

Parameter Description

Channel Settings

The available selection of radio channels is determined by your regulatory 

domain.

Channel Select the radio channel to use for this access point. When 

Least Congested Frequency is selected for the channel 

setting, the device scans for the radio channel that is the 

least busy and selects that channel for use.

The device scans at power-up and when the radio settings 

are changed.

You can also select specific channel settings from the 

Channel drop-down menu.

Column Description
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World Mode Settings

Enable World Mode

You can configure the wireless device to support world mode. When you 

enable world mode, the wireless device adds channel carrier set information to 

its beacon. Client devices with world mode enabled receive the carrier set 

information and adjust their settings automatically. For example, a client device 

used primarily in Japan could rely on world mode to adjust its channel and 

power settings automatically when it travels to Italy and joins a network there.

Country Choose the primary country for this access point.

Placement Choose indoor, outdoor, or both to indicate the placement of 

the access point.

Power Level 

Power Level settings determine the power level of the radio transmission.

The default power setting is the highest transmit power allowed in your 

regulatory domain. Government regulations define the highest allowable power 

level for radio devices. This setting must conform to established standards for 

the country in which you use the device. To reduce interference, limit the range 

of your access point; to conserve power, select a lower power setting.

For a 802.11g radio, the Transmit Power setting is divided into CCK Transmitter 

Power (dBm) and OFDM Transmitter Power (dBm). The power settings may be 

in mW or in dBm, depending on the particular radio that is being configured. The 

Power Translation Table (see Power Translation Table, page 204) translates 

both mW and dBm.

CCK 

Transmitter 

Power (dBm)

CCK is the modulation used in 802.11g for the lower 

frequency rates. In most cases you can select the Maximum; 

available selections range from 3 dBm to 17 dBm.

OFDM 

Transmitter 

Power (dBm)

OFDM is the modulation used in 802.11g for higher data 

rates (above 20 Mbps). In most cases, you can select the 

Maximum; available selections range from 3 dBm to 17 dBm.

Parameter Description
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Power Translation Table

Create or Modify WLAN SSID

This window appears when you click Create or Modify n the WLAN (SSIDs) 

window. Use the window to create a new SSID and to specify security settings for 

wireless access.

WLAN SSID settings vary, depending on the type of access point you are 

configuring:

• Create or Modify SSIDs for Cisco AP541N Access Points

• Create or Modify SSIDs for Cisco AP521 or UC500 Built-in Access 

Points

Client Power 

(dBm)

Client Power determines the maximum power level allowed 

on client devices that associate to the access point.

When a client device associates to the access point, the 

access point sends the maximum power level setting to the 

client. In most cases you can select the Maximum; available 

selections range from 3 dBm to 17 dBm.

Antenna Settings (UC520 and UC540 Wireless SKUs only)

You should only modify these antenna settings if instructed by Cisco Support. 

The UC520 and UC540 wireless SKUs only have one antenna.

Receive 

Antenna

For UC520 and UC540 wireless SKUs, the Receive Antenna 

must be set to Primary.

Transmit 

Antenna

For UC520 and UC540 wireless SKUs, the Transmit Antenna 

must be set to Primary.

Parameter Description

Approximate Translation Between mW and dBm

dBm -1 2 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

mW 1 2 3 4 5 6 8 10 12 15 20 25 30 40 50 60 80 100 125 150 200 250
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Create or Modify SSIDs for Cisco AP541N Access Points

To create a new SSID for a Cisco AP541N access point, follow these steps.

STEP 1 Configure basic SSID settings for the AP541N as described in the following table.

STEP 2 In the Security Settings section of the window, choose the type of security to use 

for this SSID and configure additional settings required for that type of security.

Settings vary, depending on the selected security type. For detailed information 

about each security type and its associated settings, see Wireless Security 

Options for AP541N Devices, page 207.

STEP 3 Choose the MAC authentication Type.

Setting Description

SSID In the SSID field, enter an SSID. The SSID can contain up to 32 

alphanumeric characters. The double quote (“) character is not 

allowed.

Broadcast 

SSID

Specify whether to allow the AP541N to broadcast the Service 

Set Identifier (SSID). Broadcast SSID is disabled by default. When 

SSID Broadcast is disabled, the network name is not displayed in 

the list of available networks on a client. Instead, the client must 

have the exact network name configured before it is able to 

connect.

Disabling the broadcast SSID is sufficient to prevent clients from 

accidentally connecting to your network, but it does not prevent 

even the simplest of attempts by a hacker to connect or monitor 

unencrypted traffic. Suppressing the SSID broadcast offers a very 

minimal level of protection on an otherwise exposed network 

(such as a guest network) where the priority is making it easy for 

clients to connect and where no sensitive information is available.

VLAN Enter the VLAN ID to associated with this SSID. Valid values range 

from 1 to 4094.

The default VLAN for voice traffic is VLAN100, and the default 

VLAN for data traffic is VLAN1.

CCA does not check to make sure that the VLAN exists on the 

network, so you must be sure to enter a valid VLAN ID in this field.
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STEP 4 Click Apply or OK.

Create or Modify SSIDs for Cisco AP521 or UC500 Built-in Access Points

To create or modify SSIDs for Cisco AP521 access points and UC500 built-in 

access points, follow these steps:

STEP 1 In the SSID field, enter an SSID. The SSID can contain up to 32 alphanumeric 

characters.

STEP 2 Check Broadcast in Beacon if you want to broadcast the SSID so that the devices 

that do not specify an SSID can associate (establish a wireless connection) with 

the autonomous access point. Only one SSID can be included in beacon (the guest 

SSID).

STEP 3 In the VLAN field, enter or choose the VLAN ID that you want to associate with the 

SSID.

If you assign a VLAN to any SSID, you must assign a VLAN to every SSID. You 

cannot have some SSIDs assigned to VLANs and others assigned to none.

STEP 4 Check the Native VLAN box if you want this VLAN to be the native VLAN.

STEP 5 In the Security Settings area, select the security setting from the Security list. The 

remaining options in this window depend upon what you choose. 

Setting Description

Disabled Do not use MAC authentication.

Local Use the MAC Authentication list that you configure on the MAC 

Authentication tab in the Wireless (SSIDs) tab. See MAC 

Authentication, page 197.

Radius Use the MAC Authentication list specified on the external RADIUS 

server.
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You can select No Security, WEP , EAP, WPA, WPA-PSK, WPA2, WPA2-PSK, 

MAC, or MAC & EAP.

See Wireless Security Options for UC500W and AP521 Devices, page 211 for 

a description of each of these settings.

Configuration Assistant automatically selects the encryption and authentication 

type depending on the security setting that you select.

STEP 6 Click OK to save your changes and to close the window.

Wireless Security Options for AP541N Devices

This section describes wireless security options and related settings for AP541N 

access points.

None

If you select None as your security mode, no additional security settings are 

required. Data transferred to and from the access point is not encrypted and no 

authentication is performed. This mode can be useful during initial network 

configuration or troubleshooting, but it is not recommended for regular use on the 

internal network because it is not secure.

Static WEP

The Static WEP security setting requires that the autonomous access point and 

the client device (device that connects to the wireless device such as a laptop or 

PC) share the same WEP key to keep the communication private.

Static WEP is not the most secure mode available, but it offers more protection 

than setting the security mode to None (Plain-text).

If you choose Static WEP, configure these additional settings.

Setting Description

Encryption Ready-only. AES encryption is used.

Authentication Read-only. Network-EAP authentication is used.

Key Length Choose either 64-bits or 128-bits for the encryption key 

length.
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Dynamic WEP

Dynamic WEP provides dynamically-generated keys that are periodically 

refreshed.

This mode requires the use of an external RADIUS server to authenticate users. 

The AP requires a RADIUS server capable of EAP, such as the Microsoft Internet 

Authentication Server. To work with Windows clients, the authentication server 

must support Protected EAP (PEAP) and MSCHAP V2.

If you choose Dynamic WEP for security, configure these additional settings.

Key Type Choose either ASCII or HEX (hexadecimal).

Key You can specify up to four WEP keys. For each key, enter a 

string of characters. Use the same number of characters for 

each key. These are the WEP keys shared with the stations 

using the AP. The keys you enter depend on the Key Type 

selected.

ASCII. Includes upper and lower case alphabetic letters, the 

numeric digits, and special symbols such as @ and #.

Hex. Includes digits 0 to 9 and the letters A to F.

The number of characters you enter in the Key fields is 

determined by the Key Length and Key Type you select. For 

example, if you use 128-bit ASCII keys, the WEP key must 

have 13 characters.

Setting Description

Encryption Read-only. AES encryption is used.

Authentication Read-only. Network-EAP authentication is used.

Active Server Displays which RADIUS server is currently in use. You can 

manually update the server by selecting a different server 

from the drop-down list.

NOTE The Active Server is not stored across restarts. The 
first configured RADIUS server is selected upon restart.

Setting Description
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WPA Personal

WPA Personal is a Wi-Fi Alliance IEEE 802.11i standard that includes AES-CCMP 

and TKIP encryption. The Personal version of WPA employs a pre-shared key 

(instead of using IEEE 802.1X) and EAP as is used in the Enterprise WPA security 

mode). The pre-shared key (PSK) is used for an initial check of credentials only.

This security mode is backwards-compatible for wireless clients that support the 

original WPA.

If you choose WPA Personal, configure these additional settings.

Broadcast Key 

Refresh Rate

Enter a value to set the interval at which the broadcast (group) 

key is refreshed for clients associated to this SSID. 

Valid values range from 1 to 86400 seconds. A value of 0 

indicates that the broadcast key is not refreshed.

Session Key 

Refresh Rate

Enter a value to set the interval at which the AP will refresh 

session (unicast) keys for each client associated with this 

SSID.

The valid range is from 0 to 86400 seconds. A value of 0 

indicates that the broadcast key is not refreshed. 

Setting Description

Encryption Read-only. TKIP, AES-CCM P is used.

Authentication Read-only. Open-EAP, Network-EAP authentication is used.

Key Enter the pre-shared secret key for WPA Personal security. 

The key can contain from 8 to 63 characters. Acceptable 

characters include upper and lower case alphabetic letters, 

digits 0 through 9, and special symbols such as @ and #.

Broadcast Key 

Refresh Rate

Enter a value from 0 to 86400 seconds to set the interval at 

which the broadcast (group) key is refreshed for associated 

clients. A value of 0 indicates that the broadcast key is not 

refreshed. 

Setting Description
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WPA Enterprise

WPA Enterprise with RADIUS is an implementation of the Wi-Fi Alliance IEEE 

802.11i standard, which includes CCMP (AES), and TKIP mechanisms. The WPA 

Enterprise mode requires the use of a RADIUS server to authenticate users.

This security mode is backwards-compatible with wireless clients that support 

the original WPA.

If you choose WPA Enterprise, configure these additional settings.

Setting Description

Encryption Read-only. Both TKIP and AES-CCMP are selected.

When both TKIP and CCMP are selected, clients configured to 

use WPA with RADIUS must have one of the following:

• A valid TKIP RADIUS IP address and RADIUS key

• A valid CCM (AES) IP address and RADIUS key

Active Server Displays which RADIUS server is currently in use. You can 

manually update the server by selecting a different server 

from the drop-down list.

NOTE: The Active Server is not stored across restarts. The 

first configured RADIUS server is selected upon restart.

Broadcast Key 

Refresh Rate

Enter a value to set the interval at which the broadcast (group) 

key is refreshed for clients associated to this AP.

Valid values range from 1 to 86400 seconds. A value of 0 

indicates that the broadcast key is not refreshed. 

Session Key 

Refresh Rate

Enter a value to set the interval at which the AP will refresh 

session (unicast) keys for each associated client.

The valid range is from 0 to 86400 seconds. A value of 0 

indicates that the broadcast key is not refreshed. 
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Wireless Security Options for UC500W and AP521 Devices

This section describes wireless security options and related settings for AP521 

access points and UC500 platforms that have an embedded access point.

No Security

This is the least secure option. Select it only for an SSID that is used in a public 

place (guest SSID) and associate it with a VLAN that restricts access to your 

network. There is no encryption, and the authentication type is open 

authentication.

WEP 

This security setting requires that the autonomous access point and the client 

device (device that connects to the wireless device such as a laptop or a PC) 

share the same WEP key to keep the communication private. The encryption type 

is WEP, and the authentication type is open authentication.

To set this kind of security:

STEP 1 Enter a passphrase in the Passphrase field, and select the bit encryption from the 

list.

STEP 2 Click Generate. The key field located next to the Key list is automatically filled in. 

You can change the key number by selecting either 1, 2, 3, or 4 in the Key list. The 

default key number is 1.

EAP

This security setting enables IEEE 802.1X authentication and requires you to enter 

the IP address and shared secret for a RADIUS server. The encryption type is 

dynamic WEP, and the authentication type is open authentication with EAP.

If you select the EAP security type, wireless clients must use EAP settings (for 

example, EAP-TLS, EAP-FAST, or PEAP).

To set this kind of security:

STEP 1 Enter the IP address of the RADIUS server.

STEP 2 Enter the shared secret that the autonomous access point will use to communicate 

with the RADIUS server.
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WPA

This security setting is more secure than the EAP setting. It enables WPA 

authentication and requires you to enter the IP address and shared secret for a 

RADIUS server. Client devices that associate to the autonomous access point by 

using this SSID must be WPA-capable. The encryption type is TKIP, and the 

authentication types are open authentication with EAP and network EAP.

Configuration Assistant enables both Open authentication with EAP and 

Network EAP authentication to allow both Cisco client devices and non-Cisco 

client devices to associate with the autonomous access point by using the same 

SSID to perform IEEE 802.1x authentication.

To set this kind of security:

STEP 1 Enter the IP address of the RADIUS server.

STEP 2 Enter the shared secret that the autonomous access point will use to communicate 

with the RADIUS server.

WPA-PSK

Select this security setting when you want to use the WPA encryption and you do 

not have access to a RADIUS server. The autonomous access point and the client 

must device share the same WPA-PSK. The key can be from 8 to 63 characters 

long. The encryption type is TKIP, and the authentication type  is WPA-PSK.

To set this kind of security, enter a key in the WPA Preshared Key field.

WPA2

This security setting is more secure than the WPA setting. It enables WPA2 

authentication and requires you to enter the IP address and shared secret for a 

RADIUS server. Client devices that associate to the autonomous access point by 

using this SSID must be WPA2-capable. The encryption type is AES CCMP, and 

the authentication types are open authentication with EAP and network EAP.

Configuration Assistant enables both Open authentication with EAP and 

Network EAP authentication to allow both Cisco client devices and non-Cisco 

client devices to associate with the autonomous access point by using the same 

SSID to perform IEEE 802.1x authentication.
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To set this kind of security:

STEP 1 Enter the IP address of the RADIUS server.

STEP 2 Enter the shared secret that the autonomous access point will use to communicate 

with the RADIUS server.

WPA2-PSK

Select this security setting when you want to use the WPA2 encryption and you do 

not have access to a RADIUS server. It requires that the autonomous access point 

and the client device share the same WPA2-PSK. The key can be from 8 to 63 

characters long. The encryption type is AES CCMP, and the authentication type is 

WPA-PSK.

To set this kind of security, enter a key in the WPA2 Preshared Key field.

MAC

Select this security setting when you want to authenticate client devices by using 

MAC-based authentication.

There is no encryption, and the authentication type is Open authentication.

To set this kind of security:

STEP 1 Enter the IP address of the RADIUS server.

STEP 2 Enter the shared secret that the autonomous access point will use to communicate 

with the RADIUS server.

MAC & EAP

Select this security setting when you want to authenticate client devices by using 

a combination of MAC-based and EAP authentication. Client devices that 

associate with the access point by using IEEE 802.11 open authentication first 

attempt MAC authentication. If MAC authentication succeeds, the client device 

joins the network; if the client is also using EAP authentication, it attempts to 

authenticate using EAP. If MAC authentication fails, the access point waits for the 

client device to attempt EAP authentication.

The encryption type is dynamic WEP, and the authentication types are Open 

authentication with EAP and Network EAP.
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Configuration Assistant enables both Open authentication with EAP and 

Network EAP authentication to allow both Cisco client devices and non-Cisco 

client devices to associate with the autonomous access point by using the same 

SSID to perform 802.1x authentication.

To set this kind of security:

STEP 1 Enter the IP address of the RADIUS server.

STEP 2 Enter the shared secret that the autonomous access point will use to communicate 

with the RADIUS server.

Resolve Guest VLAN Window

The Resolve Guest VLAN window appears if a Guest VLAN is already configured 

on an ESW500 Series switch and you open the WLAN (SSIDs) window with the 

SR520 selected as the host.

Click Resolve to create the Guest VLAN on the SR520. Click Cancel if you do not 

want CCA to create the Guest VLAN on the SR520.

Convert to LAP (Lightweight Access Point)

This window appears when you choose Configure > Wireless > Convert to LAP 

on the feature bar.

You can convert an autonomous access point to a lightweight access point. A 

lightweight access point associates to a wireless LAN controller. The controller 

manages the configuration, firmware, and control transactions such as 802.1x 

authentications. In addition, all wireless data traffic is tunneled through the 

controller.

To convert an autonomous access points to a lightweight access point, choose 

and use the Convert to LAP window See Convert to LAP (Lightweight Access 

Point), page 214). You can select multiple autonomous access points and convert 

them at the same time.

Conversion from LAP access points to autonomous AP is not supported by CCA. 

CCA will not be able to manage LAP access points converted to autonomous 

mode using the Cisco IOS command-line interface (CLI).

This table explains the settings in the Convert to LAP window.
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Follow these steps to convert autonomous access points to lightweight access 

points: 

STEP 1 Download the Cisco IOS tar files that you want to use to convert the autonomous 

access point.

STEP 2 Select one or more autonomous access points.

STEP 3 Click Conversion Settings.

STEP 4 Complete the Conversion Settings window, and click OK to save your entries. See 

Conversion Settings, page 216.

STEP 5 Check the Convert box beside each device that you want to convert now.

STEP 6 Click Convert to start the conversion process.

The current image is deleted, and the new image is downloaded. You can save the 

old image by using the command-line interface (CLI).

STEP 7 Click Status to display the Conversion Status window. This window displays the 

progress of the conversion. See Conversion Status, page 217.

Setting Explanation

Device Displays device icons and hostnames.

Convert Shows whether the device is selected for a Conversion.

Device Type Displays the device type.

Current 

Version

Displays the current Cisco IOS version.

Recovery 

Image Name

Displays the name of the Cisco IOS tar file that you provided in 

the Conversion Settings window. Only the filename appears, 

not the path.

Conversion 

Status

Displays the conversion status and progress messages. See 

the Conversion Status window for details.

IP Address Displays the IP address setting that you provided in the 

Conversion Settings window, either static or DHCP.

Hostname Displays the hostname setting that you provided in the 

Conversion Settings window, either Retain or Do Not Retain.
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When the conversion process is completed, a confirmation dialog pops up. The 

status messages list which access points converted successfully and which 

access points did not.

STEP 8 All configuration changes are automatically saved to flash memory. After 1 minute, 

the devices are reloaded, and the new image starts running. You can then close 

the Convert to LAP window.

You lose connectivity to a device when you reload it.

Conversion Settings

This window appears when you select one or more autonomous access points in 

the Convert to LAP window and click Conversion Settings.

Select DHCP IP Address if you want the WLAN controller to assign a new IP 

address to the lightweight access point after the conversion.

Select Retain Hostname if you want to retain the same hostname for the 

lightweight access point after the conversion.

From the Mode list, select Standard to use a conversion image that is stored 

locally; otherwise, select Remote TFTP Server.

If you selected Standard, enter the filename of the conversion image in the 

Conversion Image field. You can click Browse to find the file.

If you selected Remote TFTP Server:

STEP 1 In the Conversion Image field, enter the full path and filename of the conversion 

image.

STEP 2 In the TFTP Server IP Address field, enter the IP address of your TFTP server.

To perform group conversions, your TFTP server must handle multiple requests 

and sessions simultaneously.

STEP 3 In the Domain Name field, enter the domain name.

STEP 4 In the DNS IP Address field, enter the DNS address.

STEP 5 Click OK to save your settings. They appear in the Convert to LAP window.
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Conversion Status

This window appears when you select one or more autonomous access points in 

the Convert to LAP window and click Status. The window shows detailed 

messages as they are generated from the autonomous access point during a 

conversion.

This table explains conversion status messages.

Message Explanation

Click the Conversion 

Settings button to 

continue.

The Conversion Settings window needs to be 

completed before the device can be converted.

Click the Convert button 

to upgrade the device.

All the parameters are set for the device to be 

converted.

Determining the total 

flash size.

The conversion process checks whether there is 

enough space available to convert the device.

Extracting the info file 

from the tar image file.

The Cisco IOS image tar file is extracting the info file. 

Reading the info file of 

the tar image file.

Configuration Assistant reads the info file of the 

Cisco IOS image tar file for details about the Cisco 

IOS image.

Reload started for the 

device.

The device is reloading after a successful 

conversion. Even after the reload is completed, this 

message appears until you refresh the window.

Device conversion was 

successful.

The conversion completed successfully.

Device conversion 

failed.

The conversion failed. See the Details window for 

more information.

Device conversion in 

progress.

The conversion for the devices is in process.

Device conversion 

canceled.

The conversion was canceled.

Uploading the image. The image is being uploaded to the device.
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If there is insufficient space on the device to install the new image, a message with 

a link to the File Management window appears. You can use the File Management 

window to manage your file systems, and, if necessary, to delete old images to 

make space for new images.

Click OK when you are done with the window.

Wireless LAN Controller Configuration

The topics in this section cover configuration settings for WLAN controllers:

• Configuring Wireless Interfaces for a WLAN Controller, page 218

• Viewing Wireless Client Status for a WLAN Controller, page 221

• Configuring WLAN Users, page 222

• DHCP Proxy, page 227

• Wireless Controller Dashboard, page 228

• Configure RADIUS Server Settings for WLAN Controllers, page 230

Configuring Wireless Interfaces for a WLAN Controller

If your system includes a Wireless LAN controller, choose Configure > Wireless 

Interfaces from the feature bar.

Overview

You can configure dynamic wireless interfaces on a WLAN controller. Dynamic 

wireless interfaces are analogous to VLANs for wireless LAN clients. A controller 

can support up to eight dynamic interfaces (VLANs).

A wireless interface has multiple parameters associated with it, including VLAN 

identifier, port, IP address, subnet mask, default gateway (for the IP subnet), and 

DHCP server.

Use this window to view all wireless interface settings on the WLAN controller and 

to configure dynamic (user-defined) wireless interfaces on the WLAN controller.

Verifying the IOS image. The device is verifying the image.

Message Explanation
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Procedures

This table explains the columns in the Wireless Interfaces window.

Follow these steps to configure a dynamic wireless interface on the WLAN 

controller:

STEP 1 From the Hostname list, select the WLAN controller.

STEP 2 To create an interface, click Create, and complete the Create Interface window. 

See Create Interface, page 219.

A controller can support up to eight dynamic interfaces.

To modify a configuration, select the wireless interface name, click Modify, and 

use the Modify Interface window.

To delete a configuration, select the wireless interface name, and click Delete.

NOTE: You can modify and delete only dynamic interfaces. You cannot modify or 

delete static interfaces.

To save your changes and to close the window, click OK in the Wireless Interfaces 

window.

Create Interface

This window appears when you click Create in the Wireless Interfaces window. 

Use the window to create a wireless interface.

Column Explanation 

Name The wireless interface name, including dynamic interfaces and 

static interfaces (management, ap-manager, and virtual)

VLAN The VLAN associated with the wireless interface

Port The physical port number for the wireless interface

IP Address The IP address of the wireless interface
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STEP 1 In the Interface name field, enter a name for the wireless interface.

STEP 2 In the VLAN ID field, enter the VLAN ID that you want to associate with the 

wireless interface.

STEP 3 From the Port list, select a port for the wireless interface.

STEP 4 In the IP Address field, enter an IP address for the wireless interface.

STEP 5 From the Subnet Mask list, select the subnet mask for the wireless interface.

STEP 6 In the Gateway IP Address field, enter the IP address of the default gateway.

STEP 7 In the DHCP Server IP Address field, enter the IP address of the DHCP server.

STEP 8 When you complete this window, click OK to save your changes and to close the 

window.

Modify Interfaces 

This window appears when you click Modify in the Wireless Interfaces window. 

Use the window to modify the settings for a wireless interface.

Follow these steps:

STEP 1 In the VLAN ID field, enter the VLAN ID that you want to associate with the 

wireless interface.

STEP 2 From the Port list, select a port for the wireless interface.

STEP 3 In the IP Address field, enter an IP address for the wireless interface.

STEP 4 From the Subnet Mask list, select the subnet mask for the wireless interface.

STEP 5 In the Gateway IP Address field, enter the IP address of the default gateway.

STEP 6 In the DHCP Server IP Address field, enter the IP address of the DHCP server. 

STEP 7 When you complete this window, click OK to save your changes and to close the 

window.
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Viewing Wireless Client Status for a WLAN Controller

To display the status of wireless clients on the WLAN controller use the Wireless 

Clients window.

This table explains the information that you see under the columns in this window.

To close the window, click OK.

Column Explanation 

MAC Address The MAC address of the client.

Status The status of the client connection: 

• Idle

• Pending

• Authenticated

• Associated

• Active

• Power Save

• Disassociated

• Exclude

• Probing

AP Name The name of the client's lightweight access point

SSID The SSID of the client

Radio The type of client:

• 802.11a

• 802.11 b

• 802.11g

Authenticated The authentication status of the client (yes or no)



Wireless
Wireless LAN Controller Configuration

222 Cisco Configuration Assistant SBCS Administrator Guide

7

Configuring WLAN Users

You can configure wireless users on the WLAN controller. You can also configure 

authentication and Web login settings.

Wireless users can be guests or not (for example, employees).

Guest users have access to the Internet and the guests' own network without 

compromising your network's security. Guest user access is configured with an 

expiration date.

Users who are not guests have secure access to the network. There is no 

expiration date for this type of user access.

Use this window to configure wireless users on the WLAN controller or to view 

wireless user settings that you configured on the WLAN controller.

This table explains the columns in the Wireless Network Users area.

Follow these steps to configure wireless users for the WLAN controller: 

STEP 1 From the Hostname list, select the WLAN controller.

STEP 2 To create a guest or non-guest user, click Create, and complete the Create WLAN 

User window. See Create WLAN Users, page 223.

STEP 3 To save your changes and to close the window, click OK in the WLAN Users 

window.

To modify a wireless user, select the user name, click Modify, and use the Modify 

WLAN User window.

To delete a wireless user, select the user name, and click Delete.

Column Explanation 

Username The name of the wireless user. 

Guest User The guest user status (yes or no). 

SSID The SSID name.

End Time The expiry date of the guest user's access. 

Description The description of the wireless user. 
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Guest Users are deleted automatically from the Wireless Network Users list when 

you open the WLAN Users Window and the Guest User end time has expired. If 

the WLAN Users Window is already open when the Guest User end time expires 

and you attempt to modify the Guest User, the Guest User will be deleted from the 

Wireless Network Users list. Click Create to create a new Guest User.

To configure a login page for wireless users, click Configure in the Web Login 

area. See Web Login, page 226.

Create WLAN Users

This window appears when you click Create in the WLAN Users window. Use the 

window to create a new wireless user.

Overview

You can configure wireless users on the WLAN controller. You can also configure 

authentication and Web login settings.

Wireless users can be guests or not (for example, employees).

Guest users have access to the Internet and the guests' own network without 

compromising your network's security. Guest user access is configured with an 

expiration date.

Users who are not guests have secure access to the network. There is no 

expiration date for this type of user access.

Procedures

Follow these steps:

STEP 1 In the Username field, enter a name for the wireless user. You can enter up to 24 

alphanumeric characters.

STEP 2 In the Password field, enter a password for the wireless user. You can enter up to 

24 alphanumeric characters.

STEP 3 In the Confirm Password field, re-enter the password.

STEP 4 In the Description field, enter a description for the wireless user.

STEP 5 If the wireless user is not a guest user, follow these steps:

a. Uncheck the Guest User checkbox.

b. Select an SSID from the SSID list. Only SSIDs that are set with Web-Auth, WEP, 

WPA1-PSK, or WPA2-PSK security appear.
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If you need to create an SSID, click Add SSID (Pre-defined) to open the Add SSID 

(Pre-defined) window. See Add SSID, page 225

STEP 6 If the wireless user is a guest user, follow these steps:

a. Check the Guest User checkbox.

b. Select an SSID from the SSID list. Only SSIDs that are set with Web-Auth 

security appear.

If you need to create an SSID, click Add SSID (Pre-defined) to open the Add SSID 

(Pre-defined) window. See Add SSID, page 225.

STEP 7 In the End Time area, enter the expiry date by selecting the year, month, day, hour, 

and minute. The maximum expiry date for a guest user is 30 days from the current 

date.

When you complete this window, click OK to save your changes and to close the 

window.

Modify WLAN Users

This window appears when you click Modify in the WLAN Users window. Use the 

window to modify the wireless user settings.

Follow these steps:

STEP 1 In the Password field, enter a password for the wireless user. You can enter up to 

24 alphanumeric characters.

STEP 2 In the Confirm Password field, re-enter the password.

STEP 3 In the Description field, enter a description for the wireless user. 

STEP 4 From the SSID list, select an SSID.

STEP 5 If the wireless user is a guest user, modify the expiry date in the End Time area by 

selecting the year, month, day, hour, and minute. The maximum expiry date for a 

guest user is 30 days from the current date.

STEP 6 When you complete this window, click OK to save your changes and to close the 

window.
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Add SSID

This window appears when you click Add SSID in the SSID area of the Create 

WLAN User window. Use it to apply the predefined SSID settings on the WLAN 

controller.

Configuration Assistant configures the corresponding VLAN and SSID with the 

stated security type. After you have applied the predefined SSID settings to the 

WLAN controller, you can modify or delete the corresponding WLAN from the 

WLAN (SSIDs) window. You can also modify or delete the corresponding VLAN 

from the VLANs window.

Follow these steps to add an SSID: 

STEP 1 Select a wireless network type from the WLAN Selection area. The choices are: 

• Employee Data (using Web-Auth and WPA1-PSK)

• Employee Voice (using Web-Auth and WPA2-PSK)

If you are configuring a guest user, the Guest (using Web-Auth) option is selected.

STEP 2 Depending on the WLAN selection, enter this information:

• VLAN ID (2-1000)—Enter the ID of the VLAN.

• VLAN Name—For Data networks, accept the predefined name, or enter a 

different name for the VLAN. For Voice or Guest networks, this field is set 

with a predefined VLAN name that is based on your WLAN selection. 

• IP Address—Enter an IP address for the VLAN.

• Subnet Mask—Select the subnet mask for the VLAN.

• Gateway IP Address—Enter the IP address of the default gateway.

• DHCP Server IP Address—Enter the IP address of the DHCP server.

• SSID—Accept the default SSID (based on the company name and your 

WLAN selection), or enter a different SSID of up to 32 alphanumeric 

characters.

• WPA1 Pre-Shared Key (for data networks) or WPA2 Pre-Shared Key (for 

voice networks)—Enter a key from 8 to 63 characters long.

STEP 3 When you complete this window, click OK to save your changes and to close the 

window.
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Web Login

This window appears when you click Configure in the Web Login area of the 

WLAN Users window. Use it to customize the content and appearance of the Web 

login page for WLAN users.

Overview

The login page is presented to web users the first time that they access a WLAN 

with web authentication enabled. Cisco provides a default web login page that 

can be modified with any text-based HTML editor. However, the Username and 

Password fields should not be changed, and the Submit method should be 

retained. After the customized web login page is created, it must be made into a 

tar file containing the page code and any images desired.

Procedures

Follow these steps to configure the login page.

STEP 1 From the Hostname list, select the WLAN controller.

STEP 2 From the Web Authentication area, select Internal or Customized.

STEP 3 If you select Internal, follow these steps:

a. From the Cisco Logo area, select Show to display the Cisco logo on the login 

page, or select Hide to hide the logo. The default selection is Show.

b. In the Redirect URL After Login field, enter a URL to which the user will be 

directed after logging in. Enter the URL by using the www.companyname.com 

format with up to 254 characters.

c. In the Headline field, enter the login page headline or summary, up to 127 

characters. The default headline is “Welcome to the Cisco wireless network.”

d. In the Message field, enter message text, up to 2047 characters. The default 

message is “Cisco is pleased to provide the wireless LAN infrastructure for 

your network. Please login and put your air space to work.”

Click Set Default to use the default settings.

STEP 4 If you select Customized, follow these steps:

a. In the TFTP Server IP Address field, enter the IP address of the TFTP server on 

which the customized web authentication bundle file exists.
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The TFTP server cannot run on the same computer as the Cisco WCS, because 

the Cisco WCS and the TFTP server use the same communication port.

b. In the Maximum Retries field, enter the number of attempts that the WLAN 

controller tries to load the web authentication file from the TFTP server on a 

failure. The default value is 3.

c. In the Timeout (seconds) field, enter the timeout period (in seconds). If the 

WLAN controller is not able to start downloading the file within this time period, 

loading does not occur.

d. In the File Path field, enter the path of the web authentication file on the TFTP 

server. The default value is a slash (/).

e. In the File Name field, enter the name of the file to be transferred.

f. Click Download to download the customized login file.

STEP 5 When you click OK or Apply, the download starts and the customized login file is 

applied to the device.

DHCP Proxy

To configure a DHCP proxy, choose Configure > DHCP Proxy from the feature 

bar.

A DHCP proxy helps wireless clients get an IP address from the DHCP server. The 

WLAN controller receives the DHCP discover request from the wireless client and 

sends the request to the DHCP server on behalf of the wireless client. When you 

enable the DHCP proxy, the WLAN controller works between the wireless client 

and the DHCP server until the wireless client receives an IP address.

You can enable DHCP Proxy if you configured a DHCP server address on all user-

defined VLANs for this device.

To enable DHCP proxy, follow these steps.

STEP 1 Select a device to be configured from the Hostname list.

STEP 2 Check the Enable DHCP Proxy box.

STEP 3 Click OK to save your changes and to close the window.
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Wireless Controller Dashboard

If you want information for all of the WLAN controllers in the community—for 

example, the status of the WLAN controller system, the status of the 802.11b/g 

radios, the number of clients that are associated with an SSID—choose to open 

the Wireless Controller Dashboard. It displays a broad range of WLAN controller 

information, such as:

• System summary

• Access point details and statistics

• WLAN controller statistics

It displays a broad range of WLAN controller statistics on its tabs: System, AP 

Summary, WLANs, WLC Statistics, and AP Statistics. To refresh the statistics, click 

Refresh.

This table explains the data of the System section.

This table explains the data of the AP Summary section.

Column Explanation 

Controller Name The controller names.

Up Time The amount of time that has elapsed since the WLAN 

controller was last rebooted.

Temperature The internal chassis temperature. 

CPU The total CPU use of the WLAN controller. 

Memory The total memory use of the WLAN controller. 

Column Explanation 

Controller Name The controller names. 

802.11b/g Radios The status of the radios (Up and Down). 

AP Status The status of the access points (Up and Down). 
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This table explains the data of the WLANs section.

This table explains the data of the WLC Statistics section. You can choose to 

display the data in total numbers or in percentages.

This table explains the data of the AP Statistics section.

Column Explanation 

WLAN Name 

(Controller Name)

The SSID names of the controllers. 

Clients The number of clients that are associated with this SSID. 

Column Explanation 

Controller Name The controller names.

Packets received 

without error

The total number or the percentage of packets received.

Receive Packets 

Discarded

The total number or the percentage of received packets 

discarded.

Packets 

transmitted 

without error

The total number or the percentage of packets sent.

Transmit Packets 

Discarded

The total number or the percentage of sent packets 

discarded.

Column Explanation 

AP Name 

(Controller Name)

The associated access points with the WLAN controllers.

Transmit Frame 

Count

The total number of sent frames.

Transmit Failed 

Count

The total number of frames that failed to be sent.
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Configure RADIUS Server Settings for WLAN Controllers

The Configure RADIUS Servers window appears when you click Configure in the 

RADIUS Servers area of the WLANs (SSIDs) window for a WLAN controller.

From this window, you can view RADIUS server settings for the WLAN controller 

and configure up to two RADIUS servers for the WLAN controller. This table 

explains the columns in this window.

To configure RADIUS servers for the WLAN controller, follow these steps.

STEP 1 From the Hostname list, select the WLAN controller.

STEP 2 Click Create and complete the settings in the Create RADIUS Server window. See 

Create RADIUS Server Window.

To change the RADIUS server status, select the IP address of the RADIUS server, 

click Modify and complete the settings in the Modify RADIUS Server Window. 

See Modify RADIUS Server Window.

To delete a configured RADIUS server, select the IP address of the RADIUS server, 

and click Delete.

To save your changes and to close the window, click OK in the RADIUS Server 

window.

Setting Description

IP Address IP address of the RADIUS server.

Auth Port RADIUS authentication port number.

Priority The priority of the RADIUS server. It specifies the order in which 

the servers are used if one of the servers cannot be reached.

Status The status of the RADIUS server, either Enabled or Disabled.
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Create RADIUS Server Window

This window appears when you click Create in the Configure RADIUS Server 

window. Use the window to specify the RADIUS server settings.

Follow these steps.

STEP 1 In the IP Address field, enter an IP address for the RADIUS server.

STEP 2 In the Auth Port field, enter the RADIUS authentication port number. The default 

authentication port number is 1812.

STEP 3 In the Secret Key (ASCII) field, enter the shared secret that the WLAN controller 

will use to communicate with the RADIUS server.

STEP 4 In the Confirm Secret field, re-enter the shared secret.

STEP 5 From the Server Priority Key list, select the server priority.

NOTE: Each RADIUS server must use a different priority number.

STEP 6 From the Admin Status list, select Enabled or Disabled.

STEP 7 Click OK to save your changes and to close the window.

Modify RADIUS Server Window

This window appears when you click Modify in the Configure RADIUS Server 

window. Use the window to change the status of a RADIUS server.

Follow these steps:

STEP 1 From the Admin Status list, select Enabled or Disabled.

STEP 2 Click OK to save your change and to close the window.
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Security Features

This section covers configuration of these basic security features:

• NAT (Network Address Translation)

• VPN Server

• Security Audit

• Firewall and DMZ

• ACL Manager

• Network Security Settings (CE520 Switches)

• SSL VPN

• Intrusion Prevention System (IPS) (SR500 Series)

• URL Filtering (SR500 Series)

NAT (Network Address Translation)

To enable or disable network address translation (NAT), choose Configure > 

Security > NAT from the feature bar.

From this window, you can:

• Enable or disable Network Address Translation (NAT)

• Configure port mapping

• Configure port forwarding

NOTE: The NAT window user interface and configuration settings are different, 

based on how IP addresses are assigned.

For information about NAT features and configuration settings, see the following 

sections:
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• Overview

• NAT Window (IP Addresses Assigned via DHCP)

• NAT Window (Static IP or PPPoE with Static IP)

Overview

When enabled on an interface, Network Address Translation (NAT) maps the 

private IP addresses on your LAN to a public network IP address from a group of 

registered public network IP addresses.

A valid, registered, globally unique, public IP address is required for accessing the 

Internet. An organization usually does not own enough public IP addresses to 

assign a unique public IP address to each client in the organization that needs 

Internet access. Without NAT, your pool of public IP addresses would be depleted. 

The internal structure of your LAN would also be displayed to any client on the 

public network. NAT allows you to use one public IP address to provide Internet 

access to many of the clients on your LAN.

Using Configuration Assistant, you map the single public IP address assigned to 

your WAN interface to multiple private IP addresses.

It is easier for an unauthorized client to attack your network if the client can 

determine the topology of your network by using your network IP addresses. NAT 

hides your private IP addresses from the Internet. If an attacker cannot guess the 

structure of your LAN by using the IP addresses, then it is more difficult to break 

into your network.

In some cases—for example, when you configure a UC500 with an SIP trunk 

behind an SR500 secure router—NAT entries are created automatically by CCA.

NOTE NAT supports only Layer 3 Ethernet interfaces. It does not support Layer 2 

switch port interfaces. When you enable NAT on an (untrusted) outside interface, 

all other qualified interfaces are automatically selected as (trusted) inside 

interfaces.

Static NAT and Dynamic NAT

Static NAT works with the IP addresses statically mapped to each other. That is, 

the administrator can establish a one-to-one mapping between private IP 

addresses and public IP addresses. Static translations are generally used to allow 

access to a particular device through the NAT. For example, if a network has an 
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internal DNS server which needs to communicate with an external DNS server, the 

administrator would configure a static translation to enable such connectivity. The 

NAT thus allows traffic to be passed between these statically known, but 

translated address.

Alternatively, Dynamic NAT maps private IP addresses to public IP addresses. 

Dynamic NAT uses a pool of public addresses and assigns them in a round-robin 

fashion (first-come, first-served basis). When a host with a private IP address 

requests access to the Internet, dynamic NAT chooses an IP address from the pool 

that is not already in use by another host. Dynamic NAT is useful when fewer 

addresses are available than the actual number of hosts to be translated.

NAT Window (IP Addresses Assigned via DHCP)

First, from the Hostname list, choose a device on which you want to enable NAT.

To enable NAT, choose an (untrusted) outside interface from the Outside Interface 

list. Click Details to view information about the selected outside interface.

To create an entry for each port mapping, follow these steps.

STEP 1 To add an entry to the NAT window, click Add.

STEP 2 Choose an application from the Application field pull-down list:

• Web Server

• Secure Web Server

• Email Server

• FTP

• SSH

• SFTP

• Other (TCP)

• Other (UDP)

STEP 3 In the Internal address field, enter an IP address that the server uses on your 

internal network. This is an IP address that cannot be used externally on the 

Internet.
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STEP 4 In the Internal Port field, enter a port number for the inside device, which is the 

port number used by the server to accept service requests from the internal 

network.

STEP 5 In the External Port field, enter a port number that NAT is to use for this translation. 

The port number is used by the server to accept service requests from the 

Internet.

To increase security, by adding a firewall, click Firewall Service and use the 

Firewall window.  See Firewall, page 248 for these settings.

STEP 6 Click Apply or OK.

To delete a port mapping entry, follow these steps.

STEP 1 Choose an entry in the window.

STEP 2 Click Delete.

STEP 3 To close the window and save your changes, click OK.

You can delete NAT settings for a device that is behind another NAT device on a 

fully routed network. For example, when a UC500 is connected behind an SR500 

Series Secure Router, you can delete the NAT settings on the UC500.

To delete the entire NAT configuration, follow these steps.

STEP 1 Click Delete NAT Settings.

If there are entries in the IP table, a window is displayed that warns you that if you 

proceed, you will delete the NAT configuration settings. Click OK to close the 

popup dialog and continue.

STEP 2 In the main NAT window, click OK.

NAT Window (Static IP or PPPoE with Static IP)

IP Static NAT screen controls are enabled only when a static IP or PPPoE with 

static is assigned to the Internet Connection (WAN interface).
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The NAT Pool must be provisioned first before adding entries to the Static NAT 

Mapping table.

• Create NAT Pool

• Static NAT Mapping

Create NAT Pool

IP addresses for the NAT Pool are provided by the Internet Service Provider (ISP). 

Up to 10 NAT pool entries may be added.

Users cannot enter an IP address into the NAT Pool that is used by the WAN 

interface.

Create a NAT Pool Entry

STEP 1 To create a NAT Pool entry click on the Create button that is located next to the 

NAT Pool table. This will launch a new window labeled Create NAT Pool.

STEP 2 Enter a name into the Pool Name field.

STEP 3 Enter the IP Address, or click the Specify Range of Addresses and enter the range 

of IP Addresses.

NOTE: The network address used in the NAT Pool should be in the same subnet 

as that provided for the WAN interface.

STEP 4 Next, click OK.

STEP 5 After provisioning the NAT Pool click Apply, or OK to apply the configuration. This 

will install the NAT Pool and add the IP Addresses as a secondary IP to the WAN 

interface.

Delete NAT Pool Entry

STEP 1 To delete a NAT pool entry from the NAT Pool Table select the desired pool entry, 

then click the Delete button located next to the NAT Pool table.

This will delete all static NAT mappings that use the IP addresses configured for 

that pool.

STEP 2 Next, click Apply or OK.
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NOTE: IP Addresses used in one pool cannot be used in another. In addition, each 

Pool name must be unique.

Static NAT Mapping

The following guidelines apply to creating static NAT mappings:

• Each IP address pair must be unique. If an internal or external IP address 

and port are used in one mapping, then the same IP address cannot be used 

to create another mapping that does not specify a port. For example, if 

internal port 192.168.10.10:80 is mapped to 171.71.236.176:80, you cannot 

also map 192.168.10.10 to 171.71.236.175 or 192.168.10.15 to 

171.71.236.176

• A NAT mapping can consist of an IP address by itself or an IP address with 

a port number. Well-known TCP/UDP port numbers are shown in the 

Internal/External Port field. You can enter a port number if one is not shown. 

• An internal or external IP address and port that is used for one mapping 

cannot be used in mapped to any other IP address or port. For example, if 

internal port 192.168.10.10:80 is mapped to external port 

171.71.236.178:80, you cannot also map 192.168.10.10:80 to 

171.71.236.176:80 or 192.168.10.15:80 to 171.71.236.178:80

• You cannot create a static mapping using the WAN IP address alone, but 

you can create a mapping using the WAN IP address with a port.

STEP 1 To provision Static NAT Mapping click the Create button that is located next to the 

Static NAT Mapping table.

STEP 2 Map the internal and external IP addresses:

a. Enter the desired internal IP address into the Internal IP field.

b. Enter the externally registered IP address into the External IP field.

STEP 3 Click OK. This will return you to the main NAT window.

STEP 4 Click Apply or OK.
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VPN Server

To configure VPN server settings, choose Configure > Security > VPN from the 

feature bar.

!
CAUTION Cisco does not recommend that you configure the VPN server over a remote WAN 

connection. If the connection to the WAN is interrupted, the operation will fail and 

the system may become unusable.

Overview

A Virtual Private Network (VPN) allows a remote client access to the corporate 

network.

VPN is required in these circumstances:

• You need access to the SBCS network from a remote computer outside 

your network firewall.

• You want to use CCA to manage a remote SBCS device across the Internet.

You can authorize a remote VPN device to receive IPsec policies sent by a VPN 

server. You can also configure a VPN server to send IPsec policies to a remote 

VPN device.

When you authorize remote VPN clients to receive policies from a VPN server, end 

users can request a connection to their corporate network through a VPN tunnel 

by entering a password. When a connection is requested and the remote end user 

is authenticated, a VPN server forwards the parameters to the remote client. 

Otherwise, the user must manually enter the IPSec parameters to configure the 

VPN tunnel. Remote VPN devices include Cisco IOS routers, Cisco adaptive 

security appliances, and Cisco VPN clients.

A VPN group is a group of VPN clients that share the same authentication 

information and configuration. Pre-shared keys or digital certificates are used for 

authenticating the client against a group. The group policies can be configured on 

the local router database or on an external server such as RADIUS or both, a local 

and an external server.

You can configure a pre-shared key that authenticates a remote client. The 

pre-shared key adds to the security of the communications between the remote 

device receiving the IPSec policies and a server. The pre-shared key on the 

remote device must match the pre-shared key on the VPN server.
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NOTE The maximum number of simultaneous VPN connections allowed by CCA 

for UC520 and UC540 platforms is 10. For UC560 platforms, up to 20 simultaneous 

VPN connections are allowed. VPN connections used for EZVPN, SSL VPN, 

Multisite Manager, and SPA525G phone VPNs are included in this total.

Network Access — VPN Tunnel

Internet Access can be accomplished through the VPN tunnel. The security of the 

connection is greater, because you have VPN protection between the client and 

the server. Internet-related data moves through the tunnel to the server, where 

communications with the Internet takes place, providing the protections 

configured on the client and the server. This is in comparison to Split Tunneling, 

where Internet communications are sent and received outside the VPN tunnel, 

relying only on the protections configured on the client.

Internet Access — Split Tunneling

When you enable split tunneling on a remote network, client communications with 

local devices, or over the Internet with other networks, are unencrypted. The data 

is only encrypted when the end user is communicating with a protected 

subnetwork; typically the corporate network. This reduces device processing time 

and increases network performance.

For example, a teleworker uses a VPN client PC to access the corporate network 

through a router that provides connectivity from the teleworker location through 

the Internet to the corporate network by using a VPN tunnel. However, there might 

also be other PCs at the teleworker location that are not part of the corporate 

network and should not be allowed into the VPN. Typical examples would be PCs 

used by the spouse or children of the teleworker. These PCs do need Internet 

access, and users are likely to use the teleworker router to avoid installing a 

second broadband connection in the same home. The IPsec tunnel can be up at all 

times and use IEEE 802.1x to authenticate corporate users who try to gain access 

from the remote site. A RADIUS server at the corporate headquarters site holds 

the database of corporate users. As the tunnel is always available, the remote 

router can query the database to confirm the 802.1x credentials (username and 

password) of the teleworker to allow the teleworker access to the VPN, yet 

exclude all others.

!
CAUTION Split tunneling can potentially pose a security risk when configured. Because VPN 

clients have unsecured access to the Internet, the VPN clients can be compromised 

by an attacker. That attacker might then be able to access the corporate LAN 

through the IPSec tunnel by using the identity of the VPN client.
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Procedures

Begin by selecting a device to be configured from the Hostname list.

Configure settings on each of these tabs in the VPN Server window:

• Server Settings

• User Accounts

• Network Access

• VPN Profile

Server Settings

To enable a VPN server, configure VPN server policies and settings as described 

in the following table.

After you are finished configuring server settings, click Apply to apply your 

settings, click OK to exit the VPN Server window, or click the User Accounts or 

Network Access tabs to continue configuring VPN settings.

Setting Description

VPN Server 

Interface(s)

Select or view VPN Server interfaces. If only one interface 

is displayed, then the setting is read-only.

VPN Group

Configure VPN group settings. A VPN group is a group of VPN clients that share 

the same authentication information and configuration. 

VPN Group Name Read-only field. The default VPN group name used by 

Configuration Assistant is EZVPN_GROUP_1.

Maximum 

Connections

Maximum number of VPN group clients that can be 

connected to the VPN server.

Preshared Keys Enter the pre-shared key for authenticating VPN clients 

and remote VPN devices, then re-enter the key for 

confirmation.

The preshared key can contain from 8 to 127 

alphanumeric characters. Spaces and the question mark 

(?) characters are not allowed.
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To delete a VPN server, follow these steps:

STEP 1 Click Delete.

A window appears, warning if you proceed, you will delete the VPN server 

configuration settings.

STEP 2 To delete the VPN server and close the window, click Yes.

STEP 3 To save your changes and to close the window, click OK.

User Accounts

To create a user account and set a password for users requesting a connection 

through a VPN tunnel, click Create, and use the Add an Account window. See Add 

an Account, page 246.

To delete a user account, select the user account, and click Delete.

Network Access

To enable Internet access through the VPN tunnel for a remote site, check the 

Enable Internet access on remote site checkbox.

If you enable Internet access through the VPN tunnel, split tunneling is disabled.

To enable split tunneling and to identify the networks protected by encryption, 

follow these steps:

VPN Remote IP 

Range

Enter a starting IP address and an ending IP address to 

specify a range of IP addresses from which an available 

IP address is assigned to a user. Up to 10 IP addresses 

can be specified for UC520 or UC540 platforms; up to 

20 IP addresses can be specified for UC560 platforms.

DNS

Primary DNS Enter the IP address of the primary DNS server for the 

VPN server.

Secondary DNS Optional. Enter the IP address of the secondary DNS 

server for the VPN server.

Setting Description
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STEP 1 Check the Enable Split Tunneling check box.

Only the traffic destined for the protected subnet is encrypted and sent through 

the VPN tunnel to the home network. All other traffic is sent to the destination 

subnets, but it is not encrypted, and it is not protected by a VPN tunnel.

STEP 2 Click Create, and use the Add a Network window (see Add a Network, 

page 245).

To delete a protected subnet, follow these steps:

STEP 1 Choose the network and the mask.

STEP 2 Click Delete.

VPN Profile

From the VPN Profile tab, you can export a Profile Configuration File (PCF) that 

your VPN users can import into the Cisco EZVPN client to create a new 

connection.

In order to be able to do this, the UC500 must have a static WAN IP address.

To export a PCF file, click Export VPN Profile. The Export VPN Profile option is 

disabled if you have not configured VPN server settings. Save the .pcf file to your 

local machine and distribute the file to your VPN users.

VPN Profile Import Instructions

Your VPN users will follow these steps to import the PCF file into the Cisco EZVPN 

client.

STEP 1 If needed, download and install the Cisco EZVPN client from Cisco.com at 

www.cisco.com/go/vpnclient.

STEP 2 Start the Cisco EZVPN client.

STEP 3 In the VPN client, click the Import icon or choose Connection > Import from the 

menu bar and browse to the location of the PCF file on the local machine. The 

profile will appear as a new connection entry.

www.cisco.com/go/vpnclient
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STEP 4 To use the profile, double-click on the new connection entry and enter your VPN 

account username and password.

VPN Remote 

To access VPN Remote configuration, choose Configure > Security > 

VPN Remote from the feature bar.

NOTE On Model SR520-T1 secure routers, VPN Remote is a licensed feature. To 

legally use this security feature, you must purchase the FL-SR520-T1-SEC 

Security Feature License for the SR520-T1. Contact your Cisco distributor to 

purchase this license.

To enable VPN remote client services on an SR500 secure router, follow these 

steps:

STEP 1 Begin by selecting the device to be configured from the Hostname list.

STEP 2 To enable voice services, check the Enable Voice Services on Remote 

Connection check box.

STEP 3 In the IP PBX Address field, enter the CME (Cisco Unified Communications 

Manager Express) IP address. For the UC500, the default value is 10.1.1.1.

STEP 4 In the VPN Server field, enter the IP address or the hostname of the VPN server or 

concentrator.

STEP 5 Optional: In the Enter new preshared key field, enter a pre-shared key to 

authenticate encrypted tunnels.

The pre-shared key must have at least 8 alphanumeric characters and can contain 

up to 127 characters. Spaces and the question mark (?) characters are not 

allowed. If a pre-shared key is configured on the remote VPN device, it must match 

the pre-shared key configured on a VPN server.

STEP 6 In the Reenter new preshared key field, enter the preshared key.

STEP 7 To save your changes and to close the window, click OK.
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To delete the remote device authorization to receive IPSec policies, follow these 

steps.

STEP 1 Click Delete.

A window appears, warning you that if you proceed, you will delete the VPN 

remote configuration settings.

STEP 2 To save your changes and to close the window, click OK.

Establishing a VPN Tunnel (End User Client Connection Instructions)

These instructions describe how an end user connected to a service provider 

using a Cisco SR520 router can establish a VPN tunnel to a central site network. 

These instructions are provided for the convenience of a system administrator.

To establish a VPN tunnel between a remote user and a central site network, 

follow these steps.

STEP 1 Launch a Web browser window, such as Internet Explorer.

STEP 2 Enter the IP address of the VPN server in the Address field of the browser. The 

VPN tunnel Activation Tool window appears, providing the option to connect to a 

central site network by using VPN or to connect to the Internet.

STEP 3 To connect to the central site network, click Connect Now. The Authentication for 

VPN tunnel Activation window appears.

STEP 4 Click Continue. The VPN tunnel is established.

Add a Network

This window appears when Split Tunneling is enabled and you click Create on the 

Network Access tab in the VPN Server window or the SSL VPN window.

Use this window to add the subnetworks for which the packets are tunneled from 

the VPN or SSL VPN clients. Only traffic destined for these subnetworks are sent 

through the VPN or SSL VPN tunnel. All other traffic from client connections is sent 

unencrypted. For more information, see Internet Access — Split Tunneling, 

page 240.

To add a network, follow these steps:
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STEP 1 In the Network field, enter the network IP address.

STEP 2 In the Wildcard Mask field, choose a subnet mask.

STEP 3 Continue adding subnetworks for which you want to permit VPN or SSL VPN 

access.

STEP 4 To close the window, click OK.

Add an Account

This window appears when you click Create on the User Accounts tab of the VPN 

Server window.

Use this window to add user authentication details to the local database.

To add an account, follow these steps:

STEP 1 In the Username field, enter the username. The username can contain up to 64 

alphanumeric characters. These characters are not allowed: 

The administrator account is automatically enabled as a VPN user.

The default VPN user account cannot be deleted.

STEP 2 Enter the password in the Password field and again in the Confirm Password 

field. The password can contain up to 25 alphanumeric characters. The minimum 

length of a password is 6 characters. These characters are not allowed: .

STEP 3 To close the window, click OK.

(space)  +  #  %  /  \  ?  ; <  >  {  }  |  ^  ~  [  ]  ` "

(space)  +  #  %  /  \  ?  ; <  >  {  }  |  ^  ~  [  ]  ` "
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Firewall and DMZ

To configure Firewall and DMZ settings, choose Configure > Security > Firewall 

and DMZ from the feature bar.

!
CAUTION Cisco does not recommend configuring Firewall and DMZ settings over a remote 

WAN connection. If the connection to the WAN is interrupted, the operation will fail 

and the system may become unusable.

Overview

You can increase your network security by configuring a firewall and a 

Demilitarized Zone (DMZ) to protect your LAN.

• If you are configuring a UC520, you are using a CBAC Firewall.

• If you are configuring an SR520, you are using a Zone-based Firewall.

CBAC firewall policy is defined by applying static Access-Control List (ACL) 

configuration on router interfaces to define the types of traffic allowed through an 

interface.

Zone-Based Policy Firewall changes the Cisco IOS Stateful Inspection model to a 

zone-based configuration model; where router interfaces are assigned to security 

zones, and firewall inspection policy is applied to traffic moving between the 

zones. (See the “Conceptual Difference Between Cisco IOS Classic and 

Zone-Based Firewalls” white paper, available on Cisco.com, for more information.)

Manage the security of your network by performing these tasks:

• Configure a firewall to filter packets arriving at the router, based on the 

security level you choose. If a packet meets the criteria, it is allowed to pass 

through the interface or the zone. If a packet does not meet the criteria 

specified by the security parameters, the packet is dropped.

• Create a DMZ on which to place public access servers so that they will be 

on a separate, isolated network. This provides extra security for your 

internal network. The DMZ can be used for public access to the Web and 

for Web access to your servers that are accessible from the Internet. To 

create a DMZ you must first create a firewall.
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Procedures

Choose a device on which you want to enable a firewall (and optionally a 

demilitarized zone) from the Hostname list.

This window has two tabs:

• Firewall, page 248

• DMZ, page 249

From this window you can also click NAT Service to open the NAT window to 

configure network address translations. See NAT Window (IP Addresses 

Assigned via DHCP), page 235.

Firewall

You follow the same procedure to create or to modify a firewall. Follow these 

steps:

STEP 1 Choose an outside interface from the Outside (untrusted) Interface/Zone list, or 

check an inside interface on the Inside (trusted) Interface/Zone list. Outside 

interfaces connect to your WAN or to the Internet. Inside interfaces connect to 

your LAN. These guidelines apply:

• If you choose an outside interface, the Inside (trusted) Interface/Zone is 

shown in gray.

• You can select multiple inside interfaces.

• Do not select the interface through which you accessed Cisco Configuration 

Assistant as the outside (untrusted) interface.

• You cannot launch Cisco Configuration Assistant through the firewall from 

the outside (untrusted) interface.

• If you select an outside interface that is already selected as an inside 

interface or DMZ interface, a warning message appears.

• If you select an inside interface that is already selected as a DMZ interface, 

a warning message appears.
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STEP 2 Move the Security Level slider to the level that you want. The Security Level slider 

is enabled when you select an interface. The Description area lists the filtering 

rules for each of these security levels:

• High prevents the use of instant messaging and point-to-point applications 

on the network. The firewall monitors HTTP and email traffic and drops 

traffic that does not comply with the security protocol. It returns other TCP 

(Transmission Control Protocol) and UDP (User Datagram Protocol) traffic for 

sessions started inside the firewall.

• Medium monitors the use of instant messaging and point-to-point 

applications, and HTTP and email traffic. The firewall returns other TCP and 

UDP traffic for sessions started inside the firewall.

• Low does not monitor application traffic. The firewall returns other TCP and 

UDP traffic for sessions started inside the firewall.

STEP 3 In the DNS Primary field, enter the primary DNS (Domain Name Service) server IP 

address. These restrictions apply:

• If DNS was configured through another means, the DNS IP addresses cannot 

be configured. To modify the DNS configuration, use the Device 

Configuration tab in the Configure > Device Properties > IP Addresses 

window.

• If a DNS is already configured on the device, the DNS IP address appears 

and you cannot enter DNS IP address.

• If the Security Level slider is set to medium or high and DNS is not configured 

on the device, a DNS primary IP address is required.

STEP 4 Optional: In the DNS Secondary field, enter the secondary DNS server IP address.

DMZ

To create a DMZ, follow these steps:

STEP 1 From the DMZ Interface menu, choose an interface.

If the interface that you choose is an outside interface or an inside interface that is 

also identified as the interface for the firewall, a warning dialog appears.

STEP 2 Click Create, and use the Create DMZ Service window. See Create DMZ Service, 

page 250.
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STEP 3 To close the window and to save your changes, click OK.

To delete a DMZ, follow these steps:

STEP 1 Select the IP address.

STEP 2 Click Delete. A confirmation window appears.

STEP 3 To close the window, click Yes.

STEP 4 To close the window and to save your changes, click OK on the Firewall and DMZ 

window.

Create DMZ Service

This window appears when you click Create on the DMZ tab of the Firewall and 

DMZ window.

Use this dialog to add a demilitarized zone (DMZ) to an interface. You must first 

configure a firewall.

Follow these steps:

STEP 1 To determine where traffic for the specified TCP or UDP service will be directed, 

enter an IP address in the IP Address field. If NAT (Network Address Translation) 

is enabled, enter the NAT-translated address, also known as the inside global 

address.

STEP 2 From the Server Type list, choose the supported server type. The supported 

server types are FTP, Web Server, Secure Web Server, Mail Server, SSH, and 

SFTP.

STEP 3 To close the window, click OK.

Firewall—Edit ACL

The Firewall—Edit ACL window is displayed when:

• Firewall is enabled on the UC500.
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• Custom ACEs (Access Control Entries) are configured out-of-band using the 

IOS command-line interface.

• Configuration Assistant detects the out-of-band configuration when trying 

to apply voice configuration.

Use the Move Up and Move Down controls in the window to re-order the entries 

in the access control list (ACL) as needed, then click OK.

ACL Manager

Overview

ACL Manager is a user-friendly graphical user interface that allows you to 

generate and modify new ACLs. It also allows you to save the ACL configuration 

and restore the saved configuration.

Access lists filter network traffic by controlling whether routed packets are 

forwarded or blocked at the router's interfaces. Your router examines each packet 

to determine whether to forward or drop the packet; this is based upon the criteria 

that you specified within the access lists.

Access list criteria could be the source address of the traffic, the destination 

address of the traffic, the upper-layer protocol, or other information.

!
CAUTION Advanced users (e.g. an attacker) can sometimes successfully evade or fool basic 

access lists, because no authentication is required.

There are many reasons to configure the access lists. For example, you can use 

the access lists to restrict contents of routing updates or to provide traffic flow 

control. One of the most important reasons to configure the access lists is to 

provide a basic level of security for your network by controlling access to it. If you 

do not configure the access lists on your router, then all packets passing through 

the router could be permitted to pass onto all parts of your network.

All access lists must be identified by a name or a number. Named and numbered 

access lists have different command syntax.

All access lists are either standard or extended access lists. If you only intend to 

filter on a source address, the simpler standard access list is sufficient. For filtering 

on anything other than a source address, an extended access list is necessary.
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You can define ACLs without applying them, but they will have no effect until they 

are applied to the interface of the router. It is a good practice to apply the ACL on 

the interface closest to the source of the traffic.

Procedures

To create an ACL, follow these steps:

STEP 1 Access the Access List Manager, choose Security > ACL Manager from the 

feature bar.

STEP 2 Click Add to access the Add Access List pop-up window.

STEP 3 Choose the access list type, either Standard or Extended.

STEP 4 Enter the needed ACL number. Standard range is 1-99. Extended range is 

100 -199.

STEP 5 Enter the description.

STEP 6 Select the interface from the pull-down menu. 

NOTE: If None is selected, then the direction radio buttons are disabled.

STEP 7 Choose the direction, either Inbound, or Outbound.

STEP 8 Click OK.

STEP 9 Press Apply.

To delete an ACL, follow these steps:

STEP 1 Access the Access List Manager, choose Security > ACL Manager from the 

feature bar.

STEP 2 Click on the row within the Access Lists table you want to delete.

STEP 3 Click Delete.

STEP 4 Press Apply.

To edit an ACL, follow these steps:
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STEP 1 Access the Access List Manager, choose Security > ACL Manager from the 

feature bar.

STEP 2 From the Access Lists table, select the row you wish to edit.

STEP 3 Click Edit to access the Edit Access List pop-up window. 

NOTE: In the Edit mode, Type and Number cannot be changed. Description may 

be changed.

STEP 4 Select the Interface from the pull-down menu.

STEP 5 Choose the Direction, either Inbound, or Outbound.

STEP 6 Click OK.

STEP 7 Press Apply.

To create or edit a Standard Access List Entry, follow these steps:

STEP 1 Access the Access List Manager, choose Security > ACL Manager from the 

feature bar.

STEP 2 From the Access Lists table, select the row (with Type listed as Standard) that you 

wish to add or edit an Access List Entry.

STEP 3 From the Access List Entries table:

• Click Add to access the Add Standard Access List Entry pop-up window.

or

• Click Edit to access the Edit Standard Access List Entry pop-up window.

STEP 4 Choose Action - Permit or Deny.

STEP 5 Select the Any, Host, or Network button and enter the corresponding IP Add 

values.

STEP 6 Click OK.

STEP 7 Press Apply.
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To delete a Standard Access List Entry, follow these steps:

STEP 1 Access the Access List Manager, choose Security > ACL Manager from the 

feature bar.

STEP 2 From the Access List Entries table, select the row you want to delete. To scroll 

through the table use the up/down arrow keys.

STEP 3 Click Delete.

STEP 4 Press Apply.

To create or edit an Extended Access List Entry, follow these steps:

STEP 1 Access the Access List Manager, choose Security > ACL Manager from the 

feature bar.

STEP 2 From the Access Lists table, select the row (with Type listed as Extended), you 

wish to add an Access List Entry.

STEP 3 From the Access List Entries table,

• Click Add to access the Add Extended Access List Entry pop-up window.

or

• Click Edit to access the Edit Extended Access List Entry pop-up window.

STEP 4 From the General tab:

a. select Action - Permit or Deny,

b. select the Protocol from the pull-down menu,

c. select the Service from the pull-down menu. 

NOTE: Services can be selected only if you select igmp/icmp from the 

protocol pull down menu.

STEP 5 From the Source tab, select Source and Source Port services.

NOTE: Source Port and Destination Port will be enabled only for UDP and TCP 

protocols.

STEP 6 Go to Destination tab, select Destination and Destination Port services.

STEP 7 Click OK.
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STEP 8 Press Apply.

Security Audit

To perform a security audit, choose Configure > Security > Security Audit from 

the feature bar.

Overview

You can test the security policies and enable security procedures to ensure 

secure networking services on your network. By auditing your router security 

configuration, you can test for the critical security functionality on your router 

configuration to determine whether potential security problems exist. You can 

choose to accept or reject the recommended security settings.

These conditions are checked. You can change the settings as needed to adjust 

the security of your network:

• Disable the finger service

• Disable the PAD service

• Disable the TCP small servers service

• Disable the UDP small servers service

• Disable the IP BOOTP server service

• Disable the IP identification service

• Disable IP source route

• Enable the password encryption service

• Enable TCP keepalives for inbound Telnet sessions

• Enable TCP keepalives for outbound Telnet sessions

• Enable sequence numbers and timestamps on debugs

• Enable IP CEF (Cisco Express Forwarding)

• Disable IP gratuitous ARPs

• Set the minimum password length to less than six characters
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• Set the authentication failure rate to less than three retries

• Set the TCP sync wait time

• Enable logging

• Disable SNMP

• Set a scheduler allocation

• Disable the IP redirects

• Disable IP Proxy ARP

• Disable IP directed broadcast

• Disable the MOP (Maintenance Operation Protocol) service

• Disable the IP unreachables

• Disable the IP mask reply

• Disable the IP unreachables on a null interface

• Enable unicast RPF on the outside interfaces

• Enable AAA

Procedures

To run a security audit on a device, follow these steps:

STEP 1 Choose Security Audit from the Security list to display the Security Audit launch 

button.

STEP 2 From the Hostname list, choose the device to audit.

STEP 3 To display a list of the security audit settings and the recommended actions, click 

Security Audit. The Security Audit Report window appears.

STEP 4 Use this window to choose which actions to perform to secure your network.

The table shows which security settings are set to the recommended values and 

which settings are not. Those that are not set to the recommended values 

represent a potential security problem.

To modify the security configuration of a device, follow these steps:
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STEP 1 Choose a device to be audited from the Hostname list.

STEP 2 To configure the recommended security settings for parameters that are not set to 

the recommended values, click the Fix security problems radio button. To set the 

security feature to the default value, click the Undo security settings button.

STEP 3 To set the security features to the recommended values, check boxes in the Fix 

column next to the security settings that did not pass the security audit.

STEP 4 To set the security features to the default values, in the Undo column beside the 

security settings that passed, check the check boxes. To choose all of the check 

boxes, check Select All.

STEP 5 To put your security changes into effect and to close the window, click OK.

Network Security Settings (CE520 Switches)

If one or more Catalyst Express CE520 switches are present in the customer site, 

select a security level for these switches by choosing Configure > Security > 

Network Security Settings.

Overview

You must set all the Catalyst Express switches in your network at the same 

security level: low, medium, or high. The levels are defined as follows:

• Low. Broadcast storm control and control over the number of users who can 

access a port.

• Medium. Low settings plus a table for authorizing the MAC addresses that 

can access a port.

• High. Low settings plus an identified RADIUS server for authorizing host 

devices that want access.

Procedures

The Network Security Settings window appears when:

• The Event Notification window shows a conflict in network security settings 

and you click Resolve.
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• You choose Configure > Security > Network Security Settings from the 

feature bar.

The contents of the window depend on whether you set the host access security 

level to Low, Medium, or High.

The Event Notification window directs you to this window for any of these reasons:

• Your Catalyst Express switches are not set at the same security level. To 

resolve the conflict, set the security level to Low, Medium, or High, and then 

click OK.

• A MAC authentication table contains a MAC address that needs your 

approval. To perform this task, see Host Level: Medium, page 259.

• The RADIUS server configuration for your Catalyst Express switches is not 

identical. To resolve the conflict, see Host Level: High, page 260.

Host Level: Low

At the Low level, Network Assistant uses these security features:

• Enable broadcast storm control for all Catalyst Express switches in the 

community.

Broadcast storm control prevents broadcast packets from flooding the 

subnet and degrading network performance. A severe broadcast storm can 

block all network traffic.

• Enable port security control for all Catalyst Express switches in the 

community.

Port security control limits the number of MAC addresses that can access a 

port at the same time. The maximum number of MAC addresses depends on 

the Smartports role that is configured on the port. This table shows how the 

maximum varies by Smartports role.

Smartports Role Maximum Number of MAC Addresses

desktop 1

ipphone 3 if a voice VLAN is configured; otherwise, 2

access-point 30

switch No limit
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To learn more about the Smartports feature, see Smartports, page 148.

Host Level: Medium

The Medium level adds a security feature called MAC authentication. This means 

that when a desktop, server, printer, IP phone, access point, switch, or router 

connects to the community through a Catalyst Express switch port, its MAC 

address must be explicitly added to the MAC authentication table before it is 

allowed to access the community.

You add a MAC address to the MAC authentication table when you:

• Connect a device to a port on a Catalyst Express switch.

• To approve the MAC address, select Yes in its Approved cell.

• Click Add a MAC Address, and use the Add a MAC Address window. See 

Add a MAC Address, page 260.

A MAC address is always approved when added.

To change the approval of one or more MAC addresses, select them, click Modify, 

and use the Modify a MAC Address window. You can also change the approval of 

a single MAC address by editing its Approved cell. See Modify a MAC Address, 

page 260.

To delete one or more MAC addresses, select them, and click Delete.

The MAC authentication tables on the Catalyst Express switches in your network 

must be identical. If they are not, you are prompted to resolve the conflict. You can 

ask Configuration Assistant to either merge the tables or clear them.

router No limit

server 1

guest 30

diagnostic No limit

other No limit

Smartports Role Maximum Number of MAC Addresses
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Host Level: High

The High level configures 802.1x on Catalyst Express switches. 802.1x is an 

authentication protocol that requires hosts to provide their usernames and 

passwords to access the network. They are forwarded to a RADIUS server, where 

approved usernames and passwords are stored. You configure the RADIUS 

server in this window.

NOTE 802.1x authentication applies only to access requests from desktops.

When you use the High level, MAC authentication is no longer needed, so it is 

turned off.

To set up 802.1x authentication:

STEP 1 Enter the IP address of the RADIUS server.

STEP 2 Enter the RADIUS key that Catalyst Express switches will use to communicate with 

the RADIUS server.

STEP 3 Enter a UDP port from 0 to 65535 for RADIUS authorization. If you are running 

Cisco Secure ACS version 4.0 or later, 1645 is the default UDP port. For earlier 

versions, it is 1812.

Add a MAC Address

This window appears when you set the Network Security Settings window to the 

Medium security level and click Add a Preapproved MAC Address.

Enter a MAC address in the MAC Address field and click OK. The MAC address 

will appear in the Network Security Settings window with an approval status of 

yes.

Modify a MAC Address

This window appears when you select one or more MAC addresses in the 

Network Security Settings window and click Modify.

If you selected a single MAC address, it appears in the window; if you selected 

more than one, you see MAC Address: Multiple.
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In the Approve list, select Yes or No, then click OK. The status of the selected MAC 

addresses is changed accordingly.

SSL VPN

To access SSL VPN configuration, choose Configure > Security > SSL VPN. SSL 

VPN can be configured on Cisco SR500 Series Secure Routers.

To enable and configure SSL VPN, the router must have a static IP address.

NOTE 1 For the model SR520-T1 secure router, SSL VPN is a licensed feature. To 

legally use this security feature, you must purchase the FL-SR520-T1-SEC 

Security Feature License for the SR520-T1. Contact your Cisco distributor to 

purchase this license.

NOTE 2 SSL VPN for the Cisco SA500 Series Security Appliance is not 

configured through CCA. To configure SSL VPN on this device, use the SA500 

Series Security Appliance Configuration Utility.

!
CAUTION Cisco does not recommend that you configure SSL VPN over a remote WAN 

connection. If the connection to the WAN is interrupted, the operation will fail and 

the system may become unusable.

Overview

SSL (Secure Sockets Layer) VPN (Virtual Private Network) provides remote 

access connectivity from almost any Internet-enabled location using a Web 

browser and its native SSL encryption.

The main role of SSL is to provide security for Web traffic. Security includes 

confidentiality, message integrity, and authentication. SSL achieves these 

elements of security through the use of cryptography, digital signatures, and 

certificates. Although application accessibility is constrained relative to IPSec 

VPNs, SSL-based VPNs allow access to a growing set of common software 

applications, Web-enabled services such as file access, email, and TCP-based 

applications (by way of a downloadable client).
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Basic Features

The SSL VPN configuration provided through CCA enables the best-practice 

default configuration wherever possible.

Using an SSL-enabled web browser (Internet Explorer, Netscape, or the 

equivalent), the user can establish a connection to the SSL VPN gateway. The 

initial user request to the SSL VPN gateway will be responded to with a user logon 

HTML page. The username and password are submitted to the gateway for 

authentication with a RADIUS server (Cisco ACS), and a session is only granted if 

the authentication is successful.

If a session is established, it is maintained by sending a session cookie to the user 

browser. This cookie must be embedded in all the following user HTTP requests 

for authentication at the SSL VPN gateway. If the cookie is missing or incorrect, the 

session is dropped, and the user can no longer access the corporate network. 

Normally, the session remains until the user logs out, the session times out, or the 

session is cleared from the SSL VPN gateway.

Basic SSL VPN configuration provides a clientless mode, with secure access to 

private web resources and web content. This mode is useful for providing access 

to content in a web browser, such as Internet access, databases, and online tools 

that employ a web interface.

When Basic SSL is configured, after the user is authenticated and a session is 

established, an SSL VPN portal page and toolbar is displayed on the user's web 

browser. From this page, the user can access all available HTTP sites, access web 

email, and browse Common Internet File System (CIFS) file servers.

NOTE If a popup blocker is enabled, it is possible that the small SSL VPN toolbar 

window does not display.

Advanced Features

Advanced SSL VPN options provide SSL thin-client mode, and full-tunnel client 

mode.

• Thin Client (port forwarding) Mode. Thin client mode extends the 

capability of the cryptographic functions of the web browser to enable 

remote access to TCP-based applications with static ports, such as Post 

Office Protocol version 3 (POP3), Simple Mail Transfer Protocol (SMTP), 

Internet Message Access protocol (IMAP), Telnet, and Secure Shell (SSH).
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In thin client mode, the VPN user downloads a Java applet by clicking on the 

link provided in the portal page. The Java applet acts as a TCP proxy on the 

client machine for the services configured by security gateway 

administrator. The Thin Client download assumes that the user who 

downloaded the applet has administrative privileges.

• Full Tunnel Mode. Full tunnel client mode offers extensive application 

support through its dynamically downloaded Cisco Anyconnect client or 

the Cisco SSL VPN Client (SVC). Full tunnel client mode delivers a 

lightweight, centrally configured and easy-to-support SSL VPN tunneling 

client that provides network layer access to virtually any application.

In full-tunnel client mode, an SSL tunnel is used to move data to and from the 

internal networks at the network (IP) layer. When the user logs into the SSL 

VPN gateway, the SSL VPN client is automatically downloaded and installed 

at the end user's PC, and the tunnel connection is established. When the 

connection is established, the user has full VPN access to the corporate 

network. Using full tunnel mode it is also possible to have voice support.

When Full Tunnel mode is enabled, the SSL VPN Anyconnect client must be 

installed in order for the VPN to function.

NOTE The SSL VPN user must have administrative rights to install 

applications on their PC in order for automatic download and installation of 

the SSL VPN client to work.

A Cisco.com login is required to download the client. A link to this software 

download for this package is provided on the Advanced tab.

• Split Tunneling. When you enable split tunneling on a remote network, 

client communications with local devices or over the Internet with other 

networks are unencrypted. The data is only encrypted when the end user is 

communicating with a protected subnetwork, typically the corporate 

network. This reduces device processing time and increases network 

performance.

!
CAUTION Split tunneling can potentially pose a security risk when configured. Because SSL 

VPN clients have unsecured access to the Internet, the clients can be compromised 

by an attacker. That attacker might then be able to access the corporate LAN 

through the tunnel by using the identity of the client.
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Procedures

Begin by selecting a device to be configured from the Hostname list.

This window has two tabs:

• Basic

• Advanced

Basic

On the Basic tab, configure settings as described in the following table, then click 

OK to close the window.

Setting Description

Digital Certificate Select the digital certificate that will be sent to the client 

for SSL authentication. If a digital certificate is not present, 

click Generate Certificate to generate one.

IP Address This read-only field displays the configured static WAN IP 

address. This is the IP address that will be used to access 

the VPN portal.

NOTE To launch SSL VPN from the client PC, use the 

https://ipaddress format in the browser Address field 

(use https instead of http).

Intranet Websites List of intranet Website to be displayed on the SSL VPN 

portal page.

To add an Intranet Website:

1. Click Add to insert a new row in the table.

2. Click in the Label field on the new row and enter a 
descriptive label using alphanumeric characters. The 
following characters are not allowed:   +, #, %, /, \, ?, ; ,<, 
>, {, }, |, ^, ~, [, ], `, and ".

3. Click in the URL field and enter the URL for the 
Website. The following characters are not allowed: 
(space), +, ?, /, \, <, >, #, %, {, }, |, ^, ~, [, ], `, and ".

To delete an Intranet Website, select the site in the list 

and click Delete.
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User Accounts List of user accounts for this SSL VPN.

The administrator account is automatically enabled as a 

VPN user.

The maximum number of user accounts is 10 for UC520 

and UC540 platforms, and 20 for UC560 platforms.

NOTE The maximum number of simultaneous VPN 

connections allowed by CCA for UC520 and UC540 

platforms is 10. For UC560 platforms, up to 20 

simultaneous VPN connections are allowed. VPN 

connections used for EZVPN, SSL VPN, Multisite 

Manager, and SPA525G phone VPNs are included in this 

total.

To add a user account and set a password for users 

requesting a connection through a VPN tunnel:

1. Click Add to insert a new row in the table.

2. Click in the User Name field on the new row and enter 
the user ID for the new account.

3. Click in the Password field and enter the password for 
the user account. The following characters are not 
allowed: (space), +, ?, /, \, <, >, #, %, {, }, |, ^, ~, [, ], `, and ".

To delete a user account, select the account in the list and 

click Delete.

Setting Description
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Advanced

On the Advanced tab, enable and configure advanced SSL VPN settings as 

described in the following table. When finished, click OK to close the window.

Setting Description

Thin Client Enable or disable Thin Client (port forwarding) mode for SSL 

VPN. When Thin Client is unchecked, clientless mode is used.

Configure 

Port 

Forwarding 

List

When Thin Client is enabled, click Configure 

Port Forwarding to enable remote access to 

TCP-based applications such as email, Telnet, 

and SSH with static ports.

Complete the settings in the Port Forwarding 

window, as described in Configure Port 

Forwarding List, page 268.

Full Tunnel Enable or disable Full Tunnel mode for SSL VPN.

Full tunnel mode delivers a lightweight SSL VPN tunneling client 

that provides network layer access to virtually any application. 

The client is automatically downloaded and installed to the client 

PC.

For Full Tunnel mode, the SSL VPN client must be installed.

The VPN user must have administrative rights to install 

applications on their PC for automatic download and installation 

of the SSL VPN client to work.

When Full Tunnel mode is enabled, specify a range of IP 

addresses for clients to use when they connect.

Starting IP Enter the first IP address in the range.

Ending IP Enter the last IP address in the range.
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SSL VPN 

Client

When the Full Tunnel client is enabled, the Install and Uninstall 

options become active.

IMPORTANT When Full Tunnel mode is enabled, the SSL VPN 

client installation is required. If the client is not installed, an error 

message is displayed to users.

The Install option allows you to install SSL VPN client software 

(Cisco Anyconnect client Web deployment package on 

SR520-T1 secure routers or SSL VPN Client (SVC) on 

SR520-ADSL/Ethernet secure routers).

Install To install SSL VPN client software, click Install, 

click Browse to navigate to the location of the 

file, then click OK.

CCA supports the current Web deployment 

package for Windows. A link to the download 

location for this package is provided when you 

click Install. A Cisco.com login is required for 

downloading this software. See Install SSL 

VPN Client Software Window, page 270 for 

instructions.

Uninstall To uninstall the SSL VPN client software from 

the router, click Uninstall. 

Keep client 

software 

installed on 

the client PC

Check Keep client software installed on the 

client PC to leave the client software on the 

user’s PC so that it does not have to be 

downloaded and installed each time the user 

connects to the SSL VPN.

TIP Disable this option if you are using SSL 

VPN for third-party remote access, and you do 

not want to leave a copy of the client on 

external PCs.

Setting Description
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Configure Port Forwarding List

The Port Forward window appears when you click Configure Port Forwarding 

List in the SSL VPN window.

Overview

When port forwarding is enabled, the hosts file on the SSL VPN client is modified 

to map the application to the port number configured in the forwarding list. A Port 

Forwarding List object defines the mappings of port numbers on the remote client 

to the application's IP address and port behind the SSL VPN gateway.

Procedures

To add an entry to the Port Forwarding list for each server and port mapping, click 

Add, configure the settings for each entry as described below, then click OK to 

close the window and save your settings.

Split 

Tunneling

Enable split 

tunneling

Check this option to enable split tunneling. Only 

the traffic destined for the protected subnet is 

encrypted and sent through the SSL VPN tunnel 

to the home network. All other traffic is sent to 

the destination subnets, but it is not encrypted, 

and it is not protected by an SSL VPN tunnel.

Click Add to specify local subnets for SSL VPN 

traffic. See Add a Network, page 245 for a 

description of fields in this dialog.

To remove a subnet from the list, highlight the 

subnet entry in the list and click Remove.

Setting Description

Server IP Enter an IP address that the server uses. This is an IP address 

that cannot be used externally on the Internet.

Server Port Specify the port number of the application for which port 

forwarding is configured (between 1 and 65535). The service 

port must be a static port.

Setting Description
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To delete a forwarding port mapping, follow these steps:

STEP 1 Choose an entry in the window.

STEP 2 Click Delete.

STEP 3 Click OK to save your changes and close the window.

Add a User Account

This window appears when you click Add from the User Accounts tab on the SSL 

VPN window.

To add a user account, configure the settings as described below, then click OK to 

save your changes and close the window.

NOTE The administrator account is automatically enabled as an SSL VPN user 

account and cannot be deleted.

Client Port Specify the port number of the client port (between 1 and 

65535). The port must be a static port.

Description Add information about the port forwarding entry (up to 1024 

characters). This information is mandatory on Cisco IOS routers.

Setting Description

Setting Description

Username The username can contain up to 64 alphanumeric 

characters. The following characters are not allowed:   

(space), +, #, %, /, \, ?, ; ,<, >, {, }, |, ^, ~, [, ], `, and ".

Password The password can contain up to 25 alphanumeric 

characters. The minimum length of a password is 6 

characters. The following characters are not allowed: 

(space), +, ?, /, \, <, >, #, %, {, }, |, ^, ~, [, ], `, and ".

Confirm 

Password

Re-enter the password for confirmation.
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Add Intranet Websites 

This window appears when you click Add (Intranet Websites) on the SSL VPN 

window.

To add a URL, configure the settings as described below, then click OK to save 

your changes and close the window.

Install SSL VPN Client Software Window

This window appears when you click Install (SSL VPN Client Software) on the 

SSL VPN window.

Use this window to install SSL VPN client software on the client device. You can 

also use this window to download the latest version of the SSL VPN Client 

software. A Cisco.com login is required for downloading the SSL VPN client 

software.

To install SSL VPN client software on the client device, follow these steps.

STEP 1 If needed, download the SSL VPN Client (SVC) or Cisco Anyconnect Web 

deployment .pkg file from Cisco.com using the link provided. This link points to the 

currently supported Microsoft Windows client package.

If the UC500 8.1.0 software pack is installed on your system, you must use version 

2.5.1025 of the Anyconnect Microsoft client package (win-2.5.1025-k9.pkg). 

Version 2.3.0254 of the Anyconnect client is incompatible with the version of 

Cisco IOS contained in UC500 software pack 8.1.0.

STEP 2 Click Browse and navigate to the location of the SSL VPN Client or Anyconnect 

software package on your local PC.

STEP 3 Select the SSL VPN Client .pkg file.

Setting Description

URL Label Enter a description of the UR using alphanumeric 

characters. The following characters are not allowed:   +, 

#, %, /, \, ?, ; ,<, >, {, }, |, ^, ~, [, ], `, and ".

URL Enter the URL. The following characters are not allowed: 

(space), +, ?, /, \, <, >, #, %, {, }, |, ^, ~, [, ], `, and ".
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STEP 4 Click OK. to install the package and return to the SSL VPN window.

Intrusion Prevention System (IPS) (SR500 Series)

To configure IPS on SR500 Series Secure Routers, choose Configure > Security > 

IPS from the feature bar.

NOTE For the model SR520-T1 secure router, IPS is a licensed feature. To legally 

use this security feature, you must purchase the FL-SR520-T1-SEC Security 

Feature License for the SR520-T1. Contact your Cisco distributor to purchase this 

license.

Overview

An intrusion prevention system, monitors network and/or system activities for 

malicious or unwanted behavior and can react in real-time, to block or prevent 

those activities.

A network-based IPS operates in-line to monitor all network traffic for malicious 

code or attacks. When an attack is detected, offending packets are dropped, but 

all other traffic is allowed to pass. Unlike traditional firewalls, an IPS makes access 

control decisions based on application content, rather than IP address or ports.

Cisco IOS Intrusion Prevention System (IPS) is an inline, deep-packet inspection 

feature that effectively mitigates a wide range of network attacks and supports 

the following features:

• IPS can be configured for inside and outside interfaces that are considered 

vulnerable to attacks.

• After IPS interfaces are configured, you must obtain a public key and import 

an IPS signature package (Signature Definition File or SDF). IPS signature 

updates are supported for SDM-IPS package files only.

• Signature package updates can be imported after the initial configuration.

• IPS Alerts are provided to notify users of attacks and alerts, risk levels, and 

actions taken.

NOTE Signature editing, IPS security dashboard, and IPS monitoring features are 

not supported.
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Procedures

Refer to the following topics to configure IPS features:

• Initial IPS Configuration, page 272

• IPS Signature Updates, page 273

• IPS Alerts, page 274

• Deleting IPS Configuration, page 274

Initial IPS Configuration

The initial IPS configuration requires you to choose a device on which to enable 

IPS, choose interfaces for packet scanning, obtain a public key, download a 

signature package, and install the signature definition file from the package on the 

router.

To configure IPS, follow these steps.

STEP 1 Choose a device on which you want to enable IPS from the Hostname list.

STEP 2 Configure the interfaces.

To configure interfaces for IPS, choose an outside interface from the Outside 

(untrusted) Interface/Zone list or an inside interface on the Inside (trusted) 

Interface/Zone list. Available interfaces detected on the router are listed in the 

Inside and Outside columns of the table.

The terms outside and inside refer to the direction for IPS packet scanning for 

attacks on the interface (incoming or outgoing packet flow).

• When IPS is selected for an interface listed in the Outside column of the 

table, IPS scans only outgoing packets on that interface.

• Similarly, when IPS is selected for an interface listed in the Inside column of 

the table, IPS scans only incoming packets on that interface.

• The same interfaces can be configured as both inside and outside 

interfaces.

You can enable IPS scanning on an interface's outgoing and/or incoming packet 

flow, and there is no limit on the number of interfaces for which IPS can be 

enabled.

STEP 3 Download a public key.
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After you have configured the inside and outside interfaces, click on the link 

provided to download a public key from Cisco.com. Then, copy and paste 

the key-string section of the key into the text area provided for the key.

The public key is required and is named realm-cisco.pub.

STEP 4 Download and install a signature package.

You will need to provide your Cisco.com user account login and password for 

authentication.

To download and install an IPS signature package:

a. Click Install SDF to open the Download Signature Package dialog with a link 

for downloading an SDM-IPS Signature Definition File (SDF) package.

b. Click the download link to go to Cisco.com and choose a Cisco IOS SDM-IPS 

signature package from the list of SDM-IPS signature packages.

Only SDM-IPS packages in the Basic category are supported for use with the 

SR520. The Basic category supports signature files up to 128 MB in size and is 

intended for routers with up to 128 MB of memory.

c. Browse to the location of the signature package file (.zip file) on the local PC.

d. Click OK or Apply.

When you click OK or Apply, the configuration is sent to the router. All IPS-related 

configuration files are placed in the following location: flash:/ips/

After you have installed the signature package, the Delete IPS Configuration 

button, IPS Signature Updates tab, and IPS Alerts tabs become active.

IPS Signature Updates

IPS signature updates are only available if IPS was successfully configured and a 

signature package was downloaded.

IPS signature updates are supported for SDM-IPS package files only. From the IPS 

Signature Updates tab, you can import new and updated signatures for a selected 

SDF package.
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To import IPS signature updates, follow these steps.

STEP 1 In the IPS window, click the IPS Signature Updates tab.

STEP 2 Click on the link to go to Cisco.com and choose an IPS-SDM .sdf package file to 

download.

STEP 3 Browse to the location of the SDF package file (.zip file) on the local PC.

STEP 4 Click Extract Signatures to display new and updated signatures as well as 

signatures that are deployed to the router, but are currently disabled.

STEP 5 Click OK to upload the signatures displayed in the table to the router and update 

the SDF package version on the router.

IPS Alerts

The IPS Alerts section displays intrusion detection alerts and actions taken, along 

with information about the alert. The following information is displayed for each 

alert:

• Signature ID and description of the attack

• Risk rating

• Event action

• Source and destination IP addresses for the attack

• Number of hits and dropped packet counts

Click Show Alerts to view the current list of alerts; click Clear Alerts to clear the 

list.

Deleting IPS Configuration

To delete the current IPS configuration, click Delete IPS Configuration, then 

choose OK or Apply.
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URL Filtering (SR500 Series)

To configure URL Filtering on Cisco SR500 Series Secure Routers, choose 

Configure > Security > URL Filtering.

Zone Based Firewall (ZBF) configuration must be enabled before you can enable 

URL filtering.

NOTE For the model SR520-T1 secure router, URL Filtering is a licensed feature. 

To legally use this security feature, you must purchase the FL-SR520-T1-SEC 

Security Feature License for the SR520-T1. Contact your Cisco distributor to 

purchase this license.

Overview

URL filtering allows you to control access to Internet websites by permitting or 

denying access to specific websites based on a URL list. You can maintain a local 

URL list on the router.

CCA supports Black/White lists only (C3PL URL filtering). A Black/White list is a 

list of URLs that is manually created and maintained by the network security staff 

for a business. There are no default URLs; it is user-defined. CCA does not 

currently support use of third-party servers for URL filtering.

The Black/White list:

• Provides a basic solution if a few specific URLs need to be exempted.

• Allows a business to directly manage the URLs to denied as part of 

company policy.

• Leverages existing network equipment.

Procedures

STEP 1 Choose a device on which you want to manage URL Filtering from the Hostname 

list.

STEP 2 Set filtering options and manage the list of domain names to be filtered:

a. Check the Enable checkbox to enable URL filtering.

When URL filtering is disabled, you can still add and delete URLs to and from the 

domain name list, but no filtering is performed. URL filtering is disabled by 

default.
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b. Choose whether to deny all domains except the ones listed or permit all 

domains except the ones listed.

To add a URL to the list of domain names to be filtered, click Add, click in the row 

you just added, and type the domain name to be filtered. Partial domain names 

are accepted, as long as they can be validated (for example, cisco.com.is valid).

The maximum number of URLs allowed in the filter list is 100.

c. Continue adding and removing domain names as needed.

STEP 3 Click OK or Apply.

After you click OK or Apply, the names in the list cannot be modified. You must 

delete and then re-add the name in order to change it.

You can also import a text file with a list of URLs to be filtered or export the current 

list of URLs to a text file that can be imported to another device or application. The 

following guidelines apply to creating URL list files:

• The filename extension for must be either .csv or .txt.

• Lines beginning with "#" are treated as comments.

• Duplicates are not allowed in the list.

• URLs are entered one per line, as shown in the following example:

#Domain Name
www.cisco.com
www.yahoo.com
www.rediffmail.com
www.google.com
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Telephony System and Region Settings

This section covers configuration of system and region settings for Telephony 

These topics are covered:

• Voice System Initialization

• Voice System Settings

• Region Settings for Telephony

IMPORTANT Telnet access must be enabled in order to configure voice features.

Voice System Initialization

The Voice Initialization window appears when you attempt to open a voice 

configuration window before initializing system-level voice settings.

If you are not using the Telephony Setup Wizard, you must you must configure 

these settings before you can configure voice features.

If the UC500 platform you are setting up is in factory default state, we recommend 

that you use the Telephony Setup Wizard to configure these settings and set up 

trunking. For more information, see Telephony Setup Wizard, page 89.

After you have applied these settings, the system is no longer in factory default 

state, and you cannot use the Telephony Setup Wizard until you reset the UC500 

to the factory default configuration.

Click OK when you are done, or click Cancel.
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Voice System Settings

To access voice system settings, choose Configure > Telephony > System > 

System Settings.

From the System window, you configure these settings:

• Hardware Configuration

• System Message

• System Type Settings

• Web Access Settings

Click Apply or OK when you are finished making changes to these settings.

Field Description

System Mode Choose whether to configure call handling for PBX or 

Keysystem. The default value is PBX.

When the System Mode is set to Keysystem, the system 

is placed in a hybrid mode, where SIP trunks are treated 

as if the system were in PBX mode, and local trunks (FXO, 

BRI, PRI) are treated as key system lines. In this mode, FXO 

trunks and T1/E1 CAS trunks are configured as direct 

trunk lines.

Unlike earlier releases of CCA (1.x), there is no real 

difference between Keysystem and PBX mode.

Number of Digits 

Per Extension

Set the extension length. The default value is 3.

Voicemail Access 

Extension

Internal extension for accessing the voice mail system. 

The number of digits in the extension must match the 

specified Number of Digits Per Extension.
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Hardware Configuration

The UC500 hardware configuration is detected and shown in the Hardware 

Configuration section. CCA restricts the configuration parameters that can be 

modified, based on the hardware configuration of the router. Typically, these 

parameters are fixed.

System Message

System Type Settings

System Type settings are available only for the initial configuration:

• These settings can also be configured through the Telephony Setup Wizard 

or the Voice Initialization window.

• You must reset the UC500 to factory defaults to change these settings.

• After you apply these settings, these fields become read-only.

Setting Description

System Message Custom:

Select Custom to enter a short message of up to 31 

characters, such as the company name.

System Default (Cisco Unified CME):

The System Default may also be selected.

Minimum:

Select Minimum to conserve display space.

Setting Description

System Type Settings Number of Digits Per Extension:

Enter the number of digits for extensions at 

customer site. The default is 3.
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Web Access Settings

Region Settings for Telephony

To configure region and locale settings for Telephony, choose Configure > 

Telephony > System > Region from the feature bar.

From this window, you can chose the:

• Country for call progress tones

• Phone region and language

• Voicemail language

• Format to use for displaying the date and time on phones

The default system locale for the UC500 is US/English. Before configuring non-US 

locale settings in the Region window, you must download the appropriate UC500 

Software Pack and/or Locale Packs (which contain all files for localizing phones 

and voice mail) and install them on the UC500. See Installing Software on the 

UC500, page 541 and How to Localize the UC500 (Non-US/English Locales), 

page 557.

You can install up to two languages on the UC500, but only one can be active. If 

you have two languages installed, you can select the active language from this 

window. To install additional languages, choose Maintenance > Software 

Upgrade > UC500.

Configuring Region Settings

From the Region window, you can configure the following locale settings for 

telephony. When you are finished, click OK or Apply.

Setting Description

Web Access Settings Enable Web Access for Phones:

Click to enable (for Cisco Model 8961, 9951, and 

9971 phones only).

Setting Description

Devices
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Hostname Make sure that the UC500 hostname is selected.

Call Progress Tone

Country Choose the appropriate country to set tones and 

cadences for phones.

Phones

The phone region and language selections displayed here correspond to the 

phone language and localization files installed on the UC500.

The factory default is US English. If you did not install any other languages, no 

other options are listed. To install additional languages, choose Maintenance > 

Software Upgrade > UC500. See Software Upgrades, page 538.

Phone Region Choose the appropriate locale for this installation.

Phone Language Choose the language that appears on phones.

Voicemail

Voicemail Language Language of the prompts that voice mail users will hear.

On a factory default system, only English is available in 

the Voicemail Language drop-down menu. You must 

download and install the appropriate UC500 locale 

packs to localize the voice mail system. To install 

additional languages, choose Maintenance > Software 

Upgrade > UC500.

See Installing Software on the UC500, page 541 for 

more information about localizing the voice mail system 

when installing software on the UC500.

Up to two languages can be installed, but only one 

voice mail language can be active at a time.

Date and Time

Date Format Date format (dd-mm-yy, mm-dd-yy, yy-mm-dd, 

yy-dd-mm) for phone display

Time Format Time format (12-hour or 24-hour) for phone display

Setting Description
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Other Settings

This section displays the currently selected Dial Plan locale and Time Zone, 

along with information about where these settings are configured in CCA.

Setting Description
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Voice Ports and Trunks

This section covers configuration of voice ports and trunks. These topics are 

covered:

• FXS Ports

• PSTN Trunks

• SIP Trunks

• Trunk Status

FXS Ports

The FXS Ports window appears when you choose Configure > Telephony > Ports 

and Trunks > FXS Ports on the feature bar.

Overview

From the FXS Ports widow, you define how built-in FXS ports will be used (roles) 

and choose a signaling type.

Settings for FXS/DID voice interface card (VIC) ports are configured in the Ports 

and Trunks section of the PSTN Trunks window (see FXS/DID (VIC Only), 

page 290). If FXS voice interface card ports are configured within the PSTN 

Trunks setting then the role option can be set to Common Area Phone or Fax. By 

default, FXS VIC ports have role option set as Common Area Phone.

Procedures

Configure FXS Ports as described below, then click OK to apply the configuration.

Settings Explanation

FXS Port Read-only. Displays the FXS port ID, for example, 0/0/0.
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Role Defines how the device connected to this FXS port will be used 

and where it is configured. Choose one of the following:

• User phone. Allows advanced features to be configured 

on the phone such as voice mail. The ports are SCCP 

controlled and occupy a user license. Available features 

are further configured from Configure > Telephony > 

Users and Extensions > User and Phones > User 

Extensions.

• Common area phone. A common area phone is typically 

an analog phone located in a lobby or breakroom. 

Advanced features such as call forwarding and voice mail 

are not available on these phones. FXS ports assigned to 

this role are configured on the Analog Extensions tab in the 

Users and Phones window (Configure > Telephony > 

Users and Extensions > User and Phones).

• Fax. Allows integration with features such as SIP Trunk or 

T.37 Fax to Mail since additional/special configuration is 

required for them to properly handle fax machines. 

(Configure > Telephony > Users and Extensions > User 

and Phones).

Description Optional. Enter a description that identifies this FXS port and its 

usage.

Signal Choose Loop Start or Ground Start as the signal type, 

depending on what is required by the service provider. The 

default is Loop Start.

Extension If an extension is configured, it is displayed here. To configure an 

extension, choose Configure > Telephony > Users and 

Extensions > Users and Phones.

If this port is assigned a Common Area Phone or Fax role, choose 

the Analog Extensions tab and enter the extension.

If this port is assigned a User Phone role, choose the User 

Extensions tab, select the phone, and click Edit.

Settings Explanation



Voice Ports and Trunks

PSTN Trunks

Cisco Configuration Assistant SBCS Administrator Guide 285

10
 

PSTN Trunks

To access PSTN trunk configuration options, choose Configure > Telephony > 

Ports and Trunks > PSTN Trunks. PSTN Trunk settings can also be configured 

through the Telephony Setup Wizard.

The settings and options displayed on the tabs in the PSTN Trunks window vary, 

depending on the types of PSTN interfaces available on the UC500 platform that 

you are configuring.

See the following sections for information on configuring PSTN interfaces.

• FXO

• Basic Rate Interface (BRI)

• T1/E1 Interface

• FXS/DID (VIC Only)

FXO

If there are FXO ports available in the router, this tab displays read-only information 

indicating the number of FXO ports available. For example: 

Total Ports: 4 (4 Built-in, 0 VIC)

For information about configuring FXO ports, see Configuring FXO Port Settings, 

page 291.

For information about viewing status and managing FXO ports, see Trunk Status, 

page 307.

Basic Rate Interface (BRI)

If a Basic Rate Interface (BRI) is present on the system, configure settings as 

described in the following table.

NOTE If the ISDN PRI is present and selected and if one or more BRI interfaces 
are also present, you must set the BRI switch type. The Switch Type parameter is 
used to set the ISDN switch type on the BRI interface to avoid conflicts.
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T1/E1 Interface

If a T1/E1 interface is present, configure settings as described in the following 

table. Click OK or Apply when finished.

On UC560 platforms, up to two (2) T1/E1 ports can be configured; these can be 

ports on a built-in T1/E1 interface or on a T1/E1 interface installed in a VIC slot.

Setting Description

BRI Switch Type Choose one of the following the BRI switch types, as 

directed by your service provider: Basic 5ESS, Basic 

DMS100, Basic NI, NTT, Basic 1TR6, Basic NET3, VN3, 

Basic QSIG.

Bearer Capability Choose one of the following, as directed by your service 

provider: None, Speech, or 3100 Hz.

ISDN Static TEI Choose None or select a number to statically configure 

the Terminal Endpoint Identifier (TEI) value, as directed by 

your service provider. The TEI value represents any ISDN-

capable device attached to an ISDN network that is the 

terminal endpoint. TEIs are used to distinguish between 

several different devices using the same ISDN links.

Setting Description

Connection Type Click the Connection Type radio button to choose either 

T1 or E1.

This setting is available only for the initial configuration.

After this parameter is set, the field becomes read-only. 

The T1/E1 options appear if the device has a T1/E1 

interface.
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Channel Signaling Choose one of the following:

• ISDN PRI

• FXO

• FXS

• E&M

• FGD (applies to T1 only)

Setting Description
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Channel Signaling 

(Continued)

ISDN PRI

If you selected ISDN PRI as the channel signaling type, 

configure the following settings, as directed by your 

service provider.

• From the Switch Type menu, choose the switch 

type to be configured. This parameter is used to set 

the global ISDN switch type and the interface-level 

switch type.

• In the Bearer Capability field, choose None, 

Speech, or 3100 Hz.

• Check Get Incoming Caller ID Name from 

Facilities IE Message to enable.

The UC500 must be configured to match the 

requirements of the telephony company or service 

provider so that the Caller ID Name is interpreted 

and displayed correctly throughout the UC500 

system. By default the interface handles incoming 

Caller ID Names as Display IE. If the incoming Caller 

ID Name is on Facilities Information Element (IE), the 

interface must be reconfigured to correctly detect 

and interpret it. Without correct configuration, 

Unknown may be seen in the system indicating the 

lack of this information.

NOTE: Unknown is different from blocked names 

which are usually displayed Private or Blocked.

• Check Send Outgoing Redirecting Number IE to 

enable.

• Check Map All Outgoing Calls to Unknown 

Numbering Type and Plan to enable. Enable this 

setting if the ISDN carrier requires calls to be 

mapped as plan type unknown.

Setting Description
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Channel Signaling 
(Continued)

• In the PRI Group section, specify the range of ISDN 

PRI group time slots.

The default T1 range is 1 time slot to 24 time slots; 

time slot 24 (the D-channel) is always included. The 

range of time slot 24 to time slot 24 is invalid.

The default E1 range is 1 time slot to 31 time slots; time 

slot 16 (the D-channel) is always included. The range of 

time slot 16 to time slot 16 is invalid

Channel Signaling 
(Continued)

FGD**

** applies to T1 only

If you selected FGD from the Channel Signaling menu, 

follow these steps:

• To choose the signal type, click EANA or OS 

(operator services).

• To use separate time slots for incoming and 

outgoing calls, check the Use Separate Groups for 

Incoming and Outgoing Calls check box.

• In the Time Slots fields, enter the range of time slots.

If you checked the Use Separate Groups for 

Incoming and Outgoing Calls check box, enter the 

range of incoming time slots in the Incoming Group 

Time Slots field, and enter the range of outgoing 

time slots in the Outgoing Group Time Slots field.

The default T1 range is 1 time slot to 24 time slots; 

time slot 24 (the D-channel) is always included. The 

range of time slot 24 to time slot 24 is invalid.

Setting Description
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FXS/DID (VIC Only)

If a FXS/DID voice interface card (VIC) is present, configure the following settings 

for each port.

NOTE: To configure built-in FXS ports, choose Configure > Telephony > Ports 

and Trunks > FXS Ports from the feature bar.

Channel Signaling 

(Continued)

FXO

FXS

E&M

If you selected FXO, FXS, or E&M from the Channel 

Signaling menu, follow these steps:

• Choose the Signal Type.

• Check the Use Separate Groups for Incoming and 

Outgoing Calls check box to use separate time 

slots for incoming and outgoing calls.

• In the Time Slots fields, enter the range of time 

slots.

If you checked the Use Separate Groups for 

Incoming and Outgoing Calls check box, enter the 

range of incoming time slots in the Incoming Group 

Time Slots field, and enter the range of incoming 

time slots in the Outgoing Group Time Slots field.

The default T1 range is 1 time slot to 24 time slots; 

For these T1 signaling types, there is no dedicated 

D-Channel.

The default E1 range is 1 time slot to 31 time slots; 

time slot 16 (the D-channel) is always included. The 

range of time slot 16 to time slot 16 is invalid.

Setting Description

Port Read Only: Displays the VIC port number

Setting Description
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Configuring FXO Port Settings

To navigate to the FXO trunk panel from the feature bar, choose Configure > 

Telephony > Ports and Trunks > PSTN Trunks > FXO Tab.

Editing FXO Port Settings

To modify general port settings or adjust timers and audio settings for the 

selected port, choose Edit Settings. (Double clicking on the selected row will also 

launch the Edit Settings window).

The following FXO port setting tabs are:

• General Tab

• Timers Tab

Mode Choose FXS or DID

Signal If the Mode is set to FXS, choose Loop Start or Ground 

Start, as directed by your service provider.

If the Mode is set to DID, choose Immediate, Wink Start, 

or Delay Start, as directed by your service provider.

Caller ID If the Mode is set to FXS, enter the number to be displayed 

for the Caller ID for this FXS port.

N/A if the Mode is set to DID.

Extension If the Mode is set to FXS, enter the number to be displayed 

for the Extension for this FXS port.

N/A if the Mode is set to DID.

Permissions If the Mode is set to FXS, this field is N/A and uneditable 

until the Caller ID and Extension fields are populated. After 

populated, you can choose National, Internal, Local, 

International, Unrestricted, Local-Plus, or National-Plus.

N/A if the Mode is set to DID.

Block Restricted 

Numbers

If the Mode is set to FXS, click Enable or Disable.

N/A if the Mode is set to DID.

Setting Description
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• Audio Tab

General Tab

To configure the general port settings parameters, complete the fields as 

described in the following table, then click OK or Apply.

Contact the service provider of the CO lines to determine how these settings 

should be configured for a particular site.

Setting Description

Signaling Type FXO and FXS interfaces indicate on-hook or off-hook 

status and the seizure of telephone lines by one of two 

access signaling methods: loop-start or ground-start.

• Loop Start. Configures the loop start signaling on 

selected port specifically used for Foreign 

Exchange Office (FXO) and Foreign Exchange 

Station (FXS) interfaces. With loop start signaling 

only one side of a connection can hang up. This is 

the default setting for FXO and FXS voice ports.

• Ground Start. Configures the ground start 

signaling on voice port and specifically used for 

FXO and FXS interfaces. Ground start signaling 

allows both sides of a connection to place a call 

and to hang up.

Companding Type Specifies the companding standard used to convert 

between analog and digital signals in pulse code 

modulation (PCM) systems.

• u-law. Configures North American u-law ITU-T 

PCM encoding standard for particular port. 

This is the default setting.

• a-law. Configures European a-law ITU-T PCM 

encoding standard.
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Timers Tab

To configure the timers parameters, complete the fields as described in the 

following table, then click OK or Apply.

Supervisory 

Disconnect

Applies only to Loop Start signaling and typically used for 

hung voice ports. Supervisory Disconnection options are 

disabled when Ground Start is selected as the Signaling 

Type.

Supervisory Disconnect options are as follows:

• Anytone

• Dualtone preconnect

• Dualtone mid-call

• Signal

This is the default Supervisory Disconnect option 

for FXO port.

Please contact Small Business Support Center for 

assistance. For information select Troubleshoot > 

Support Information.

Enable Battery 

Reversal

The battery-reversal command applies to FXO and FXS 

voice ports. FXS ports normally reverse battery upon call 

connection. The Enable Battery Reversal option restores 

voice ports to their default battery-reversal operation. If 

an FXO port or its peer FXS port does not support battery 

reversal, avoid enabling the battery-reversal command 

on the FXO port.

By default this option is checked.

Setting Description
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Setting Description

Packet Jitter 

Buffer

Playout delay is the amount of time that elapses between 

the time at which a voice packet is received at the jitter 

buffer on the digital signal processor (DSP) and the time 

at which it is played out to the codec.

Mode:

• Adaptive. When the Playout-delay mode is set to 

Adaptive, the jitter buffer size and amount of 

playout delay is adjusted during a call, based on 

current network conditions. 

This is the default list option for Playout delay 

mode.

• Fixed. When the Playout-delay mode is set to Fixed, 

the jitter buffer size is not adjusted during a call 

Instead, a constant playout delay is added.

Nominal:

Configures the initial setup time and minimum allowed 

delay time that the DSP can insert before playing out 

voice packets.

The allowable range is 40 - 250 milliseconds.

The default value is 60 milliseconds.

Timer Configures the Supervisory Disconnect values for the 

port. This setting is mainly used to ensure that an on-hook 

indication is intentional.

Sup-Disconnect Timer:

The allowable range is 50 - 1500 milliseconds.

The default value is 350 milliseconds.
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Audio Tab

To configure the audio parameters, complete the fields as described in the 

following table, then click OK or Apply.

Timeouts Wait to Release:

Specifies the amount of time a voice port can be held in a 

call failure state while the Cisco router sends a busy tone, 

reorder tone, or out-of-service tone to the port. After the 

timeout expires, the release sequence is enabled.

The allowable range is 1 - 3600 seconds.

The default setting is 30 seconds.

Call Disconnect:

Specifies the time for which an FXO voice port remains 

connected after the calling party hangs up, when a call is 

not answered.

The allowable range is 0 - 120 seconds.

The default setting is 60 seconds.

CallerID Alerting Number of rings for Caller ID Alerting.

Allowed to select 1 | 2 | 3 | 4 | rings.

Setting Description
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Setting Description

Echo Tail 

Coverage

Configures echo cancel coverage on voice port and 

specifically used to adjust the coverage size of the EC. This 

command enables cancellation of voice that is sent out the 

interface and received on the same interface within the 

configured amount of time. If the local loop (the distance from 

the interface to the connected equipment that is producing 

the echo) is greater than this amount of time, the configured 

value of this command should be increased.

The allowable range for software pack 8.0 and later is 

[ 24 | 32 | 48 | 64 | 80 | 96 | 112 | 128 ] ms

The allowable range for all previous software pack releases 

24 | 32 | 48 | 64 | ms

The default value is 128 milliseconds for software pack 8.0 

and later.

Enable Echo Cancel:

The echo-cancel enable command enables cancellation of 

voice that is sent out the interface and received back on the 

same interface; sound that is received back in this manner is 

perceived by the listener as an echo. Disabling echo 

cancellation might cause the remote side of a connection to 

hear an echo. Because echo cancellation is an invasive 

process that can minimally degrade voice quality, this 

command should be disabled if it is not needed.

The default state is enabled.

This is an advanced configuration setting. Please contact 

Small Business Support Center for assistance. For 

information select Troubleshoot > Support Information.



Voice Ports and Trunks

PSTN Trunks

Cisco Configuration Assistant SBCS Administrator Guide 297

10
 

Echo Tail 

Coverage 

(continued)

Enable Non-Linear:

Configures non-linear command on voice port and 

specifically used along with echo cancel command. The 

function enabled by this command is also generally known as 

residual echo suppression.

The default state is enabled only if echo cancel is enabled.

This is an advanced configuration setting. Please contact 

Small Business Support Center for assistance. For 

information select Troubleshoot > Support Information.

Input Gain Configures the input gain in decibel on voice port and 

specifically when user wants to increase the gain of a signal 

entering the router. If the voice level is too low, user can 

increase the input gain.

The allowable range is -6 dB to +14 dB

The default value is 0 dB.

Output 

Attenuation

Configures the attenuation level in decibel on voice port and 

specifically when user wants to increase the attenuation of a 

signal leaving the router. If the voice level is too high, user can 

increase the attenuation. If the voice level is too low, user can 

decrease the attenuation.

The allowable range is -6 dB to +14 dB

The default value is 3 dB.

Setting Description
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Copying FXO Port Settings

To copy all port settings from one port to other ports, follow these steps.

STEP 1 In the FXO tab window click on the row of the table that corresponds to the port 

you want to copy.

STEP 2 Click Copy Settings. A FXO Port Copy Settings window, listing the port’s settings 

and its corresponding values, will open.

STEP 3 Under the Copy Settings To section of the window choose the targeted FXO 

port(s) you wish to paste the copied settings to, then click Add.

The Available Ports list is empty if all the ports already have identical settings.

• Click Select All to chose all available FXO ports.

Impedance This setting specifies the terminating impedance of analog 

telephony interfaces.

To adjust the impedance, choose one of the following options.

• 600c. 600 ohms + 2.15 uF

• 600r. Resistive 600 ohm termination

• 900c. 900 ohms + 2.15 uF

• 900r. Resistive 900 ohm termination

• Complex 1. 220 ohms + (820 ohms  | | 115 nF)

• Complex 2. 270 ohms + (750 ohms  | | 150 nF)

• Complex 3. 370 ohms + (620 ohms  | | 310 nF)

• Complex 4. 600r, line = 270 ohms + (750 ohms  | | 150 

nF)

• Complex 5. 320 + (1050 ohms  | | 230 nF), line = 12 kft

• Complex 6. 600r, line = 350 ohms + (1000 ohms | | 210 

nF)

The default impedance is country- specific. For North 

America the default is 600r.

Setting Description
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• Click Remove to remove a selected FXO port(s) from the list.

STEP 4 Click OK.

STEP 5 In the FXO tab window click OK or Apply to complete the copy configuration 

changes.

SIP Trunks

To configure SIP trunk settings, choose Configure > Telephony > Ports and 

Trunks > SIP Trunk from the feature bar.

These topics are covered:

• Overview

• Service Provider

• Account Information Tab

• Generic SIP Trunk Provider Configuration 

• Advanced Options Tab

Overview

SIP trunk parameters configured in this window vary, depending on the selected 

Service Provider template. SIP trunk parameter values must be obtained from the 

Internet Telephony Service Provider (ITSP).

If your ITSP is not listed, you may add a new Service Provider to configure the SIP 

trunk. For more information about these settings see Generic SIP Trunk Provider 

Configuration, page 303.

From the Advanced Options tab, you can specify IP addresses that are permitted 

to access your VoIP network.

To learn more about SIP trunking on Cisco SBCS/UC500 platforms, visit the 

following link in the Cisco Small Business Support Community:

https://supportforums.cisco.com/docs/DOC-9830/

https://supportforums.cisco.com/docs/DOC-9830/
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Service Provider

To add or delete Service Providers, complete the instructions as described in the 

following table.

Field Description

Service 

Provider

SIP trunk service provider that this router will connect to; for 

PSTN access.

Cisco-certified SIP Service Providers are identified in the 

drop-down Service Provider list with Cisco logo.

NOTE: If a certified service provider is selected then the 

custom and generic fields may not be modified; as the fields 

are predefined by the provider.

To configure SIP trunk parameters for other providers, select 

Add and complete the fields required by that Service 

Provider. For more information about Generic SIP Trunk 

Provider configuration, see Generic SIP Trunk Provider 

Configuration, page 303.

The Add and Delete options in the Service Provider drop-

down list are provided so that custom templates for Service 

Providers can be configured, imported, or deleted.

• The built-in templates for Cisco-certified Service 

Providers cannot be deleted.

• Templates to be imported are obtained from the SIP 

Service Provider or Cisco support community.

When a new Service Provider template is added, it becomes 

available for selection in the Service Provider list and the 

appropriate Service Provider-specific configuration settings 

are displayed when selected.
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Account Information Tab

To configure SIP trunk parameters, complete the fields as described in the 

following table, then click OK or Apply.

Field Description

Voice Codec From the pull down menu, select the desired Voice Codec 

that is recommended by your ITSP.

Proxy Server 

(primary)

IP address or DNS hostname of the primary SIP proxy server 

for the ITSP.

Proxy Server 

(secondary)

Optional. IP address or DNS hostname of the secondary 

(backup) SIP proxy server for the ITSP.

Registrar 

Server

Optional. IP address or DNS hostname of the SIP registrar 

server for the ITSP. This field is required if the ITSP requires 

SIP registrations.

Outbound 

Proxy Server

Optional. IP address or DNS hostname of the Session Border 

Controller (SBC) for the ITSP. This setting is required if the IP 

address of the SBCS at the ITSP is not the same as the SIP 

proxy server.

Maximum 

Number of 

Calls

Optional. Number of concurrent calls allowed for call 

admission control. You must configure this setting if the ITSP 

requires the UC500 to limit the number of concurrent calls. 

Check with your ITSP to see whether this setting is required.

The range for the supported number of concurrent calls is 

listed in brackets, for example, [1-48]. The maximum number 

of concurrent calls is equal to the number of licenses on the 

UC500.

When you change this setting, the Maximum Calls setting 

configured under Configure > Telephony > Maximum Calls 

is also updated. See Maximum Calls (Call Admission 

Control), page 494.
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Digest 

Authentication

Optional. Username and Password for SIP registration or 

calling. This setting is required if a SIP Registrar server is 

present.

Click the Display Password as Plain Text checkbox to 

toggle display of the password in plain text.

Domain Name 

Service

Optional. SIP Domain Name. Domain name for the SIP 

server. the SIP Domain Name is specific to Voice over IP 

(VoIP) services.

Optional. DNS Server Address. IP address of the DNS 

server for the SIP domain. You can configure a DNS server 

here if no DNS server is configured and domain names are 

being used for SIP trunk configuration. However, the 

preferred location for DNS configuration is on the Device 

Configuration tab in the IP Addresses window (Configure > 

Routing > IP Addresses). 

User 

Credentials

Optional. This field is required if the ITSP requires SIP 

registration with a unique username and password per DID 

for all DIDs associated to the UC500 or registration of the 

main account number. Most ITSPs only register the main 

number.

To add a set of user credentials for ITSPs that require per-DID 

SIP authentication:

1. Click Add to create a new row in the table.

2. Click in the Username column for the new row and enter a 
username. In general, the username field will contain an 
E.164-format PSTN number.

3. Click in the Password column for the new row and enter 
the password provided by the ITSP.

4. Click in the Realm column to edit. This field is 
automatically populated with the Proxy Server value If 
available, or another value if provided by your ITSP.

5. Click the Display Password as Plain Text checkbox to 
toggle display of user passwords in plain text.

6. Repeat these steps to add more credentials.

Field Description
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To delete a set of per-DID SIP user credentials, follow these steps.

STEP 1 Click in the row in the table that corresponds to the set of credentials you want to 

delete.

STEP 2 Click Delete.

STEP 3 Click Apply.

Generic SIP Trunk Provider Configuration

Prior to CCA 3.2, the SIP Trunk UI offered limited functionality for the Generic SIP 

Trunk Provider option.  This option is no longer available.  In its place, a new UI is 

offered for adding service providers with advanced configurations.

New providers may be added through a SIP Trunk UI that leverages many of the 

options already supported through the XML template (see Service Provider 

Settings Tab, page 304).

Advanced Options Tab

For security reasons, CCA blocks SIP traffic from unknown sources. Configure 

additional IP addresses here if your provider uses SIP gateways with IP addresses 

that are different from the proxy servers configured on the SIP Trunks tab.

To configure SIP trunk parameters, complete the fields as described in the 

following table, then click OK or Apply.

Field Description

Toll Fraud 

Protection

To enable Toll Fraud Protection, click to enable 

(recommended).

Toll fraud protection prevents unwanted calls on the system, 

but requires the definition of all IP addresses allowed to 

access the VoIP network. Internal networks and servers 

defined under Account Information are included. Any 

additional IP Address from your Service Provider may be 

entered. If your Service Provider is unable to provide a 

complete list, this feature may be disabled.
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Service Provider Settings Tab

To configure Service Provider Settings, complete the fields as described in the 

following table, then click OK or Apply.

Additionally 

Allowed IP 

Addresses

To configure additionally allowed IP addresses that are 

permitted access to the VoIP network, follow these steps.

STEP 1 Click Add to open a new row in the table for editing.

STEP 2 Enter the IP address.

STEP 3 Configure the Additional Allowed IP Addresses, if 

needed.

To delete additionally allowed IP addresses:

STEP 1 Select the IP address you desire to delete.

STEP 2 Click Delete to open a new row in the table for 

editing.

Timers and 

Retries

• Registrar Sever Expiry

range is 60 - 65535 seconds.

Default is 3600. Provider setting is 300.

NOTE: This is configured only if there is a Registrar 

Server defined.

• Number if Register Retries

Range is 1-10.

• Number of Invite Retries

Range is 1-10.

• Connect Timer

Range is 100 - 1000 milliseconds.

• Proxy Server Keepalive Timer (active)

Range is 10 -600 seconds.

Field Description
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Click Import or Export to import and export the SIP Service Provider XML 

Template. 

Field Description

General Tab Service Provider Name:

Enter desired name of the Service Provider.

Numbering Plan Locale: 

From the pull down menu select the appropriate Locale 

Number Plan (for example, None, North American, France, 

UK, or enter a new Locale, and so on).

Preferred Voice Codec:

From the pull down menu select the preferred voice Codec 

(for example, G711ulaw, G729, G711alaw).

Alternate Voice Codec:

From the pull down menu select the alternate voice Codec 

(e.g, G711ulaw, G729, G711alaw).

Fax Protocol:

From the pull down menu select the preferred Fax Protocol 

(for example, Upspeed G711, T38).

DTMF Method:

From the pull down menu select the appropriate DTMF 

Method (for example, RFC 2833, Inband G711).

RTP Payload:

From the pull down menu select the appropriate RTP 

Payload (for example, 96, 97, 98, . . . 126).

DID Registration:

Select one the following:

• Register Caller ID Main Number Only

• Register DIDs Using Same Password

• Register DIDs Using Different Passwords

• Do Not Register DIDs
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Session Data 

Tab

Call Forwards and Transfers

• Hairpin Transferred Calls

• Hairpin Forwarded Calls

• Preserve Caller IDs

Quality of Service (QoS)

DSCP for Signalling:

Select from the pull down menu the appropriate DSCP 

Signaling (for example, af11, af12, af13, af21. af22, af23, af31, 

af32, af33, af41, af42, af43, cs1, cs2, cs3, cs4, cs5, cs6, cs7, ef).

DSCP for Media:

Select from the pull down menu the appropriate DSCP for 

Media (for example, af11, af12, af13, af21. af22, af23, af31, 

af32, af33, af41, af42, af43, cs1, cs2, cs3, cs4, cs5, cs6, cs7, ef).

Destination Port: 5060

Transport Protocol: udp

Session Port:

Select from the pull down menu the appropriate Session Port 

(for example, Random, Fixed).

Allow Remote Party IDs:

Click to enable.

Provisional Response ACK:

Select from the pull down menu select the appropriate 

Provisional Response ACK (for example, System, Disable, 

Require, Supported).

Header - Optional field

Field Description
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Trunk Status

The Trunk Status window appears when you choose Configure > Telephony > 

Ports and Trunks > Trunk Status on the feature bar.

Overview

From the Trunk Status window, you can view Trunk Port, Current Status, and 

Action.

From the Action drop-down window inactive voice ports can be shut down. This 

ensures calls are not sent to the selected port(s) if no devices are attached.

When a voice port is shut down, no calls can be directed to it. However, the port is 

still shown as an available option on other screens in Configuration Assistant. The 

configuration can still be applied to the port, but the port must be manually 

reactivated before it can begin using that configuration.

Procedures

To shut down or reset a voice trunk port, select the port from the list and choose 

Reset Port or Shutdown Port from the drop-down menu in the Action column. 

Then click Apply or OK.

To re-activate a voice trunk that was shut down, select the port from the list and 

choose Activate Port from the drop-down menu in the Action column. Then click 

Apply or OK.
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Users and Extensions

This section explains how to configure settings for users, phones, and extensions 

that are listed under the Configure > Telephony > Users and Extensions on the 

feature bar.

These topics are covered:

• Users and Phones

• Voicemail and Notifications

• Single Number Reach (SNR)

• System Speed Dials

• Local Directory

Users and Phones

NOTE For information about the SIP Phones please refer to SIP Phones, page 625.

To open the Users and Phones window, choose Configure > Telephony > Users 

and Extensions > Users and Phones from the feature bar.

See the following sections for more information on configuring the options on each 

of the tabs in the Users and Phones window:

• User Extensions

• Floating Extensions

• Extension Mobility

• Analog Extensions

• FXS Gateway
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• Configuring Phone Button Assignments

User Extensions

NOTE For information about the SIP Phones please refer to SIP Phones, page 625.

To access configuration settings for User Extensions, choose Configure > 

Telephony > Users and Extensions > Users and Phones and select the User 

Extensions tab.

Follow the instructions in this section for:

• Adding, Editing, and Deleting Phones

• Importing Phone Data for Multiple Users (Bulk User Import)

TIP Left-click and drag with the mouse on column headers on the User 

Extensions tab to rearrange the columns in the view. You can also left-click on the 

column header in the view to sort the data in ascending or descending order.

Adding, Editing, and Deleting Phones

When you plug an IP phone into the UC500 it registers automatically, and is 

assigned an IP address on the voice VLAN (VLAN100) using DHCP. The MAC 

address of the phone is also discovered and displayed.

You can also add unregistered phones and configure their settings. Later, when the 

phone is plugged in, it will receive the configuration.

Users and extensions for phones connected to FXS ports that are assigned a User 

Phone role are also configured here.

For step-by-step instructions, see these sections:

• Adding a Phone

• Editing a Phone

• Deleting a Phone

If you are adding and pre-configuring a large number of phones, you perform a 

bulk import of user and phone data. For instructions on performing a bulk import, 

see Importing Phone Data for Multiple Users (Bulk User Import), page 317.
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Adding a Phone

You can add a phone and pre-configure its settings before it is physically 

connected to the system.

To add a phone and associate a user with the phone, follow these steps.

STEP 1 In the Users and Phones window, click the Add button at the bottom of the 

window.

STEP 2 Configure these settings for the new phone.

Field Description

Phone Information

MAC Address Enter the MAC address for this IP phone.

NOTE: For a CiscoMobile-iOS device, this number is user-

defined; however, it must match the number assigned to this 

device in the CiscoMobile client (Cisco Jabber) and is 

prepended with “SEP” on the client side. For example, a valid 

MAC address entry here might be 123412341234, but on the 

CiscoMobile client it should be SEP123412341234.

Phone Type Choose the IP phone model from the drop-down list.

When you select a Phone Type, the Button Assignment tab 

updates to display the correct number of rows for the model 

you select.

Expansion 

Module

Optional. For phones that support expansion modules, the 

Expansion Module menu lists supported models.

CCA does not automatically discover expansion modules 

that are connected to phones. If one or more expansion 

modules are connected to a phone, you must manually select 

them here. The “x2” selections in the list indicate that two 

expansion modules are connected to the phone.

When you choose an expansion module from the list, rows 

are added to the button list for the line buttons on the 

expansion module and phone model graphic updates to 

display the expansion module.
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Preferred 

Codec

From the pull down menu select:

• G711ulaw

• G729

• G711alaw

Permissions For SIP Phones, see Users and Phones - (SIP Phones), 

page 626

Missed Calls Missed calls are presented on the IP phone and listed in the 

missed-calls directory. Missed calls to overlay buttons are 

not reported.

Choose one of following settings:

• Exclude overlay button - All Missed Calls excluding 

those on overlay button. Default.

• All - All Missed Calls

• None - No Missed Calls

NOTE: Analog, ATA Phones, 301, 501, 6901, 6911 Phones do 

not support Missed Calls.

Field Description
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Allow Video 

Calls

Choose whether to allow video calls for this phone.

The Allow video calls setting does not apply to Analog 

Phones or ATAs.

• When Allow video calls is checked, Cisco Unified 

Video Advantage (CUVA) is enabled for this user’s 

phone. When coupled with a USB video camera, CUVA 

enables a PC connected to a Cisco Unified IP Phone or 

to Cisco IP Communicator to add video to internal calls 

made on the phone.

• When Allow video calls is unchecked, video calls are 

not allowed for this phone.

If this setting has been modified from its original value, that 

value is retained if you change the Phone Type. In most 

cases, you would only change the Phone Type when adding 

an unregistered phone. If this is the case, you must manually 

edit this setting after changing the Phone Type.

By default, Allow video calls is initially un-checked.

NOTE: The following phones do not support video calls:

• SPA300 Series IP Phones

• SPA500 Series IP Phones

• Unified IP Phone 6901

• Unified IP Phone 6911

• Unified IP Phone 8961

• CiscoMobile-iOS

Field Description
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Use as 

Teleworker 

Phone

Check or uncheck the Use as teleworker phone option to 

enable or disable MTP.

When Use as teleworker phone is checked, Media 

Termination Point (MTP) is configured on the phone so that 

Cisco Unified CME terminates the media stream. The MTP 

setting causes the UC500 to act as a proxy. Media packets 

are forwarded to other IP phones with the IP address of the 

UC500 in the source address field. MTP is typically used in 

remote teleworker phone deployments.

When this option is unchecked, MTP is not configured on the 

phone.

The Use as teleworker phone checkbox is not displayed for 

Cisco IP Communicator (CIPC) softphones, since MTP is 

always configured for CIPC softphones.

User Information

Last Name Phone user last name. The last name is displayed in the 

directory and used for Auto Attendant Dial-By-Name service.

First Name Phone user first name. The first name is displayed in the 

directory and used for Auto Attendant Dial-By-Name service.

User ID User ID for this phone user. This ID is used when logging in to 

Cisco Unity Express User Options web pages to change 

phone settings.

Password Password for this IP phone.

Password is mandatory if voicemail is enabled and optional if 

voicemail is disabled.

This password is used by the phone user to log in to Cisco 

Unity Express User Options web pages to change phone 

settings. The password applies only to the Cisco Unity 

Express GUI, and the IMAP (Internet Message Access 

Protocol). If this is an SCCP phone, this field also applies to 

the CME (Cisco Unified Communications Manager Express) 

GUI.

Field Description
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STEP 3 Click OK.

Editing a Phone

After you have added a phone, follow the steps in this section to edit phone 

settings.

Extension Mobility

Enable 

Extension 

Mobility

When this box is checked, Extension Mobility is enabled for 

this phone. Checkbox is in the enabled state only when there 

is a minimum of one phone profile configured and available. 

For more information, see Extension Mobility, page 324.

CAUTION If this is an existing user, their voice mailbox, 

button assignments, speed dials and phone configuration will 

be removed and overwritten by the selected phone profile 

when you click OK.

Select Logout 

Profile

Choose a phone logout profile to apply to this user’s phone. 

For more information, see Extension Mobility, page 324.

The phone profile defines the default button assignment of 

the phone when there is no Extension Mobility user login.

Phone Button Assignments and Speed Dials

Button 

Assignments

For each button you want to configure on the phone, select a 

Button Type.

You must choose a Phone Type before you can configure 

Button Assigments.

The Button <#> area of the page displays the settings that 

must be configured for the selected Button Type.

For detailed information about the types of buttons that can 

be assigned to each type of button and their associated 

settings, see Configuring Phone Button Assignments, 

page 339.

Speed Dials Click the Speed Dials tab to configure speed dials for the 

phone. For more information, see Speed Dials, page 319.

Field Description
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When a phone is physically connected to the UC500 it is discovered and listed by 

its MAC address. It does not automatically receive an extension or any default user 

information. You must edit the phone and configure these settings.

IMPORTANT In releases of CCA prior to 3.0, phones were automatically 

assigned an extension and some placeholder user information, but this is no longer 

the case. You must edit phone settings to add the required configuration after the 

phones are connected.

When the User Extensions tab is initially selected, it displays a list of all user 

phones. Analog ports that are configured with a role of User Phone are listed on 

the User Extensions page as Analog Phones. The MAC address, phone model, first 

extension, user first and last name, and the user ID are displayed for each phone.

To edit phone settings, follow these steps.

STEP 1 Click on a phone to select it, then click the Edit button at the bottom of the window 

to display its details. You can also double-click on a phone in the list to open its 

details for editing.

STEP 2 Edit settings as needed. For information about phone settings configured here, see 

Adding a Phone, page 311.

STEP 3 Click OK to send the configuration to the device.

Deleting a Phone

To delete one or more phones, follow these steps.

STEP 1 Unplug the phones to be deleted.

STEP 2 Choose Configure > Telephony > Users and Extensions > Users and Phones 

from the feature bar.

STEP 3 In the Users and Extensions window, click on the phones that you want to delete to 

select them.

STEP 4 Click Delete. All selected phones are deleted.
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Importing Phone Data for Multiple Users (Bulk User Import)

A sample Microsoft Excel file named BulkUserImport.xls is provided for entering 

phone data for multiple users. This data can be exported to XML and imported into 

CCA.

If you installed Configuration Assistant to the default location, this file is located in 

the following directory:

C:\Program Files\Cisco Systems\CiscoSMB\Cisco Configuration 

Assistant\appdata

To import data for multiple phones and users into CCA, follow these steps.

STEP 1 On your PC, locate the Excel file named BulkUserImport.xls in the appdata 

directory under the CCA installation directory on your PC.

STEP 2 Click Enable Macros when prompted. For the import to work correctly, macros 

must be enabled.

STEP 3 Make a copy of the file and give it a different name.

STEP 4 Open the file and enter the information required in the .xls file. All data entered 

must be within the table provided in the spreadsheet.

Field Name Description

User ID Required. User ID to associate with this phone.

First Name

Last Name

Required. First name and last name of the user associated 

with this phone. The first and last names can be displayed on 

the phone, used for Auto-Attendant dial-by-extension, and 

are included in directory listings.

Phone Type Required. From the drop-down list, choose the model for this 

phone.

Choose the /14 option if an expansion module will be 

connected to the phone. Choose the /14x2 selection if two 

expansion modules will be connected.

For SIP Phones, select a SIP Phone model. Refer to SIP 

Phones, page 625 for supported SIP Phones and their 

parameters.
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STEP 5 Click the Generate XML button in the .xls file to export and save the data to an 

XML file.

You can name the XML file anything you want, but it must have an .xml extension.

STEP 6 Launch CCA and navigate to Configure > Telephony > Users and Extensions > 

Users and Phones.

STEP 7 In the Users and Phones window, click the Import button at the bottom of the 

window.

MAC Address Required. Enter the MAC address of the phone in the 

following format: nnnn.nnnn.nnnn (for example, 

ABCD.1234.1234).

Extension Required. Enter an extension number to use for the first 

extension on the phone (button 1).

The number of digits must match the extension length 

chosen for the site (variable-length extensions are not 

supported).

Password Required. User password for this phone.

Line Type Required. For SCCP Phones choose either Dual or Octal 

from the drop-down list. For SIP Phones choose Ignore.

CFNA Extn Required. Internal extension or external phone number to use 

as the destination for unanswered calls to the first (primary) 

extension.

When specifying an external number, enter the number 

exactly as it would be dialed on your system, including 

access codes.

CFB Extn Required. Internal extension or external phone number to use 

as the destination for calls when the first (primary) extension 

is busy.

When specifying an external number, enter the number 

exactly as it would be dialed on your system, including 

access codes.

CFNA Timeout Required. Number of seconds before unanswered calls are 

transferred to the CFNA destination. The default is 

20 seconds.

Field Name Description



Users and Extensions

Users and Phones

Cisco Configuration Assistant SBCS Administrator Guide 319

11
 

STEP 8 Click Browse and navigate to the location of the XML file on your PC that contains 

the generated phone and user data.

STEP 9 Click OK to upload the file. CCA validates the XML data when you import the file.

STEP 10 If there are errors, you must fix them in the .xls file, re-generate the XML, then 

re-import the generated .xml file into CCA.

STEP 11 When you are finished, click OK.

Speed Dials

NOTE For information about the SIP Phones please refer to SIP Phones, page 625.

For information about configuring personal speed dials on user’s phones or EM 

profiles, see these sections:

• Overview

• Procedures

Overview

You can configure personal speed dials for individual phones, Extension Mobility 

phones (via the EM Phone Profile), and Extension Mobility users (via the EM User 

Profile). These speed dials are accessed by pressing buttons on the phone or 

from menus on the IP phone.

For example, the phone user Ted Brown has 205 as his primary extension, an 

intercom on button 2, and three speed dials configured on his phone. Buttons 

3 through 5 display the speed dials.
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The following usage guidelines apply to speed dials configured from this window:

• Up to 55 speed dials can be configured.

• These speed dials are applied in order, beginning with the first available 

button on the user’s phone.

• Speed dial buttons cannot be placed between line or feature buttons. For 

example, if button 1 is configured as a Normal extension and button 3 is 

configured as an Intercom button, the first speed dial is assigned to button 4. 

A speed dial cannot be assigned to button 2. This also applies to button 

assignments for phones with expansion modules.

• If the number of speed dials configured is greater than the number of buttons 

on the user’s IP phone, the phone user can access the rest of the speed dials 

from menus on their IP phone. To access these speed dials:

- Press the services button on their IP phone.

- From the CME Service URLs menu, choose My Phone Apps.

- From the My Phone Apps menu, choose Speed Dial Buttons.

• An IP phone user can also use abbreviated dialing feature with these speed 

dials. To use abbreviated dialing:

- With the phone on-hook, press the number of the speed dial as it appears 

in the menu list. For example, to dial the tenth speed dial in the list, the 

user presses “1” then “0.”

- Press the AbbrDial softkey to dial the number.

• Speed dials that the user manually adds from the services menu on their 

phone are also displayed on the Speed Dials window in CCA.

• IP phones are restarted automatically after speed dial configuration is 

applied.

Procedures

To add, edit, or delete speed dials, for individual phones or EM profiles, follow 

these steps:

STEP 1 Choose Configure > Telephony > Users and Extensions > Users and Phones 

from the feature bar.

STEP 2 To configure speed dials for a regular phone user, select the User Extensions tab in 

the Users and Phones window.
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To configure speed dials for an Extension Mobility user or phone profile, select the 

Extension Mobility tab, select the User Profile or Phone Profile sub-tab, then click 

the Speed Dials tab.

STEP 3 Click in a row of the table to select a phone for which you want to configure speed 

dials.

You can sort phones in the list by extension, phone type, first name, last name, user 

ID, or MAC address.

STEP 4 Click Edit. The Edit Phone window appears.

STEP 5 In the Edit Phone window, select the Speed Dials tab.

STEP 6 On the Speed Dials tab, follow these steps to add a speed dial.

a. Click on the row that corresponds to the speed dial button number that you 

want to add or edit.

b. In the Number field, enter a phone number exactly as the user would dial it, 

including an access code for external dialing or site dialing prefix, if needed.

East Asian double-byte characters are not supported with speed dials. 

The Number field accepts these characters: digits 0-9, A, B, C, D, #, * and +. 

The non-digit characters can be used for security access or other systems that 

a customer may have at their site.

c. In the Label field, enter a label to identify the speed dial button on the phone 

display.

STEP 7 Continue adding speed dial buttons as needed.

STEP 8 Click OK when you are finished.

STEP 9 The affected phones are restarted automatically. IP phones that are in use are 

restarted after the current call completes.

STEP 10 To delete a speed dial, follow these steps.

a. Click on the row that corresponds to the speed dial button number you want to 

delete.

b. In the Number field, manually delete the phone number.

c. In the Label field, manually delete the data.

STEP 11 Click OK when you are finished.
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The affected phones are restarted automatically. IP phones that are in use are 

restarted after the current call completes.

Floating Extensions

To access configuration settings for Floating Extensions, choose Configure > 

Telephony > Users and Extensions > Users and Phones and select the Floating 

Extensions tab.

Overview

A floating extension is an extension that is not associated with any phone. Here are 

some examples of how this feature can be used.

• You can use floating extensions to create voice mailboxes that are not 

associated to a phone. Users can access their voice mail from any phone on 

the system by simply dialing the voice mail extension or voice mail PSTN 

access number. They are prompted to enter their voice mail PIN. The default 

PIN for voice mail access is 1234. Users accessing voice mail for the first 

time will be prompted to change their PIN.

• You can configure a floating extension for a mobile worker and configure it 

to forward all calls to a cell phone number. 

The forwarded number can be changed without having to change the 

extension number, and the actual number (in this case a cell phone number) 

is not exposed to the caller.

You can map a DID number to a floating extension on the Direct Dialing tab in the 

Incoming Dial Plan window (Configure > Telephony > Dial Plan > Incoming).

A floating extension can be assigned as:

• A night service extension.

• A No Answer Forward to destination for calls to a hunt group. In the No 

Answer Forward to drop-down list, choose Other Number and enter the 

floating extension number.

• A destination for calls transferred from the Auto Attendant. Select Call 

Other Number and enter the floating extension number.

Procedures

To add or edit a floating extension, follow these steps.
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STEP 1 Choose Configure > Telephony > Users and Extensions > Users and Phones.

STEP 2 Select the Floating Extensions tab.

STEP 3 Click Add or select an existing floating extension from the list and click Edit. The 

Add/Edit Floating Extensions window appears.

STEP 4 Configure settings as described in Adding or Editing Floating Extensions.

STEP 5 Click OK.

Adding or Editing Floating Extensions

To create an extension that is not associated with any phone, configure settings as 

described below, then click OK.

Setting Description

Extension Settings

Number Extension number to use for the floating extension. 

The extension must be unique and must contain the 

correct number of digits for your system. Single-digit 

extension is supported.

PSTN Number If a DID number has been mapped to this extension, it 

is displayed here. If not, the text “No DID mapped” 

appears.

To associate a DID number to an extension, go to 

Configure > Telephony > Dial Plan > Incoming and 

select the Direct Dialing tab. In the Direct Dial to 

Internal Extensions section of the page, click Add or 

Modify to create or edit the mapping between the 

desired DID number and the floating extension or 

range of floating extensions.

Call Forward All Forward all calls to this extension to the specified 

number. If the number is an external number, include 

any access codes that are required.

Enable Voicemail Create a voice mailbox for this extension. When this 

setting is checked, User Information is required.
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Extension Mobility

To access configuration settings for Extension Mobility, choose Configure > 

Telephony > Users and Extensions > Users and Phones and select the Extension 

Mobility tab.

The Extension Mobility (EM) feature allows you to provide phone mobility for end 

users.

A user login service allows Cisco IP phone users to log in to an EM-enabled phone 

where they can make and receive calls using their personal directory number and 

speed dials and optionally access a personal voice mailbox.

User Information

User information is only required if Auto Attendant Dial-By-Name service is 

required or you wish to enable voice mail for the floating extension.

First Name First name of the user associated with this floating 

extension. It is displayed in the directory and used for 

Auto Attendant Dial-By-Name service.

Last Name Last name of the user associated with this floating 

extension. It is displayed in the directory and used for 

Auto Attendant Dial-By-Name service.

User ID User ID for the user associated with this floating 

extension. This user ID is used to log in to Cisco Unity 

Express User Options web pages to change 

voicemail settings.

Password Password for the user associated with this floating 

extension.

This password is used to log in to Cisco Unity 

Express User Options web pages to change 

voicemail settings. The password applies only to the 

Cisco Unity Express GUI, and the IMAP (Internet 

Message Access Protocol). If this is an SCCP phone, 

this field also applies to the CME (Cisco Unified 

Communications Manager Express) GUI.

Clear User Fields Remove all user information from this floating 

extension.

Setting Description
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For information about the Extension Mobility feature and the settings that are 

configured on each tab, see these sections:

• Example Extension Mobility Deployment Scenarios

• EM User Profile

• EM Phone Profile

Overview

To set up Extension Mobility for a site, you must perform these steps:

• Configure general settings. These are global settings that apply to all EM-

enabled phones. You can configure up to 3 auto-logout times. At the 

specified time, all EM sessions on EM-enabled phones are automatically 

logged out. You can also specify whether the EM user’s call history is 

cleared at logout. See General Settings, page 329.

• Create EM User Profiles. The EM User Profile defines the button 

assignments and speed dial settings that the EM user will see when they 

log in to an EM-enabled phone. Every EM user must have a profile. See EM 

User Profile, page 327.

Create EM Phone Profiles. The EM Phone Profile defines the button 

assignments and speed dial settings of an EM-enabled phone when there 

are no EM users logged in to the phone. Multiple phones can be associated 

with the same Phone Profile. See EM Phone Profile, page 328.

* The CCA Phone Profile is also referred to as a Logout Profile in Cisco 

IOS.

• Enable selected IP phones for the EM service. A phone is enabled for 

Extension Mobility when it is associated with a Phone Profile. Enabling EM 

on a Phone, page 328.

Example Extension Mobility Deployment Scenarios

This section describes some common deployment scenarios for extension 

mobility and an overview of the configuration steps for each.

Scenario 1: Mobile employees share EM-enabled phones

In this scenario, a pool of IP phones are enabled for EM service. Mobile employees 

(for example, salespersons) share these EM-enabled phones when they are onsite, 

instead of having personal desk phones. Each mobile employee has a personal 

mailbox and their own phone button assignments and speed dials when they log 

into an EM-enabled phone.
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In this type of deployment, you will need to:

1. Create an EM Phone Profile that specifies the default button assignments and 
speed dials that the phone will have when no one is logged into it. Typically this 
is a very simple profile with restricted calling permissions. See EM Phone 
Profile, page 328.

2. Enable EM service for each of the IP phones in the common pool by associating 
it with a Phone Profile. See Enabling EM on a Phone, page 328.

3. Create an EM User Profile for each mobile employee. This profile will have the 
employee’s personal extensions and speed dials. In each EM User Profile, 
enable and assign a personal mailbox to the user’s primary extension. See EM 
User Profile, page 327.

Scenario 2: Mobile employees share common phones when onsite, but have 

their own IP phones at another location

In this scenario, a pool of common phones at a site are enabled for EM service. 

Mobile employees share these phones when they are onsite, but also have a 

primary IP phone at another location. When they log into an EM-enabled phone, 

their personal Normal and Share extensions and speed dials are the same as on 

their primary IP phone. They can access the their personal mailbox from an 

EM-enabled phone, in addition to their primary phone.

In this type of deployment, you will need to:

1. Create a EM Phone Profile that specifies the default button assignments and 
speed dials that the phone will have when no one is logged into it. Typically this 
is a very simple profile with restricted calling permissions. EM Phone Profile, 
page 328.

2. Enable EM service for each of the IP phones in the common pool by associating 
it with the EM Phone Profile you created. Enabling EM on a Phone, page 328.

3. Create an EM User Profile for each mobile employee with the desired button 
assignments and speed dials. See EM User Profile, page 327.

For the EM user to use the same phone number at an EM enabled phone and 
their home IP phone, a Share line should be used for the primary number. To 
access the same voice mail box the share line should be enabled with a 
Personal Share mailbox.

In order for the EM user to use the same phone number and voice mailbox at an 
EM enabled phone and also at his/her home IP phone, a Share line should be 
provisioned as the primary number with the voicemail option enabled.



Users and Extensions

Users and Phones

Cisco Configuration Assistant SBCS Administrator Guide 327

11
 

Requirements and Limitations

The following limitations apply to configuring Extension Mobility using CCA:

• Cisco Unified CallManager Express (CME) version 8.0 or later is required.

• CCA currently supports only the Normal and Share line types on the User 

and Phone profiles.

• The maximum number of EM users allowed is equal to the three times the 

number of phone licenses for the UC500 platform that the customer has 

(3 work shifts).

• If you want an EM user to also have a phone, assign the same number to the 

EM Profile and the user’s phone using a share line. Set up the mailbox for the 

share line as a Personal (Share) mailbox.

• Existing phone users cannot be automatically converted to Extension 

Mobility Users, and Extension Mobility Users cannot automatically be 

converted to regular phone users. You must manually delete the user from 

the Users and Extensions tab and re-create the user by creating a user 

profile on the Extension Mobility tab. The user’s existing voice mailbox will 

be deleted.

• No softkeys are provided for direct access to Extension Mobility on EM 

phones. EM users must go to the CME Services Menu on their phone and 

select the Extension Mobility menu item to log in and log out.

• A user profile can only be active on one phone at a time. When an EM user 

who is already logged on to one phone logs in to a different phone using the 

same profile, they are automatically logged out of the first phone.

• After-hours call blocking is not supported.

EM User Profile

The EM User Profile defines the phone buttons and speed dials the user will see 

when they are logged in to an EM-enabled phone.

If a personal mailbox is required for the user, you must enable the mailbox. A user 

ID, password, First Name, and Last Name are required when creating an EM User 

Profile.

To create or edit an EM User Profile, follow these steps.
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STEP 1 On the Extension Mobility tab in the Users and Phones window, select the User 

Profiles tab.

STEP 2 To create a new EM User Profile, click Add.

STEP 3 To edit an existing EM User Profile, locate the user in the profile list, click anywhere 

in the row to select that user’s profile, and click Edit.

STEP 4 Configure settings as described in Add Extension Mobility User Profile, 

page 330.

STEP 5 Click OK.

EM Phone Profile

The EM Phone Profile defines the button assignments and speed dial settings of 

an EM-enabled phone when there are no EM users logged in to the phone. Multiple 

phones can be associated with the same Phone profile.

To create or edit an EM Phone Profile, follow these steps.

STEP 1 On the Extension Mobility tab in the Users and Phones window, select the Phone 

Profiles tab.

STEP 2 To create a new EM Phone Profile, click Add.

STEP 3 To edit an existing EM Phone Profile, locate the phone in the profile list, click 

anywhere in the row to select that phone’s profile, and click Edit.

STEP 4 Configure settings as described in Add Extension Mobility Phone Profile, 

page 332.

STEP 5 Click OK.

Enabling EM on a Phone

To enable Extension Mobility on a phone, follow these steps.

STEP 1 On the User Extensions tab in the Users and Phones window, click on a phone in 

the list and click Edit or click Add to add new phone.

STEP 2 In the Extension Mobility section of the Add or Edit Phone Settings window, check 

the Enable Extension Mobility option.
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When you enable extension mobility on a phone:

• If this is a new phone, all of the user information and line assignment tabs are 

disabled.

• If a user is currently associated with the phone, all of their user information, 

phone button assignments, and speed dials are cleared and will be deleted 

when the change is applied.

• If the user currently associated with the phone has a personal voice mailbox, 

the mailbox is also deleted when the configuration is applied.

STEP 3 In the Select Phone Profile drop-down list, select the EM Phone Profile to 

associate with this phone.

When you select a Phone Profile, the User Information area of the window updates 

to display the user information that is currently configured for that phone profile.

STEP 4 Click OK.

General Settings

Configure global logout settings for all EM-enabled phones at your site as 

described below, then click OK.

Setting Description

Auto-logout Configure up to 3 auto-logout times, using a 24-hour format. 

These auto-logout settings apply to all EM-enabled phones.

At the specified auto-logout time, all sessions on all EM-enabled 

phones are logged out.

If a call is in progress at the auto-logout time, the user’s session 

is logged out after the call ends.

Clear call 

history after 

user logout

When this option is checked, the call history for the logged-in 

EM user is removed when the user logs out or auto-logout 

occurs.
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Add Extension Mobility User Profile

This window appears when you click Add or Edit from the User Profiles tab under 

Extension Mobility in the Users and Phones window. You can also double-click on 

an existing EM User Profile to open this window.

The EM User Profile defines the button assignments and speed dial settings that 

the EM user will see when they are logged in to an EM-enabled phone. Every EM 

user must have a profile. You can also choose to enable a personal mailbox for the 

EM user.

Configure a user profile as described below, then click OK.

Setting Description

Profile Settings

User ID

Password

Required. Enter the User ID and password for logging into 

EM-enabled phones.

Since the user will be entering the ID and password on the 

phone keypad to log in, it should be brief.

The same User ID and Password also define the login 

credential for accessing the CUE GUI.

First Name

Last Name

Required. The EM profile user first name and last name are 

also included in the directory and used for Auto Attendant 

Dial-By-Name service.

Auto Logout 

Timeout 

(minutes)

Enter the number of minutes of idle time you want to 

elapse before the profile user is automatically logged out.
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Enable Privacy 

Button

When the Enable Privacy Button option is checked, a 

Privacy button is placed on the phone. The Privacy button 

is used in conjunction with the Conference Barge (cBarge 

feature). 

The Privacy button is placed on the phone automatically 

by IOS according to the following rules:

• The Privacy button is assigned after the last line or 

feature button appearance and cannot be placed 

between line or feature buttons. 

For example, if buttons 1 and 2 are in use, then the 

Privacy button is assigned to button 3. If buttons 1, 

2, and 5 are in use, then the Privacy button is 

assigned to button 6, even through button 3 and 4 

are unused.

• If there are not enough buttons on the physical 

phone, the Privacy button will not appear on the 

phone.

Setting Description
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Add Extension Mobility Phone Profile

This window appears when you click Add or Edit from the Phone Profiles tab 

under Extension Mobility in the Users and Phones window.

The EM Phone Profile defines the phone buttons and speed dials the user will see 

when there are no EM users using the phone.

Details

Line Select the Line tab to assign buttons to this EM User 

Profile.

• To add or delete extension lines, specify the 

number of desired extensions into the Number of 

Extension Lines. You can add up to 69 extensions.

For each button:

• Choose a Button Type, either Normal or Share. 

See Normal Extension, page 339 and Share 

Extension, page 346 for information about 

configuring options for these button types.

• Specify the extension number or select a share 

extension.

• Enter a descriptive label for the button. This label 

appears on the phone.

• Optional. Check the Mailbox option to create a 

mailbox for this extension.

Speed Dials Select the Speed Dials tab to assign speed dials to this 

EM User Profile.

For more information, see Speed Dials, page 319.

Setting Description
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Configure a phone profile as described below, then click OK.

Setting Description

Profile Settings

User ID

Password

Optional. The User ID and Password are only required if a 

voice mailbox is enabled for this phone profile.

The same User ID and Password also define the login 

credential for accessing the CUE GUI.

First Name

Last Name

Optional. Phone user first name and last name are only 

required if a voice mailbox is enabled for this phone 

profile.

If defined, the EM profile user first name and last name are 

also included in the directory and used for Auto Attendant 

Dial-By-Name service.

Enable Privacy 

Button

The Privacy button is used in conjunction with the 

Conference Barge (cBarge feature).

The Privacy button is placed on the phone automatically 

by IOS according to the following rules:

• The Privacy button is assigned after the last line or 

feature button appearance and cannot be placed 

between line or feature buttons. 

For example, if buttons 1 and 2 are in use, then the 

Privacy button is assigned to button 3. If buttons 

1, 2, and 5 are in use, then the Privacy button is 

assigned to button 6, even through button 3 and 4 

are unused.

• If there are not enough buttons on the physical 

phone, the Privacy button will not appear on the 

phone.

The Privacy button in the Phone Profile can also be 

toggled at the Telephony > Voice Features > Conference 

Barge window after it is assigned to a phone.
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Analog Extensions

To access configuration settings for Analog Extensions, choose Configure > 

Telephony > Users and Extensions > Users and Phones and select the Analog 

Extensions tab.

The ports listed on the Analog Extensions tab are FXS ports that have been 

configured with the Common area Phone or Fax role from the Configure > 

Telephony > Ports and Trunks > FXS Ports window. These devices include 

legacy analog phones and FAX machines.

These notes apply when configuring analog extensions:

• In the Extension field, enter a unique extension.

• Advanced features such as voice mail, call forwarding, and so on, are not 

available on phones configured as analog extensions.

Details

Line Select the Line tab to set the number of extension lines 

and assign buttons to this EM phone profile.

• To add or delete extension lines, specify the 

number of desired extensions into the Number of 

Extension Lines field, then click OK. You can add 

up to 69 extension lines.

• For each button, choose a button type, enter or 

select an extension to assign, and enter a 

descriptive label for the button.

You can only add Normal and Share phone buttons. See 

Normal Extension, page 339 and Share Extension, 

page 346 for information about configuring the button 

section for these button types.

Speed Dials Select the Speed Dials tab to assign speed dials to this 

Phone Profile.

For more information, see Speed Dials, page 319.

Setting Description
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• To prevent the user from calling the restricted (blocked) numbers 

configured in the outgoing dial plan, check the Block Restricted Numbers 

check box.

• The Permissions settings specify the type of outgoing calls that can be 

placed from this phone. For more information, see Permissions, page 341.

After making changes in this window, click Save Settings apply the configuration.

FXS Gateway

To configure the FXS Gateway, you must configure both the UC500 and the 

gateway itself.

To configure the gateway on the UC500, see Configuring the FXS Gateway on 

the UC500, page 335.

To configure a SPA8000, see Configuring the SPA8000 Gateway, page 336.

To configure a SPA8800, see Configuring the SPA8800 Gateway, page 337.

Configuring the FXS Gateway on the UC500

To access configuration settings for User Extensions, choose Configure > 

Telephony > Users and Extensions > Users and Phones and select the User FXS 

Gateway tab.

NOTE Only one SPA8000 or SPA8800 gateway can be configured and connected to the 

UC500.

To configure the FXS Gateway, follow these steps.

STEP 1 Choose Configure > Telephony > Users and Extensions > Users and Phones 

and select the FXS Gateways tab.

STEP 2 Click Add and select your gateway.

STEP 3 Select your gateway and click Edit.

STEP 4 Configure settings as described below, then click OK.
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Configuring the SPA8000 Gateway

To complete the gateway configuration, you must log in to the SPA8000 Gateway 

and make the following changes.

STEP 1 Plug a computer into the AUX port of the SPA8000 Gateway.

STEP 2 Type http://192.168.0.1/advanced in a supported browser.

STEP 3 If a password has been assigned to the SPA8000, enter the User Name and 

Password. The default User Name is user. If a password has not been assigned, 

the next window will open.

Field Description

Gateway Information

MAC Address Enter the MAC address for this gateway.

Gateway Type From the pull down menu select the gateway type.

Authentication 

ID
Enter the authentication ID used by the UC500 for this device.

Password Password for this gateway.

Permissions From the pull down menu select the desired permission level.

Extension and Mailbox Assignment

Extension Enter the extension number.

Block 

Restricted 

Number

Click to enable restricted number blocking.

Voicemail Click to enable voicemail. If enabled, all four parameters 

below must be defined and each User ID must be unique.

User ID Optional voicemail input. Define User ID or leave blank.

First Name Optional voicemail input. Define first name or leave blank.

Last Name Optional voicemail input. Define last name or leave blank.

Password Optional voicemail input. Define password or leave blank.
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STEP 4 Click the Voice tab.

STEP 5 For each line (L1-L8), configure the settings as described below:

STEP 6 Save the settings.

STEP 7 Logout from the gateway.

Configuring the SPA8800 Gateway

To complete the gateway configuration, you must log in to the SPA8800 Gateway 

and make the following changes. Only one SPA8800 Gateway can be configured 

to the UC500.

Field Description

Proxy and Registration/

Proxy

Enter the UC500 IP address.

Proxy and Registration/

Voice Mail Server

Enter the IP address of the voice mail server.

Subsciber Information/

Display Name

Enter the display name that will be displayed 

on the phone.

Subsciber Information/

Password
Enter the password. This is the password that 

was entered in the Gateway Information table 

above.

Subsciber Information/

Auth ID

Enter the authentication ID. This is the 

authentication ID that was entered in the 

Gateway Information table above.

Subsciber Information/

User ID

Enter the phone number.

Subsciber Information/

Use Auth ID

Choose yes.

Call Forward Settings/

Cfwd No Ans Dest

Enter the voice mail number for this line.

Call Forward Settings/Cfwd 

Busy Dest

Enter the voice mail number for this line.



Users and Extensions
Users and Phones

338 Cisco Configuration Assistant SBCS Administrator Guide

11

STEP 1 Plug a computer into the AUX port of the SPA8800 Gateway.

STEP 2 Type http://192.168.0.1/advanced in a supported browser.

STEP 3 If a password has been assigned to the SPA8800, enter the User Name and 

Password. The default User Name is user. If a password has not been assigned, 

the next window will open.

STEP 4 Click the Voice tab.

STEP 5 For each line (Phone 1 - Phone 4), configure the settings as described below:

STEP 6 Logout from the gateway.

Field Description

Proxy and Registration/

Proxy

Enter the UC500 IP address.

Proxy and Registration/

Voice Mail Server

Enter the IP address of the voice mail server.

Subsciber Information/

Display Name

Enter the display name that will be displayed 

on the phone.

Subsciber Information/

Password
 Enter the password.

Subsciber Information/

Auth ID

Enter the authentication ID.

Subsciber Information/

User ID

Enter the phone number.

Subsciber Information/

Use Auth ID

Choose yes.

Call Forward Settings/

Cfwd No Ans Dest

Enter the voice mail number for this line.

Call Forward Settings/Cfwd 

Busy Dest

Enter the voice mail number for this line.
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Configuring Phone Button Assignments

For information on the types of buttons that can be configured on the phone and 

detailed information about Button <#> settings (where <#> stands for button 

number), see the following sections:

• Normal Extension, page 339

• Share Extension, page 346

• Setting Up GDM or Personal (Share) Mailbox for Shared Extensions, 

page 347

• Monitor, page 348

• Watch, page 348

• CO Line, page 349

• Overlay Extension, page 350

• Intercom, page 351

• Dialable Intercom, page 352

• Whisper Intercom, page 354

• Octal Lines, page 357

Normal Extension

When you configure a phone button as a Normal extension, a single extension is 

assigned to the button.

To configure Button <#> section for a Normal extension button, follow these steps.

STEP 1 Choose Configure > Telephony > Users and Extensions > Users and Phones 

and select the User Extensions tab.

STEP 2 Click on a phone in the list to select it, then click the Edit button to displays its 

configuration details.

STEP 3 Select the Button Assignments tab.

STEP 4 Choose a button number.

STEP 5 In the Button <#> section, configure settings for the extension as described 

below.
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Field Description

Button Type Using the pull-down menu, set to Normal.

Parameters Tab

Extension Enter the desired extension number for this line.

Button Label Enter the desired label for this button.

Description Specify a description for this phone. This description is 

displayed in the top right corner on the phone.

Valid characters in this field are alpha-numeric characters (A-Z, 

a-z, 0-9, spaces, period (.), underscore (_), and minus (-) sign.

For example, your customer may require the full Direct Inward 

Dial (DID) phone number to be displayed on phones. You can 

edit this description field so that it displays the DID number, for 

example, 555 555-5555.

Dual Line or 

Octal Line

Line type, either dual or octal. This selection applies only to 

Normal button and Share button types. The default value is 

Octal Line, if the phone supports this feature.

An octal line directory number supports up to eight active calls, 

both incoming and outgoing, on a single phone button. The 

Octal is not available for phones that do not support this 

feature. Octal lines are only available if the UC500 is running 

Cisco IOS version 12.4(20)T or later, and the Cisco UC500 

software pack version is 7.0(2) or later. For more information, 

see Octal Lines, page 357.

A shared octal-line extension is required for enabling the 

Conference Barge (cBarge) feature. See Conference Barge, 

page 403.

Enable 

Voicemail

Click to enable (checked) or disable (unchecked).

When the Mailbox option for a Normal line is checked, a 

personal mailbox is created for this extension. Only one 

personal mailbox can be created per user.

The mailbox and its contents are not deleted when you re-

associate the mailbox to a different extension.
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Block 

Restricted 

Numbers

To prevent the user from calling the restricted (blocked) 

numbers configured in the outgoing dial plan, check the Block 

Restricted Numbers check box.

Permissions This setting specifies the type of outgoing calls that can be 

placed from this phone. Permission levels are defined in the 

outgoing dial plan (Configure > Telephony > Dialplan > 

Outgoing Dial Plan, and select the Outgoing Call Handling tab). 

Choose one of the following:

• Unrestricted. Can place outgoing calls to the PSTN 

without any restrictions.

• Internal. Can place outgoing calls only by dialing 

internal and emergency numbers. Restricted from 

placing all other calls.

• Local. Can place outgoing calls only by dialing local, 

internal, and emergency numbers. Restricted from 

placing local plus, domestic long distance, or 

international calls.

• Local plus. Can place outgoing calls by dialing local, 

internal, and emergency numbers plus additional local 

numbers as defined in the outgoing dial plan.

• National. Can place outgoing calls only by dialing 

national long distance, local, internal, and emergency 

numbers. Restricted from placing national plus numbers 

and international calls.

• National plus. Can place outgoing calls only by dialing 

national long distance, local, internal, and emergency 

numbers, plus additional numbers as defined in the 

outgoing dial plan. Restricted from placing international 

calls.

• International. Can place outgoing calls by dialing 

internal, local, national long distance, emergency, and 

international numbers.

Field Description
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Call Forward 

Busy

Transfer calls to this extension when this line is busy. Click in 

the field and enter an extension to change the setting.

If the Voicemail check box is checked when Call Forward Busy 

is empty then Call Forward Busy is defaulted to Voicemail’s 

extension number.

Call Forward 

No Answer

Transfer incoming calls to this extension if there is no answer. 

Click in the field and enter an extension to change the setting.

If the Voicemail check box is checked when Call Forward No 

Answer is empty then Call Forward No Answer is defaulted to 

the Voicemail’s extension number.

CFNA 

Timeout, 

seconds

Number of seconds before unanswered calls are transferred to 

the Call Forward No Answer destination. The default is 

20 seconds.

IMPORTANT If this extension is a member of a Call Blast 

Group, the CFNA Timeout value you set here must be greater 

than the Timeout value configured for the Call Blast Group. For 

example, if the Timeout value for the Call Blast Group that the 

extension belongs to is 10 seconds, set the CFNA timeout for 

the extension to at least 11 seconds. Alternatively, you can 

lower the Timeout value for the Call Blast Group. See Call Blast 

Groups, page 385.

PSTN 

Number

Read-only field that displays the PSTN number that is mapped 

to this extension in the incoming dial plan, if configured.

To map DID numbers to internal extensions, choose Configure 

> Telephony > Dial Plan > Incoming, select the Direct Dialing 

tab, and configure settings under Direct Dial to Internal 

Extensions.

Field Description
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Call Hold Alert Tab

The Call Hold Alert feature enables you to set up an audible, repeating alert tone 

to notify the user when a call is placed on hold on a Cisco IP phone.

Call Hold 

Alert

Choose one of following settings to specify when Call Hold 

alert tones are played.

• None. Alerts are disabled. This is the default setting.

• When Idle. Alerts are played only when the phone is 

idle.

• When Idle or Busy. Alerts are played when the phone is 

busy or idle.

• When Idle or Alert Shared. Alerts are played only when 

the extension is idle. Alerts are played on all phones that 

share this extension.

Timeout Number of seconds between audible alert notifications. Enter a 

value from 15 to 300.

For example, if this value is set to 25 seconds, the call hold 

alert tone is played once every 25 seconds.

Field Description
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Ring Parameters Tab

Ring Type Choose one of following settings:

• Normal Ring - default

For incoming calls on this extension, the phone 

produces audible ringing, a flashing icon in the phone 

display, and a flashing red light on the handset. On the 

Cisco IP Phone 7914 Expansion Module, a flashing 

yellow light also accompanies incoming calls.

• Call-Waiting Beep No Ring

Audible ring is suppressed for incoming calls, but call-

waiting beeps are allowed during active calls. Visible 

cues are the same as those described for a normal ring.

• Feature Ring

Differentiates incoming calls, on a special line, from 

incoming calls on other lines of the phone. The feature-

ring cadence is a triple pulse; as opposed to a single 

pulse for normal internal calls, and a double pulse for 

normal external calls.

• Silent Ring

Audible ring and call-waiting beep are suppressed for 

incoming calls. The only visible cue is a flashing (< icon  

in the phone display).

NOTE: Analog and ATA Phone do not support Ring Type.

NOTE: If you select Call-Waiting Beep No Ring and Silent 

Ring then Distinctive ring type option should be disabled. See 

Distinctive Ring, page 345.

Field Description
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STEP 6 Click OK.

Distinctive 

Ring

Distinctive ring is used to identify internal and external 

incoming calls. An internal call is defined as a call originating 

from any Cisco Unified IP phone that is registered in Cisco 

Unified CME or is routed through the local FXS port.

Choose one of following settings:

• None - default

• Internal

• External

• Feature

Call Waiting Choose one of following settings to specify call-waiting 

notification:

• System Default - default

• No Call-Waiting Beep

• Call-Waiting Ring

HuntStop 

Channel - 

Dual Line

Entering huntstop channel tells the router to stop hunting for 

other matches with one channel of the ephone-dn.

Choose one of following settings:

• Enable - default for the Share Line

If enable is selected the channel combo box is 

displayed.

• None - default for the Normal Line

If set to None, the channel combo box is hidden.

Channel* (1 through 8)

NOTE*: This window is only visible for Octal Line.

Default is Channel 8.

Field Description
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Share Extension

You can set up a shared extension and add a button for the shared extension to 

multiple phones so that incoming calls to that extension ring all the phones with a 

button for the share extension.

For information about creating voice mailboxes for shared extensions, see Setting 

Up GDM or Personal (Share) Mailbox for Shared Extensions, page 347.

To set up a shared extension, follow these steps.

STEP 1 Set up phones and users, as described in Adding a Phone, page 311.

STEP 2 Choose Configure > Telephony > Users and Extensions > Users and Phones, to 

open the Users and Phones window, then select the User Extensions tab.

STEP 3 Click on a phone to select it, then click the Edit button at the bottom of the window 

to display its details.

STEP 4 Click the Button Assignments tab.

STEP 5 Choose a button number in the table and set its type to Share.

STEP 6 In the Extension field for that phone button, enter or choose the extension to use 

for the share line.

• To create a new shared extension, enter unique extension number to use for 

the shared extension.

• To put an existing shared extension on the selected phone button, choose 

an extension from the drop-down list.

• If you selected Button 1 on the phone for the shared extension, only shared 

extensions on Button 1 of other phones are listed in the drop-down list.

• If you selected a button other than Button 1, only shared extensions that are 

not on Button 1 appear in the drop-down list.

STEP 7 If this is a new shared extension, configure the Button <#> section for the share 

line, as described in the section Normal Extension, page 339.

Voice mail boxes are treated a little differently for shared extensions. For more 

information, see Setting Up GDM or Personal (Share) Mailbox for Shared 

Extensions, page 347.

STEP 8 In the Share Name field, enter the name to use for this shared extension. A name is 

required if the shared extension is on a non-primary button. 
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NOTE: The Share Name field is disabled if the shared extension is placed on 

Button 1 of the phone. For shared extensions placed on Button 1, user information 

is pre-populated from the user for which the shared extension was initially created 

(except for the User ID and password, which must be unique per phone).

STEP 9 Click OK when you are finished.

STEP 10 Place calls to the share extension to verify that the extensions are shared on 

phones as expected.

Setting Up GDM or Personal (Share) Mailbox for Shared Extensions

When you enable voice mail for a shared extension, the type of mailbox that is 

created by default is different between shared extensions that are placed on 

Button 1 of a phone than for the other buttons on the phone:

• If Enable Voicemail is checked for a shared extension on Button 1 of a 

phone, a Personal (Share) mailbox is created by default. This functionality is 

provided for cases in which a single user has multiple phones but wants a 

single personal mailbox that they can access from all of their phones. 

If, for some reason, the user with multiple phones does not want to use 

Button 1 for this, it is possible to create the shared extension on a different 

button, then go to the Mailboxes tab on the Voicemail window, change the 

GDM mailbox to a Personal (Share) mailbox, and select the desired User ID 

from the drop-down list. Only users with this shared extension that do not 

currently have an enabled Personal voice mailbox will be listed. After you 

change the mailbox type to Personal and choose a user, CCA removes the 

GDM mailbox and creates a Personal (Share) mailbox for the shared 

extension using the specified user ID.

Alternatively, you could first define a Normal extension for the user and 

assign a Personal mailbox to it, then redefine the same extension as a shared 

extension using the same extension number an enable the voice mailbox. 

CCA will retain the Person mailbox and re-associate it with the shared 

extension.

• If Enable Voicemail is checked for a shared extension on any other button, a 

GDM (group mailbox) is created by default. When assigning a GDM to a 

shared extension on a phone, the user should also have a personal mailbox 

assigned in order to access the GDM using their own Personal voice mail 

PIN. 
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When you add the shared extension to other phones, be sure to enable the 

mailbox for the extension if you want the user to be able to access the GDM 

mailbox.

Monitor

A Monitor button monitors only the specified extension.

The line status indicates whether the line is either idle or in use. A receptionist can 

use Monitor buttons to visually monitor the in-use status of phone extensions.

To configure a Monitor button, follow these steps.

STEP 1 Choose Configure > Telephony > Users and Extensions > Users and Phones 

and select the User Extensions tab.

STEP 2 Click on a phone in the list to select it, then click the Edit button to displays its 

configuration details.

STEP 3 Select the Button Assignments tab.

STEP 4 Choose a button number and set its Type to Monitor.

STEP 5 In the Button <#> area for this button, select the extension to be monitored from 

the drop-down list. Call Park extensions are included in the list of extensions that 

can be monitored.

The label of the monitored extension is automatically inserted in the Label field for 

the Monitor button.

STEP 6 Click OK.

Watch

A Watch button allows a user to watch all lines on the phone with the specified 

extension.

The line status indicator on the Watch button lights Red when any line on the 

watched phone is in use, out-of-service, or in Do Not Disturb mode.

The phone user can press the Watch button to speed-dial the watched extension. 

Other calls cannot be made or received using a line button that is in watch mode. 

Incoming calls on a line button that is in watch mode do not ring and do not display 

caller ID or call-waiting caller ID.

To configure a watch button, follow these steps.
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STEP 1 Choose Configure > Telephony > Users and Extensions > Users and Phones 

and select the User Extensions tab.

STEP 2 Click on a phone in the list to select it, then click the Edit button to displays its 

configuration details.

STEP 3 Select the Button Assignments tab.

STEP 4 Choose a button number and set its Type to Watch.

STEP 5 In the Button <#> area for this button, select the extension to be watched from the 

drop-down list.

The label of the watched extension is automatically inserted in the Label field for 

the Watch button.

STEP 6 Click OK.

CO Line

Choose CO Line if you want to assign a Central Office line (direct trunk line) to this 

button. You cannot assign a mailbox to a CO Line button.

To configure a CO Line button, follow these steps.

STEP 1 Choose Configure > Telephony > Users and Extension > Users and Phones and 

select the User Extensions tab.

STEP 2 Click on a phone in the list to select it, then click the Edit button to displays its 

configuration details.

STEP 3 Select the Button Assignments tab.

STEP 4 Choose a button number.

STEP 5 In the Type drop-down menu for the selected button, choose CO Line, for 

example, CO 1 (0/1/0).

These correspond to direct PSTN trunk lines connected to FXO ports. Edit the 

Label as needed to identify the CO line.

STEP 6 In the Button <#> area for this button, select the trunk line to use for the CO Line 

from the drop-down list.
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STEP 7 Click OK.

Overlay Extension

A normal Overlay extension enables multiple lines (up to 25) to share a single 

button on a multi-button phone. Overlay extensions require at least two available 

normal, share, or CO line extensions.

CCA also supports Overlay configuration on a CO (Central Office) line. This 

configuration allows a CO Line to share a button with a regular extension. The user 

can answer calls on that CO Line and see the state of the line, but can still make 

and receive calls using their regular extension. This functionality is most useful 

phones with a limited number of buttons.

NOTE: Octal lines do not support Overlay. This means that extensions that are 

configured for features such as Conferencing or Conference Barge (cBarge) 

cannot be overlaid.

To configure an Overlay button, follow these steps.

STEP 1 Choose Configure > Telephony > Users and Extensions > Users and Phones 

and select the User Extensions tab.

STEP 2 Click on a phone in the list to select it, then click the Edit button to displays its 

configuration details.

STEP 3 Select the Button Assignments tab.

STEP 4 Choose a button number and set its Type to Overlay.

STEP 5 In the Button <#> area for this button, select the extension to use for the Overlay 

from the drop-down list.

STEP 6 In the Button <#> area, configure these settings.

a. Choose whether to enable or disable call waiting for this overlay extension. 

When the Enable Call Waiting option is checked, call waiting is enabled on the 

overlay extension. 

With call waiting enabled, if the Overlay extension is in use and a second call 

comes in on the Overlay extension, the call waiting tone is played and the call is 

displayed on the IP phone screen.

b. Use the Add, Remove, Select All and Select None buttons to move share 

extensions from the Available Extensions list to the Selected Extensions list. 
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You must choose at least two extensions for the Overlay button. Normal, Share, 

and CO line extensions appear in the Available Extensions list.

c. Use the Up and Down arrows to re-order the extensions in the Selected 

Extensions list.

d. Optional. In the Overlay Button Label field, enter a descriptive name for this 

extension to display on the phone.

By default, the label for the first extension number on the Selected list is used 

for the overlay button label. When you edit the Overlay Button Label, the label 

for the first extension number is also changed.

STEP 7 Click OK.

Intercom

An Intercom button is a push-to-talk, single-button intercom line between two IP 

phones.

• Multiple intercoms can be configured on one phone.

• Button 1 cannot be configured as an intercom.

To configure an Intercom button, follow these steps.

STEP 1 Choose Configure > Telephony > Users and Extensions > Users and Phones 

and select the User Extensions tab.

STEP 2 Click on a phone in the list to select it, then click the Edit button to displays its 

configuration details.

STEP 3 Select the Button Assignments tab.

STEP 4 Choose a button number and set its Type to Intercom.

STEP 5 In the Button <#> area for this button, configure these settings.

a. From the Target Intercom Button User drop-down list, choose a target user. 

The intercom button is placed on this user’s phone.

b. From the Target Intercom Button Number drop-down list, choose an available 

button on the target user’s phone to use for the intercom.
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c. In the Label for the Target User field, enter the text you want to display on the 

target user’s phone desktop next to this Intercom button.

When the Intercom button is pressed on this user’s phone, this label text is 

displayed in the From: field of the calling information displayed on the target 

user’s phone.

d. In the Label for the Current User field, enter the text you want to display on 

this user’s phone desktop for this Intercom button. 

When the Intercom button is pressed, this text is displayed in the To: field of the 

calling information on this user’s phone.

STEP 6 Choose whether to enable or disable Mute for this Intercom.

When the With Mute option is enabled (checked), the recipient of the intercom 

must deactivate mute by pressing the Mute button on their phone or lift the 

handset to respond to the intercom.

When the WIth Mute option is disabled (unchecked), both parties hear each other 

when the call is connected.

STEP 7 Click OK.

Dialable Intercom

For information about Dialable Intercoms, see these sections:

• Feature Description, page 352

• Unsupported Phones, page 353

• Configuration Steps, page 353

Feature Description

Intercom button that allows a phone user to intercom any other phone on the 

system that also has a dialable intercom button by pressing the intercom button 

and dialing the extension they want to intercom.

Unlike normal Intercoms and Whisper Intercoms, which are always configured 

between two specific phones, phone users can intercom other phones by 

pressing the Intercom button on their phone and dialing a Dialable Intercom 

extension.
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Dialable intercoms are used by operators or administrative staff who provide 

support for many employees, as opposed to administrative assistants who are 

generally responsible for one or two people and have specific intercom buttons on 

their phone for each person. When this feature is used, a Dialable Intercom button 

is usually configured on every user’s phone.

Only one dialable intercom button can be configured per phone.

CCA does not allow Dialable Intercoms to be configured on button 1 of a phone.

You can optionally configure the Dialable Intercom with or without Mute.

• When Mute is enabled for the intercom, the called phone automatically 

answers the call in speakerphone mode with Mute activated. The phone 

beeps when the Intercom call is auto-answered to alert the recipient to the 

incoming intercom call. 

To respond to the intercom call and enable two-way audio, the recipient 

deactivates the Mute function by pressing the Mute button on their phone 

or, on some phones, lifting the handset.

• When Mute is disabled, both the caller and the recipient immediately hear 

each other when the Intercom call is connected. 

The benefit of disabling Mute is that the recipient of the intercom call can 

speak and be heard without having to first deactivate the Mute function. 

However, nearby background sounds or conversations can be heard as 

soon as the intercom call is connected.

Unsupported Phones

Dialable Intercoms are not supported on these phones:

• Analog phones

• ATAs

Configuration Steps

To configure Dialable Intercom button, follow these steps:

STEP 1 Choose Configure > Telephony > Users and Extensions > Users and Phones 

and select the User Extensions tab.

STEP 2 Click on a phone in the list to select it, then click the Edit button to displays its 

configuration details.

STEP 3 Select the Button Assignments tab.
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STEP 4 In the button list, click on the number of the button you want to use for the Dialable 

Intercom.

Only one dialable intercom button can be configured per phone.

STEP 5 In the Type drop-down menu, choose Dialable Intercom.

STEP 6 In the Dialable Intercom options area to the right, configure these settings.

a. Choose an extension from the Dialing Digits drop-down menu. This is the 

extension that users on the system dial to intercom this phone. All normal 

extensions configured on the phone are listed.

b. Choose whether to enable or disable Mute for intercom calls.

When Mute is enabled, the called phone automatically answers the call in 

speakerphone mode with Mute activated, and the recipient must deactivate 

the Mute button in order to speak. When Mute is disabled, both of the parties 

on the Intercom call immediately hear each other.

STEP 7 Optional. In the Label column of the button list, edit the label for the Dialable 

Intercom button that is displayed on the phone. The default label is 

Dialable Intercom<Ext>.

STEP 8 Click OK.

Whisper Intercom

The Whisper Intercom allows an intercom call to a busy extension. The calling 

party can only be heard by the recipient. For more information, see these sections:

• Feature Description, page 354

• Requirements and Limitations, page 355

• Unsupported Phones, page 355

• Procedures, page 356

Feature Description

To place a Whisper Intercom call, the phone user presses the Whisper Intercom 

button on their phone.

• The phone receiving a Whisper Intercom call displays the extension and 

name of the party that initiated the intercom, and a zip-zip tone plays before 
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the called party hears the caller’s voice. The Whisper Intercom button lights 

Amber to indicate one-way audio.

• If the recipient of the Whisper Intercom wants to speak to the phone user 

who initiated the Whisper Intercom, they press the Whisper Intercom button 

on their phone, which will then light Green to indicate two-way audio.

• When the recipient of the Whisper Intercom presses the Whisper Intercom 

button to talk, the active call on their phone is automatically put on hold.

To end a Whisper Intercom call, the phone user presses the EndCall softkey.

Requirements and Limitations

The following requirements and limitations apply to Whisper Intercoms configured 

using CCA:

• Whisper Intercom requires Cisco Unified CME 7.1 or later and SCCP 12.0 or 

later on IP phones.

• Whisper Intercom requires CIPC 7.x or later on CIPC (Cisco IP 

Communicator) phones.

• A Whisper Intercom button can place calls only to another Whisper 

Intercom.

• Only one intercom call at a time (either incoming or outgoing) is allowed on 

a phone.

Unsupported Phones

Whisper Intercoms are only available on phones that support octal lines. Whisper 

Intercoms are not currently supported for these phones:

• Analog FXS phones

• ATAs

• Cisco Model 7931 IP phones with firmware versions prior to 8.5(3)

• Cisco Model 39xx IP phones

• Cisco Model CP-521 IP phones

• Cisco SPA500 Series and SPA300 Series IP phones

• Cisco Model 7902, 7905, 7906, 7910, 7911, and 7912 IP phones

• Cisco Model 7940 and 7960 IP phones
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Procedures

To configure a Whisper Intercom button, follow these steps.

STEP 1 Choose Configure > Telephony > Users and Extensions > Users and Phones 

and select the User Extensions tab.

STEP 2 Click on a phone in the list to select it, then click the Edit button to displays its 

configuration details.

STEP 3 Select the Button Assignments tab.

STEP 4 Choose a button number and set its Type to Whisper Intercom.

STEP 5 In the Button <#> area for this button, configure these settings.

a. From the Target Intercom Button User drop-down list, choose a target user. 

The Whisper Intercom button is placed on this user’s phone.

b. From the Whisper Intercom Button Number drop-down list, choose an 

available button on the target user’s phone to use for the Whisper Intercom.

c. In the Label for the Target User field, enter the text you want to display on the 

target user’s phone desktop next to this Whisper Intercom button.

When the Whisper Intercom button is pressed on this user’s phone, this label 

text is displayed in the From: field of the calling information displayed on the 

target user’s phone.

d. In the Label for the Current User field, enter the text you want to display on 

this user’s phone desktop for this Whisper Intercom button. 

When the Whisper Intercom button is pressed, this text is displayed in the To: 

field of the calling information on this user’s phone.

STEP 6 Click OK.
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Octal Lines

An Octal Line directory number supports up to eight active calls, both incoming 

and outgoing, on a single phone button: 

• Unlike a dual-line directory number, which is shared exclusively among 

phones (after a call is answered, that phone owns both channels of the dual-

line directory number), an octal line directory number can split its channels 

among other phones that share the directory number.

• All phones are allowed to initiate or receive calls on the idle channels of the 

shared octal line directory number. One octal line directory number can 

handle multiple calls. Multiple incoming calls to an octal line directory 

number ring simultaneously.

• After a phone answers a call, the ringing stops on that phone and the 

call-waiting tone plays for the other incoming calls.

• When phones share an octal line directory number, incoming calls ring on 

phones without active calls and these phones can answer any of the ringing 

calls. Phones with an active call hear the call-waiting tone.

• After a connected call on an octal line directory number is put on hold, any 

phone that shares this directory number can pick up the held call. If a phone 

user is in the process of initiating a call transfer or creating a conference, the 

call is locked and other phones that share the octal line directory number 

cannot take the call.

• Missed calls (calls not answered) are not displayed by default.

• A shared octal-line extension is required for enabling the Conference Barge 

(cBarge) feature. For more information, see Conference Barge, page 403.

The following limitations apply to octal lines:

• Octal lines do not support Overlay. This means that extensions that are 

configured for features such as Conferencing or Conference Barge (cBarge) 

cannot be overlaid.

• Octal lines are only available if the Cisco IOS version on the UC500 is 

12.4(20)T or later, and the Cisco Unified Communications Manager Express 

(CUCME) version is 7.0 or later. Upgrading to the latest UC500 Software 

Pack is recommended.

• Not all Cisco IP phone models support octal lines.

• Cisco IP Phone Models 7920, 7902, 7931G, CP-52xG, CP-52xSG, and Cisco 

SPA500 Series IP phones do not support octal lines.
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• Cisco ATA and analog FXS ports do not support octal lines.

Voicemail and Notifications

The topics in this section provide instructions for configuring voicemail and 

notifications:

To configure Voicemail settings and mailbox options, choose Configure > 

Telephony > Users and Extensions > Voicemail from the feature bar. See the 

following topics for information on how to enable and configure voice mail 

features.

• Overview

• General Guidelines

• Setup

• Mailboxes

• Notifications

Overview

From the Voicemail window, you configure basic voice mail settings for the site, 

view and edit the amount of voicemail storage in minutes for each mailbox.

General Guidelines

The following guidelines apply to voice mailboxes and notifications:

• When adding users and phones through the Telephony Setup Wizard, voice 

mailboxes are created if the option to enable voice mail for the user is 

checked.

• Users can access their voice mail from any phone on the system by simply 

dialing the voice mail extension or voice mail PSTN access number. They are 

prompted to enter their voice mail PIN in order to access the mailbox. The 

default PIN for voice mail access is 1234. Users accessing voice mail for the 

first time are prompted to change their PIN.

• When adding users through the expert mode UI or .xml file upload, Personal 

mailboxes are initially created on the system for users when Call Forward 

Busy or Call Forward No Answer settings for any Normal extension are 
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configured to go to voice mail. These settings are configured on the User 

Extensions tab in the Edit Phone window (Configure > Telephony > Users 

and Extensions > Users and Phones > Edit Phone).

• The default setting for both Call Forward Busy and Call Forward No 

Answer is Voicemail. This means that if you add a user and do not modify 

both of these settings when the user is added, a voice mailbox is 

automatically created for that user. You can disable the voice mailbox later 

from the User Extensions tab in the Edit Phone window (Configure > 

Telephony > Users and Extensions > Users and Phones > Edit Phone).

• When you change an existing user’s Call Forward Busy and Call Forward 

No Answer setting from Voicemail to a different option, the user’s mailbox 

remains on the system. If you no longer want that user to have a voice 

mailbox, you must disable it manually from the User Extensions tab in the Edit 

Phone window (Configure > Telephony > Users and Extensions > Users 

and Phones > Edit Phone).

• One personal mailbox can be created per user and it can be associated with 

any one of the Normal extensions configured for the user or a Personal 

(Share) extension.

• General Delivery Mailboxes (GDMs) are created for shared extensions, hunt 

groups, and call blast groups when No Answer Forward To is set to 

Voicemail for the group or share extension. You can also choose to create a 

Personal (Share) mailbox for shared extension.

TIP: The Dashboard view (Home > Dashboard) provides a Voicemail Status 

item that displays a summary of system and per-mailbox voice mail storage usage, 

per-mailbox information, and status.

Setup

On the Setup tab, you configure these basic voice mail settings for a site:

• Voicemail access extension and PSTN number

• Prefix for direct transfer to voice mail

• Global site settings to enable notification of incoming voice mail messages 

via email and/or phone

• Enable VoiceView Express and LiveReply features for the site
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To configure system voice mail settings, complete the fields on the Setup tab as 

described below, then click OK.

Setting Description

Access Numbers

The Voicemail setup supports two pairs of Voicemail Access Extension and 

PSTN Numbers. The first pair, on top, is the primary and the second pair, on the 

bottom, is the secondary. 

As the voicemail language is changed at the Region UI, the language title shown 

above the primary and secondary Access Numbers is updated accordingly. 

The second set of Access Numbers is only shown when two languages are 

installed in the CUE.

Primary:

Voicemail 

Access 

Extension

Internal extension number for voicemail access. The default 

Voicemail Access Extension is 399.

The primary Access Numbers are always associated with 

the system’s preferred language and is mandatory.

Primary:

Voicemail 

Access PSTN 

Number

Optional. External PSTN number for voicemail access. This 

must be a full E.164 number. This is the number that external 

callers dial to reach voice mail.

The Voicemail Access PSTN Number can begin with a “+” 

character.

Secondary:

Voicemail 

Access 

Extension

Optional. Internal extension number for voicemail access. 

The Voicemail Access Extension should be assigned a 

unique extension number in the system.

The secondary Access Numbers define the access 

numbers for the remaining language and is optional.

Secondary:

Voicemail 

Access PSTN 

Number

Optional. External PSTN number for voicemail access. This 

must be a full E.164 number. This is the number that external 

callers dial to reach voice mail.

The Voicemail Access PSTN Number can begin with a “+” 

character.



Users and Extensions

Voicemail and Notifications

Cisco Configuration Assistant SBCS Administrator Guide 361

11
 

Voicemail Operator

For Transfer Operator, there is a Voicemail Operator Number field for defining 

the operator number.  The operator number is an optional E.164 number.  If 

missing, the caller call-flow Transfer-Operator key will behave like an Ignore 

key.

Operator 

Number

This operator field is only shown when zero-out option is 

supported (CUE Version 8.0 and later).

Voicemail Features

VoiceView 

Express

VoiceView Express allows phone users to interact with 

their Cisco Unity Express voice mailbox using their Cisco IP 

Phone display and softkeys on the phone.

Users can manage personal mailbox options, manage 

notifications, send, listen to, record, and manage voicemail 

messages. The feature provides an alternative to the 

Telephony User Interface (TUI) and web interface for these 

tasks. By default, this feature is enabled.

Live Reply Live Reply enables Cisco Unity Express voice mail users 

who listen to voice mail messages by phone or Voice View 

Express to reply to another user’s message by pressing 

4-4.

When Live Reply is invoked, Cisco Unity Express attempts 

to establish a call between the two parties. If the attempt is 

successful, the voice mail user is connected to the called 

party or the voice call is forwarded based on rules defined 

by the called party.

After the call is ended, the initial connection to voice mail is 

disconnected. The voice mail user is not returned to their 

voicemail session. To review other voice mail messages 

after a successful live-reply session, the user must re-dial 

the voice mail access number. By default, this feature is 

disabled.

Setting Description
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Play Caller ID for 

Incoming 

Messages

Enables or disables playing of spoken Caller ID for 

incoming voicemail messages.

When Play Caller ID for Incoming Messages is enabled 

and an incoming voicemail message is received, 

depending on whether the incoming call is from an internal 

or external number:

• Internal calls. If the caller ID information matches an 

entry in the local directory, the system plays the 

spoken caller name from the local directory when the 

recipient listens to that message. This feature is 

always on for internal calls regardless of the Play 

Caller ID for Incoming Messages setting.

• External calls. If the caller ID information does not 

match an entry in the local directory, the system plays 

the sender's telephone number when the recipient 

listens to that message.

For external calls, the system does not verify that the 

caller ID information is valid. That function depends 

on the Central Office (CO) and the incoming trunk 

setup.

An external call is one that is from any telephone 

number that is not listed in the local user directory. 

Possible sources of external calls are the local 

telephone company, an IP telephone, or a H.323 

gateway. These sources must be configured to 

present caller ID information to the voice mail system.

NOTE: SIP endpoints are not supported on H.323 

trunks. SIP endpoints are supported on SIP trunks 

only.

Setting Description
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Direct Transfer

Enable Direct 

Transfer to 

Voicemail

Check this option to enable Direct Transfer to Voicemail 

and specify a Voicemail Transfer Prefix.

The Voicemail Transfer Prefix can be a number from 

1 through 9. The default value is 6. The prefix is used by the 

Auto Attendant and by phone users who do not have 

softkeys for transferring calls to voice mail on their phone. 

The prefix cannot be the same as the PSTN access code 

for external calling or the first digit of an internal extension.

When this feature is enabled, the Auto Attendant is updated 

to include an option for direct transfer to voice mail.

When you enable or disable Direct Transfer to Voicemail, 

IP phones are restarted and softkeys are added or 

removed.

When Direct Transfer to Voicemail is enabled, IP phone 

users with the TrnsferVM softkey on their phones can 

transfer a call directly to a user or group voice mail box by 

following these steps:

1. Press the TrnsferVM softkey on their phone.

2. Enter the user or group voice mail extension.

3. Press the TrnsferVM softkey again to make the transfer.

Phone users without a voicemail transfer softkey can 

transfer a call to voicemail by following these steps:

1. Press the Trnsfer softkey.

2. Enter the voice mail transfer prefix, followed by the user's 
extension. 

For example, if the voice mail transfer prefix is 6 and you 
want to transfer to voice mail for extension 201, you 
would press Trnsfer, followed by 6201.

Setting Description
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Voicemail Notification

Enable and configure global site settings for voice mail notifications.

Enable 

Voicemail 

Notification

Voice mail message notification is disabled by default.

You must check the Enable Voicemail Notification option 

before you can configure site settings for email and phone 

notifications or enable notifications for your users.

Disabling voice mail notifications. If voice mail notifications 

are currently enabled and you uncheck this option, the CCA 

will reset the notification settings.

Notification 

Schedule

Choose when the system will send the notification:

• Click 8 AM to 5 PM Monday to Friday

Or

• Click 24 Hours a day 7 days a week.

Email 

Notification

Configure these settings to enable and configure voice mail 

notifications via email.

• Check the Enable Email Notification option to 

enable voice mail notifications via email for the site.

• In the Outgoing Email Reply-To Address: field, enter 

the email address that will appear in the From: field 

for email notifications sent from the voice mail 

system.

• In the SMTP Server Address field, enter the 

hostname or IP address of the SMTP server that the 

voice mail system will use to send the text 

notifications. In order to use a hostname for this 

setting, DNS must be enabled.

• Enter the SMTP Server Port number.

• If the SMTP server requires authentication, check 

the Require Authentication option and enter the 

username and password for the SMTP server.

Setting Description
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Mailboxes

From the mailboxes tab you can view storage and summary information for 

personal and group mailboxes.

Configure mailbox settings as described blow, then click OK after making 

changes.

Mailbox Popup Editor

You can access the popup editor by first selecting a row (single click) and then 

clicking the Edit button.

Action Management

Action Management allows you to customize how the call flow proceeds in 

response to keys pressed at the mailbox greeting for leaving a voicemail. For each 

mailbox, the system administrator can assign one of the following actions to the 

keys input by the caller:

Phone 

Notification

The Allow Notification Recipients to Access Mailbox 

Login option must be checked if you want to enable 

sending of voice mail message notifications to phones.

This option is disabled by default.

Field Description

Storage Available and used voice mail storage, in minutes, for the system.

Summary Summary information for each voice mailbox.

Name (User ID) Phone user ID, group ID (for example, hunt1 

or blast1), or Share Line, for the selected 

mailbox.

Extension User extension, hunt or call blast group pilot 

extension, or share line extension for the 

selected mailbox.

Mailbox Mailbox status, either Enabled or None.

Size Mailbox size, in minutes.

Setting Description
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• Ignore the input

• Skip the greeting

• Repeat the greeting

• Transfer the call to another number

• Connect to the operator

• Play good-bye

• Proceed with subscriber sign-in

These actions can be assigned only to single digit input by the user, such as the 

numbers zero through nine (0 - 9), the asterisk (*), or the pound sign (#).   The 

mailbox greeting can then be customized to announce the key-actions.

NOTE: The multi-key zero-out option is available since CUE 7.0 is released. 

Previously, it was a single button (key zero) feature and is configured using 

different CLI. CCA will only support this feature for CUE starting from version 8.0.

Notifications

If voice mail notifications are enabled and configured for this site, the options on 

the Notifications tab allow you to select extension that have a voice mail box and 

configure settings for email and phone notifications.

Voice mail and fax message notifications can be sent to a phone (for example, the 

user’s home phone, cell phone, or other work number) or to their email inbox.

For each user, you can:

• Choose whether to enable notifications via phone, email, or both.

• Choose whether voice messages and faxes are attached to notification 

emails (faxes are attached as .TIFF-format files).

• Specify a separate notification level for phone and email notifications. You 

can choose whether to send notifications for all voice mail messages or 

only for messages marked Urgent by the sender. The Urgent option applies 

only to voice mails, not to faxes.

The following voice mail notification features are not supported by CCA:

• Notification schedule

• Notification message prefix and suffix text

• Connection timeout
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Field Description

Mailbox 

Parameters 

of

View or edit mailbox settings for the selected voice mailbox.

Extension If this is a personal mailbox, this field 

displays the user extension associated with 

this mailbox.

Type Personal or GDM (General Delivery Mailbox). 

You can change a GDM mailbox that is 

created for a shared extension to a Personal 

(Share) mailbox by changing the Type to 

Personal and choosing a user from the drop-

down list. Only users with the shared 

extension that do not currently have an 

enabled Personal voice mailbox are listed.

A Personal (Share) mailbox cannot be 

changed to a GDM mailbox. If the mailbox 

Type for a shared extension is Personal 

(Share), the only way to change it to a GDM is 

to delete the user associated with the 

Personal (Share) mailbox, apply the 

configuration, and then re-create the user.

Size View or edit the amount of storage allocated 

to this mailbox, from 4 to 90 minutes. The 

default is 12 minutes.

UserID Phone user ID, group ID (for example, hunt1 

or blast1), or Share Line, for the selected 

mailbox.

Voicemail 

Language

Choose the desired bilingual voicemail 

language from the drop-down menu.

Mailbox call flow 

key assignment

Contains the table for defining the key-action 

behavior for the zero-out feature.

Seven possible modes are supported:

• Ignore

• Skip Greeting

• Repeat Greeting
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• Restriction table for specifying the phone numbers that voice mail users can 

use for sending message notifications

• Cascading message notification

To add voice mail notification users or edit notification settings for existing users, 

follow these steps.

STEP 1 Choose Configure > Telephony > Users and Extensions > Voicemail and select 

the Notifications tab.

STEP 2 If you are adding a new user and extension, click Add.

STEP 3 To edit settings for an existing user and extension, select a user from the list and 

click Edit.

STEP 4 Configure settings as described in Add or Edit Notification User, page 368.

STEP 5 Click OK.

Add or Edit Notification User

The Add/Edit Notification User dialog appears when you click Add or Edit from 

the Notification tab in the Voicemail window (Configure > Telephony > Users and 

Extensions > Voicemail).

To configure settings for voice mail notification via email and phone for an 

extension, configure described below, then click OK.

Mailbox 

Parameters 

of 

(continued)

Mailbox call flow 

key assignment 

(continued)

• Transfer To

• Play Good-bye

• Subscriber Sign-In

• Transfer Operator

NOTE: This operator field is only shown 

when CUE Version 8.0 or later is used. 

Please see Operator Number, page 361

Field Description
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Setting Description

Extension Choose an available extension from the drop-

down list. Only extensions that have a voice 

mailbox are listed. These can be personal voice 

mailboxes or group (GDM) mailboxes.

Username (read-only) When you choose an extension, the user’s first 

and last name and their user ID appears here. If it 

is a share extensions, Share Line is displayed 

here.

Email Notification

Configure voice mail and fax notifications via email for the voice mailbox 

associated with this extension.

Notify User of New 

Voicemail via Email

When this option is checked, notification of new 

voice mail messages or faxes via email is 

enabled for this user.

Email Address Enter the email address to which notifications are 

sent. The email address can contain up to 129 

characters.

Attachment When the Attach Voicemail File to Email 

Message option is checked, the voice mail 

message or fax is attached to the notification 

email. Each voice mail message is attached as a 

.wav file. The .wav file format is G711 mu-law, 

8 kHz, 8-bit mono. Faxes are attached in .TIFF file 

format.

This setting is disabled by default. Private 

messages are never attached to notification 

e-mails.
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Notification Level Choose one of these notification levels:

• Urgent Voicemail Only (does not apply to 

faxes).

• All Voicemail. Choose this option if T.37 

Fax to Mail is configured for your system 

and you want users to be notified of 

incoming faxes via email with the fax 

attached to the email.

Phone Notification

Notify User of New 

Voicemail via Phone

When this option is checked, notification of new 

voice mail messages or faxes via phone is 

enabled for this user.

Phone Type Choose one of these phone types:

• Cell phone

• Home phone

• Work phone

Phone Number Enter the phone number to which the 

notifications will be sent.

When specifying an external number, be sure to 

include any access codes, if needed.

Extra Digits The system dials these digits when the outgoing 

call is answered. These digits are treated as 

DTMF digits. For example, extra digits may be 

used when sending calls to a pager or 

automated answering system.

You can specify up to 64 extra digits. Extra digits 

can consist of digits from 0 to 9, # (pound), 

asterisk (*), and plus sign (+).

Setting Description
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Single Number Reach (SNR) 

This window appears when you choose Configure > Telephony> Users and 

Extensions > Single Number Reach from the feature bar.

Single Number Reach (SNR) provides users with the ability to be reached on two 

numbers: a regular extension on their IP phone, and a PSTN number. BRI, PRI, FXO, 

and SIP interfaces are supported.

NOTE: For SNR numbers going over SIP trunks, the Caller ID may not reflect the 

Caller ID of the original caller, because the Caller ID is determined by the Internet 

Telephony Service Provider (ITSP). The Caller ID will usually be the station or the 

main PSTN number configured for SIP trunk. Most ITSPs require Caller IDs that are 

mapped explicitly to their accounts in order to prevent fraud. If the Caller ID for the 

original caller is not overridden with the Caller ID required by the ITSP, the call to 

the SNR number will fail.

• Overview

• Limitations

• SBCS Platform Requirements

• Configuration Procedures and Settings

Notification Level Choose one of these notification levels:

• Urgent Voicemail Only (does not apply to 

faxes).

• All Voicemail. Choose this option if T.37 

Fax to Mail is configured for your system 

and you want users to be notified of 

incoming faxes via email with the fax 

attached to the email.

Setting Description
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Overview

The Single Number Reach (SNR) feature allows phone users to answer incoming 

calls on their desktop IP phone or at a remote destination, such as a mobile phone, 

and to pick up in-progress calls on the desktop phone or the remote phone 

without losing the connection. This allows callers to use a single number to reach 

the phone user. Calls that are not answered can be forwarded to voice mail.

Remote destinations may include these devices:

• Mobile (cellular) phones

• Smart phones

• IP phones not belonging to the same Cisco Unified CME router as the 

desktop phone

• Home phone numbers in the PSTN

• Supported PSTN interfaces include PRI, BRI, SIP, and FXO.

For incoming calls to the SNR extension, Cisco Unified CME rings the desktop IP 

phone first. If the IP phone does not answer within the configured amount of time, 

it rings the configured remote number while continuing to ring the IP phone. 

Unanswered calls are sent to a configured voice mail number.

The IP phone user has these options for handling calls to the SNR extension:

• Pull back the call from the remote phone. Manually pull back the call to the 

SNR extension by pressing the Resume soft key, which disconnects the call 

from the remote phone.

• Send the call to the remote phone. Send the call to the remote phone by 

using the Mobility softkey. While connected to the call, the phone user can 

press the Mobility softkey and select “Send call to mobile.” The call is 

forwarded to the remote phone.

• Enable or disable Single Number Reach. While the IP phone is in the idle 

state, the user can toggle the SNR feature on and off by using the Mobility 

softkey. If the user disables SNR, the system does not ring the remote 

number.

IP phone users can modify their own SNR settings directly from the phone by 

using the menu available with the services feature button. You must enable the 

feature on the phone to allow a phone user to access the user interface.

Limitations

The following limitations apply to SNR configuration and features:
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• Each IP phone supports only one SNR number.

• Concurrent use of SNR and T.37 Fax Detection application is not supported.

• The SNR feature is not supported for the following:

- SCCP-controlled analog FXS phones

- Video calls

- SCCP phones that do not have softkeys. In some cases, SNR may be 

configured on these phones, but since there are no softkeys, the Mobility 

feature cannot be used.

For more information about the SNR feature and limitations, see the Cisco 

Communications Manager Express System Administrator Guide, available on 

Cisco.com at the following URL:

www.cisco.com/en/US/docs/voice_ip_comm/cucme/admin/configuration/guide/

cmeadm.html

SBCS Platform Requirements

This feature is supported on CME 7.1, available with UC500 software pack version 

7.1.1-EA or later.

Configuration Procedures and Settings

To enable SNR for one or more phone users or edit settings for SNR users, follow 

these steps.

STEP 1 Choose Configure > Telephony > Users and Extensions > Single Number 

Reach from the feature bar.

STEP 2 Click Add or Edit. The Add SNR User or Modify SNR User window appears.

STEP 3 Configure SNR user settings as described in the section Adding an SNR User, 

page 374 or the section Modifying an SNR User, page 375.

STEP 4 Click OK.

http://www.cisco.com/en/US/docs/voice_ip_comm/cucme/admin/configuration/guide/cmeadm.html
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Adding an SNR User

This window appears when you click Add from the Single Number Reach window.

To add an SNR user, follow these steps.

STEP 1 Configure these settings for each SNR user.

Setting Description

User Name Select a user from the drop-down list.

MAC Address Read-only. This field displays the MAC address of the 

phone associated with the user extension that you select 

when creating the SNR user.

Extension When you select a user, the drop-down menu lists 

available extensions on the user’s phone that can be used 

for SNR.

If the extension you choose is a share line, the text (Share 

Line) appears to the right of the extension.

Select the extension on the user’s phone to use for SNR. If 

the user selected already has SNR configured on an 

extension on their phone, a warning msg is displayed. 

Only one extension per phone can be configured for SNR.

Remote 

Destination

Enter or edit the phone number for the remote destination.

When entering the remote destination phone number, 

enter the number exactly as you would dial it, including 

any access codes, long distance dialing code, and any 

other required dialing digits.

Delay and Timeout Settings

Delay Before 

Dialing Remote 

Destination 

(seconds)

The delay specifies the number of seconds that the call 

rings the IP phone before ringing the remote phone. Enter 

a number from 1 to 10 seconds. The default value is 

5 seconds.
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STEP 2 Click OK.

Modifying an SNR User

This dialog appears when you click Edit on the SNR window (Configure > 

Telephony > Users and Extensions > Single Number Reach).

You can edit the remote destination number and SNR timeout settings only.

If you want to change the extension associated with an SNR user, you must 

remove the SNR user, re-add the SNR user, and select a different extension.

To modify SNR user settings, follow these steps.

STEP 1 Modify SNR user settings as described in the following table.

Call Forward to 

Voice Mail Delay 

(seconds)

Number of seconds to let the call ring on the IP phone and 

remote phone before transferring the call to voice mail. 

Enter a number from 5 to 60 seconds. The default value is 

30 seconds.

Secondary 

Destination

This is the call-forward-no-answer extension number. 

User can configure this number to a secondary voicemail 

extension (for the alternative voicemail language), or to 

another extension or number if required.

When editing the secondary destination phone number, 

enter the number exactly as you would dial it, including 

any access codes, long distance dialing code, and any 

other required dialing digits.

Setting Description

Setting Description

User Name Read-only. This field displays the first and last name of the 

user associated with this extension.

MAC Address Read-only. This field displays the MAC address of the 

phone associated with this SNR user extension.
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STEP 2 Click OK.

Extension Read-only. This field displays the extension that you 

selected when adding this SNR user.

Remote 

Destination

Edit the phone number for the remote destination.

When editing the remote destination phone number, enter 

the number exactly as you would dial it, including any 

access codes, long distance dialing code, and any other 

required dialing digits.

Share Line 

Members

Read-only. If the extension is a share line, this displays the 

list of users.

Delay and Timeout Settings

Delay Before 

Dialing Remote 

Destination (sec)

The delay specifies the number of seconds that the call 

rings the IP phone before ringing the remote phone. Enter 

a number from 1 to 10 seconds. The default value is 5 

seconds.

Call Forward to 

Voice Mail Delay 

(sec)

Number of seconds to let the call ring on the IP phone and 

remote phone before transferring the call to voice mail. 

Enter a number from 5 to 60 seconds. The default value is 

30 seconds.

Secondary 

Destination

This is the call-forward-no-answer extension number. 

User can configure this number to a secondary voicemail 

extension (for the alternative voicemail language), or to 

another extension or number if required.

When editing the secondary destination phone number, 

enter the number exactly as you would dial it, including 

any access codes, long distance dialing code, and any 

other required dialing digits.

Setting Description
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System Speed Dials

To configure System Speed Dials, choose Configure > Telephony > Users and 

Extensions > System Speed Dial from the feature bar.

From the System Speed Dial window, you can set local speed dial numbers.

Overview

A list of frequently called numbers can be created for all phones. A phone user can 

quickly dial a number from a list by using a speed-dial number.

Phone users access these speed dials from the Local Services > Local Speed 

Dial menu on their phone.

You can add, edit, or delete speed-dial entries. The list entries can be moved up or 

down the list and appear on the telephone display in the order in which they are 

listed. A maximum of 32 frequently called numbers can be defined in the list.

Procedures

To enable a local speed-dial menu for all IP phones, perform the following steps:

STEP 1 Click Add.

STEP 2 In the Name field, enter the name of the speed dial.

STEP 3 In the Phone Number field, enter the number for the speed dial.

STEP 4 To reorder a local speed-dial number in the list, select the entry, and click the up 

arrow or the down arrow. The numbers are listed in the order in which they are 

displayed on the phone.

STEP 5 To remove a local speed-dial number from the menu, select the entry in the menu, 

and click Delete in the Local Speed Dials box.

If the list has reached the maximum number of entries allowed, the Add button is 

disabled.

Local Directory

This window appears when you choose Configure > Telephony > Users and 

Extensions > Local Directory from the feature bar.
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The Local Directory feature allows for Dialed Number Identification Service (DNIS) 

(also referred to as called-party number) look-up option. The DNIS number 

identifies which number is called to reach you. The Local Directory feature also 

allows the CCA administrator to add and manage entries in the Local Directory. 

This means the CCA administrator must manually enter a number and name.

. 

Field Description

Devices

Hostname Selects the desired UC500 from the pull-down menu.

Called Name Display Settings

NOTE: Enabling the directory lookup for called number option will take 

precedence when both options are enabled.

Enable 

directory 

lookup for 

called number

This box is for enabling directory lookup on directory 

services. This specifies that incoming calls to a called 

number should display the name that was defined for this 

directory number.

Enable 

directory 

lookup for 

called number 

for overlay

This box is for enabling directory lookup for overlay 

extensions. This specifies that incoming calls to a called 

number should display the name that was defined for this 

overlay directory number.

Directory Number(s)

Number Editable option: The extension associated with the dialed 

name.

Value/Range: A minimum of 1 and a maximum of 32 dialable 

digits. Dialable digits may contain any combination from the 

following set: 0123456789*#ABCDEF-,()+.  The number may 

be terminated with a character T. 

Name Editable option: The name associated with the dialed 

number.

Value/Range: Requires a minimum of 1 character and a 

maximum of 24 characters. Quotation Mark, single quotation 

mark, and backquote are not allowed.
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Creating a Directory Entry

STEP 1 Open the Local Directory dialog by selecting Configure > Telephony > Users and 

Extensions > Local Directory from the CCA menu.

STEP 2 Click Add to create a blank row in the table.

STEP 3 Edit the Number column to input a Dialable Number.

STEP 4 Edit the Name column to input a valid name.

STEP 5 Press OK or Apply to update the directory with the new entry.

Modifying a User Defined Entry

STEP 1 Open the Local Directory dialog by selecting Configure > Telephony > Users and 

Extensions > Local Directory from the CCA menu.

STEP 2 Locate the entry to be modified by using one of the following techniques:

a. If the table is lightly populated, scroll through the entries and visually locate the 

desired entry.

b. Sort the table on either the Number or Name field, and locate the desired field 

in the sorted list.

c. Click Filter to reduce the number of entries visible in the Name or Number field.

STEP 3 Edit the Number column to the desired new value.

STEP 4 Edit the Name column to the desired new value.

STEP 5 Press OK or Apply to update the directory with the modified entry.

Deleting a User Defined Entry

STEP 1 Open the Local Directory dialog by selecting Configure > Telephony > Users and 

Extensions > Local Directory from the CCA menu.
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STEP 2 Locate the entry to be deleted by using one of the following techniques:

a. If the table is lightly populated, scroll through the entries and visually locate the 

desired entry.

b. Sort the table on either the Number or Name field, and locate the desired field 

in the sorted list.

c. Click Filter to reduce the number of entries visible in the Name or Number field.

STEP 3 Select the entry by clicking on any of the fields.

STEP 4 Press Delete to delete the entry.

STEP 5 Press OK or Apply to update the directory with the selected entry removed.
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Phone Groups

This section provides instructions for configuring these types of phone groups:

• Hunt Groups

• Call Blast Groups

• Pickup Groups

• Paging Groups

• Paging Cast Option

To configure phone groups, choose Configure > Telephony > Phone Groups from 

the feature bar.

Hunt Groups

To configure hunt groups, choose Configure > Telephony > Phone Groups > 

Hunt Groups from the feature bar.

Overview

Use hunt groups to manage distribution of incoming calls to a pre-defined group of 

extensions (members). The hunt group type determines the order in which 

members of the hunt group receive calls.

Up to 10 hunt groups can be configured on the system. Each hunt group must have 

at least one member and can contain up to 20 members.

After you configure hunt groups, they are available to be selected as destinations 

for inbound call routing, Auto Attendant, call forward destinations, and other 

telephony features.
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When you configure a hunt group, the HLog softkey is added to member phones. 

Hunt group members can log in or out of the group using the HLog softkey. The 

HLog softkey is displayed on the hunt group member phone when an incoming 

call to the hunt group rings their phone. Users can also access this softkey from 

the main phone screen by pressing the more softkey. The HLog softkey replaces 

the use of DnD (Do Not Disturb). DnD is less flexible, since it makes the subscriber 

unavailable for all calls, not just hunt group calls.

Limitation

The following limitation applies to Hunt Groups configuration:

• A phone that has SNR enabled cannot be a member of a hunt group.

Procedures

To enable and configure a hunt group, configure settings as described below, then 

click OK or Apply.

Setting Description

Enable When this box is checked, the associated hunt group is 

enabled.

Pilot # Pilot number for this hunt group. This is the extension that is 

dialed to reach the hunt group. Use the default extension for the 

pilot number or click in the field and edit it.

Description Optional. Text description that identifies this hunt group. This 

description is only used in the Hunt Group window. In other 

parts of the CCA user interface, the hunt group is identified by 

its number and pilot extension, for example, hunt1 (502).
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Hunt Type Determines the order in which calls are received by members 

of the hunt group. Choose one of the following options:

• Sequential—Call hunting always starts with the pilot 

number for the group and continues to each number in 

the group in the order in which they are listed, from top to 

bottom, in the Members list.

• Longest Idle—Calls go to the directory number that has 

been idle for the longest time, according to the time 

stamp of the most recent call to the hunt group taken by 

that extension. If that extension is unavailable, the search 

continues to the next extension in the group.

• Peer—Hunt group in which the first number called is 

selected round-robin from the list.

Members Define the members of the Hunt Group. These are all the 

numbers that can ring when a call comes in to the pilot number.

1. Click Members to display the list of Available and Selected 
users at the bottom of the Hunt Groups window.

2. Use the Add and Remove arrow buttons to move items 
between the list of Available and Selected members. Use 
CTRL-click and SHIFT-click to select multiple members to 
move between lists.

3. Use the Up and Down arrows to specify the order in which 
calls are routed to the Hunt Group.

Timeout 

(sec)

Number of seconds after which an unanswered call is 

redirected to the next number in a voice hunt-group list. Valid 

range is from 3 to 60000 seconds.

No Answer 

Forward To

Destination for forwarding unanswered calls for the hunt group.

You can choose None, Voice Mail, Extension, Blast Group, or 

Other Number.

If you select Voice Mail as the destination for No Answer 

Forward To, a General Delivery Mailbox (GDM) is created for 

the group. To view GDM mailbox information or change the size 

of the mailbox, go to Configure > Telephony > Users and 

Extensions > Voicemail window and select the Mailboxes tab.

Setting Description
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Number Number for the selected destination type selected for No 

Answer Forward To: 

• If you selected Voice Mail, enter the number in the 

Number field exactly as you would dial it.

• If you selected Extension, select an extension from the 

pull down menu displayed in the Number field.

• If you selected Blast Group select a group from the pull 

down menu in the Number field.

• If you selected Other Number, enter the number in the 

Number field exactly as you would dial it, including any 

access codes.

Setting Description
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Call Blast Groups

To configure Call Blast Groups, choose Configure > Telephony > Phone Groups > 

Call Blast Groups from the feature bar.

Overview

A call blast group is a special type of phone group in which calls to a specified 

pilot number simultaneously ring multiple phones. This feature can also be used to 

set up a Single Number Reach scenario in which a call to a user's phone extension 

simultaneously rings another number (for example, a cell phone number or home 

phone number) or a different extension.

Up to 10 call blast groups can be configured on the system. Each call blast group 

must have at least two members and can contain up to 32 members.

After you configure call blast groups, they are available to be selected as 

destinations for inbound call routing, Auto Attendant, call forward destinations, and 

other telephony features.

Procedures

To enable and configure a call blast group, configure settings as described below, 

then click OK or Apply.

Setting Description

Enable When this box is checked, the associated call blast group is 

enabled.

Pilot # Pilot number for this call blast group. This is the extension that is 

dialed to reach the call blast group. Use the default extension for 

the pilot number or click in the field and edit it.
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Members Define the members of the call blast group. These are all the 

numbers that will ring when a call comes in to the pilot number.

1. Click Members to display the list of Available and Selected 
users at the bottom of the Call Blast Groups window.

2. Use the Add and Remove arrow buttons to move members 
between the list of Available and Selected members. Use 
CTRL-click and SHIFT-click to select multiple members to 
move between lists.

To add an external PSTN number (for example, a cell phone 

number or home phone number) to the list of Available members 

and move it to the Selected list:

1. In the Other Number field, enter the phone number exactly as 
you would dial it, including any access codes (up to 16 digits).

2. Click the Add button to the right of the Other Number field to 
move it to the Available list.

3. Click the Add arrow button to move the Other Number you just 
added to the Selected list.

To remove an external number from the Selected list, click the 

Remove arrow button to move it back to the Available list.

After you close the Call Blast Groups window or select a different 

Call Blast Group to configure, any external numbers added to the 

Available list but not moved to the Selected list are removed from 

the Available list. When you next open the Members selection list, 

these external phone numbers do not appear in the Available list.

Timeout 

(sec)

Number of seconds after which an unanswered call is redirected 

to the destination specified by No Answer Forward To. Valid 

range is from 3 to 60000 seconds. The default Timeout is 16 

seconds.

IMPORTANT The Timeout value for the Call Blast group must 

be lower than the CFNA Timeout value for any of its member 

extensions. You may need to lower the Timeout value for a Call 

Blast Group or raise the CFNA timeout value for member 

extensions to ensure that this requirement is met.

Setting Description
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Pickup Groups

To configure Pickup Groups, choose Configure > Telephony > Phone Groups > 

Pickup Groups from the feature bar.

Overview

Create Pickup Groups to configure a group of user extensions that can retrieve 

calls ringing on extensions belonging to members of the same Pickup Group by 

pressing the GPickUp softkey on the IP phone and pressing the * key.

The following notes apply to using Pickup Group features on SBCS platforms:

• Any phone user can pick up a ringing call by pressing the PickUp softkey on 

their phone and dialing the ringing extension. No configuration is needed.

No Answer 

Forward To

Destination for forwarding unanswered calls for the hunt group.

You can choose None, Voice Mail, Extension, Hunt Group, or 

Other Number.

If you select Voice Mail as the destination for No Answer 

Forward To, a General Delivery Mailbox (GDM) is created for the 

group. To view GDM mailbox information or change the size of 

the mailbox, go to Configure > Telephony > Voicemail window 

and select the Mailboxes tab.

Number Number for the selected destination type selected for No 

Answer Forward To:

• If you selected Voice Mail, enter the number in the 

Number field exactly as you would dial it.

• If you selected Extension, select an extension from the list 

displayed in the Number field.

• If you selected Hunt Group, select a group from the list 

displayed in the Number field.

• If you selected Other Number, enter the number in the 

Number field exactly as you would dial it, including any 

access codes.

Setting Description
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• Any phone user can pick up a call ringing on a group pick-up extension by 

pressing the GPickUp softkey on their phone and dialing the group pick-up 

extension.

• If the user’s phone and the ringing extension are in the same Pickup Group, 

the phone user can retrieve the call by pressing the GPickUp softkey, then 

the *(star) key on their phone. If there is only one Pickup Group configured 

on the system, the user is automatically connected and does not have to 

press the * key.

Procedures

To enable and configure a Pickup Group, configure members as described below, 

then click OK or Apply.

Setting Description

Members Define the extensions that are members of the Pickup Group.

1. Click Members to display the list of Available and Selected 
extensions at the bottom of the Pickup Groups window.

2. Use the Add and Remove arrow buttons or the Select All 
buttons to move extensions between Available and Selected 
lists. Use CTRL-click and SHIFT-click to select multiple 
extensions to move between lists.
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Paging Groups

To configure paging groups, choose Configure > Telephony > Phone Groups > 

Paging Groups from the feature bar.

Paging Group configuration is described in these sections:

• Overview, page 389

• Creating a Simple Paging Group (Individual Phones Only), page 390

• Creating a Combined Paging Group, page 390

• Editing a Paging Group, page 391

• Deleting a Paging Group, page 392

• Paging Group Dependency View, page 394

Overview

You can create paging groups to allow phone users to broadcast announcements 

to groups of Cisco IP phones by using the phone speakers. You can create up to 

10 paging groups.

Only Cisco IP phones can be members of paging groups.

You can also configure combined paging groups. A combined paging group can 

contain other paging groups as members or a combination of individual phones 

and other paging groups. For example, a phone in a real estate office may need to 

receive pages going to the property management department, while a different 

phone needs to receive pages going to the sales department. In addition, both 

phones need to receive pages sent to all employees.

The process for configuring a combined paging group has these general steps:

1. First, create each of the individual paging groups required and assigned phones 
to them.

2. Create the combined paging group and add individual phones that are 
members of the combined group only.

3. Add the individual paging groups you created in Step 1 to the combined paging 
group.

A paging group can be a member of multiple paging groups, but a phone can be 

assigned to only one paging group. One level of nesting is supported for 

combined paging groups. See Nested Paging Groups, page 392 for some 

examples.
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Creating a Simple Paging Group (Individual Phones Only)

To enable and configure a paging group that contains one or more individual 

phones, follow these steps.

STEP 1 Enable configuration for the group you want to create by checking the Enable 

option.

STEP 2 In the Paging # field, enter the extension to use for the paging group or accept the 

default extension. The default extension range for paging groups is 101 through 

110.

This is the extension that is dialed to reach the paging group.

STEP 3 Optional. Enter a Description that identifies this paging group. This description is 

used only in the Paging Groups window and is not displayed on phones.

STEP 4 Add member phones to the paging group.

a. Click the Phones tab at the bottom of the page. The Available list displays the 

user ID and MAC address for each phone that is not currently part of a paging 

group.

b. Click on a user ID in the Available list and use the Add and Remove buttons to 

move members to and from the Selected list. You can also use the CTRL-click 

and SHIFT-click shortcuts to select multiple phones to move between lists.

STEP 5 Click OK or Apply to create the paging group.

The Members column updates to show the number of phones that are part of the 

group.

Creating a Combined Paging Group

To create a paging group that contains other paging groups, follow these steps.

STEP 1 Create the paging groups that you want add as members to the combined group 

and identify individual phones that will be part of the combined group.

See Creating a Simple Paging Group (Individual Phones Only), page 390.

STEP 2 Enable configuration of the combined group by checking the Enable option for the 

new group.
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STEP 3 In the Paging # field, enter the extension to use for the paging group or accept the 

default extension. The default extension range for paging groups is 101 through 

110.

This is the extension that is dialed to reach the paging group.

STEP 4 Optional. Enter a text description that identifies this paging group. This description 

is used only in the Paging Groups window and is not displayed on phones.

STEP 5 Add paging groups and phones to the paging group.

a. To add phones, click the Phones tab at the bottom of the page. The Available 

list displays the user ID and MAC address for each phone that is not currently 

part of a paging group. 

Click on a user ID in the Available list and use the Add and Remove buttons to 

move members to and from the Selected list.

b. To add paging groups as member, click the Groups tab at the bottom of the 

page. Choose group from the Available list and use the Add and Remove 

buttons to move groups to and from the Selected list.

A paging group can be a member of multiple paging groups, but a phone can be 

assigned to only one paging group.

You can use the CTRL-click and SHIFT-click shortcuts to select multiple phones or 

groups.

The Members column updates to reflect the number of phones and paging groups 

that are part of the group.

STEP 6 Optional. To view dependencies between groups or check for configuration 

problems in combined paging groups, click Show Group Dependency. See 

Paging Group Dependency View, page 394.

STEP 7 Click OK or Apply.

Editing a Paging Group

To edit a paging group, click the Phones (n) and Groups (n) button for the group 

you want to edit.

The Phones and Groups tabs update to display Available and Selected phones 

and groups for the paging group to be edited.

Use the Add and Remove buttons to edit the group members, then click OK or 

Apply.
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Deleting a Paging Group

To delete a paging group, uncheck the Enable setting that corresponds to the 

group you want to delete and click OK or Apply.

Before removing a group, you can click Show Group Dependency to see which 

groups are members of other groups.

TIP If the group you delete is part of a combined paging group, it is automatically 

removed from the combined paging group. In this case, you may want to update 

the Description you entered for the combined paging group to reflect the change.

Nested Paging Groups

Combined (“nested”) paging groups are supported up to one level deep.

The following scenario illustrates combined paging groups with one level of 

nesting:

• Assume paging group 1 contains only phones, paging group 2 contains only 

phones, and paging group 3 contains paging groups 1 and 2 and some 

phones. In this scenario, there is one level of nesting.

• A paging call to group 3 reaches all phones in groups 1, 2, and 3.

The paging group dependency view for this scenario is shown below:
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The following scenario illustrates combined paging groups with two levels of 

nesting:

• Assume paging group 1 contains paging group 2, and paging group 2 

contains paging group 3. In this scenario, there are two levels of nesting.

• A paging call to group 1 reaches all phones in groups 1 and 2, but does not 

reach the phones in group 3.
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The paging group dependency view for this scenario is shown below:

Paging Group Dependency View

The Paging Group Dependency window appears when you click Show Group 

Dependency in the Paging Groups window (Configure > Telephony > Phone 

Groups > Paging Groups).

This window displays a graph that can help you to quickly see which paging 

groups are members of other paging groups. As shown in the example below:

• The numbers in the view correspond to the number of the paging group 

listed in the Paging Groups window.

• The arrows in the view indicate which groups are members of other groups. 

The arrow always points to the member group.
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Some sample paging group dependency view graphs are shown below.

Paging Cast Option

The Paging Cast Option allows the user to modify the casting method of paging 

phones.

To configure paging cast options, choose Configure > Telephony > Phone 

Groups > Paging Cast Options from the feature bar, then click OK.

Setting Description

Hostname From the pull down menu select the desired hostname.

User ID Read-only. Identifies the User ID associates with this phone.

MAC 

Address

Read-only. This field displays the MAC address of the phone 

associated with the user extension that you selected.
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Phone 

Model

Read-only. Phones that are currently a member of any paging 

group is visible.

Cast Type From the pull down menu select either Unicast or Multicast. 

Multicast is the default value.

NOTE: The following phones do not support Multicast. The 

default setting for these phones is Unicast. The user can not 

modify this setting and the option will be greyed out.

• 7920

• 7921

• 7925

Setting Description
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Voice Features

The topics in this section provide instructions for configuring these voice features:

• Call Park

• Conference

• Conference Barge

• Music on Hold (MoH)

IMPORTANT Telnet access must be enabled in order to configure voice features.

Call Park

To configure call park, choose Configure > Telephony > Voice Features > Call 

Park from the feature bar.

Overview

Call Park provides temporary holding locations for incoming calls. When a call is 

parked, it is transferred to the call park extension and put on hold until it is 

retrieved by another employee. The message Call Park <call park extension> 

displays on the phone that parked the call. To retrieve a parked call, other users 

can dial the park slot extension.

• A 1-second reminder ring occurs at the specified reminder interval and the 

message “Call Park <extension>” re-appears on the LCD display of the 

phone that parked the call. The reminder ring and message are sent only to 

the phone that parked the call.

• You can choose to enable Timeout and Recall settings to specify the action 

to take when the call park timeout is reached. The call park timeout is equal 

to the number of retries multiplied by the number of seconds in the 

reminder interval. The call can be transferred to the extension that parked 

the call, transferred to another extension, or disconnected.

When Timeout and Recall is enabled, you also set the number of reminders, 
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reminder interval, retry delay, and number of retries. After the timeout 

expires, the call park timeout action is taken.

Limitations and Guidelines

These limitations and guidelines apply to Call Park:

• Only one call can be parked at each call park slot extension.

• Phones without softkeys cannot be used to park calls.

Procedures

To create a new call park slot, click Create, complete settings as described in the 

section Creating or Editing a Call Park Slot, page 398. In the Call Park window, 

click OK or Apply to send the configuration to the UC500.

To edit a call park slot, click on a call park slot in the list to select it, click Modify, 

and edit the settings as described in the section Creating or Editing a Call Park 

Slot, page 398. In the Call Park window, click OK or Apply to send the 

configuration to the UC500.

To delete a call park slot, click on a call park slot in the list to select it, click Delete, 

and choose OK when you are prompted to confirm the deletion. In the Call Park 

window, click OK or Apply to send the configuration to the UC500.

Creating or Editing a Call Park Slot

To create or modify a Call Park slot, follow these steps.

STEP 1 In the Extension field, enter the extension to use for this park slot.

STEP 2 In the Slot Label field for each new park slot extension, enter a description for 

each park slot.

STEP 3 If needed, check the Enable Timeout and Recall option to enable the call park 

timeout and recall feature.

STEP 4 If Enable Timeout and Recall is checked, configure these settings.
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STEP 5 Click OK.

Setting Description

Reminder Interval 

(sec)

Number of seconds to wait between call park reminders. 

The default reminder interval is 120 seconds.

Number of 

Reminders

Number of call park reminders to send to the phone that 

parked the call. The default number of reminders is 2.

The call park timeout is the number of retries multiplied by 

the number of seconds in the reminder interval. for 

example, if you set the reminder interval to 20 seconds 

and the number of retries to 3, a call can be parked up to 

60 seconds before the timeout expires and the timeout 

expiration action is taken.

When Timeout 

Expires

Specify the action to take after the call park timeout 

expires. Choose one of these options:

• Recall to extension that parked the call (this is the 

default).

• Transfer to extension. If you choose this option, 

enter the Transfer Extension, set the Retry Delay, 

and specify the Number of Retries.

• Disconnect call.

Transfer 

Extension

If you set the timeout expiration action to Transfer to 

extension, enter the extension here. for example, you 

could enter a hunt group pilot number or some other 

extension.

Retry Delay (sec) Enter the number of seconds to wait between attempts to 

transfer a parked call. The number of attempts is 

specified in the Number of Retries setting. The default 

retry delay is 120 seconds.

Number of 

Retries

Enter the number of retries to allow when transferring a 

parked call. The default number of retries is 2.
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Conference 

To configure multiparty conferencing, choose Configure > Telephony > Voice 

Features > Conference from the feature bar.

For information about configuring conferencing, see these topics:

• Overview, page 400

• Enabling and Configuring Multiparty (MeetMe and AdHoc) 

Conferencing, page 402

• Limitations and Notes that Apply to Multiparty Conferencing, page 403

• Conference Barge, page 403

Overview

From the Conference window, you can choose whether to enable Multi-party 

conferencing and configure conferencing options.

NOTE: Multi-party conferencing must be enabled in order to use the Conference 

Barge (cBarge) and Privacy features.

When Multi-party conferencing is disabled:

• Software resources are used for conferencing.

• You can specify the maximum number of simultaneous 3-way calling 

sessions to allow on the system.

When Multi-party conferencing is enabled:

• Hardware resources (DSPs) are used.

Configuration Assistant automatically detects the UC500 platform you are 

configuring and automatically determines the maximum supported number 

of participants per conference and simultaneous conferencing sessions that 

can be configured for both MeetMe and AdHoc conferencing. 

Cisco UC500 platforms that support 24 or more users have approximately 

twice the amount of hardware conferencing resources and can support a 

greater number of participants and sessions. 
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NOTE: Hardware conferencing is disabled if there are not enough 

hardware resources. for example, hardware conferencing may be disabled 

if a T1/E1 add-on card is added to a UC500-16U chassis, because voice 

ports consume resources from the same pool of resources that is allocated 

for hardware conferencing.

• You can configure both MeetMe and AdHoc conferencing.

- An AdHoc conference is a type of conference in which one party calls 

another and either party decides to add another party to the call.

- A MeetMe conference is one in which the parties dial a predetermined 

MeetMe conference number. 

The conference creator goes off-hook, presses the MeetMe softkey on 

their phone, hears a confirmation tone, then dials the MeetMe number. 

After the conference is initiated, other parties can join the MeetMe 

conference by dialing the MeetMe number. 

When you configure MeetMe conferencing, all phone users have 

permission to initiate MeetMe conferences. The MeetMe conference 

creator can press the ConfList softkey to list all participants. The creator 

can also press the RmLstC softkey to remove the last joined caller, and 

remove a party from a conference.

MeetMe conferencing softkeys are configured, and automatically 

applied to the phones, when multiparty conferencing is enabled and 

MeetMe extensions are set up.

- An Unlocked MeetMe conference allows the user to unlock the MeetMe 

conference bridge. The MeetMe conference bridge allows unrestricted 

and uncontrolled access for external callers.This feature is only 

supported for MeetMe conference. 

When a user unlocks the MeetMe conference bridge in Cisco Unified 

CME, the user can initiate a MeetMe conference without pressing the 

MeetMe soft key on the phone, this allows external callers to initiate a 

MeetMe conference.

NOTE:  To configure Direct Inward Dial (DID) numbers to ring internal 

user extensions you must create translation rules to define the mapping 

between each DID number and its corresponding internal extension. A 

single DID number is mapped to a single internal extension. See Add 

Caller ID for Internal Extensions, page 461.
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Pre-requisite:

To check or uncheck the Enable MeetMe Unlocked conference option 

you must use Cisco Unified CME version 8.0 and above. The unlock 

option will not be visible for prior Cisco Unified CME versions.

NOTE: In order to configure an unlocked MeetMe conference, all 

ephone-dn tags associated with the same number should have unlocked 

option configured. If some of the ephone-dn tags do not have unlocked 

option configured, unlocked MeetMe conference may not work properly.

- You can enable or disable playing of tones when callers join or leave a 

multi-party conference. By default, these are disabled.

Enabling and Configuring Multiparty (MeetMe and AdHoc) Conferencing

To enable and configure multi-party conferencing, follow these steps.

STEP 1 In the Conference window, choose whether to enable multiparty conferencing.

• Check the Enable Multi-Party Conferencing checkbox to enable multiparty 

conferencing (uses hardware resources).

- When this option is selected, both AdHoc and MeetMe conferencing can 

be configured.

- The maximum number of sessions that be configured depends on the 

number of hardware resources for the UC500 platform being configured.

• If you do not choose to enable multiparty conferencing, use the Maximum 

3-way Calling Sessions pull-down menu to set the maximum number of 

simultaneous 3-party AdHoc conference sessions that you want to allow.

- When this option is selected, Cisco IOS software resources are used for 

conferencing. Hardware resources are not required. This option is used 

when hardware conferencing is disabled or not configured.

- Each AdHoc conferences can have up to three participants.

STEP 2 If Enable Multi-Party Conferencing is checked, configure the following settings.

a. Choose a Mode, either G711 (single mode) or G711/G729 (mixed mode).

The Mode setting determines the amount of hardware conferencing resources 

required per call. G711 uses fewer hardware conferencing resources than 

G711/G729.
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G711 only mode is recommend for deployments where local trunks only are 

used. Mixed mode (G711/G729) is recommended for deployments that include 

SIP trunking, if the SIP Service Provider supports G729.

b. Under Tone Settings, choose whether to enable or disable playing of tones 

when callers join or leave a multiparty conference.

By default, conference join and leave tones are disabled. When multi-party 

conferencing is disabled, tone settings are also disabled.

c. Use the pull-down menu to select the Maximum MeetMe Participants per 

conference.

d. Use the slider bar to the right of the Sessions menu to allocate sessions 

between AdHoc and MeetMe conferences. The total number of sessions must 

be equal to or less than the maximum number of simultaneous sessions.

e. Edit MeetMe extension numbers or leave the default values.

STEP 3 Click OK or Apply.

Limitations and Notes that Apply to Multiparty Conferencing

• If you are configuring a 8-user or 16-user system with a VIC and hardware-

based AdHoc conferencing is already configured on the device, before any 

VIC card is configured from CCA, AdHoc conferencing must be restored to 

software-based conferencing by unchecking Enable Multiparty 

Conferencing and clicking Apply.

• If any DSP-related out-of-band configuration exists (for example, 

transcoding), conferencing is not available. You must either remove the 

existing out-of-band configuration, or continue to configure it out-of-band.

Conference Barge

To configure Conference Barge (cBarge) and an optional Privacy button for cBarge 

phones, choose Configure > Telephony > Voice Features > Conference Barge 

from the feature bar.

IMPORTANT Multi-party conferencing must be enabled before you can 

configure cBarge and Privacy. Conference Barge can only be configured on IP 

phones that have at least one octal-line shared extension.
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For information about cBarge and Privacy features, refer to these topics.

• Conference Barge and Privacy Feature Descriptions, page 404

• cBarge and Privacy Usage and Examples, page 405

• Prerequisites for cBarge and Privacy, page 407

• Unsupported Phones, page 407

• Setting Up Shared Octal Line Extensions, page 408

• Configuring Conference Barge and Privacy Features, page 408

• Removing cBarge and Privacy for a User’s Phone, page 409

Conference Barge and Privacy Feature Descriptions

The cBarge feature allows users with shared octal-lines on their phones to press 

the cBarge softkey to “barge in” and join a call in progress on that shared octal-

line. When a third party joins the call, an AdHoc conference is created. Other users 

who also have cBarge configured for the same shared octal-line can join the 

conference, up to the maximum number of participants. These guidelines apply to 

the cBarge feature:

• Maximum cBarge sessions. The maximum number of active cBarge 

conference sessions is the same as the maximum number of AdHoc 

conference sessions allowed on your system. You can view this information 

on the Conference tab.

• Maximum number of cBarge participants per session. A cBarge 

conference supports the maximum number of participants that are 

configured for AdHoc conferencing on your UC500 platform. You can view 

this information on the Conference tab.

• If no AdHoc conference session is available or the maximum number of 

participants is reached, the cBarge request is rejected, and an error 

message is displayed on the initiating phone.

• When any party releases from the call, the call remains a conference call if 

at least three participants remain on the line. If only two participants remain 

in the conference, they are reconnected as a point-to-point call, which 

releases the conference bridge resources.

• When the target party parks the call or joins the call with another call, the 

cBarge initiator and the other parties remain connected.
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The Privacy feature works in conjunction with cBarge. This feature allows users 

with cBarge enabled for a shared extension to block other users who share the 

extension from seeing call information, resuming a call, or barging into a call on the 

shared extension. The phone must have an available line button in order to enable 

this feature.

When Privacy is configured for a phone with cBarge using CCA:

• A Privacy button is placed on the phone. If no line button is available, a 

message appears in the CCA Error bar.

• The phone user can press the Privacy button on their phone to toggle 

Privacy between On and Off.

• When Privacy is On, the Privacy button on the user’s phone lights Amber.

cBarge and Privacy Usage and Examples

Usage. Assume User A and User B both have extension 222 assigned to a button 

on their respective phones. Extension 222 is configured as a shared octal-line 

extension. The cBarge feature is enabled for extension 222 on both phones, and 

Privacy is disabled (Off) on both phones.

The cBarge softkey becomes available when User A presses the line button for 

Extension 222 to answer an incoming call on the shared line. While User A is on the 

call on Extension 222, User B can press the cBarge softkey on their phone to join 

the conversation with User A and the other party on Extension 222. This is 

accomplished internally by creating an AdHoc conference between User A, 

User B, and the other party on Extension 222.

To extend this example:

• If a third user, User C, also has the shared octal-line extension configured on 

their phone, they can also press the cBarge softkey on their phone to join 

the conference.

• If User A then presses the Privacy button on their phone to toggle Privacy 

On, the cBarge softkey is not available to the other users with Extension 222 

on their phone and no other users can join the call.

cBarge and Privacy can be enabled or disabled on phones that share the same 

octal-line extension. When cBarge is Disabled, Privacy can still be enabled. Here 

are some examples.

Example 1. In a work environment where all employees are peers, all phones that 

share the same octal-line extension can have both cBarge and Privacy enabled.
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Example 2. In a small call center environment where a supervisor and multiple 

employees share the same octal-line extension, cBarge and Privacy can be 

configured as shown below.

Example 3. In an office where a manager has several supervisors who each 

monitor a small group of employees, you can configure cBarge and Privacy as 

shown below.

Phones/Users cBarge Privacy Result of the Configuration

All phones Enabled Enabled Any user of the shared extension can 
barge into any call on that extension 
and/or set Privacy for calls on the 
shared extension.

Phones/
Users

cBarge Privacy Result of the Configuration

Supervisor 
phone

Enabled Disabled The supervisor can barge into any of their 
employee’s calls on the shared octal-line 
extension.

There is no need to enable Privacy on the 
Supervisor phone, since none of the 
employees can barge into a call on the 
shared extension.

Employee 
phones

Disabled Disabled Employees with this shared octal-line 
extension cannot barge into any calls or 
enable Privacy for calls on this extension.

Phones/Users cBarge Privacy Result of the Configuration

Manager phone Enabled Enabled The Manager can barge into calls on the 
shared extension made by either 
supervisors or employees.

Only the manager can make their calls 
private on this extension.
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Prerequisites for cBarge and Privacy

To configure Conference Barge and Privacy features, your system must meet the 

following requirements:

• UC500 Software Pack 7.0.2 or later is required to ensure that the required 

versions of Cisco IOS and CUE are installed (Cisco IOS 12.4(20)T2 or later 

and CUE 7.0 or later). For Cisco 7931 phones, UC500 Software Pack 8.0.4 or 

later is required.

• Multiparty conferencing must be enabled and AdHoc conference sessions 

and participants must configured before you can configure cBarge and 

Privacy features. See Conference, page 400.

• Shared octal-line extensions must be configured on phones before you can 

configure cBarge and Privacy features. See Setting Up Shared Octal Line 

Extensions, page 408.

Unsupported Phones

cBarge and Privacy features cannot be configured for single-button phones and 

phones that do not support shared octal-line directory numbers (DNs). Phones that 

do not support shared octal-line DNs are listed below:

• Analog FXS phones

• ATAs

• Cisco Model 7935,7936,7937 and 39xx phones

Model 7931 phones are supported.

• Cisco Model CP-521 IP Phones

• Cisco Model CP-52xG IP Phones

Supervisor 
phones

Enabled Disabled The supervisor can barge into any of 
their employee’s calls on the shared 
octal-line extension but cannot barge 
into a call on the shared extension when 
the Manager has Privacy On.

Employee 
phones

Disabled Disabled Employees with this shared octal-line 
extension cannot barge into any calls or 
enable Privacy for calls on the shared 
extension.

Phones/Users cBarge Privacy Result of the Configuration
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• Cisco Model 7902, 7905, 7906, 7910, 7911, 7912, 7920, and 7985 

IP Phones

• All Cisco SPA500 Series Phones (Models SPA501G, SPA525G, SPA525G2, 

and SPA50x)

• All Cisco SPA300 Series IP Phones

• SCCP analog phones (VG224 type)

Setting Up Shared Octal Line Extensions

For more information about octal lines, see Octal Lines, page 357.

To configure a shared octal-line extension on a phone so that cBarge be enabled 

on a phone, follow these steps.

STEP 1 Follow the instructions in the section Share Extension, page 346.

STEP 2 Make sure that the line type is set to Octal Line when configuring Line Options for 

the Shared line button on the phone.

STEP 3 After you have created the Shared octal-line extension, add that Shared line to a 

button on each of the phones that will be configured with cBarge and Privacy 

enabled.

For a list of phones that do not support this feature, see Unsupported Phones, 

page 407.

STEP 4 Click OK to apply the changes and close the Users and Phones window.

Configuring Conference Barge and Privacy Features

After you have enabled multiparty conferencing and configured the required 

shared octal-line extensions on phones, follow these steps to configure cBarge 

and Privacy features for these extensions.

STEP 1 From the feature bar on the left, choose Configure > Telephony > Voice Features 

> Conference Barge.

All phones on the system with shared octal-line extensions are listed. The cBarge 

and Privacy features are Disabled on these extensions by default.

STEP 2 For each phone, choose whether to enable cBarge and Privacy.
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cBarge and Privacy can be enabled or disabled on phones that share the same 

octal-line extension. For some usage examples, see cBarge and Privacy Usage 

and Examples, page 405.

To enable Privacy for a shared octal line, you must have an available line button. If 

there are no available line buttons on the phone, the error bar displays the 

message “Cannot enable Privacy on <FirstName LastName> (username) because 

no line buttons are available.”

STEP 3 Click OK or Apply.

Removing cBarge and Privacy for a User’s Phone

To remove cBarge or Privacy from a phone, follow these steps.

STEP 1 From the feature bar on the left, choose Configure > Telephony > Voice Features 

> Conference Barge.

STEP 2 Locate a user in the list.

STEP 3 To remove cBarge from the associated user’s phone, choose Disabled from the 

pull-down list in the cBarge column.

STEP 4 To remove Privacy from the associated user’s phone, choose Disabled from the 

pull-down list in the Privacy column.

STEP 5 Click OK or Apply.

Music on Hold (MoH)

To configure Music on Hold settings, choose Configure > Telephony > Voice 

Features > Music on Hold from the feature bar.

Overview

Music on Hold (MoH) provides music from a streaming external source or .wav file 

on the UC500 flash to a caller who was placed on hold by another caller.

Procedures

To configure music-on-hold, follow these steps.
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STEP 1 In the Audio File field, choose None or choose a audio file.

STEP 2 Choose whether to enable music on hold for internal calls and/or enable Music on 

Hold input from a music source connected to the external Music on Hold port on 

the UC500.

• When Enable music on hold for internal calls is checked, internal IP phone-

to-IP phone calls placed on hold hear music. Otherwise, internal callers hear 

tone on hold.

• When Enable external music on hold port is checked, music on hold for 

internal calls is automatically enabled and cannot be disabled. If an audio file 

is selected and the external music-on-hold port is also enabled, the music 

input from the external port takes precedence. The selected audio file 

serves as a backup music source if the external source fails or is not 

available.

• MoH for a PSTN or SIP trunk is always enabled, even if MoH for internal calls 

is disabled. To disable MoH for PSTN or SIP trunk calls, uncheck all options 

and select None for the audio file.

STEP 3 Click Apply.

To upload a custom Music on Hold audio file (.au file) to the UC500:

STEP 1 Choose Home > Topology to open the Topology View.

STEP 2 Drag and drop the audio file from your desktop onto the UC500 icon in the 

topology view.

The audio file must have an .au extension.

After you have uploaded the file, it becomes available on the Audio File selection 

list for Music on Hold.

For specifications and instructions on how to create a custom audio file for Music 

on Hold, see the Cisco Unified Communications Manager Express System 
Administrator Guide, available on Cisco.com.
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Call Handling

These topics are covered:

• Schedules

• Auto Attendant

• Dial By Name

• Basic Automated Call Distribution (ACD)

• Night Service

• Live Record

• T.37 Fax to Mail

Schedules

To configure schedules, choose Configure > Telephony > Call Handling > 

Schedules.

Business hours, holidays, and night service schedules are managed from these 

tabs in the Schedules window:

• Business Hours

• Holidays

• Night Service Schedule

Business Hours

The Business Hours schedule defines open and closed hours. This enables the 

Auto Attendant to be configured to present different prompts and perform 

different actions for open and closed hours. You can define up to four different 

business schedules.
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If you are using multiple auto attendants, you can set up a separate schedule for 

each one. You can configure open and closed hours for each day of the week, in 

half-hour increments.

To enable and define a schedule:

STEP 1 Select a schedule from the list on the left side of the tab.

STEP 2 Click Enable Business Schedule to enable and open the selected schedule for 

editing.

STEP 3 Edit the name of the schedule to provide a more descriptive name. The default 

name is systemschedule.

STEP 4 Use the pull-down menus at the top of the window to specify open and closed 

hours for the days of the week, then click Update Table to refresh the display.

You can also click checkboxes inside the table to set business hours.

Timeslots marked with a check indicate hours that the business is open.

STEP 5 Click Apply or OK.

Holidays

Up to 26 holidays can be defined per year, for the current year and for the next 

year. However, if Night Service is also configured, Night Service is activated only 

for the first 15 holidays entered (a warning message is displayed if Night Service 

is enabled and you add more than 15 holidays). On scheduled holidays, the Auto 

Attendant activates its Closed Hours prompts and actions. Night Service is 

activated, if it is configured for the site.

You can also modify or delete existing holidays or copy all holidays from the 

current year to the next year. When copying holidays from the current year to the 

next year, if the same date appears in both years, the current year entry is used.

NOTE: You cannot modify the year for an existing holiday. Delete and re-add the 

holiday if you need to change the year.

To add a holiday:

STEP 1 In the Schedules window, choose either the current year or next year.

STEP 2 Click Add to open the Add Holiday window (see Add Holiday, page 413).
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STEP 3 When finished adding holidays, click OK.

Add Holiday

This window appears when you click Add Holiday from the Schedules window.

To add a holiday, follow these steps.

STEP 1 Click the calendar icon and choose a date from the selected year.

STEP 2 Use the forward (>) and back (<) arrows to go to different months in the calendar.

STEP 3 Enter a description for the holiday. The description can contain up to 64 

characters.

STEP 4 Click OK.

Night Service Schedule

Specify the hours that Night Service is enabled for each day of the week.

After you have configured a night service schedule, go to Configure > 

Telephony > Call Handling > Night Service to enable and configure this feature.

During Night Service hours:

• Night service is enabled for the specified phones and extensions.

• Calls to extensions with call forward to another number after hours are 

automatically forwarded to that number.

On holidays, Night Service is activated if it is configured for the site.

To configure Night Service hours, follow these steps.

STEP 1 Select a day of the week from the pull-down menu or click the row corresponding 

to a day of the week in the Night Service Schedule summary display.

STEP 2 Use the from and to pull-down menus to set the hours for the selected day. Click 

Delete to clear the hours for that day.

STEP 3 Click Add to add hours. Skip this step if you are deleting hours.

STEP 4 Continue selecting days of the week and setting Night Service hours.
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Use the Copy selected row to option to copy settings from one day to a different 

day of the week, weekend days, or weekdays.

Example: if you want Night Service to be active from 4:00 pm to 9:00 am Monday 

through Friday and 24 hours on Saturday and Sunday, set up the From Hours and 

To Hours as shown below:

NOTE The Delete Date button (at the bottom of the table) is used for deleting a selected 

Holiday date which cannot be removed from the Holiday tab.

STEP 5 Click Apply or OK.

For more information, see these topics:

• Auto Attendant, page 414

• Night Service, page 431

Auto Attendant

To configure an Auto Attendant and manage Auto Attendant prompts and scripts, 

choose Configure > Telephony > Call Handling > Auto Attendant.

These topics are covered:

Day From Hours (HH:MM) To Hours (HH:MM)

Monday 17:00 8:00

Tuesday 17:00 8:00

Wednesday 17:00 8:00

Thursday 17:00 8:00

Friday 17:00 8:00

Saturday 9:00 8:00

Sunday 9:00 8:00
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• Prerequisites

• Auto Attendant Configuration

• Prompt Management

• Script Management

Prerequisites

Before setting up Auto Attendant configuration and prompts, these telephony 

features should already be set up:

NOTE: Telnet must be enabled in order to configure Auto Attendant features.

• Phone extensions and associated voicemail accounts

• Dial plan and associated voice features

• Schedules for business hours of operation and holidays

• Voicemail transfer prefix, if Direct Transfer to Voicemail is used as an Auto 

Attendant option

Auto Attendant Configuration

The Auto Attendant tab initially displays options for enabling or disabling the Auto 

Attendant and choosing whether to configure a standard Auto Attendant with one 

level of menus (the default) or a multi-level Auto Attendant with submenus.

For instructions on how to configure the Auto Attendant, see these sections:

• Auto Attendant Modes, page 415

• Configuring a Standard Auto Attendant, page 416

• Configuring a Multi-Level Auto Attendant, page 419

Auto Attendant Modes

Three Auto Attendant modes are available:

• Off. When the Auto Attendant mode is set to Off, the factory default settings 

are used, and the AA Script is set to aa.aef.



Call Handling
Auto Attendant

416 Cisco Configuration Assistant SBCS Administrator Guide

14

If you choose to disable the Auto Attendant by setting the mode to Off, the 

dial plan mapping between the AA PSTN number and AA internal extensions 

are deleted. Voice feature settings that reference the Auto Attendant, such as 

the main number, hunt groups, and call blast groups, may need to be 

modified.

• Standard. The Standard Auto Attendant mode enables you to configure up 

to 5 Auto Attendants, each with a single level of menus. See Configuring a 

Standard Auto Attendant, page 416.

• Multi-Level. The Multi-Level Auto Attendant mode enables you to 

configure the AA so that it presents a main menu with up to three submenus 

to callers. See Configuring a Multi-Level Auto Attendant, page 419.

When you change the Auto Attendant mode, the existing Auto Attendant 

configuration is not retained. You must reconfigure all of the parameters if you 

change modes.

Configuring a Standard Auto Attendant

To configure a standard Auto Attendant, follow these steps.

STEP 1 In the Mode field, make sure that Standard is selected.

STEP 2 In the Number of Auto Attendants field, use the pull down menu to select the 

number of Auto Attendants to configure. Up to 5 Auto Attendants may be selected.

STEP 3 In the AA Extension field, enter the extension number to be accessed for general 

company auto attendant functions.

This is usually the main telephone extension number for the office. When a caller 

dials this extension, the Auto Attendant script runs. The AA Extension must be 

unique across the system. The default AA Extension is 398.

STEP 4 In the AA Script field, choose the AA script that is to run when the Auto Attendant 

is triggered.

These CCA and system scripts are listed.

• aa_sbcs_v04.aef provides two new functions:

- Alternate Greeting

When recording a prompt using the AVT (Administration Via Telephone) 

feature on the system, the user can designate the newly recorded prompt 

as the alternate greeting. AA always plays the alternate greeting (if 

defined) before its standard greeting when answering a call.
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Alternate greeting provides the means for the company administrator to 

manage the AA greetings remotely without using CCA. For example, the 

administrator can call the AVT from his/her home phone to record a 

company temporary shutdown announcement due to a snow storm and 

removing it as soon as the storm passed.

- Dial-by-First-Name

WARNING: The Dial-by-First-Name feature is NOT preloaded with a 

default prompt message. For the Dial-by-First-Name to be operational 

the UC500 administrator MUST record the supplementary instruction 

prompt dialbyfirstname.wav. Dial-by-First-Name replaces the Dial-by-

Last-Name feature.

An example of the instruction prompt is:

“Spell the first name of the person you want to call, followed by the last 

name. For letter Q press 7 and for letter Z press 9.”

After that, AA will play its standard prompt “To start over, press star”, 

telling the caller to use the star key for repeating the dialbyfirstname.wav 

prompt.

• aa_sbcs_v03.aef is the default script. This supports multi-level AA menus 

and enables configuration of separate key actions and prompts for business 

hours and closed hours, based on pre-defined Business and Holiday 

schedules. It also supports options for Dial by Number Anytime and Allow 

External Transfer, as well as fallback to a configurable number (No Option 

Transfer To) if the caller does take any action after the main menu prompt 

plays three times (default value).

• aa_sbcs_v02.aef provides the same functions as aa_sbcs_v03.aef except 

that it does not support the No Option Transfer To field.

• aa.aef (System) and aa_sample1.aef (Custom) are default system scripts 

that are deployed as part of Cisco Unity Express (CUE). When either of these 

scripts is selected, CCA allows only the base parameters to be configured 

(AA extension, AA PSTN number, and AA script).

• aa_transfer2.aef is an updated version of the aa_transfer.aef script that 

supports two additional key options (# and *) and the Play Prompt action.

You can upload custom user-defined scripts. However, for user-defined scripts, 

CCA only configures the AA extension and the AA PSTN number. See Script 

Management, page 423. These configuration steps apply only when the 

aa_sbcs_v02.aef, aa_sbcs_v03.aef or aa_sbcs_v04.aef AA script is selected.
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Currently, CCA discards all configurations on the UI when switching between 

scripts. However, CCA will allow user to retain the AA configuration on the UI when 

they switch from aa_sbcs_v03.aef script to aa_sbcs_v04.aef script and vice versa 

because these two scripts have identical settings. This will simplify the migration 

process for users needed to move between the two scripts.

STEP 5 In the Language field, choose the preferred language to use for this Auto 

Attendant.

The Language field has three items in the drop down list for selection; the two 

languages installed and the option “System (system language)”. [The “System” 

keyword followed by the system language is in parenthesis]. When operated in 

System language mode, the voicemail language defined in the Region UI dictates 

the AA language to be used. If only one language is installed in CUE, the language 

installed and “System” language are shown in the drop down list.

STEP 6 In the Business Hour Schedule field, choose the business schedule to use for this 

Auto Attendant.

STEP 7 Choose whether to enable Dial by Number Anytime and Allow External Transfer. 

When Dial by Number Anytime is enabled, callers can enter the callee's number 

at any time and the call will be directed to that number.

STEP 8 If you are using the aa_sbcs_v04.aef or aa_sbcs_v03.aef script, you can 

optionally enter a number in the No Option Transfer To field. This number can be 

an internal extension or an external PSTN number.

• If you specify an external PSTN number, enter the number exactly as you 

would dial it on the phone, including any access codes.

• If you specify an internal extension, make sure that you have entered the 

extension correctly. CCA does not check to see whether the extension is 

valid on your system.

STEP 9 If you are using the aa_sbcs_v04.aef or aa_sbcs_v03.aef script, you can 

optionally enter a number in the Maximum Menu Prompt Attempts field. This 

parameter dictates the number of times AA will replay its greeting before 

terminating or transferring an idling call (i.e., a call without any key input). After that, 

AA will transfer the call to the No-Option-Transfer-To number, or it will terminate 

if the No-Option-Transfer-To number is not defined. The range for the Maximum 

Menu Prompt Attempts field is 1-5; with the default set for 3 attempts.
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STEP 10 Configure prompts and key actions for both Business Hours and Closed Hours.

a. In the Menu Prompt field, choose the .wav file for the prompt to play when the 

Auto Attendant is triggered. The menu prompt will only show the list of prompts 

that is associated with the language selected in the AA language combo box.

b. (Optional) Click Record to use the CCA record and playback feature to record 

menu prompts. See Sound Recorder, page 422.

c. Define key actions. For each key action you wish to define:

• Click in the Mode column to choose the type of action.

• Click in the Parameters column to set input parameters, if needed.

For example, to have the AA direct the call to a hunt group when the user 

presses 4, select Call Hunt Group in the Mode column, then choose a hunt 

group from the list of available hunt groups displayed in the Parameter 

column.

Available actions include Call Blast Group, Call Hunt Group, Call Voicemail, 

Transfer to Voicemail, Call Extension, Play Prompt, Dial-by-Name, Dial-

by-Number, Call Other Number, and None.

NOTE Transfer to Basic ACD is not supported.

For Play Prompt, the menu prompt will only show the list of prompts that is 

associated with the language selected in the AA language combo box

If an external number is specified for Call Other Number, make sure that the 

number is entered exactly as you would dial it, including access codes or 

long distance codes, if required.

STEP 11 Click Apply or OK.

Configuring a Multi-Level Auto Attendant

The Multi-Level Auto Attendant mode enables you to configure the AA to present 

a main menu with up to three submenus to callers.

Configuring a multi-level AA with submenus is similar to configuring a Standard 

Auto Attendant, with these exceptions:

• For the Main menu configuration, the default Auto Attendant script is always 

used (aa_sbcs_v03.aef), and the script selection option is not displayed.
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• For submenus, the aa_transfer2.aef script is always used, and the script 

selection option is not displayed.

• One additional key action, Call Menu, is provided so that you can assign 

keys for navigating between the main menu and submenus.

For information about configuring the rest of the settings, see Configuring a 

Standard Auto Attendant, page 416.

Prompt Management

From the Prompt management tab, you can:

• Create prompts using one of these methods:

- Record prompts using the CCA sound recorder. This method allows 

you to record and play back prompts from within CCA by using the 

integrated CCA sound recorder. See Record Prompts Using Sound 

Recorder, page 421.

- Upload previously recorded custom prompts from a PC. You can 

record and play back .wav files on your PC and upload them to CUE. The 

.wav file must be recorded in G.711 u-law, 8-kHz, 8-bit mono format 

(Windows) or G.711 u-law, 44100-Hz, 8-bit mono format (Mac). The 

prompt cannot be longer than 60 seconds. See Upload Prompts, 

page 421.

- Use the CUE Greeting Management System to record prompts from 

a phone. To use this method, you configure an extension for AA prompt 

management on CUE and assign prompt management privileges to 

users. The ability to record prompts from a phone eliminates the need 

for a PC or sound editing software to manage prompts.

The prompt management extension is the extension that users with 

prompt management privileges dial to record or delete prompts.  When 

a user with prompt management privileges dials the prompt 

management extension, they must enter their extension number and 

voice mail PIN to log in. See Enable Prompt Management via Phone and 

Assign Prompt Management Privileges to Users, page 421.

• Upload prompts. See Upload Prompts, page 421.

• Change the prompt file name.

Filenames for user-created prompts recorded from phones or through the 

built-in sound recorder are initially named User_Prompt_<time_stame>.wav.
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To rename a prompt so that you can easily identify it when assigning it a key, 

click on the PromptName in the list of Available Prompts, edit the name, and 

then click OK.

• Delete prompts.

To delete a prompt, click on the PromptName in the list of Available Prompts, 

click Delete, then click OK.

Record Prompts Using Sound Recorder

To record Auto Attendant prompts using the integrated sound recorder, follow 

these steps.

STEP 1 Select the Prompt Management tab in the Auto Attendant window.

STEP 2 In the Create Prompts, Record Using Sound Recorder section of the Prompt 

Management tab, click Open.

STEP 3 Use the integrated sound recorder to record and save the prompt. See Sound 

Recorder, page 422.

Upload Prompts

To upload a previously recorded prompt file from your PC:

STEP 1 Select the Prompt Management tab in the Auto Attendant window.

STEP 2 In the Available Prompts section of the Prompt Management window, click Add.

STEP 3 Select the desired language from the Language pull down menu.

STEP 4 Click Browse to locate the prompt file on your PC.

STEP 5 Optional: Use the Play Prompt controls to listen to the prompt.

STEP 6 Click OK.

Enable Prompt Management via Phone and Assign Prompt Management 

Privileges to Users

To enable prompt recording from a phone on the system and assign prompt 

management privileges to users, follow these steps.
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STEP 1 Select the Prompt Management tab in the Auto Attendant window.

STEP 2 In the Prompt Recording Extension field, enter the extension to use for recording 

prompts.

STEP 3 In the Prompt Administrators field, click Users.

STEP 4 In the Assign Prompt Privileges to Users dialog, click the Add and Remove 

arrow buttons or use SelectAll to manage the list of selected users.

STEP 5 Click OK.

Sound Recorder

This window appears when you click Open from the Prompt Management tab in 

Auto Attendant window, or when you click Record to record the prompts.

To record Auto Attendant, or Custom Prompt file for incoming call in T.37 Fax-to-

Mail, or Basic ACD prompts using the integrated sound recorder, follow these 

steps.

STEP 1 Click Record and begin recording your message. You can pause, play back, and 

stop the recording.

STEP 2 Select the desired language from the Language pull down menu. This option only 

appears for the Auto Attendant window.

STEP 3 When you are satisfied with your recording, click Save As to navigate where you 

want to store the .wav file on your PC.

STEP 4 Enter an appropriate file name for the prompt and click Save.

STEP 5 Click OK. When you click OK, CCA closes the sound recorder and saves the new 

prompt file to your PC.



Call Handling

Auto Attendant

Cisco Configuration Assistant SBCS Administrator Guide 423

14
 

Script Management

You can upload, rename, and delete custom Auto Attendant scripts created using 

the CUE AA script editor.

Up to 2 custom user-defined AA scripts can be used. A maximum of 12 scripts are 

allowed; however, 10 of these script slots are reserved for CCA and default CUE 

system scripts, which cannot be deleted.

For custom, user-defined scripts, CCA only configures the AA extension and the 

AA PSTN number. You must use the CUE GUI to configure all other script 

parameters.

CCA-supported AA scripts (such as aa_transfer2.aef, aa_sbcs_v02.aef, 

aa_sbcs_v03.aef, and aa_sbcs_v04.aef) and CUE system default AA scripts (such 

as aa.aef and aa_sample1.aef) cannot be deleted, modified, renamed, or 

overwritten.

For information on how to create CUE AA scripts, see the Cisco Unity Express 

Guide to Writing and Editing Scripts, available on Cisco.com.

Procedures

To upload a custom AA script:, follow these steps.

STEP 1 From the Script Management tab in the Auto Attendant window, click Add.

STEP 2 Click Browse to locate the file on your PC.

STEP 3 Click OK.

To delete a custom AA Script, follow these steps.

STEP 1 From the Script Management tab in the Auto Attendant window, click on a script in 

the Available Prompts list to select it.

STEP 2 Click Delete.

You cannot delete a script that is currently being used by the Auto Attendant.



Call Handling
Dial By Name

424 Cisco Configuration Assistant SBCS Administrator Guide

14

Dial By Name

To configure Dial By Name, choose Configure > Telephony > Call Handling > Dial 

By Name on the feature bar.

Dial-By-Name feature can be assigned to a key button, so that the caller who 

reaches AA can dial the name of a phone owner to reach his/her extension.

In the past, the AA Dial By Name service was tied together with the personal 

mailbox creation. If mailbox was disabled, the “username <userID> phonenumber 

<extension>” CLI was not sent to the CUE. Accordingly, the Dial-By-Name on CUE 

would not work because the mapping between userId and extension was not 

defined.

The Dial By Name UI allows you to enable the AA Dial-By-Name service without 

defining a mailbox. The Dial-By-Name table displays the user and normal line(s) 

relation.

For each user defined on Users and Phones (User Extensions tab, Extension 

Mobility tab and Floating Extension tab), the Dial-By-Name table displays the list of 

Normal line extensions defined on the phone.

If the associated user mailbox is not defined, then you can select a Normal Line 

extension for the Dial-By-Name extension.

The Dial-By-Name extension cannot be changed on the Dial-By-Name UI if the 

user is already assigned a mailbox, or if the associated user is defined with a 

floating extension. This is because the Dial-By-Name extension is already defined 

in these two cases and managed respectively in the Floating Extension UI and 

User UI.

Basic Automated Call Distribution (ACD)

To configure Basic ACD, choose Configure > Telephony > Call Handling > Basic 

ACD on the feature bar.

This section covers these topics:

• Overview

• Before You Begin

• Configure Basic ACD Service
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• Create/Edit Basic ACD Parameters

• Members of Hunt Group

• Hunt Group Report Parameters

Overview

Basic ACD (BACD) provides automatic answering and distribution of incoming 

calls through interactive menus and hunt groups.

A Basic ACD application consists of one call queue service and up to 10 Basic 

ACD services. For each Basic ACD service, you configure a pilot number for the 

service, hunt group parameters, prompts, destination for unanswered calls, 

timeout, number of retries, and other settings.

The Basic ACD call flow implemented in Configuration Assistant is limited to drop-

through mode, in which the Auto Attendant serves as the top-level entry point and 

control is transferred to Basic ACD for second-level menu actions.

When an Auto Attendant is configured for drop-through mode, the Auto Attendant 

sends incoming calls directly to a call queue without providing menu choices to 

callers. When in the queue, a caller hears ringback if an agent is available, or Music 

on Hold (MoH) if all agents are busy. If a prompt for drop-through mode is 

configured, the caller hears the prompt before being sent to the queue as 

described. The drop-through prompt is simply a greeting to callers; it might say 

“Thank you for calling XYZ, Inc. An agent will be with you shortly.” Note that 

customers cannot make interactive choices in drop-through mode; calls are simply 

answered and routed to a call queue.

The BACD capabilities of the UC500 Series platform are listed below:

• Up to 10 BACD hunt groups (call queues)

• Up to 30 calls allowed in each queue

• Up to 20 agents can be members of a BACD hunt group

CCA Release 2.5 and later adds the HLog softkey on BACD agent phones. Agents 

can now log in or out of a BACD hunt group using the HLog softkey. The HLog 

softkey is displayed on agent phones when an incoming call to the BACD hunt 

group is received. Users can also access this softkey from the main phone screen 

by pressing the more softkey. The HLog softkey replaces the use of DnD (Do Not 

Disturb). DnD is less flexible, since it makes the subscriber generally unavailable 

for all calls, not just BACD hunt group calls.



Call Handling
Basic Automated Call Distribution (ACD)

426 Cisco Configuration Assistant SBCS Administrator Guide

14

See Create/Edit Basic ACD Parameters, page 426 for an explanation of the 

summary parameters displayed in the Basic ACD window for configured BACD 

services.

Before You Begin

Before configuring Basic ACD:

• Define the call flow and options to present to callers.

• Determine what prompts are needed and which ones will need to be 

customized.

• Make sure that phones and users are configured.

• When you configure Basic ACD, Configuration Assistant automatically 

creates hunt groups to handle Basic ACD forwarding. Parameters for these 

hunt groups are configured from the Create/Edit Basic ACD Parameters 

window.

Configure Basic ACD Service

To configure a Basic ACD service, follow these steps.

STEP 1 In the Basic Parameters Summary section of the Basic ACD window, click Create 

or Modify. The Create/Edit Basic ACD Parameters window opens.

STEP 2 Configure service parameters, hunt groups, and prompts in the Create/Edit Basic 

ACD Parameters window. See Create/Edit Basic ACD Parameters, page 426 for 

information about these settings.

STEP 3 Click OK or Apply and close the Basic ACD window.

Create/Edit Basic ACD Parameters

The Create/Edit Basic ACD Parameters window appears when you click Create or 

Modify in the Basic ACD window (Configure > Telephony > Call Handling > Basic 

ACD).
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Service Parameters

Configure Service Parameters as described below for each Basic ACD service. Up 

to 10 Basic ACD services can be configured.

Setting Description

Pilot Number Extension for this Basic ACD service.

Retry Number in 

x Seconds

Number of seconds to wait before re-sending the call to the 

local hunt group for this B-ACD service.

No Answer 

Forward to

Destination for calls unanswered by the B-ACD hunt group, 

either because all agents are logged out or busy, or the 

maximum call retry limit is exceeded. Unanswered calls 

can be forwarded to the Auto Attendant, Hunt Group, Blast 

Group, Voice Mail, an internal extension, or Other Number 

(external PSTN number).

Max Retry 

Before Call 

Drops

Number of times to retry the destination specified for No 

answer forward to before the call is dropped. When the 

call is dropped, the Basic ACD disconnect prompt is 

played. Valid values range from 1 to 3. The default value is 

1.

Play Busy 

Prompt in x 

Seconds

Number of seconds to wait before playing the Basic ACD 

busy prompt. This is the time delay between when the 

caller joins the B-ACD queue and when the second 

greeting is played or replayed. The same time interval is 

used between repeats of the second greeting. Valid values 

range from 30 to 120 seconds. The default value is 

60 seconds. The default busy prompt file is 

en_bacd_allagentsbusy.au.

No Answer 

Forward To in x 

Seconds

Maximum amount of time for call retry before the call is 

forwarded to the destination specified by No answer 

forward to. This is the maximum amount of time that the 

call can stay in the queue. Valid values range from 60 to 

3600 seconds. The default value is 600 seconds.

No Answer 

Forward to 

Number

Phone number for calls unanswered by the B-ACD hunt 

group.
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Hunt Group Parameters

Configure settings for Hunt Group Parameters as described below for each 

configured Basic ACD service. The Basic ACD hunt group that is created is local to 

the Basic ACD service.

Welcome 

Prompt

Not used. CCA supports drop-through mode only; 

therefore, this prompt is not applicable. Use the Transfer 

prompt.

Setting Description

Hunt Type Defines the order in which calls are distributed to members 

of the Basic ACD hunt group. Choose one of these types: 

• sequential. Calls are routed to Basic ACD hunt group 

members in the order they are listed in the Members 

dialog.

• peer. Calls are routed to Basic ACD hunt group 

members in round-robin order.

• longest-idle. Calls are routed to the member of the 

Basic ACD hunt group with the longest idle time.

Members Click Members to open a dialog for selecting phones and 

their associated users as members of this Basic ACD hunt 

group. See Members of Hunt Group, page 429.

Hunt Timeout Number of seconds before a call that is unanswered by a 

member of the hunt group is directed to the next member, 

as specified by the Hunt Type. The default is 8 seconds.

Enable Auto 

Logout

When this option is checked, autologout is enabled. When 

the Attempts Before Logout value is exceeded, the agent 

phone is automatically logged out of the Basic ACD hunt 

group.

All Agents 

Logged Out 

Display 

Message

Message to display when all agents (hunt group members) 

are logged out. The default is All Agents Logged Out. The 

message can contain up to 39 characters.

Setting Description
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Prompt Management

To manage Basic ACD prompts, configure the settings as described below. When 

you are finished making changes, click OK or Apply.

Members of Hunt Group

This window appears when you click the Members button in the Create/Edit Basic 

ACD Parameters window.

To create or edit the list of hunt group members and their associated phones, 

follow these steps.

STEP 1 Click on a user in the Available or Selected list. Use the CTRL-click and SHIFT-click 

keyboard shortcuts to select multiple users in either list.

STEP 2 Use the Add, Remove, and Select All buttons to move selected users between 

the Available and Selected lists.

STEP 3 Use the Up and Down arrow buttons to order the members of the hunt group.

STEP 4 Click OK to apply your changes.

Attempts Before 

Logout

Maximum number of unanswered calls to the B-ACD hunt 

group member (from 1 to 20) before autologout. The default 

value is 3.

Setting Description

Transfer to Basic 

ACD Prompt

Choose from one of the default Basic ACD prompts listed 

in the pull down menu or click Record to record a custom 

prompt using the built-in sound recorder. See Sound 

Recorder, page 430

Setting Description
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Hunt Group Report Parameters

The Basic ACD feature uses the CME B-ACD report generator to create simple 

CSV-format report files that can be imported into a spreadsheet program.

To enable Basic ACD reporting and configure hunt group report parameters, 

complete the fields in the Hunt Group Report Parameters section of the window as 

described below.

When you are done configuring Basic ACD hunt group report settings, click OK or 

Apply.

Sound Recorder

This window appears when you click Record from the Create/Edit Basic ACD 

Parameters window.

To record Auto Attendant or Basic ACD prompts using the integrated sound 

recorder, follow these steps.

Setting Description

Enable CME 

Report

When checked, Basic ACD hunt group report generation 

is enabled. Basic ACD reporting is disabled by default.

CME Report 

Location

Location of the TFTP or FTP server and directory for 

Basic ACD reports. The format is tftp://

<ServerIPAddress>/<directory>/<filename> or

ftp://<ServerIPAddress>/<directory>/<filename>.

for example, tftp://192.168.10.1/bacdrpts/mybacd

Number of 

Reports

The number of simple CSV-format report files to be 

created. Valid values range from 1 to 200.

Frequency of 

Reports (hrs)

Frequency of report generation, in hours. Valid values 

range from 1 to 84.

Manually Upload 

Reports

If CME reporting is enabled, click Manually Upload 

Reports to immediately trigger sending of report data to 

the specified report location on the TFTP server.

This option is unavailable when CME reporting is 

disabled.
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STEP 1 Click Record and begin recording your message. You can pause, play back, and 

stop the recording.

STEP 2 When you are satisfied with your recording, click Save As to navigate where you 

want to store the .wav file on your PC.

STEP 3 Enter an appropriate file name for the prompt and click Save.

Click OK. When you click OK, CCA closes the sound recorder and saves the new 

prompt file to your PC.

Night Service

To configure Night Service, choose Configure > Telephony > Call Handling > 

Night Service from the feature bar.

Before you can enable Night Service, you must set up a night service schedule 

from the Night Service Schedule tab in the Schedules window (Configure > 

Telephony > Call Handling > Schedules). See Night Service Schedule, 

page 413.

Overview

Up to four extensions can be configured for night service. Each extension can be 

configured with a Call Forward number or a Night Service Bell.

When a call forward number is configured for a night service extension, incoming 

calls to that extension during night service hours are forwarded to that number.

The night service bell allows you to provide coverage for unstaffed extensions for 

night-service hours. During night-service hours, extensions configured for night-

service bell receive notification of incoming calls with a special “burst” ring. Phone 

users at the night-service phones can then use the call-pickup feature to answer 

incoming calls.

To configure night-service phones, at least one of the extensions must be 

configured with a night service bell.

A user can enter a night-service code to manually toggle night-service treatment 

off and on from any phone with a night service extension. The night service toggle 

code turns night service on or off for all phones with night service.

The following limitations apply to night service:
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• Analog phones do not receive night service notifications. However, the 

extensions for the analog phones that are configured with a User Phone role 

can be configured to be monitored during night service.

• IP phones that do not have softkeys can use feature access codes to pick 

up calls to the night service extension.

Procedures

To configure a night service extension with a call forward number:

STEP 1 In the Extn # field, choose an available extension from the drop-down list.

STEP 2 In the Answer Type field, choose call forward night service.

STEP 3 Enter a number in the Forward to Number field.

Inbound calls to this extension during night service hours are forwarded to this 

number.

This number can be an external PSTN number or an extension number. When 

entering an external PSTN number, enter the number exactly as you would dial it, 

including the access code.

STEP 4 Repeat the steps 1 to 3 to configure night service with a call forward number for 

more extensions.

STEP 5 Click OK or Apply.

To configure Night Service with Night Service Bell, follow these steps.

STEP 1 In the Extn # field, choose an available extension from the drop-down list.

STEP 2 In the Answer Type field, choose night service bell.

STEP 3 Click the Night Service Phones button to launch a window for selecting phones.

STEP 4 Select the phones from the available phones list.

STEP 5 Click Add.

STEP 6 Click OK or Apply.
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To configure a night service code, follow these steps.

STEP 1 In the Night Service Code field, enter the night service toggle code.

You can enter up to 15 digits. CCA automatically prefixes the code with an asterisk 

(*).

When choosing a code for toggling Night Service, keep in mind that a default set 

of feature activation codes (used primarily for analog lines) are sent to the UC500 

by CCA. To avoid overlap with these feature activation codes, the Night Service 

toggle code should begin with *2, *7, *8, or *9.

STEP 2 Click OK or Apply.

To remove a night service extension, set the Extn# field to None and apply the 

change. You can also select a different extension and modify any of the other 

settings.

To modify the list of night service phones, click Night Service Phones, use the 

Add, Remove, and Select All buttons to update the Selected Phones list, then 

apply your changes.

For more information, see these topics:

• Night Service Phones, page 433

• Night Service Schedule, page 413

Night Service Phones

This window appears when you click Night Service Phones in the Night Service 

window.

Click on phones from the Available list and use the Add, Remove, and Select All 

arrow buttons to move phones between the Available and Selected Phones lists.

Selected phones are configured as night service phones and will receive 

notification of incoming calls when night service is active. Phone users at the night-

service phones can then press the GPickUp button on their phone to answer 

incoming calls.

When you are finished choosing phones, click OK.

For more information, see these topics:
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• Night Service, page 431

• Night Service Schedule, page 413

Live Record

This window appears when you choose Configure > Telephony > Call Handling > 

Live Record from the feature bar.

Overview

Live Record enables users to record live conversations and store the recording as 

a message in their mailbox. They can then play it or forward it to another voice 

mailbox. The default setting for this application is disabled.

Phone users can start a Live Record session by pressing the LiveRcd softkey on 

their IP phone during a call. The system sets up a conference call between the Live 

Record pilot number you configure here and the party to be recorded.

Periodic beep tones are played to indicate that the call is being recorded. You can 

choose to enable or disable these tones and set the tone duration and interval.

The following notes apply to Live Record:

• External callers cannot use this feature because it uses the extension 

number assigned to the caller.

• Live Record messages do not trigger a message notification when 

delivered to a voice mailbox.

• The size of Live Record messages is limited only by the amount of space 

remaining in the subscriber's voice mailbox.

Procedures

NOTE: User needs to configure the ad-hoc conference if the hardware 

conference resource is not present. See Enabling and Configuring Multiparty 

(MeetMe and AdHoc) Conferencing, page 402.

To enable and configure Live Record, follow these steps.
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STEP 1 Configure Live Record Settings:

a. Check the Enable Live Record option to enable this feature.

b. In the Pilot Number field, enter the Live Record pilot extension number. 

This extension is used to forward all incoming calls to the voice mail system 

pilot number. All calls sent to the voice mail pilot number from this number will 

bypass the voice mail greeting. If the caller has a voice mailbox, recording 

starts immediately.

STEP 2 Configure Live Record Beep Settings:

a. The Beep Duration setting specifies the number of milliseconds that the beep 

tone will play. The beep duration can range from 50 to 1000 milliseconds. The 

default is 250 milliseconds.

b. The Beep Interval specifies the number of seconds between the end of one 

beep and the start of the next beep. The beep interval can range from 1 to 

30 seconds. The default beep interval is 15 seconds.

STEP 3 Click OK or Apply.

T.37 Fax to Mail

To configure T.37 Fax to Mail, choose Configure > Telephony > Call Handling > 

T.37 Fax to Mail from the feature bar.

To learn more about T.37 Fax to Email features and configuration settings, see the 

following topics:

• Overview

• Limitations

• Prerequisites for Configuring T.37 Fax

• Enabling T.37 Fax to Mail and Configuring Services

• Configuring Mailboxes for Incoming Faxes
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Overview

T.37 is an ITU standard for sending fax messages using email. The CCA T.37 Fax to 

Mail feature allows the UC500 to act as a fax gateway for communicating with 

regular fax machines, converting faxes to emails, or converting emails to faxes. 

Within Cisco, this feature is also referred to as T.37 Store and Forward Fax.

The CCA T.37 Fax to Mail feature allows you to configure the UC500 and the voice 

mail system to provide the following features:

• Incoming fax services, using the On Ramp application.

Using CCA, you configure the voice mailboxes that will receive incoming 

faxes. The stored faxes can be forwarded as email attachments or sent to a 

fax printer. Fax messages are converted to image files in TIFF format. You 

can configure the mailboxes for fax-only service (all incoming calls are 

assumed to be fax calls) or for voice and fax service (incoming calls can be 

either voice calls or faxes).

CCA configures voice mailboxes for users, groups, and floating extensions 

(extension not associated with a phone or group). All voice mailboxes, 

including those associated with floating extensions, can receive and store 

fax mail, as long as that they are associated with an incoming phone number 

on a PSTN trunk.

• Voice and fax detection, using the Voice and Fax Detection Application. 

Voice and fax detection provides the ability to detect whether an incoming 

call is voice or fax. This enables you to use a single incoming number for 

both voice and fax calls.

• Fax printing, using the Off Ramp application. This enables phone users to 

use the Telephony User Interface (TUI) to forward faxes stored in voice mail 

to a local fax machine for printing.

• Receive faxes as email messages. Using CCA, you can integrate T.37 Fax 

to Mail services with voice mail notification or IMAP services so that users 

can be notified of incoming faxes via phone or email, with the option to 

include the fax as an email attachment.

• Record custom prompts or use default system prompts for incoming 

calls to lines configured to receive both fax and voice calls. You can use 

the default prompts for incoming calls to lines with voice and fax detection 

or you can configure custom prompts. Default prompts are provided in 

US/English, Spanish, and Chinese.
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CCA bundles the Interactive Voice Response (IVR) applications used for fax 

services, fax detection and fax printing. These applications are implemented as 

Tool Command Language (TCL) scripts and are uploaded to the UC500 flash 

when you apply the T.37 Fax to Mail configuration. The default prompts presented 

to users for incoming calls to lines configured with voice and fax detection are 

uploaded to the flash when you apply the configuration. 

The application TCL scripts and default system prompts are located in the 

flash:applications/faxmail directory on the UC500 flash. Your custom 

prompts are placed in the flash:applications/faxmail/custom directory 

on the flash.

Limitations

The following limitations apply to T.37 Fax to Mail configuration using CCA:

• Only mailboxes associated with incoming phone numbers on PSTN trunks 

can be configured to receive incoming faxes. SIP trunks are not supported.

• Voice and Fax Detection does not work with all fax machines or all modes of 

operation. Tones may not be detected correctly for fax machines operating 

in manual mode.

• Concurrent use of T.37 Fax Detection application and SNR is not supported.

• Phones that do not have a Telephony User Interface (TUI), cannot be used to 

forward faxes to a local fax machine for printing.

Prerequisites for Configuring T.37 Fax

Before you enable and configure T.37 fax, the following configuration must be set 

up:

• Configure users, extensions, and voice mailboxes on the system. 

To do this, go to Configure > Telephony > Users and Extensions > Users 

and Phones and select the User Extensions or Floating Extensions tab. Note 

that voice mailboxes for Hunt Groups and Call Blast Groups are created 

when No Answer Forward To option is set to Voicemail in the Phone Groups 

window (Configure > Telephony > Phone Groups).

• Only voice mailboxes associated with incoming phone numbers on PSTN 

trunks can be configured to receive incoming faxes. You must create an 

incoming dial plan for each extension with a voice mailbox that will be 

configured to receive incoming faxes. 
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To do this, go to Configure > Telephony > Dial Plan > Incoming. When 

selecting a Destination Type for Incoming FXO Calls or Direct Dial to Auto 

Attendant, Groups, or Operator, choose OPERATOR or HUNT_GROUP as 

the Destination Type.

• If you want to enable Fax Printing, you must have a local fax machine 

connected to an FXS port on the UC500 and the FXS port must be assigned 

a FAX role. To do this, go to Configure > Telephony > Ports and Trunks > 

FXS Ports.

• To integrate T.37 Fax to Mail with voice mail notifications so that users can 

receive email notification of incoming faxes with the fax as an attachment, 

go to Configure > Telephony > Users and Phones > Voicemail, and 

configure notifications for the mailboxes that are set to receive incoming 

faxes.

For instructions on how to do this, see Notifications, page 366.

NOTE: In order to receive email or phone notification of incoming faxes the 

Notification Level should be set to All Voicemail.

• You can also enable Unified Messaging in CCA to integrate T.37 Fax to Mail 

with IMAP. To enable Unified Messaging, go to Applications > Smart 

Applications > Smart Applications Manager. See Unified Messaging 

(IMAP), page 516.

Enabling T.37 Fax to Mail and Configuring Services

On the Services tab, you can:

• Enable T.37 Fax to Mail services

• Configure prompt settings for Voice and Fax Detection

• Set the default fax printer to use for Fax Printing

To enable and configure T.37 Fax to Mail Services settings, follow these steps.

STEP 1 In the Hostname device pull-down menu, choose the UC500.

STEP 2 Click the Enable Fax to Mail checkbox.

STEP 3 Complete the fields on the Services tab as shown in the following table.
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Settings Description

Incoming 

Fax Only

The Incoming Fax Only section of this page displays the version 

of the On Ramp Fax Only application that is installed.

If T.37 Fax to Mail has not been configured for the system, the 

message “Pending Install (version 2.0.1.3)” is displayed. The On 

Ramp application will be uploaded and installed on the UC500 

when you apply the configuration.

Incoming 

Voice and 

Fax

Voice and fax detection provides the ability to detect whether 

an incoming call is voice or fax. This enables you to use a single 

incoming number for both voice and fax calls.

CCA configures fax detection to “listen first” so that the call 

does not need to be connected. When a fax tone is detected on 

the call, it is processed and routed as a fax call. If no fax tone is 

detected, it is routed as a normal voice call.

The version of the Voice and Fax Detection application that is 

installed is also displayed here. If T.37 Fax to Mail has not been 

configured for the system, the message “Pending Install” and 

the version of the Voice and Fax Detection application are 

displayed. The Voice and Fax Detection application will be 

uploaded and installed on the UC500 when you apply the 

configuration.
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Incoming 

Voice and 

Fax 

(continued)

Prompt for Incoming Calls

The detection process may delay incoming calls for up to 

9 seconds. Default system prompts are provided for alerting 

callers and providing options for callers to avoid the delay and 

be connected immediately or send a fax. You can also record a 

custom prompt for this purpose (for example, you may want to 

do this if you require the prompt to be played in a different 

language).

The default system prompt is “To send a fax, press the START 

key on your fax machine now. For voice calls, press any key or 

stay on the line.”

Choose ones of these options

• Custom. Record a custom prompt for incoming calls.

• System (Chinese). Use the Chinese language system 

default prompts.

• System (English). Use the English language system 

default prompts. This is the default value.

• System (Spanish). Use the Spanish language system 

default prompts.

• None. Choose this option if you are not using Voice and 

Fax Detection (mailboxes that receive incoming faxes 

are configured as Fax Only).

The built-in TFTP server in CCA is used for uploading and 

downloading system prompts. Make sure that the firewall 

settings on your PC allow TFTP traffic to and from the UC500 

and that there are no third-party TFTP servers running on your 

PC.

Custom Prompt File (Optional)

Displays the filename of the prompt you recorded for incoming 

calls. This menu only appears if the Prompt for Incoming Calls 

feature is set to Custom. When selected, click Add File to 

record and upload a custom prompt. SeeAdd Custom Prompt 

File, page 441.

Settings Description
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Add Custom Prompt File

Upload Prompts

To upload a previously recorded prompt file from your PC:

STEP 1 Click Browse to locate the prompt file on your PC.

STEP 2 Optional: Use the Play Prompt controls to listen to the prompt.

STEP 3 Click OK.

Fax Printing Fax mail may be printed to any dialable number or to the default 

fax printer configured.

If you want to enable Fax Printing, you must have a local fax 

machine connected to an FXS port on the UC500 and the FXS 

port must be assigned a FAX role. To do this, go to Configure > 

Telephony > Ports and Trunks > FXS Ports.

Only FXS ports that have been assigned a Fax role are 

available for selection.

The version of the Off Ramp fax printing application that is 

installed is also displayed. If T.37 Fax to Mail has not been 

configured for the system, the message “Pending Install 

(version 2.0.1.1)” is displayed. The Off Ramp fax printing 

application will be uploaded and installed on the UC500 when 

you apply the configuration.

Default Fax Printer

To configure a default fax printer:

1. Set the default printer to use.

2. Click OK or Apply.

Settings Description
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Record Prompts Using Sound Recorder

To record Custom Prompts, using the integrated sound recorder, follow these 

steps:

STEP 1 Click Record and begin recording your message. You can pause, play back, and 

stop the recording.

STEP 2 When you are satisfied with your recording, click Save As to navigate where you 

want to store the .wav file on your PC.

STEP 3 Enter an appropriate file name for the prompt and click Save.

STEP 4 Click OK. When you click OK, CCA closes the sound recorder and saves the new 

prompt file to your PC.

Configuring Mailboxes for Incoming Faxes

Incoming faxes may be stored and forwarded to voice mailboxes. All mailboxes 

can receive faxes, provided they have an incoming dial plan. The same mailbox is 

used for storing both faxes and voice mails.

Also, you can disable the fax without impacting the existing messages in the 

mailbox. However, after faxing is disabled for a mailbox, the system rejects faxes 

addressed to that mailbox from a fax machine.

Mailboxes configured with an email destination may receive faxes as email. To 

configure email destinations, go to Telephony > User and Extensions > Voicemail 

and select the Notifications tab to enable email notification via email.

NOTE: Unified Messaging may also be used to receive faxes as email. To 

configure Unified Messaging, go to Applications > Smart Applications > Smart 

Applications Manager.

Adding Mailboxes to Receive Incoming Faxes

Only mailboxes associated with incoming numbers on PSTN trunks may be added. 

To configure incoming numbers go to Telephony > Dial Plan > Incoming.

To add mailboxes that will receive incoming faxes, follow these steps:
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STEP 1 Click Add on the Mailboxes tab in the T.37 Fax to Email window. The Add 

Mailboxes to Receive Incoming Faxes window appears.

STEP 2 In the Add Mailboxes to Receive Incoming Faxes window, use the Add, Remove, 

and Select All buttons to move selected users between the Available Mailboxes 

and Selected Mailboxes lists.

STEP 3 Click OK to return to the T.37 Fax to Email window.

Removing Mailboxes from the List

To remove mailboxes to receive incoming faxes follow these steps:

STEP 1 From the Mailboxes tab, select the desired Mailbox.

STEP 2 Click Delete.

STEP 3 Click OK or Apply.
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Dial Plan

This section covers incoming and outgoing dial plan configuration, including the 

following topics:

• Incoming Dial Plan

• Outgoing Dial Plan

• PSTN Trunk Groups

• Dial Plan Templates

• Call-back Rules

Incoming Dial Plan

To configure the incoming dial plan, choose Configure > Telephony > Dial Plan > 

Incoming Dial Plan from the feature bar.

Before You Begin

Before configuring incoming dial plan settings for direct dialing and incoming FXO 

calls, make sure that settings in the PSTN Trunks window for BRI, PRI, and FXO 

trunks have been configured (Configure > Telephony > Ports and Trunks > PSTN 

Trunks). If SIP trunks are used, make sure these are configured (Configure > 

Telephony > Ports and Trunks > SIP Trunk). Auto Attendant, hunt groups, and call 

blast groups should also be configured so that they are available as destinations 

for incoming FXO calls and DID numbers.

The incoming dial plan window has these tabs:

• Incoming FXO Calls

• Direct Dialing
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Incoming FXO Calls

On the Incoming FXO Calls tab, choose the destination for incoming calls on FXO 

ports.

To configure destinations for incoming calls to FXO ports, select an FXO port from 

the list, edit settings as described below, then click OK or Apply.

Field Description

Description Description for this FXO port. You can edit the default 

value, which initially is the same as the FXO port number, 

for example, 4 FXO-0/0/1.

Trunk Read-only field that contains the FXO port number, for 

example, 4 FXO-0/0/1.

Destination Type Destination for inbound calls to this FXO trunk. Choose 

from the following destination types.

• CO_LINE (direct “Central Office” PSTN trunk line)

• OPERATOR

• AUTO_ATTENDANT

• BLAST_GROUP

• HUNT_GROUP

• B_ACD (Basic ACD service extension)

Destination If you choose AUTO_ATTENDANT, HUNT_GROUP, 

BLAST_GROUP, or B_ACD, as the extension type, select 

the appropriate extension or group from the list of those 

configured on your system.

If you choose Operator as the extension type, manually 

enter the extension to be used for the Operator for the site.

If you choose CO_LINE, a read-only description is 

displayed, for example, Direct Trunk Line - CO1.
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Direct Dialing

On the Direct Dialing tab, set up translation rules for mapping incoming PSTN 

numbers to internal extensions. Two types of translations can be set up:

• Direct Dial to Internal Extensions. Configure direct inward dial (DID) 

numbers to ring internal extensions. Use this method to create a one-to-one 

mapping between a single DID number and a single internal extension. See 

Direct Dial to Internal Extensions, page 447.

• Direct Dial to AA, Groups, Operator. Configure a DID number or range of 

DID numbers to ring a hunt group, call blast group, Basic ACD service, Auto 

Attendant or Operator extension.  See Direct Dial to Auto Attendant, 

Groups, Operator, page 449.

Direct Dial to Internal Extensions

This window appears when you click Add from the Direct Dial to Internal User 

Extensions section in the Incoming Dial Plan window.

Overview

From this window, you configure DID (direct inward dial) numbers to ring internal 

extensions. This is done by creating translation rules to define the mapping 

between each DID number and its corresponding internal extension. A single DID 

number is mapped to a single internal extension.

The DID number provided by your carrier can have any number of digits. Consult 

your carrier for the DIDs that have been assigned for your installation.

The maximum number of DID translation rules is 15. However, a single translation 

rule can be used to map multiple DID numbers to internal extensions by using a 

range, as shown in this example.
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Procedures

To configure a translation rule for direct dial to internal user extensions, click Add, 

complete the fields in the Direct Dial to Internal User Extensions window as 

described below, then click OK.

Direct Dial to Internal User Extensions

Setting Value

PSTN Numbers

DID Range Start Number 9725551000

DID Range End Number 9725551005

Internal Extensions

Internal Extension Start Number 200

Internal Extension End Number 205

Resulting Configuration

Incoming calls to this DID number Ring this extension

972-555-1000 Ext. 200

972-555-1001 Ext. 201

972-555-1002 Ext. 202

972-555-1003 Ext. 203

972-555-1004 Ext. 204

Field Description

Description Description for the DID extension mapping.

Incoming Trunks Choose the digital trunk type from the list that 

corresponds to the carrier providing the DID numbers, for 

example, SIP Trunk, BRI Trunk, or T1/E1 Trunk.
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Direct Dial to Auto Attendant, Groups, Operator

This window appears when you click Add from the Direct Dial to Auto Attendant, 

Groups, Operator section in the Incoming Dial Plan window.

From this window you create DID translations to map one or more incoming PSTN 

numbers to an Auto Attendant, hunt group, call blast group, Basic ACD service, or 

operator.

To configure direct dial from one or more PSTN numbers to a hunt group, blast 

group, Basic ACD service, Operator extension, or the Auto Attendant, click Add, 

complete the fields in the Direct Dial to Auto Attendant, Groups, Operator window 

as described below, then click OK or Apply.

PSTN Numbers DID (PSTN) numbers to map to the corresponding internal 

extensions.

• To map only one number, enter the same number 

for the DID Range Start Number and DID Range 

End Number.

• To map a range of numbers, enter starting and 

ending numbers to define the range.

• DID numbers can begin with a “+” character.

Internal 

Extensions

Internal extension numbers to map to DID numbers.

• To map only one number, enter the same number 

for the Internal Extension Start Number and 

Internal Extension End Number.

• To map a range of numbers, enter starting and 

ending numbers for internal extensions to define 

the range.

• The number of internal extensions specified by the 

range must match the number of DID numbers 

specified by the DID range.

Field Description
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Field Description

Description Description for the DID extension mapping.

Trunks Choose the voice trunk type from the list that corresponds 

to the carrier providing the DID numbers, for example, SIP 

Trunk, BRI Trunk, or T1/E1 Trunk.

DID Numbers DID (PSTN) numbers to map to the corresponding internal 

destinations.

• To map only one number, enter the same number for 

the DID Range Start and DID Range End.

• To map a range of numbers, enter starting and 

ending numbers to define the range.

• DID numbers can begin with a “+” character.

Destination Type Choose from the following internal destinations types. If a 

destination type is not listed, no internal extensions of that 

type are configured on the system: 

• OPERATOR

• AUTO_ATTENDANT

• BLAST_GROUP

• HUNT_GROUP

• B_ACD (Basic ACD service extension)

Destination If you choose AUTO_ATTENDANT, HUNT_GROUP, 

BLAST_GROUP, or B_ACD, as the destination type, select 

the appropriate extension or group from the list of those 

configured on your system.

If you choose Operator as the Destination Type, manually 

enter the extension to be used for the Operator for the site.
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Outgoing Dial Plan

This window appears when you choose Configure > Telephony > Dial Plan > 

Outgoing from the feature bar.

NOTE: Telnet must be enabled in order to configure dial plan features.

IMPORTANT  If you experience problems with outgoing dial plan configuration, 

telephony configuration, or dial plan templates, check the contents of the directory 

<USER_HOME>\.configuration assistant\telephony\dialplan. You should see 

several files ending with .xml. If you are missing these files, they may have been 

removed after installation, and a re-installation of CCA is required. Also, make sure 

that you are logged in with the same credentials that were used to install CCA. If 

you are running Windows 7, <USER_HOME> should be “C:\Users\<loginid>”. 

Otherwise, <USER_HOME> should be “C:\Documents and Settings\<loginid>”. 

Alternately, you can check the value of the environment variable HOMEPATH on 

your Windows system.

The Outgoing Dial Plan window has these tabs:

• Outgoing Call Handling

• PSTN Trunk Groups

• Caller ID

Outgoing Call Handling

On the Outgoing Call Handling tab, you can:

• Choose a Numbering Plan Locale

• Set the Default Access Code and Digit Collection Timeout

• Configure Outgoing Numbers

• Add or Edit an Outgoing Number

Choose a Numbering Plan Locale

From the Numbering Plan Locale menu, choose one of the following:

• A built-in numbering plan template for a specific locale, for example, 

Template: Australia or Template: North America.
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The following locales have built-in templates: Argentina, Australia, Austria, 

Belgium, Brazil, Chile, China, Columbia, France, Germany, Indonesia, Ireland, 

Italy, Japan, Malaysia, Mexico, Netherlands (6-digit or 7-digit), New Zealand, 

North America (7-digit and 10-digit), Norway, Philippines, Singapore, 

Slovenia, Spain, Switzerland, UK, Taiwan, Thailand, and Venezuela.

For North America, both 7-digit and 10-digit dial plan templates are provided 

so that you do not have to manually edit the dial plan for local dialing. 

Similarly, 6-digit and 7-digit templates are provided for the Netherlands.

• Define a new locale (creates a new, blank numbering plan).

• A custom template based on one of the default templates with modifications 

or a custom imported template.

After you choose a numbering plan locale, the tab updates to display the outgoing 

numbers defined in the selected locale or, if you selected Define New Locale, all 

outgoing numbers are cleared.

After you have added or modified any of the outgoing numbers in the default 

template for a locale, a new dial plan is created with your changes, leaving the 

original template intact.

When you first apply an outgoing dial plan template, if that template contains any 

blocked numbers, you are asked whether you want to globally enable or disable 

call blocking on all user phones. This global option appears only during initial dial 

plan configuration. If you add or remove blocked numbers after the template is 

applied, this global enable/disable option is not available. Call blocking on phones 

added after the dial plan template is applied must be manually configured on the 

User Extensions tab in the Voice window.

For more information, see Dial Plan Templates, page 458.

Set the Default Access Code and Digit Collection Timeout

An access code is a single-digit number that phone users dial to place external 

calls. In the Access Code field, enter a single digit, from 0 to 9 or use the default 

value of 9. This sets the default access code.

If you change the default Access Code for an existing dial plan, Configuration 

Assistant displays a dialog asking you whether or not you want the default access 

code to be applied to all outgoing numbers. Choose Yes to update all outgoing 

numbers in the existing dial plan.

In the Digit Collection Timeout field, enter the number of seconds (from 2 to 120) to 

wait for user input when dialing or use the default value of 5.
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Configure Outgoing Numbers

!
CAUTION All changes to dial plan configuration for outgoing numbers must be tested. Errors 

in dial plan configuration can result in customers being unable to place calls.

Cisco strongly recommends that you use an actual IP phone to test the outbound 

dial plan after you have applied the configuration. CCA checks for conflicts within 

the UC500, but checking for incompatibility with the Telco provider is out of scope 

for CCA. 

For example, some North American Telco providers require the PSTN access prefix 

to be sent to the CO, while other providers require the access code to be stripped.

You may need to Add or Edit an Outgoing Number in the numbering plan to:

• Change permissions for certain types of calls.

Prevent users from dialing certain numbers (call blocking).

Call blocking prevents calls to restricted numbers. When a user attempts to 

place a call to a blocked number, a fast busy signal is played for 

approximately 10 seconds. The call is terminated, and the line is placed 

back on-hook. Call blocking can be enabled and disabled on all types of 

phones except SIP phones. Call blocking is controlled separately from user 

permissions and must be enabled on a per-phone basis from the More 

options window on the Users tab in the Voice window. For more 

information, see Call Blocking Example, page 457.

Call permissions and restricted numbers in the dial plan do not apply to CO 

(central office) trunk lines. The Block Restricted Calls and Permissions 

options are not available for CO Lines.

The Telephony Setup wizard does not globally enable call blocking for user 

phones when the dial plan template is applied. After the wizard completes, 

you must manually configure call blocking on each phone.

• Permit phone users to place calls to specific numbers that are outside 

their normal permissions. For example, phone users permitted to dial 

National Plus numbers may also need to be able to dial an international 

number to reach the main corporate office. In that case, you can add an 

outgoing number specifically for that purpose and set its permission to 

National Plus.
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• Edit the Trunk List to route calls to the appropriate trunk in order of 

preference. For example, if you select PSTN Only for the Trunk List for 

Local and Local Plus numbers, all local/local plus calls and emergency calls 

are routed to PSTN trunks. If you select SIP then PSTN as the Trunk Type 

for International and International Plus calls, these are routed to available 

SIP trunks first (since they are free), with fallback to PSTN trunks.

Add or Edit an Outgoing Number

To add an outgoing number, click Add Number to insert a new row in the table, 

configure settings as described in the following table, then click OK or Apply.
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Field Description

Permissions Permission level for the outgoing number. You can also define 

patterns for call blocking.

Each outgoing number has a permission level. The permission 

level corresponds to the Permissions and Block Restricted 

Calls settings that are configured on each phone. Permission 

levels are cumulative, as listed below:

• Blocked. Restricted number. When Block Restricted 

Numbers is enabled for a phone, calls to these 

numbers are blocked.

• Emergency. Outgoing number for emergency services 

calls. Emergency numbers are included in all 

permission levels.

• Toll-Free. Outgoing number for free calls that is 

included in all permission levels.

• Local. Includes Emergency, Toll-Free, and Local calls.

• Local Plus. Includes Emergency, Toll-Free, Local, and 

Local Plus numbers.

• National Includes Emergency, Toll-Free, Local, Local 

Plus, and National numbers.

• National Plus. Includes Emergency, Toll-Free, Local, 

Local Plus, National, and National Plus numbers.

• International. Includes Emergency, Toll-Free, Local, 

Local Plus, National, National Plus, and International 

numbers.

• International Plus. Includes Emergency, Toll-Free, Local, 

Local Plus, National, National Plus, International, and 

International Plus numbers.

• Unrestricted. Includes all permission levels except 

Blocked.

Description Description of the outgoing number rule. For blocked calls, the 

description is always Restricted Number, and is displayed 

automatically.
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Access Code Access code, if needed, for dialing the outgoing number. In 

most cases, this will be the default access code defined for 

external calling. You can also enter a different access code for 

an outgoing number.

Begins With Number or pattern to be matched.

• The pattern must be unique.

• Numbers and patterns are matched beginning with the 

first digit.

• A number that includes the pattern, but does not begin 

with the pattern is not matched.

• When specifying a pattern, an “x” matches any digit 

from 0 through 9. A series of numbers enclosed in 

brackets ([089]) matches any one of the digits.

• You can also specify a range. For example, [2-9] 

matches any single digit in the range from 2 to 9.

Number of 

Digits

Enter the number of digits in the dialed number or select 

Variable. The number of digits cannot be smaller than the 

prefix defined in the Begins With field and cannot be larger 

than 15.

Dial Pattern As you enter patterns in the Begins With field, the Dial Pattern 

column in the table updates to display the dial pattern that is 

matched, including the access code.The Dial Pattern column 

is read-only.

Trunk Priority Trunk priority settings enable you to assign priority to the 

outgoing trunk with the lowest cost for a given type of call.

Specify a trunk priority for the outgoing number. Choices 

include PSTN only, SIP only, PSTN then SIP, SIP then PSTN, or 

None.

Field Description
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To edit an outgoing number, locate the number you want to edit, click in the row to 

select it, make your changes, then click OK.

To delete an outgoing number, locate the number you want to delete, click in the 

row to select it, click Delete, then click OK.

Call Blocking Example

To configure the dial plan so that outgoing calls to all numbers that begin with 

1976 for the North American Dial Plan are blocked, follow these steps.

STEP 1 From the Outgoing Numbers window, click Add Number.

STEP 2 From the Permissions menu, choose Blocked and enter the access code.

STEP 3 In the Begins With field, enter 1976.

STEP 4 In the Number of Digits column, enter 11.

Configure 

Priority

Optional. Click the Configure Priority button to open the 

Trunk List Details dialog, where you can view or edit trunk list 

settings. To edit trunk list settings:

1. Click in the Preference column that corresponds to the 
trunk whose priority you want to edit and select a new 
priority, from 1 (highest) to 10 (lowest).

2. Click Add Trunk to add trunk groups that are configured on 
the system were not added to outgoing numbers when 
they were created. When a trunk is created, you can 
choose whether you want to add it to the trunk list for all 
outgoing numbers. If you did not choose to add it at the 
time of creation, use this option to add it to an outgoing 
number.

3. Click Delete Trunk to remove trunks from the list (for 
example, you can remove a SIP trunk if you want all calls to 
be routed through ports connected to the PSTN).

4. The Forward Access Code controls whether or not the 
access code dialed by the user is forwarded to the trunk. 
By default, Forward Access Code is set to No. Do not 
modify this field unless it is required by the Service 
Provider.

5. Click OK.

Field Description
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STEP 5 The Trunk List and Configure Priority settings do not apply to blocked numbers.

STEP 6 Click OK.

After you have modified the dial plan to add blocked numbers, you must enable 

Block Restricted Calls on each phone for which you want to block these numbers. 

To access this setting, choose Configure > Telephony > Users and Extensions > 

Users and Phones, select the User Extensions tab, then configure call blocking for 

each Normal or Shared line button on the phone.

Dial Plan Templates

Through dial plan templates, Configuration Assistant provides support for tailoring 

the outgoing dial plan to meet locale-specific requirements. From the Outgoing 

Handling tab, you can:

• Define a new locale that is not based on an existing template. To define a 

new locale, choose Define New Locale from the Numbering Plan Locale 

menu. This creates a new, blank numbering plan locale.

• Import a template. When a template is imported, it is copied to the location 

that contains the Configuration Assistant built-in dial plan templates. 

Subsequent launches of Configuration Assistant display the new template 

as an option in the Numbering Plan Locale menu. To import a template, click 

Import Template.

• Export a new locale or an existing configuration as a template. When a 

template is exported, you are prompted to enter a unique name for the 

template. It is saved in the same location as the built-in Configuration 

Assistant dial plan templates. Subsequent launches of Configuration 

Assistant display the exported template in the Numbering Plan Locale menu 

on the Outgoing Call Handling tab. To export a locale or existing 

configuration as a new template, click Export as Template.

• Delete a locale. To delete a locale, choose Delete Locale from the 

Numbering Plan Locale menu. Use the arrow keys in the Delete Locale 

Template dialog to move available locale templates to the deleted locale 

templates list, then click OK. Click OK again when prompted to confirm the 

deletion.
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PSTN Trunk Groups

PSTN trunk groups provide a way to logically group voice ports into trunk groups 

to allow flexibility in choosing voice ports for outgoing calls.

NOTE: The Least Cost Routing support addressed in this section refers to the 

process of manually selecting a PSTN or SIP trunk, by dialing a pre-defined 

access code.

Least Cost Routing refers to the ability to choose the outgoing trunk with the 

lowest cost for a given type of call.

Configuration Assistant provides support for Least Cost routing by providing the 

ability to: 

• Configure trunk priority for outgoing numbers

• Assign a hunt scheme for voice ports within a trunk group

• Create and manage new PSTN trunk groups to form logical groupings of 

voice ports

To create a new, custom PSTN trunk group, select the PSTN Trunk Group tab and 

click Add. See Trunk Group Parameters, page 462.

Caller ID

See these sections for details on how to configure Caller ID settings:

• Specify the Caller ID Per-Call Block Code

• Specify the Default Caller ID to Display for Each PSTN Trunk Group

• Override the Default Caller ID Number for Specific Extensions

Specify the Caller ID Per-Call Block Code

The Caller ID Per Call Block Code is a four-digit code that phone users can dial 

before making a call. The code must begin with an asterisk (for example, *111).

Users dial the code before making any call on which they do not want their number 

displayed on the called-party phone. The caller ID is sent, but its presentation 

parameter is set to “restricted” so that the caller ID is not displayed.

To configure the code, enter a 3-digit number in the Caller ID Per Call Block Code 

field and click Apply or OK.

The asterisk (*) is automatically inserted by CCA. For example, if you enter 222 as 

the per-call block code, phone users will dial *222 to block display of their Caller 

ID for a call.
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Specify the Default Caller ID to Display for Each PSTN Trunk Group

The Caller ID Main PSTN Number is the caller ID number that is displayed by 

default for all outgoing calls from a SIP or PSTN trunk group.

The Caller ID tab lists all default and custom PSTN trunk groups or SIP Trunk 

configured on the system, along with the currently configured Caller ID Main PSTN 

Number for each trunk group. By default, the Caller ID Main PSTN number uses the 

main PSTN number that was configured when the trunk was created.

To modify the caller ID for a trunk group, follow these steps.

STEP 1 On the Caller ID tab in the Outgoing Dial Plan window, click on a PSTN trunk group 

to select it.

STEP 2 Click in the Caller ID Main PSTN Number field for the selected PSTN trunk group.

STEP 3 Enter the phone number to display for the caller ID. The number can have up to 15 

digits. The number can begin with a “+” character.

STEP 4 Click Apply or OK.

You can override the default caller ID for specific extensions. See Override the 

Default Caller ID Number for Specific Extensions, page 460.

Override the Default Caller ID Number for Specific Extensions

To override the default caller ID for specific extensions, follow these steps.

STEP 1 On the Caller ID tab in the Outgoing Dial Plan window, click on a PSTN trunk group 

to select it.

STEP 2 Click Add.

The Add Caller ID for Internal Extensions dialog displays. Complete the fields in 

this dialog as described in Add Caller ID for Internal Extensions, page 461.

You can add up to 14 caller ID override entries.

STEP 3 Click Apply or OK.

To modify existing caller ID override settings, highlight the caller ID override entry 

in the list and click Modify.
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Add Caller ID for Internal Extensions

This window appears when you select a PSTN Trunk Group on the Caller ID tab of 

the Outgoing Dial Plan window and click Add or Modify.

Configure the caller ID for internal extensions as described below, then click OK. 

You can add up to 14 caller ID override entries. By specifying a range of internal 

extensions to map to one or more caller ID numbers, you can reduce the number of 

entries used.

Field Description

Internal Extension 

Start Number

Internal Extension 

End Number

Enter starting and ending internal extension numbers to 

override the default caller ID for a range of numbers.

To override the default caller ID for a single extension, 

enter the same extension number in the Internal 

Extension Start Number and Internal Extension End 

Number fields.

Caller ID Start 

Number

Caller ID End 

Number

Enter starting and ending numbers to override the 

default caller ID for the specified range of internal 

extensions. The numbers can begin with a “+” character; 

however, if the preceding “+” is used for the start 

number, it must also be used for the end number.

If you are mapping a range of internal extensions to a 

range of caller ID numbers, the trailing digits must match. 

For example, if you enter 205 to 210 as the starting and 

and ending numbers for internal extensions, the starting 

and ending caller ID numbers must end in -05 and -10.

For a single PSTN trunk group, internal extension ranges 

cannot overlap.

To override the default caller ID for a single extension or 

to display the same caller ID number for a range of 

extensions, enter the same number in the Caller ID Start 

Number and Caller ID End Number fields.
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Examples

To override the default caller ID for extensions 205 through 225 with caller ID 

numbers 12229990005 through 12229990005:

• Enter 205 for the Internal Extension Start Number.

• Enter 225 for the Internal Extension End Number.

• Enter 12229990005 for the Caller ID Start Number.

• Enter 12229990025 for the Caller ID End Number.

To display 12229991200 as the caller ID for internal extensions 200 through 230:

• Enter 200 for the Internal Extension Start Number.

• Enter 230 for the Internal Extension End Number.

• Enter 12229991200 for both the Caller ID Start Number and the Caller ID 

End Number.

To override the default caller ID for extension 505 only with caller ID 

12229991100:

• Enter 505 for both the Internal Extension Start Number and the Internal 

Extension End Number.

• Enter 12229991100 for both the Caller ID Start Number and the Caller ID 

End Number.

Trunk Group Parameters

This window displays when you click Add or Modify on the PSTN Trunk Group tab 

in the Outgoing Dial Plan window.

All voice ports are initially placed in default groups based on the SKU type. For 

example, ALL_FXO or ALL_ BRI. These default groups can be modified.

When you create a new PSTN trunk group, you are prompted to choose whether 

you want to add the new trunk as an option for all outgoing numbers or manually 

add the trunk group to selected numbers as needed.

When you create a new SIP trunk or T1/E1 trunk group, you are prompted to enter 

a main PSTN number for these trunks. The main PSTN number is required for trunk 

groups that are not empty. If you create a trunk group, but do not assign voice 

ports as members, the main PSTN number is not required. If there are voice ports 

assigned to that trunk group, it is required.
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When creating or modifying a PSTN Trunk Group, configure settings as described 

below, and click OK.

Field Description

Trunk Group Descriptive name for this trunk group.

Hunt Scheme The hunt scheme determines how member voice ports 

are chosen for outbound calling. The following options are 

available: 

• sequential. Selects the voice port with the lowest 

preference.

• round-robin. Selects the next voice port with free 

timeslots.

• random. Randomly selects a timeslot.

• longest-idle. Selects the voice port with the 

timeslot that is idle the longest.

• least-idle. Selects the voice port with the timeslot 

that is idle the least.

Trunk Type Choose a trunk type from the list of trunk types available 

on your system.

Trunk Group 

Members

Choose trunk group members from the list of available 

voice ports for the selected trunk type.

A voice port can belong to only one PSTN trunk group.

You cannot mix different types of PSTN trunks in a single 

trunk group. For example, an analog FXO port cannot be a 

member of a trunk group that contains ISDN BRI ports.

Use the Up and Down arrow keys to re-order the list of 

voice ports, if the selected hunt scheme is sequential or 

round-robin.
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Call-back Rules

To configure the Call-back Rules, choose Configure > Telephony > Dial Plan > 

Call-back Rules from the feature bar.

The Call-back Rules is a feature to translate inbound call to an appropriate format, 

based on the translation rules, so that user does not need to edit the phone 

number prior to placing the call from the Telephony User Interface (TUI) of an IP 

Phone. Call-back rules are created based on the calling number length and the 

prefix to add.

Add and edit a new Call-back translation rule

You can create up to 14 translation rules. The translation rules are executed in the 

order they were entered by the user. The order may be changed if desired.

To add rules, click Add. To edit rules, click Edit, or double click on the row. To 

reorder the rules use the up-down arrow buttons. When adding call-back rules you 

must enter values for Calling Number Length Match and Prefix to Add as 

described below, and click Apply or OK.

Field Mandatory Max Size Validation

Calling Number 

Length Match

Yes 2 digits • Values between 1 - 14 

inclusive

• * is allowed. For variable 

number length use *

• Combination of * and digits 

are not allowed (example *1)

Prefix to Add Yes 14 chars • Only DTMF digits are 

allowed

• DTMF digits are:

0, 1, 2, 3, 4, 5, 6, 7, 8, 9, 

A, B, C, D, *, #

• + is not allowed
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Delete a Call-back rule

To delete a Call-back rule select the desired rule(s), then click the Delete button. 

After deleting the rule, a pop up screen will appear with a confirmation dialog 

stating, Are you sure you want to delete the selected rule? Click either Yes or No. 

You may delete multiple rows at a time.
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Site Management

These topics are covered:

• Multisite Manager

• Maximum Calls (Call Admission Control)

Multisite Manager

Use the Multisite Manager to configure, manage, and monitor up to five Cisco 

SBCS customer sites connected through a full-mesh VPN only, or Intersite Dialing 

only, or both.

This feature enables end users at connected sites to place intersite calls using 

abbreviated dialing and share data over a secure WAN connection. Multisite 

deployments are well-suited for small businesses with up to five locations.

Supported deployment models include customer sites with a single UC500 or a 

UC500 behind a Cisco SR500 secure router for advanced security features.

• Multisite Design Requirements and Guidelines

• Multisite Configuration Procedures

• Multisite Status Monitoring

• Voice Features Supported Across Multiple Sites

Multisite Design Requirements and Guidelines

Only the following network topologies are supported for individual customer sites 

that are members of a multisite deployment. Any of these site topologies can be 

combined as long as the total number of sites is five or fewer. The sites can be 

configured with a full-mesh VPN — that is, every site has a direct link to every 

other site.
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• A single UC500 connected to the WAN.

• A single SR520-T1 secure router combined with a UC500. The SR520-T1 is 

connected to the WAN and provides advanced security features, and the 

UC500 provides voice and data to the site. In this type of deployment, the 

data VLAN must be unique for both the SR520-T1 and the UC500.

For the current release, only the model SR520-T1 secure router is supported 

for use in Cisco SBCS multisite deployments configured using CCA.

IMPORTANT Each site must have a UC500 for voice and data. The Multisite 

Manager cannot be used to configure any of the following types of deployments:

• A standalone SR520-T1 router as one of the sites

• A data-only, site-to-site VPN between two or more SR500 secure routers

• A remote phone behind an SR520-T1 without a UC500

This diagram shows a simple example of a deployment with two sites that 

illustrates the supported topologies and some of the design requirements 

discussed in this section.

The above example illustrates these key elements of multisite configuration:

• Site topology. The Charlotte site provides an example of a site that has a 

UC500 behind an SR520-T1, while the San Jose site has a UC500 only.

• Data VLAN IP addressing must be unique. Since the data VLAN IP 

addresses must be unique across all sites for any UC500 and also for any 



Site Management

Multisite Manager

Cisco Configuration Assistant SBCS Administrator Guide 469

16
 

SR520-T1, the data VLAN IP for the UC500 at the Charlotte site is set to 

192.168.10.1/24, and the data VLAN IP for the UC500 San Jose is set to 

192.168.20.1/24. The VLAN IP for the SR520-T1 at the Charlotte site is 

192.168.75.0/24, and there is no SR520-T1 present at the San Jose site 

(otherwise a unique data VLAN IP would also be required for it).

• Dial plan and intersite dialing. For this configuration, we have chosen to 

use an intersite dialing prefix of “8.” The Charlotte site ID is set to “1”, and 

the San Jose site ID is set to 2. As shown in the example, phone users dial 

the Intersite Dialing Prefix + Site ID + extension to reach other sites. Both 

sites have their extension length set to 3. Although it is not required that 

sites use the same extension length, it is recommended for ease of use and 

configuration.

• Static IP or DHCP WAN IP addressing is supported. The Charlotte site 

uses a static WAN IP address, while the San Jose site is configured to use 

DHCP. Since DHCP is used, Dynamic DNS (DDNS) is configured for the San 

Jose site.

• Full-mesh VPN with authentication using pre-shared key. A global 

pre-shared key is configured identically for each site to provide 

authentication for the VPN tunnel.

• Call admission control. Both sites are configured to allow a maximum of 

four simultaneous calls over the WAN.

This table lists and describes multisite design requirements and guidelines in 

more details.

IMPORTANT Existing out-of-band configuration is not supported by the Multisite 

Manager. You must remove existing out-of-band multisite configuration before you 

can use the Multisite Manager.

Configuration Item Requirements/Recommended Guidelines

Number of sites Up to five sites in a full-mesh topology.
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Number of IPsec 

tunnels

For UC520 and UC540 platforms, each customer site 

supports up to 10 IPsec tunnels. For UC560 platforms, 

each customer site supports up to 20 IPsec tunnels. 

This include EZVPN tunnels, SSL VPN tunnels, multisite 

VPN tunnels, and SPA525G phone VPN tunnels.

When a site is part of a multisite deployment, 

N-1 of these VPN tunnels are used for the full-mesh 

site-to-site VPN, where N is the number of sites. For 

example, if the multisite deployment for a UC540 

platform has 4 sites, 3 IPsec tunnels are used for the 

full-mesh site-to-site VPN, leaving 7 tunnels available 

for EZVPN and/or SSL VPN.

Firewall Cisco Zone-Based Firewall (ZBF) on SR500 or Cisco 

IOS-based CBAC policy on the UC500. Third-party 

firewalls are not supported.

Data VLAN 

addressing

The data VLAN IP address for each UC500 and 

SR520-T1 must be unique across all sites.

If each site is at factory default, you must remember to 

modify the default data VLAN address during the initial 

configuration of each additional site member to ensure 

that it is unique. Use the Telephony Setup Wizard to 

configure the initial settings.

If one of the remote sites has an existing data VLAN IP 

address that is not unique, you must modify its data 

VLAN address. For a site that is not at factory default 

state, this can only be done through the Multisite 

Manager.

After modifying the data VLAN IP address, you will lose 

connectivity to the UC500, and must request and obtain 

a new IP address from the UC500. To do this, go to 

Start > Run on your PC and enter cmd to open a 

command prompt window. At the command prompt, 

enter the command ipconfig /renew. 

Configuration Item Requirements/Recommended Guidelines
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WAN connection 

type

Sites can use either DHCP with DDNS configured or 

static IP addressing.

For sites that use DHCP to dynamically obtain an IP 

address, DDNS (Dynamic Domain Name Service) or 

some other DNS registration method must be used to 

manage dynamic addresses.

When configuring DDNS, the DDNS provider name, 

hostname for each site, and authentication information 

(username and password) must be provided as part of 

the multisite connection configuration. See Configuring 

DDNS, page 485.

The DDNS hostname must be unique for each site.

Configuration Item Requirements/Recommended Guidelines
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DDNS (Dynamic 

DNS) hosting service

DDNS must be configured for sites with DHCP WAN 

connections that are part of a multisite deployment. 

Sites that are configured with a static IP address are not 

required to configure DDNS.

These DDNS hosting services can be selected from the 

HTTP DDNS section in the Modify Internet Connection 

window (Configure > Routing > Internet Connection > 

Modify > Connection Settings).

• cgi.tzo.com

• dup.hn.org

• members.dyndns.org

• members.easydns.com

• www.dynx.cx

• www.justlinux.com

• www.zoneedit.com

Accounts with these DDNS providers must be 

established outside of Configuration Assistant.

TIP Cisco recommends that you upgrade from the free 
package to a paid or premium package from the DDNS 
provider. For example, some free packages are 
designed to expire due to inactivity (for example, if the IP 
address is not updated in 30 days). Loss of the DNS 
support for a domain name means that the VPN tunnels 
can become inoperable or fail to come up, resulting in 
service interruptions.

Traffic Shaping/

Quality of Service 

(QoS)

Optional. Although this setting is optional, it is strongly 

recommended. Sites that have limited bandwidth 

should enable traffic shaping and configure QoS 

settings for multisite deployments.

Codec You must choose either G.711 or G.729 as the codec to 

use for intersite calls. The G.729 codec offers higher 

compression, which can translate into significant 

bandwidth savings, but can result in poorer quality for 

some types of audio such as Music on Hold.

Configuration Item Requirements/Recommended Guidelines
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Call Admission 

Control

Optional. Configure Maximum Calls (maximum 

simultaneous calls) to ensure voice quality for intersite 

and VoIP calls by helping to prevent the Internet 

connection from being over-subscribed.

Configuration Assistant uses the currently configured 

QoS settings for upstream bandwidth, codec 

preference, and bandwidth reservation for voice media 

to provide recommendations for call admission control.

Dial Plan Specify an Intersite Dialing Prefix for site-to-site 

calling.

To dial another site, phone users must dial:

Intersite Dialing Prefix + Site ID + Extension

This feature allows for flexibility in extension 

assignments for sites. Prefix digit that are already in use 

are not available for selection.

Extension length It is recommended, but not required, that all sites in a 

multisite configuration use the same extension length.

Hostname To avoid confusion when selecting the hostname from 

Configuration Assistant menus, it is recommended that 

you define system hostnames to be unique across all 

sites.

The system hostname is displayed in the Configuration 

Assistant hostname selection menus and system 

prompts.

Configuration Item Requirements/Recommended Guidelines
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Multisite Configuration Procedures

To launch the Multisite Manger, choose Configure > Telephony > Site 

Management > Multisite Manager from the feature bar.

The topics in this section cover multisite configuration procedures for supported 

configurations.

If you have not previously configured multisite connections on this UC500, the 

initial window provides an overview of configuration steps, with these options:

• Manually Specify Multisite Settings. Choose this option to go to the 

Multisite Configuration tab. See Adding and Configuring Sites, page 476.

• Import Multisite Configuration File. Choose this option to import site 

settings that were previously exported to a configuration file on another 

site. See Exporting and Importing Sites, page 488.

NOTE: All multisite configuration procedures assume that the PC running 

Configuration Assistant is connected to an Ethernet port on the UC500 and has 

obtained an IP address from the UC500. When the UC500 is behind an SR520-T1 

secure router, connect directly to the UC500 and use DHCP to obtain an IP 

address from the UC500.

• Multisite Design Requirements and Guidelines

• Prerequisites for Multisite Configuration

• Adding and Configuring Sites

• Configuring DDNS

• Configuring Quality of Service (QoS)

• Maximum Calls (Call Admission Control)

• Exporting and Importing Sites

• Modifying a Site After the Initial Configuration

• Deleting a Site

Prerequisites for Multisite Configuration

Several prerequisites must be met before you can configure multisite connections. 

For more detailed information, see Voice Features Supported Across Multiple 

Sites, page 493.
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• Configure Firewall and NAT settings prior to configuring Multisite Manager. 

Any changes made to the Firewall or NAT settings after configuring Multisite 

Manager will require the Multisite Manager to be reconfigured.

• Basic voice and data configuration must be established on the UC500, 

using either the Telephony Setup Wizard (recommended for sites that are 

configured from factory default settings) or using Configuration Assistant in 

expert mode. This includes:

- Internet connection

- Data VLAN IP address for each UC500 and SR520-T1 should be unique 

across all sites. If it is not, this can be modified later through the Multisite 

Manager.

- Voice system initialization settings such as the default access code for 

external calling (Configure > Telephony > Dial Plan > Outgoing > 

Outgoing Call Handling tab).

- At a minimum, local telephony must be configured for calls within the 

site, preferably through the Telephony Setup Wizard.

• If the SR500 secure router is the edge device (that is, the UC500 at a site is 

behind an SR500), these settings must be configured:

- WAN connection. If using an SR520-T1 secure router, you must run the 

T1 connection utility before running the Telephony Setup wizard.

- Firewall and NAT are disabled on the UC500. When you run the 

Telephony Setup Wizard, you are automatically prompted to this as part 

of the setup.

- The UC500 has a static WAN IP address of 192.168.x.2 where x is 

obtained from the SR500 data VLAN75.

- The SR500 can route to the UC500 (simple static route to the data 

VLAN1). When you run the Telephony Setup wizard, these routes are 

established automatically.

- The SR500 must have a network-wide unique address configuration for 

VLAN75.

• For sites using a DHCP WAN connection, the following information is 

required for DDNS configuration:

- DDNS provider name

- Unique hostname for each site
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- Account username and password from the DDNS provider

Adding and Configuring Sites

Overview

If you are configuring multisite connections for sites with UC500 and SR500 

platforms with factory default settings, the recommended steps for configuring 

connections among sites is as follows.

1. If any of the sites use an SR520-T1 secure router as the edge device, you must 
run the T1 Connection Utility first (before running the Telephony Setup Wizard). 
See the Cisco Small Business Pro SR520-T1 Quick Start Guide and the 
UC500 and SR520-T1 Secure Router Setup application note for instructions.

2. On the first site:

a. Verify that basic voice and data configuration is established on the UC500.

b. Launch Configuration Assistant and configure Traffic Shaping/Quality of 

Service, Maximum Calls (Call Admission Control), and DDNS settings, as 

required. Sites configured with a DHCP WAN connection must configure 

DDNS in order to launch the Multisite Manager.

c. Launch the Multisite Manager (Configure > Telephony > Site Management 

> Multisite Manager) and configure global settings for multisite:

- Pre-shared key for VPN tunnel authentication

- Intersite dialing prefix

- Codec to use for site-to-site VoIP calls (G.711 or G.729)

d. Configure multisite settings for the first site:

- Site name

- Site index

- Number of digits in extensions.

e. Add the other remote sites and configure basic multisite settings:

- Site name

- WAN IP or Fully Qualified Domain Name (FQDN)

- Internal addressing (data VLAN for the UC500, whether or not site has an 

SR520-T1)
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- Site dial pattern (site ID number and digits per extension)

f. Apply the configuration and export the configured multisite settings to 

import at other sites.

3. On the second site and each of the remaining sites (up to five sites, maximum).

a. Verify that basic voice and data configuration is established on the UC500.

b. Configure Traffic Shaping/QoS, Maximum Calls, and DDNS settings, as 

required.

c. Launch the Multisite Manager and import the multisite configuration file that 

was created and exported from the first site.

d. Configure the same pre-shared key on the remote sites.

If you are connecting one or more existing sites, the steps are similar, except that 

instead of using the Telephony Setup Wizard, you establish the configuration in 

expert mode. If you need to change the default data VLAN IP address for the 

SR520-T1 or UC500, you can do this through the Multisite Manager when 

importing site data.

Procedures

STEP 1 Verify that the requirements described in Prerequisites for Multisite 

Configuration, page 474 are met.

STEP 2 Verify that the PC running Configuration Assistant is directly connected to the 

UC500 and has obtained an IP address from the UC500.

STEP 3 Launch Configuration Assistant and connect to the first site to be configured.

STEP 4 From the feature bar, choose Configure > Telephony > Site Management > 

Multisite Manager.

STEP 5 Select the Multisite Configuration tab.
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STEP 6 Configure these Global Settings for all sites.

Setting Description

Pre-Shared 

Key for 

Authentication

This field is required only if Dialing Only or Both is selected in 

the Intersite Options section. See Intersite Options, page 

483

Enter a pre-shared key for authenticating remote sites. Use a 

pre-shared key that meets strong password criteria. From 8 

to 127 characters can be entered; Spaces and “?” characters 

are not supported.

Place a check mark in the Display Key box (by clicking on the 

box) to enable display of the pre-shared key in plain text.

Place a check mark in the Allow Key to be Exported box (by 

clicking on the box) to enable export of the pre-shared key as 

plan text in the configuration file.

IMPORTANT The pre-shared key must be the same for all 

sites. By default, the pre-shared key is not exported in the 

multisite configuration. If you choose to export the key, it is 

exported as plain text. If the pre-shared key is not exported, 

you must manually re-enter it when importing multisite 

configuration data to other sites. 

Codec for 

Intersite Calls

Preferred codec for intersite calls. Choose either:

• G711: G711 codec is preferred.

• G729: G729 codec is preferred.

H.323 Call 

Start:

Slow: Selects whether the H.323 gateway uses Slow 

Connect procedure.

Fast: Selects whether the H.323 gateway uses Fast Connect 

procedure.
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STEP 7 Review and edit settings for the first site. This is the site to which you are initially 

connected.

To begin editing site settings, click Edit. See Site Settings, page 482 for more 

information.

The following information is read in and displayed from the site to which you are 

connected.

Intersite 

Dialing Prefix

Choose a prefix from the drop-down list. The system detects 

prefix digits that are currently in use by the dial plan and only 

displays available selections. This is the prefix digit that 

phone users must dial when making calls to other sites.

To call remote sites, phone users dial the

Intersite Dialing Prefix + SiteID + Extension

For example, if the prefix digit for intersite dialing is 7 and a 

user at site 1 wants to dial extension 307 at site 2, the user 

must dial 72307 to reach that extension.

Setting Description
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Setting Description

WAN Address Read-only. WAN IP address of this site.

UC500 Data VLAN 

Address

Read-only. UC500 Data VLAN IP address for this site.

UC500 Data VLAN 

Subnet Mask

Read-only. UC500 Data VLAN subnet mask for this 

site.

SR500 Data VLAN 

Address

Read-only. SR520-T1 data VLAN IP address, if an 

SR520-T1 is part of the customer site.

SR500 Data VLAN 

Subnet Mask

Read-only. SR520-T1 data VLAN subnet mask, if an 

SR520-T1 is part of the customer site.

Site Dial Pattern Read-only. Displays the pattern that site members 

dial when making site-to-site calls over the WAN. 

Connected to This Site

Click Show Extra Configuration Options to view the status (either Configured 

or Not Configured) of additional settings that might need to be configured for 

this site.

DDNS Optional. Dynamic DNS configuration. Indicates 

whether or not DDNS is configured for this site. If 

DDNS is not configured and you are using DHCP, you 

must configure it before you can launch the Multisite 

Manager.

Click the Configured or Not Configured link to open 

the Internet Connection window where you can 

modify these settings. See Configuring DDNS, 

page 485.
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STEP 8 After you have reviewed and configured settings for the first site, click Add Site 

and configure settings for the rest of the sites that are part of the deployment.

See Site Settings, page 482.

STEP 9 When you are finished adding and configuring all remote sites, click Apply.

The Apply button is disabled (greyed out) if any of the required settings are not 

configured (for example, pre-shared key).

After the changes are successfully applied, the Export Multisite Configuration 

File button becomes active.

STEP 10 Click Export Multisite Configuration File.

The Export Multisite Configuration File button is unavailable (greyed out) until 

you have successfully applied the configuration.

STEP 11 Save the configuration file to your PC. You can use the default filename or specify 

a different filename.

WAN Traffic Shaping Optional, but strongly recommended. Indicates 

whether or not Traffic Shaping and Quality of Service 

(QoS) settings are configured for the site. Although 

these settings are optional, they are strongly 

recommended for all sites, and especially sites with 

limited bandwidth. This specifies preferential 

handling for voice traffic over data when needed.

Click the Configured or Not Configured link to open 

the Internet Connection window where you can 

modify these settings. See Configuring Quality of 

Service (QoS), page 486.

Call Admission 

Control

Indicates whether or not Call Admission Control 

(CAC) is configured for this site. Call admission 

control settings determine the maximum number of 

simultaneous calls for a site.

If CAC is not configured, choose Configure > 

Telephony > Maximum Calls from the feature bar to 

access configuration options. See Maximum Calls 

(Call Admission Control), page 494.

Setting Description
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IMPORTANT Do not edit the XML configuration file. Any changes to the multisite 

configuration settings that are exported must be made through the Multisite 

Manager and re-imported to any sites that are part of the configuration. See 

Exporting Sites, page 488.

STEP 12 Click OK.

STEP 13 Save your changes to the startup configuration to all devices in the customer site:

• Click Configure > Save Configuration, or

• Click Save when prompted to save the configuration before exiting 

Configuration Assistant.

STEP 14 Import the multisite configuration file you just exported to each of the other sites 

using the procedures described in Importing Sites, page 489.

After you import and apply settings among all the remote sites, the VPN tunnels 

will begin to come up.

It can take up to 3 minutes for the VPN tunnels to be established.

To manually bring the IPsec tunnels up, choose the Multisite Status tab and click 

Connect to All Sites.

Site Settings

The Site Settings window appears when you:

• Click Add Site in the Multisite Manager window.

• Click Edit (Pencil icon) in the Multisite Manager window to edit settings for 

any of the sites.

Add or modify site settings as described in this table, then click OK to return to the 

Multisite Manager.

Changes made to site configuration will result in dropped calls and interruption in 

data traffic during the re-configuration.
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Setting Description

Site Information

Site Name Descriptive name for this site.

WAN IP Address or 

Domain

Public IP address (if static IP addressing is used) or 

fully-qualified domain name for the site (if DDNS is 

used).

Intersite Options

Options:

• VPN Only

- If selected, the Site Dial Pattern will not be 
shown. Extra configuration options will show 
only DDNS configuration.

- If selected, only VPN secure tunnel will be 
created between configured sites. Users 
cannot dial intersite.

• Dialing Only

- If selected, the Site Dial Pattern and Extra 
configuration will be shown.

- If selected, user can only dial intersite. VPN 
Secure tunnel will not be created.

• Both (default option)

- If selected the Site Dial Pattern and Extra 
configuration will be shown.

- If selected, both VPN secure tunnel and 
Intersite dialing will be created.
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Internal Addressing

Internal addressing field is needed for inter site options such as VPN only/ Both 

options. It is not needed for dialing only option.

If you are directly connected to this site, Internal Addressing data is read from 

the current device configuration.

You can modify the data VLAN IP address for the UC500 or SR520-T1, but if you 

do, a warning dialog is displayed.

• You are prompted to verify or re-acquire an IP address on your PC before 

restarting Configuration Assistant and re- connecting to the customer 

site.

• No other multisite configuration is applied during this change. You must 

re-visit the Multisite Manager and configure or re-import your multisite 

settings after the VLAN has been updated.

UC500 Data VLAN IP 

Address

IP address of the data VLAN on the UC500. For 

example, 182.168.30.5.

UC500 Data VLAN 

Netmask

Subnet mask for the data VLAN on the UC500. For 

example, 255.255.255.0. If you are directly connected 

to this site, this information is read from the current 

configuration.

Site uses SR500 as 

WAN device

Check to enable this option if the UC500 is behind an 

SR520-T1 secure router.

SR500 Data VLAN IP 

Address

IP address of the data VLAN on the SR520-T1. If you 

are directly connected to this site, this information is 

read from the current configuration.

SR500 Data VLAN 

Netmask

Subnet mask for the data VLAN on the SR520-T1. If 

you are directly connected to this site, this 

information is read from the current configuration.

Setting Description
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Configuring DDNS

DDNS is only required for sites that use DHCP to obtain a WAN IP address or sites 

that use PPPoE with IP address negotiation.

Procedure

STEP 1 Choose Configure > Routing > Internet Connection and open the Modify Internet 

Connection window.

STEP 2 In the HTTP DDNS section of the Modify Internet Connection window, complete 

these settings:

Site Dial Pattern

Intersite Dialing Prefix This read-only field displays the currently configured 

single-digit prefix for site-to-site dialing. This is a 

global configuration setting for all sites.

Site Identifier Enter a number from 1 to 5 that identifies this site. 

This is the Site ID used for intersite dialing.

To dial this site, phone users at remote sites must use 

this format:

Intersite Dialing Prefix + SiteID + Extension

For example, if the prefix digit for intersite dialing is 7, 

and a user at site 1 wants to dial extension 307 at site 

2, they must dial 72307 to reach that extension.

Digits per extension Number of digits used for internal extensions (that is, 

extension length).

Resulting Dial Pattern This read-only field displays the site dialing pattern, 

based on the values currently configured for intersite 

dialing prefix, site identifier, and number of digits per 

extension.

Setting Description
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STEP 3 Click OK.

STEP 4 Verify that the site configuration change triggered a DNS update with the DDNS 

provider.

Configuring Quality of Service (QoS)

Quality of Services (QoS) settings for multisite deployments allow you to:

• Enable traffic shaping

• Specify the amount of upload bandwidth available for a site

• Specify the percentage of available WAN bandwidth to allocate for VoIP 

traffic when it is present on the network

• Use call admission control (CAC) to ensure that your call count can not 

exceed this bandwidth allocation to avoid degradation.

Field Description

Provider Choose a DDNS provider from the pull-down menu. The 

account with the DDNS provider must be established 

outside of Configuration Assistant.

Hostname Unique hostname for this site, obtained from your DDNS 

provider. This is usually a fully qualified domain name 

(FQDN), for example, myhost.mydomain.net, but may be 

different for some DDNS services. The hostname must 

be registered.

This field is not validated by Configuration Assistant. 

Make sure that you have entered the hostname exactly 

as specified by your DDNS provider.

If you are configuring a multisite deployment, each site 

must have a unique DDNS hostname.

Username Account user name, obtained from your DDNS provider.

Password/

Confirm Password

Account password, obtained from your DDNS provider.

Re-enter the password for confirmation.
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When QoS is enabled and configured:

• Priority is guaranteed for voice traffic, up to the percentage of available 

WAN bandwidth specified. When voice traffic exceeds this percentage, 

audio degradation will be observed for all VoIP calls.

• The remainder of the available WAN bandwidth is used for all other network 

traffic.

• If no voice traffic is present on the network, all of the available bandwidth 

can be used for data traffic.

Important Guidelines

These important guidelines apply to configuring QoS:

• Configure QoS settings before configuring Maximum Calls so that 

Configuration Assistant can determine recommended settings for CAC.

• QoS configuration is optional, but strongly recommended. By default, it is 

disabled.

• QoS must be configured separately for each site. It is not part of the 

multisite configuration that is exported through the Multisite Manager.

• QoS is always configured on the device that is connected to the Internet:

- If the UC500 is directly connected to the WAN, configure QoS on the 

UC500.

- If the UC500 is behind an SR520-T1, configure QoS on the SR520-T1.

• Always specify the actual upstream bandwidth for the site, as determined 

by a reliable connection speed test or the Committed Information Rate (CIR) 

specified in the Service Level Agreement (SLA) for the Internet service 

provider.

If the CIR and connection speed test results are not available, specify an 

upstream bandwidth that is approximately 80% of the upstream bandwidth 

advertised by the Internet service provider.

Applying a bandwidth that is greater than experienced rates can cause 

audio degradation.
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Procedures

STEP 1 Navigate to Configure > Routing > Internet Connection.

STEP 2 From the Hostname menu, select hostname of the device that is connected to the 

Internet (either the UC500 or an SR520-T1).

STEP 3 Click on a connection to select it.

STEP 4 Click Modify.

STEP 5 In the Modify Internet Connection window, click the Traffic Shaping tab.

STEP 6 Click the Traffic Shaping checkbox to enable traffic shaping.

STEP 7 In the Upstream Bandwidth [kbps] field, enter the actual upstream bandwidth for 

the site, as determined by a connection speed test or the CIR (Committed 

Information Rate) specified in the SLA from the service provider. For example, if 

the upload speed is 1.8 Mbps, enter 1800 for the upstream bandwidth.

Value values range from 384 kbps to 100000 kbps.

If the results of a speed test are not available, enter a value in kbps that is 80% of 

the upstream bandwidth advertised by the ISP.

STEP 8 In the Media Reservation field, use the slider bar to specify the proportion of 

available bandwidth to guarantee for voice media if it is present on the network. 

Valid values range from 10 to 95 percent (the remaining 5 percent covers signaling 

and other overhead). The default is 50%.

STEP 9 Click OK or Apply.

STEP 10 Save the configuration (Configure > Save Configuration).

Exporting and Importing Sites

After you have configured connection settings for each site, you export these 

settings to an XML file that can be imported onto each of the other sites.

Exporting Sites

For each site, these settings are exported:

• Site name and index

• Intersite dialing prefix and number of digits in extensions
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• Public IP address or hostname of the site

• IP address and subnet mask of the data LAN for the edge device on the 

network (SR500 or UC500)

• IP address and subnet mask of the UC500, if it is behind an SR500 secure 

router

IMPORTANT For security reasons, the Pre-shared key for site authentication is 

not included in the exported configuration file by default.

• If the pre-shared key is not exported in the configuration file, you must 

manually re-enter it for each site.

• You can choose to include the pre-shared key in the exported site data. The 

pre-shared key is exported as plain text, which is less secure.

Do not edit or delete any of the settings in this XML file. Any changes to the 

multisite configuration settings must be made through Configuration Assistant.

To export the multisite connection settings:

STEP 1 Click Export Multisite Configuration File.

STEP 2 Save the configuration file to the PC running Configuration Assistant.

Importing Sites

To import multisite connection settings:

STEP 1 Connect the PC running Configuration Assistant directly to a LAN port on the 

UC500 for the site and make sure the PC has obtained an IP address from the 

UC500.

STEP 2 Launch Configuration Assistant and connect to the site.

STEP 3 Choose Configure > Telephony > Site Management > Multisite Manager from 

the feature bar to open the Multisite Manager.

STEP 4 If you have not previously configured multisite connections, click the Import 

Multisite Connection Settings button on the page that is initially displayed for the 

Multisite Manager.
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If you are re-importing settings, click Import Site from the main Multisite Manager 

window.

STEP 5 Browse to the location of the configuration file you exported previously and click 

OK.

STEP 6 Choose the site to import and click OK.

STEP 7 If the site settings do not match the current configuration on the site, Configuration 

Assistant detects the differences in the configuration and asks you whether you 

want to update the configuration.

If the data LAN IP address must be re-configured on the UC500 you will lose 

connectivity to Configuration Assistant and must re-connect using the new IP 

address.

Modifying a Site After the Initial Configuration

You can modify site settings after the initial configuration, but if you do, you must:

• Export the new configuration.

• Import the new configuration onto all sites.

Deleting a Site

To delete a single site from the a multisite configuration, follow these steps.

STEP 1 Launch Configuration Assistant and choose Configure > Telephony > Site 

Management > Multisite Manager.

STEP 2 In the Multisite Manager window, select the Multisite Configuration tab.

STEP 3 Locate the site you want to remove and click Delete.

STEP 4 Click OK to confirm the deletion.

STEP 5 Click Apply or OK.

To delete all multisite configuration from the device to which you are connected, 

follow these steps:
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STEP 1 Launch Configuration Assistant and choose Configure > Telephony > Site 

Management > Multisite Manager.

STEP 2 In the Multisite Manager window, select the Multisite Configuration tab.

STEP 3 Click Delete Multisite Configuration. This option is located in the lower right 

corner of the Multisite Manager window. The Delete Multisite Configuration 

option is only available if the Multisite Manager detects an existing configuration 

(that is, a configuration was successfully applied at least once).

STEP 4 Click OK when you are asked whether you want to remove all multisite 

configuration.

When you click OK, all existing multisite configuration is completely removed from 

the device. The Multisite Manager window refreshes to display the default initial 

page without any configuration settings.

Multisite Status Monitoring

To monitor multisite VPN tunnel connections and view diagnostic information:

• Choose Monitor > Multisite Status from the toolbar, or

• Click the Multisite Status tab in the Multisite Manager.

The Multisite Status monitor has these areas:

• VPN Tunnel Status Summary

• VPN Tunnel Status Detail

VPN Tunnel Status Summary

The VPN Tunnel Status Summary section displays the status of each VPN tunnel 

connection among all sites in the deployment. If the multisite configuration has not 

yet been imported and applied to a site, the text “Site Configuration Not Yet 

Applied” is displayed.

Click Connect to All Sites to manually bring up the VPN tunnels among all the 

sites.
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VPN Tunnel Status Detail

The VPN Tunnel Status Detail area displays the output for the show crypto 

session detail Cisco IOS command. This command lists all active Virtual Private 

Network (VPN) sessions and the IKE (Internet Key Exchange) and IPsec SAs 

(security associations) for each VPN session.

Note these lines in the example output:

• Session status. This displays the tunnel status. When the tunnel is coming 

up, this status is DOWN-NEGOTIATING. When the tunnel is up, the status can 

be UP-ACTIVE, UP-NO-IKE, or UP-IDLE. If the session status is DOWN, the 

tunnel does not exist.

• IPSEC FLOW. A snapshot of information about the IPsec-protected traffic 

flow. The IP addresses correspond to the data VLAN IP addresses and 

subnet masks configured for the UC500 and SR500.

Crypto session current status

Code: C - IKE Configuration mode, D - Dead Peer Detection     
K - Keepalives, N - NAT-traversal, T - cTCP encapsulation     
X - IKE Extended Authentication, F - IKE Fragmentation

Interface: Serial1/0:1
--> Session status: UP-NO-IKE
Peer: 10.130.2.2 port 500 fvrf: (none) ivrf: (none)
      Desc: (none)
      Phase1_id: (none)
--> IPSEC FLOW: permit ip 192.168.30.0/255.255.255.0 192.168.20.0/
255.255.255.0 
        Active SAs: 2, origin: crypto map
        Inbound:  #pkts dec'ed 335 drop 0 life (KB/Sec) 4429573/683
        Outbound: #pkts enc'ed 335 drop 0 life (KB/Sec) 4429573/683
--> IPSEC FLOW: permit ip 192.168.75.0/255.255.255.0 192.168.20.0/
255.255.255.0 
        Active SAs: 0, origin: crypto map
        Inbound:  #pkts dec'ed 0 drop 0 life (KB/Sec) 0/0
        Outbound: #pkts enc'ed 0 drop 0 life (KB/Sec) 0/0

Interface: Serial1/0:1
Session status: UP-NO-IKE
Peer: 10.130.1.2 port 500 fvrf: (none) ivrf: (none)
      Desc: (none)
      Phase1_id: (none)
--> IPSEC FLOW: permit ip 192.168.75.0/255.255.255.0 192.168.10.0/
255.255.255.0 
        Active SAs: 0, origin: crypto map
        Inbound:  #pkts dec'ed 0 drop 0 life (KB/Sec) 0/0
        Outbound: #pkts enc'ed 0 drop 1 life (KB/Sec) 0/0
--> IPSEC FLOW: permit ip 192.168.30.0/255.255.255.0 192.168.10.0/
255.255.255.0 
        Active SAs: 2, origin: crypto map
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        Inbound:  #pkts dec'ed 725 drop 0 life (KB/Sec) 4492717/470
        Outbound: #pkts enc'ed 707 drop 1 life (KB/Sec) 4492717/470
. . .

Voice Features Supported Across Multiple Sites

This table lists common voice features and indicates which are supported among 

sites in a multisite configuration.

Voice Feature Supported Among Multiple Sites

Basic site-to-site calls with 

abbreviated dialing

Yes

Transfer calls between sites Yes

Conference calls between sites Yes

Paging and Call Park across 

sites

No

Forward voice mails between 

sites

No

Auto Attendant Partial

The Auto Attendant can transfer calls to 

other site extensions using abbreviated site 

dialing.

Fax between sites Yes

Extension mobility across sites No

Hunt groups configured across 

sites

No*

Call Blast groups support “Other” digit entry, 

which allows Blast Groups to be configured 

across sites.

Shared directory across sites No
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Maximum Calls (Call Admission Control)

To access call admission control settings, choose Configure > Telephony > Site 

Management > Maximum Calls.

Overview

Call Admission Control (CAC) limits the number of simultaneous calls over the 

WAN. When call admission control is enabled and configured, it is applied to all 

calls that traverse the WAN. This includes intersite calls in a multisite deployment 

and SIP calls.

Configure Traffic Shaping/QoS settings before configuring Maximum Calls so that 

Configuration Assistant can determine recommended settings for CAC based on 

these settings.

When you change this setting, the Maximum Number of Calls setting configured 

in the SIP Trunk window is also updated (Configure > Telephony > Ports and 

Trunks > SIP Trunks). See SIP Trunks, page 299.

Procedures

To configure Call Admission Control, follow these steps.

STEP 1 Choose Configure > Telephony > Site Management > Maximum Calls from the 

feature bar to open the Maximum Calls window.

STEP 2 Choose a device from the Hostname field.

STEP 3 In the Maximum Calls field, enter the maximum number of simultaneous calls to 

allow. 

If you enter a value of zero (0), call admission control is disabled.

If QoS is enabled and configured for the site:

• The Current Traffic Shaping section displays read-only information about 

the Traffic Shaping settings currently configured on the system (upstream 

bandwidth in kbps and percentage of WAN bandwidth guaranteed for VoIP 

calls).

• The Maximum Call Ranges section displays Recommended, Sensitive, and 

Degraded ranges for the Maximum Calls setting, based on the currently 

configured QoS settings.
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If QoS is not configured, choose Configure > Routing > Internet Connection from 

the feature bar, select the WAN connection, click Modify, and select the Traffic 

Shaping tab.

CAUTION If you choose a number in the Sensitive or Degraded range for the 

Maximum Calls setting, this can result in poor voice quality for all VoIP calls, 

including intersite calls) if available bandwidth is exceeded.

STEP 4 Enter the maximum number of calls to allow for this site.

STEP 5 Click OK.
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Phone Customization

This section provides instructions for configuring:

• Ringtones

• Backgrounds

• Editable URLs

• Phone Template Editor

• Phone Template Assignment

Ringtones

To view the list of available ringtones or upload a ringtone file to the UC500, 

choose Telephony > Phone Customization > Ringtones from the feature bar.

Overview

Cisco SCCP based IP phones (such as the SPA Series, 69 Series and 79 Series) 

allow for ringtones and distinctive ringtones to be defined. The phone displays a 

list of available ringtones and allows the user to select the desired ringtone. From 

the Ringtones window, you can view the list of available ringtones, upload 

additional ringtones to the UC500, or change the order that ringtones are listed on 

the phones. You can also upload a ringtone file by dragging and dropping the file 

onto the UC500 icon in the Topology view. Ringtones are stored on the UC500 

flash in a directory called Ringtones.

To access ringtones on your phone, press the settings button on your phone and 

choose User Preferences > Rings. You can assign any of the available ringtones 

as the default ringtone, or as a distinctive ring for any of the normal or shared 

extensions on your phone.

NOTE: For SPA300 and SPA500 Series phones you must manually reset the 

phone in order to access the updated ringtones list.
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Limitations

• The maximum number of ringtones allowed is 50. 

SPA phones support up to 34 ringtones.

• The maximum field length for the Name field is 20 characters.

- Allowed characters are:

0 to 9, a to z, A to Z, .(dot) –(hyphen) _(underscore)

• The ringtone files must meet the following requirements:

- Raw PCM (no header)

- 8000 samples per second

- 8 bits per sample

- u-Law compression

Add new Ringtones

To upload a ringtone to the UC500 using CCA, follow these steps.

STEP 1 Choose Telephony > Phone Customization > Ringtones from the feature bar.

STEP 2 Click Add.

STEP 3 Enter a descriptive name into the Ringtone Name field.

STEP 4 Click Browse to locate the desired file for the Ringtone File.

STEP 5 Verify the ringtone file using Play, Pause, and Stop.

STEP 6 Click Apply or OK.

Delete Ringtones

To delete ringtones choose Telephony > Phone Customization > Ringtones from 

the feature bar.

STEP 1 Click on the row, or rows, that contains the ringtone(s) file you wish to delete.

STEP 2 Click Delete.

STEP 3 Click Apply or OK.
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Reorder Ringtones

To reorder the ringtones, choose Telephony > Phone Customization > Ringtones 

from the feature bar.

STEP 1 Click on the row that contains the ringtone file you wish to move.

STEP 2 Use the Up or Down arrows to arrange the ringtone files as desired. Note - only 

one row may be moved at a time.

STEP 3 Click Apply or OK.

Rename Ringtone

To rename a ringtone, choose Telephony > Phone Customization > Ringtones 

from the feature bar.

STEP 1 Click on the row that contains the ringtone file you wish to rename.

STEP 2 Rename the Name field as desired.

STEP 3 Click Apply or OK.

Backgrounds

To configure phone desktop backgrounds, choose Telephony > Phone 

Customization > Backgrounds from the feature bar.

Overview

Cisco SCCP based IP phones with LCD screens that support 16-bit color depth, 

such as the 7945, 7965, 7970, 7971 and 7975 phones, support user-created 

custom phone backgrounds. The phone displays a list of user selectable 

backgrounds that can be added.

To access background images on your phone, press the settings button on your 

phone and choose User Preferences > Background Images. You can assign any 

of the available background images as the default background on your phone.

Background images are stored in .jpg, .png, and .gif formats on the UC500 flash in a 

directory called Desktops.
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You can also upload background image files by dragging and dropping the file(s) 

onto the UC500 icon in the Topology view. If the image is valid, then it is uploaded 

to the UC500 flash, and added to the end of the backgrounds list.

Limitations

• The maximum number of background images is 50.

• The maximum number of filename characters is 25.

- Allowed characters are:

0 to 9, a to z, A to Z, .(dot) –(hyphen) _(underscore).

Add new background

To add backgrounds, choose Telephony > Phone Customization > Backgrounds 

from the feature bar.

STEP 1 Click Add.

STEP 2 Search or enter a descriptive name into the File name field.

STEP 3 Click Open.

STEP 4 Click Apply or OK.

Delete background

To delete backgrounds, choose Telephony > Phone Customization > 

Backgrounds from the feature bar.

STEP 1 Click on the row or rows that contains the background file you wish to delete.

STEP 2 Click the Delete.

STEP 3 Click Apply or OK.

Reorder background

Backgrounds are displayed on the phone in the order they appear in the list. To 

reorder the backgrounds, choose Telephony > Phone Customization > 

Backgrounds from the feature bar.
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STEP 1 Click on the row that contains the background file you wish to move.

STEP 2 Use the Up or Down arrows to arrange the background files as desired. Note - 

only one row at a time may be moved.

STEP 3 Click Apply or OK.

Editable URLs

To configure URLs, choose Telephony > Phone Customization > URLs from the 

feature bar.

To provision URLs for the Cisco IP phones connected to the Cisco IOS Telephony 

Service router-specific URLs are provisioned on the Cisco IP phone; these URLs 

point to XML-based web pages formatted with XML tags that the Cisco IP phone 

understands and uses. When you press a function button, the Cisco IP phone uses 

the configured URL to access the appropriate XML web page for instructions. The 

web page sends instructions to the Cisco IP phone to display information on the 

screen for you to navigate.  User can configure Authentication, Messages, 

Information, Directories, Services, Proxy-server and Idle URLs. It is helpful to 

display respective functionality based URL’s on IP phones.

Some applications require an authentication URL for access. Only one 

authentication URL can be in use at a time. To configure a different application and 

authenticating URL, you must disable the application that is using this setting. 

Provisioning the directory URL, to select an external directory resource, disable 

the Cisco Unified CME local directory service.

NOTE: For the new URLs to take effect, the IP Phone will be rebooted.

User can enter URLs corresponding to the URL’s name.

User will be able to modify/edit the URLs corresponding to the URL’s name.

User can delete the URLs  by removing  the URLs string from the corresponding 

URL’s text field.

Add/Edit/Delete URLs

To add, edit, or delete the URLs to the UC500 using CCA, follow these steps. User 

can delete the URLs  by removing  the URLs string from the corresponding URL’s 

text field.
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STEP 1 Enter or edit the desired URL.

STEP 2 Click Apply or OK.

Field Description

Directories Uses the information at the specified URL for the Directories 

button display.

Provisioning the directory URL to select an external directory 

resource disables the Cisco Unified CME local directory 

service.

Information Uses the information at the specified URL for the Information 

button display. This button can be labeled "i" or "?".

Messages Uses the information at the specified URL for the Messages 

button display. 

Proxy-Server Specifies the host and port used to enable proxy HTTP 

requests for access to remote host addresses from the 

phone HTTP client. 

Services Uses the information at the specified URL for the CME 

Services button display. 

Idle Information at the specified URL displays on the window of 

the IP phone during the idle state. 

Timeout: Time interval between display refreshes in 

seconds. Range is 0-300 seconds.

If the user uses 0 seconds for timeout, then there will not be 

any display of idle URL content on the phone.

Authentication For CME Server Access through the phone: Uses the 

information at the specified URL to validate requests made to 

the phone web server.

User Name and Password

Used by timecard and CME
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Phone Templates

Phone Template Editor

To configure the Phone Template Editor, choose Telephony > Phone 

Customization > Phone Templates > Template Editor from the feature bar.

Overview

Each template allows custom URL and softkeys to be assigned to any IP phone on 

the UC500, on a per phone basis. Up to 10 templates can be defined. Reserved 

templates cannot be modified. Template assignments can be changed anytime 

(even for phones which have reserved templates) using the Phone Template 

Assignment User Interface (see Phone Template Assignment, page 508).

Field Description

Templates

• Template 1 to 10 are available for custom use

• Template 11 to 20 are reserved for CCA use and may not be modified

NOTE 1: A maximum of only 1-20 template numbers are allowed by the CME. 

Custom template numbers allowed by CCA are from 1 to 10. Template 

numbers 11 to 20 are reserved.

NOTE 2: CCA features such as SNR, cBarge …etc., do not work with custom 

phone templates; they only work with the reserved templates.
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Softkeys Tab

Features using Softkeys include:

• LiveRecord

• SNR

• CBarge

• Transfer to Voicemail

• Meetme Conference

NOTE: Custom Templates will not be affected by enabling or disabling these 

features.

Field Description
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Softkey States The following Phone States and associated Softkeys are 

listed below.

• Alerting: Softkey order for alerting (ring out) state

• Acct: Account Code

• CallBack: Call back

• Endcall: End call

• Connected: Softkey order for connected state

• Acct: Account Code

• ConfList: List all participants in conference

• Confrn: Conference

• Endcall: End call

• Flash: Hook Flash

• HLog: Hunt Login/Logout

• Hold: Hold

• Join: Join established call to conference

• LiveRcd: Enable live recording on the current call

• Mobility: Mobility SNR

• Park: Call Park

• RmLstC: Remove last conference participant

• Select: Select call to join in conference

• TrnsfVM: Select call to transfer to voice mail

• Trnsfer: Call Transfer

• Hold: Softkey order for HOLD state

• Join: Join established call to conference

• Newcall: New call

• Resume: Resume

• Select: Select call to join in conference

Field Description
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Softkey States 

(Continued)

• Idle: Softkey order for IDLE state

• Cfwdall : Call forward all

• ConfList: List all participants in conference

• Dnd: Do not Disturb

• Gpickup: Group Call Pick Up

• HLog: Hunt Login/Logout

• Join: Join established call to conference

• Login: Login

• Mobility: Mobility SNR

• Newcall: New call

• Pickup: Call Pick Up

• Redial: Redial

• RmLstC: Remove last conference participant

• Remote-in-use: Softkey order for REMOTE-IN-USE state

• CBarge: Conference Barge

• Newcall: New call

• Ringing: Softkey order for ringing state

• Answer: Answer

• Dnd: Do not Disturb

• HLog: Hunt Login/Logout

• Seized: Softkey order for seized state

• CWOff: Cancel Call Waiting

• CallBack: Call back

• Cfwdall: Call forward all

• Endcall: End call

• Gpickup: Group Call Pick Up

• HLog: Hunt Login/Logout

• MeetMe: MeetMe Conference

• Pickup: Call Pick Up

• Redial: Redial

Field Description
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Service URL Tab

Service URLs provide access to Smart Applications from IP phones.

Features using Service URLs include:

• Voiceview Express

• TimeCardView

• WebEx Phone Connect

NOTE: A maximum of only 8 URLS per template are allowed by the CME.

Service URLs functionality is the same as it is for existing Reserved Templates. 

If a URL is created, deleted, or modified in a Reserved Template it applies to all 

Reserved Templates.

Language Tab

Phone Template Editor allows editing of language for custom templates; 

however, reserved templates cannot be modified. Phone languages are 

installed during software upgrade and locale upgrade. If you change the current 

installed language, via software or locale upgrade, then the language option for 

the templates (both custom and reserved) will be mapped to the system 

defined language.

Software Upgrade installs languages and the active language is the default 

display language for all phones. These are defined by user-locales in 

telephony-service. Ephone-template can be used to override the default 

selection.

Language setting for Custom Template will be cleared if the system language is 

changed using Region or modified by software installation and locale 

installation.

Features Tab

Phone Web Access allows the user to access the phone’s web GUI via the 

phone’s Voice VLAN IP Address.

CIPC phones cannot use all the functions of the SCC Advanced Client unless 

web access is disabled.

Field Description
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Add and Delete Templates

STEP 1 To add a new template click Add.

STEP 2 To delete an existing template highlight the template row and click Delete.

NOTE: Templates in use (assigned) cannot be deleted.

Edit Templates

NOTE: Reserved templates cannot be edited and are grayed out.

STEP 1 Highlight the template row that you want to edit.

STEP 2 Access the Softkeys Popup Editor by double clicking a row in the Phone State 

table, or by first selecting a row (single click) and then clicking the Edit button.

STEP 3 To add softkeys into the Selected Softkeys category, highlight the desired 

softkeys located in the Available Softkeys, or click Select All, then click Add.

STEP 4 To move softkeys from the Selected Softkeys category to the Available Softkeys 

category, highlight the desired softkeys, or click Select All, then click Remove.

STEP 5 To change the priority of a softkey in the Selected Softkeys category click the Up 

or Down key.

STEP 6 Click OK. This will exit you from the Softkeys Popup Editor.

STEP 7 Click OK, or Apply in the Devices window to exit.

Phone Template Assignment

To reassign the Phone Template Number, follow these steps:

STEP 1 Choose Telephony > Phone Customization > Phone Templates > 

Template Assignment from the feature bar.

STEP 2 Select the desired phone.
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NOTE: Multiple template reassignment can be done at one time for phones with 

the same template number and will have the same new template number. Select 

the 1st phone, then hold down the Ctrl key and select all the phones you want to 

reassign the same template to.

STEP 3 Click Edit.

STEP 4 From the Template Number menu select the desired template from the pull-down 

menu.

STEP 5 Click OK.
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Applications

Cisco Configuration Assistant provides support for enabling and configuring 

Cisco SBCS Smart Applications and other third-party applications for UC500 

platforms.

For some applications, application-specific setup options must be configured to 

enable and use the application.

These topics provide information about enabling and configuring settings for 

Cisco SBCS applications:

• General Settings

• Smart Applications Manager

• Application-Specific Configuration

For information on Cisco SBCS third-party applications, go to this URL on the 

Cisco Small Business Support Community:

https://supportforums.cisco.com/docs/DOC-9780/

General Settings

Some applications, such as Cisco WebEx PhoneConnect or other third-party 

SBCS applications, require general system settings to be configured in order to 

run. To access general settings for applications, choose Applications > General 

Settings from the feature bar.

General settings that can be configured are described in these sections:

• Call Accounting

• HTTPS Authentication

For more detailed information about general settings for applications, refer to the 

documentation for the application that you are configuring. 

https://supportforums.cisco.com/docs/DOC-9780/
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Call Accounting

The Call Accounting window appears when you choose Applications > 

General Settings > Call Accounting from the feature bar.

Overview

From this window you can enable or disable Call Detail Record (CDR) collection 

and specify the location on an external TFTP or FTP server where the CDRs are 

stored, as well as specify a backup location on the UC500 flash. These settings 

are used in conjunction with call accounting applications that capture CDRs and 

store them to an external FTP server.

Backup CDR files are stored in the flash:cdr/ directory on the UC500. Click Copy 

CDR to File to manually write CDRs to the specified backup file on the flash.

For more information, see the documentation for the call accounting application 

you are configuring.

Procedures

Configure general settings for Call Accounting applications as described in this 

table. Click OK or Apply when you are finished.

Setting Description

Call Accounting Server

FTP URL Sets the primary location for storing the CDRs 

generated for file accounting.

Specify a path/filename for the location of the file on an 

FTP server.

For example: ftpserver01/cdrs

Username Username for FTP server authentication.

Password Password for FTP server authentication.
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HTTPS Authentication

This window appears when you choose Applications > General Settings > 

HTTPS Authentication from the feature bar.

Some applications, such as Cisco WebEx PhoneConnect, require you to enable 

HTTPS communication and provide a username and password for authentication.

For more information refer to the documentation for the application you are 

configuring.

Configure HTTPS Authentication settings as described in this table. Click OK or 

Apply when you are finished.

Flash Backup 

Flash Backup 

Filename

Base filename to use for CDR backups in the flash:\cdr\ 

directory on the UC500, for example, cdr_backups. 

The filename can contain up to 15 characters. Spaces 

and special characters are not permitted.

The CDR backup file is given a unique name when it is 

created. The router hostname and time stamp are 

appended to the filename in the format 

<filename>.<hostname>.<timestamp>.

For example, if the Flash Backup Filename is 

cdr_backups, the path and filenames are formatted as 

shown below:

flash:/cdr/
cdr_backups.UC520.07_25_2009_18_15_10.346

Copy CDR to File Click Copy CDR to File to manually write pending CDR 

information to the CDR backup file on the UC500 flash.

When you click Copy CDR to File, a new CDR backup 

file is created on the flash.

Setting Description
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Smart Applications Manager

To access options for enabling and disabling Smart Applications, choose 

Applications > Smart Applications > Smart Applications Manager from the 

feature bar.

Overview

From the Smart Applications Manager, you can enable, disable, and configure 

Cisco SBCS Smart Applications. These applications run on the CUE module of the 

UC500 platform. You can also view total resources available, resources required 

for each application, and current usage by each application. Applications that can 

be enabled from this window include:

• Unified Messaging

• Cisco WebEx PhoneConnect

• Cisco TimeCardView

Setting Description

Enable HTTPS 

Communication

When enabled (checked), this setting creates the HTTPS 

private certificate used to connect to the PhoneConnect 

Web Services API.

For WebEx PhoneConnect, this option must be checked.

Name Username for HTTPS authentication. The username can 

contain up to 15 characters. Spaces and special 

characters are not permitted. By default this setting is 

blank. Required for WebEx PhoneConnect.

Password Password for HTTPS authentication. The password can 

contain up to 15 characters. Spaces and special 

characters are not permitted. By default this setting is 

blank. Required for WebEx PhoneConnect.
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System resources in use by an application are indicated by displaying a number of 

credits. A total of 100 credits are available to the system. The number of credits 

required for each application is the minimum number of credits needed to run the 

application, based on CPU, memory, and disk utilization. Some applications such 

as Video Telephony and Live Record do not require any credits to run. 

Configuration Assistant displays an error if you attempt to enable an application 

without the required number of resources.

To enable or disable an application:

STEP 1 In the Applications list on the left, click on the application you wish to enable.

A brief description of the application is displayed.

STEP 2 Click Configure to access options for enabling and configuring the application.

See these sections for information about configuring Cisco SBCS Smart 

Applications:

• Unified Messaging (IMAP), page 516

• Cisco WebEx PhoneConnect, page 517

• TimeCardView, page 529

STEP 3 Click OK or Apply when you are finished configuring application settings.

Application-Specific Configuration

The topics in this section provide an overview of each application along with 

instructions for configuration application-specific setup options.

• Unified Messaging (IMAP)

• Video Telephony

• Cisco WebEx PhoneConnect

• TimeCardView
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Unified Messaging (IMAP)

The Unified Messaging Configuration window appears when you select Unified 

Messaging from the Applications list in the Smart Applications Manager window 

and click Configure.

Overview

Unified Messaging allows voice mail subscribers to have an integrated view of 

their emails and voice mail messages from a single email client using IMAP. 

Subscribers can delete voice mail messages or mark them as read or unread in a 

manner similar to email messages. The voice mail messages are downloaded as 

attachments to email messages. Subscribers can access voice mail messages 

over the network or download them selectively. The default setting for this 

application is disabled.

Procedures

Enabling or Disabling Unified Messaging

To enable or disable Unified Messaging, click the Enable Unified Messaging 

checkbox, then click OK to return to the Smart Applications Manager window.

Configuring the IMAP Client

In order for a user to take advantage of this feature, their email client (for example, 

Microsoft Outlook) must be configured for IMAP. When configuring the client for 

IMAP:

• Use the Cisco Unity Express (CUE) module IP address (10.1.10.1) for the 

IMAP server IP address.

• The username and password configured on the IMAP client for 

authentication must match the username and password of the phone user 

as it is configured in Cisco Configuration Assistant.

Video Telephony

The Video Telephony window appears when you choose Applications > Smart 

Applications > Video Telephony from the feature bar.

The Cisco Unified Video Advantage (CUVA) solution in SBCS allows users to make 

desktop-to-desktop video telephony calls between Cisco IP phones that are video 

enabled.

Video Telephony is enabled by default. To disable this open, uncheck the Enable 

Video Telephony option and click OK.
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You can choose whether video calls are allowed on specific phones by enabling 

or disabling the Allow video calls option on each phone. See Allow Video Calls, 

page 313.

Cisco WebEx PhoneConnect

WebEx PhoneConnect is designed for customers who want fast, simple access to 

WebEx meetings from their IP phone without the need for a desktop PC. WebEx 

PhoneConnect automates this entire process so that IP phone users can join the 

audio portion of a WebEx conference by pressing a single softkey on their IP 

phone. This section covers these topics:

• About Cisco WebEx PhoneConnect

• SBCS Platform Requirements

• Related Documentation

• WebEx Site Administrator Account Information

• Procedures

About Cisco WebEx PhoneConnect

When a WebEx user is associated with an IP phone through WebEx 

PhoneConnect, a simple meeting browser application is installed on their Cisco IP 

phone display that allows the IP phone user to:

• List WebEx meetings they are hosting

• List WebEx meetings to which they are invited by other IP phone users in 

their company (users must share same UC500 router)

• Receive audio and visual alerts on their IP phone when it is time to join a 

meeting

• Control how far in advance of the meeting they want to receive alerts

• Press a single softkey to join a meeting

WebEx users with access to a WebEx Connect client from a desktop PC can use 

Click-to-Call with their IP phone to automatically dial someone on their WebEx 

Connect Buddy List.
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SBCS Platform Requirements

Related Documentation

For detailed information on configuring and administering WebEx PhoneConnect, 

see the Cisco WebEx PhoneConnect Administration Guide.

End-user information and instructions are documented in the Cisco WebEx 

PhoneConnect Quick Reference.

Component Version

Cisco Configuration 

Assistant (CCA)

2.0 and later

UC500 Software Pack 7.0(3) or later

Cisco IOS 12.4(20)T2 or later

Cisco Unified Communications Manager 

Express (CME) 7.0 or later

Cisco Unity Express (CUE) CUE 7.0 or later

Supported Cisco IP Phones Cisco Unified IP Phone Models 794x, 796x, and 

797x

Cisco Unified Wireless Phones Models 7921 

and 7925

Cisco Unified IP Phone 7937

Cisco Unified IP Phone 524G

Cisco Unified IP Phone 521G

Cisco SPA525G and SPA525G2 IP Phones

Cisco IP Communicator (CIPC) softphone client
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WebEx Site Administrator Account Information

Before you can enable and configure the WebEx PhoneConnect application, your 

customer must have or obtain a WebEx small business account from WebEx with 

an administrative user.

• Your customer must provide you with their WebEx service site account 

information (administrative user ID and password, site ID, and site URL).

CCA uses this information to connect to the customer’s WebEx service site 

and associate the customer's WebEx user accounts with the WebEx 

PhoneConnect application.

• Make sure that you know the password policy being used for the site.

When a WebEx site is set up, the site administrator can specify a password 

policy. The policy defines user password requirements such as the minimum 

and maximum number of characters, password strength, characters that 

cannot appear in passwords, and so on. All WebEx user passwords must 

conform to this policy.

Before You Begin

Before configuring WebEx PhoneConnect, make sure that:

• Phones and user extensions are configured on the system (Configure > 

Telephony > Users and Extensions > Users and Phones > User 

Extensions tab).

• Dial plan and voice trunks have been configured and inbound/outbound 

calls are working correctly.

• DNS server IP address is configured. The Internet Service Provider DNS 

server IP address is used by WebEx PhoneConnect to locate the 

webex.com server.

• NTP server is configured (optional; recommended for synchronization of 

meeting times and alerts).

Procedures

Read this section for an overview of WebEx PhoneConnect configuration steps. 

For more detailed information, see the Cisco WebEx PhoneConnect 
Administration Guide, available on Cisco.com.
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To configure Cisco WebEx PhoneConnect, follow these steps.

STEP 1 Launch Cisco Configuration Assistant and connect to the Cisco UC500.

STEP 2 Choose Applications > General Settings > Authentication URL from the feature 

bar. In the Authentication URL window, configure these settings:

a. Verify that http://10.1.10.2/CCMCIP/authenticate.asp is being used 

for the URL. If not, modify this setting so that it is.

b. Click OK.

STEP 3 Choose Applications > General Settings > HTTPS Authentication from the 

feature bar.

STEP 4 In the HTTPS Authentication window, configure these settings:

a. Check Enable HTTPS Communication (required).

b. Enter a username and password for HTTPS authentication (required).

c. Click OK.

CME Service URL settings for WebEx PhoneConnect are automatically filled in 

after the PhoneConnect application is enabled.

STEP 5 Navigate to Applications > Smart Applications > Smart Applications Manager.

STEP 6 Click WebEx Phone Connect to select the application, then click Configure. The 

PhoneConnect Configuration Login window appears.

STEP 7 In the PhoneConnect Configuration Login window, enter the customer’s WebEx 

administrator username, password, site ID, and Site URL and click OK. See 

PhoneConnect Configuration Login Window, page 521.

After the site login credentials are verified, the PhoneConnect Application Main 

window appears and displays information for the WebEx site.

STEP 8 In the PhoneConnect Application Main window, click the Enable checkbox at the 

top of the window and configure site settings. See PhoneConnect Application 

Main Window, page 521.

STEP 9 Add users and enable WebEx PhoneConnect on their Cisco IP phones as 

described in the Cisco WebEx Phone Connect Administration Guide. See 

PhoneConnect Application Main Window, page 521.

STEP 10 Click OK to apply the site settings and close the PhoneConnect Application Main 

window.
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STEP 11 In the Smart Applications Manager window, click OK.

See PhoneConnect Advanced Site Configuration, page 527, for information 

about additional settings that may need to be configured.

PhoneConnect Configuration Login Window

To configure PhoneConnect, you must first log in with the WebEx site administrator 

account credentials, as described below.

Click OK when you are finished entering login credentials.

PhoneConnect Application Main Window

This window appears after you have successfully logged in with the WebEx site 

administrator credentials after clicking Setup Options for WebEx PhoneConnect in 

the Smart Applications Manager window.

Configure the settings in the PhoneConnect Application Main window as 

described below. Click OK or Apply when you are finished making changes.

Setting Description

UserID WebEx site administrator user ID. Also referred to as a 

WebEx ID.

Password WebEx site administrator password.

SiteID WebEx site ID number (text characters are not accepted 

in this field).

SiteName WebEx site name (the first string in the WebEx site URL).

For example, if the WebEx site URL is 

http://acme.webex.com, enter acme for the site name.

Setting Description

Customer Administrator Information

Contact information for the WebEx site administrator.

First Name WebEx site administrator first name
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Last Name WebEx site administrator last name

Email WebEx site administrator email address

Company WebEx site administrator company name

Phone WebEx site administrator phone number

WebEx Users Information

UserID Required. This is the WebEx account user ID that the user 

enters when logging in to the WebEx service site to 

schedule, attend, and browse meetings.

Recommended format: <phone user 

ID>@<admindomain>.com

All new WebEx users created through PhoneConnect 

must use the email address format for their user ID. 

WebEx user accounts created before PhoneConnect was 

enabled can continue to use the existing user ID format.

If all of your customer’s users share the same email 

domain, it is recommended that you add your customer’s 

email domain after the phone user ID, and use this as the 

User ID, for example, jsmith@acme.com.

Password Required. This is the password the user enters when 

logging in to the WebEx service site to host, attend, or 

browse meetings.

After a WebEx site is set up, the site administrator can 

specify a password policy. The policy defines criteria for 

user passwords such number of characters, passwords 

that cannot be used, and so on. All user passwords must 

conform to the password policy for your customer’s 

WebEx service site.

Be sure to notify users if you change their password.

Setting Description
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Email Required. This is the email address to which WebEx 

meeting invitations and WebEx notices are sent.

If the user does not have an email address (for example, 

the user is a conference room), this format is 

recommended:

<phone user ID>@<admindomain>.com

where the <phone user ID> is the phone user ID found in 

the Associated Phone User field.

Last Name Required. WebEx account user first name.

First Name Required. WebEx account user last name.

Associated Phone Read only. Displays the current phone user ID associated 

with this WebEx account. If no phone user ID is associated 

with the WebEx PhoneConnect user, --None-- is shown.

Select Phone Click Select Phone to open a dialog for choosing a phone 

user to associate with this WebEx user account and 

enabling the PhoneConnect application on their phone. 

See Select Phone, page 526.

If the user has an existing WebEx account and has a 

phone configured on the system, but does not have 

PhoneConnect enabled on their phone you can use Select 

Phone to enable the PhoneConnect application on their 

phone.

IMPORTANT: If you are editing an existing WebEx user 

account, in order to enable PhoneConnect, you must 

assign the WebEx user a new password (this is required 

so that PhoneConnect can authenticate the phone user). 

Be sure to notify the user of their new WebEx account 

password.

Add Insert a new row in the WebEx users list for adding a new 

WebEx user.

Setting Description
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Delete Delete the selected WebEx user.

The user is moved to the de-activated state on the WebEx 

service site. After a user account is deleted, the user no 

longer has access to WebEx or WebEx PhoneConnect. 

The user will no longer receive meeting invitations or 

alerts, and will not be able to attend or host WebEx 

meetings from their company’s WebEx service site.

To reinstate a user after they have been deleted (for 

example, if a user leaves the company but then returns), 

you can use their old UserID and other account 

information. However, a new password must be created, 

as WebEx can be configured to reject a password that is 

the same as any of the last three passwords previously 

registered with WebEx.

Copy From Device Copy From Device is an alternative method for adding 

WebEx users.

Click Copy from Device to open a dialog for choosing 

existing phone users to associate with this WebEx 

account. The first name, last name, password, and phone 

for each selected phone user are copied into the WebEx 

users list. The WebEx UserID and email address fields are 

left blank. See Copy From Device, page 526.

Customer Site Configuration Information

Install Language 

Files

Add a new localized language for your IP phone users’ 

WebEx PhoneConnect meeting browser and alerts.

Only the WebEx PhoneConnect IP phone screens are 

affected by this procedure. See Install Language File for 

WebEx PhoneConnect, page 528.

Advanced 

Configuration

Access advanced configuration settings. See 

PhoneConnect Advanced Site Configuration, 

page 527.

Meeting Call-In Configuration

Call-In Preference Use a Toll-Free or Toll number for WebEx meeting call-in. 

The default is Toll-Free.

Setting Description
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Dial-out Prefix Digit that callers dial to get an outside line. The default 

value is the access code for external dialing defined on 

the system. You can edit this setting.

Call-In Number Conversion - Toll Number or Free Number

Depending on where your customer is dialing, how their outgoing dial plan is 

set up, and how the WebEx call-in number is formatted, you might need to use 

these settings to remove or replace initial dialing prefixes such as country 

codes, area or city codes, or code for international dialing.

WebEx Provided 

Number

Read-only. Telephone number provided by WebEx for 

this WebEx site.

Remove Num. of 

Digits from the 

Front

Number of digits to remove from the beginning of WebEx-

provided number. This field is required and cannot be 

blank. The default value is zero (0).

Enter the number of digits that must be removed or 

replaced as required to match the dial-out number.

Add Digits to the 

Front

Digits to add to the beginning of the WebEx-provided 

call-in number. This field can contain up to 20 digits. The 

default value is None (blank).

Enter digits to be added to the front of the number, for 

example, an area code that differs from the one in the 

WebEx-provided number. You do not need to add the 

Dial-Out Prefix (access code) here. The Dial Out Prefix is 

automatically added to the front of the number.

Resulting Number 

of Digits to Dial

Dial-out number after adding and removing digits and 

pre-pending the dial-out prefix. The number displayed is 

read-only and is generated using the Dial-out Prefix and 

the values entered in the Dial-Out Prefix and Remove/Add 

Digits fields.

Verify that the number matches what users manually dial 

to reach the WebEx service.

Setting Description
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Select Phone

This window appears when you click Select Phone in the WebEx users list on the 

WebEx PhoneConnect Application Main window.

STEP 1 In the Select Phone window, select a phone from the list that you wish to associate 

with this WebEx PhoneConnect user.

Only phones that are not currently enabled for PhoneConnect are listed.

STEP 2 Click OK to return to the WebEx PhoneConnect Application Main window.

Copy From Device

This window appears when you click Copy From Device in the WebEx 

PhoneConnect Application Main window.

The Copy From Device option provides a convenient way to add WebEx accounts 

and enable PhoneConnect for multiple existing phone users. When you use Copy 

From Device, previously provisioned values are automatically copied into the 

appropriate WebEx user account fields.

To use Copy From Device, follow these steps.

STEP 1 Select one or more phone users for which you want to add WebEx accounts. Only 

phones that are not associated with a WebEx user account are listed.

STEP 2 Click Select All, or use the CTRL-click and SHIFT-click keyboard shortcuts, to 

select multiple users.

STEP 3 Click Add to move phone users to the list of selected users.

STEP 4 Click OK.

The User ID, first name, last name, email address, and associated phone for each 

existing phone user are copied into the WebEx users list in the WebEx 

PhoneConnect Application Main window. The password is left blank.

STEP 5 In the PhoneConnect Application Main window, you must locate the users that you 

just added, and complete the Password field.
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As soon as an IP phone is associated with a WebEx user, it has full WebEx 

PhoneConnect functionality. The IP phone does not need to be restarted. Open 

menus on phones might need to be closed to see the changes.

PhoneConnect Advanced Site Configuration

To access advanced configuration settings for WebEx PhoneConnect, click 

Advanced Site Configuration from the WebEx PhoneConnect Application Main 

window.

In most cases, you can use the default settings. You only need to make changes if 

you are experiencing problems with WebEx PhoneConnect.

Configure advanced site settings for the WebEx PhoneConnect application as 

described below. Click Apply or OK when you are done configuring site settings.

Setting Description

Application Timing Configuration

Check for new 

meetings (minutes)

How often to poll WebEx for new meetings. The default 

value is 4 minutes.

Reducing frequency below 4 minutes can adversely affect 

Cisco Unity Express (CUE) performance.

Delay before 

providing the 

meeting ID 

(seconds)

Number of seconds that the system waits after the Call 

button on the IP phone is pressed before auto-entering 

the meeting ID. The default setting of 10 seconds is based 

on FXO/BRI/PRI trunk connectivity.

This value can be set to 7 seconds if SIP trunks are used. 

You may need to increase the interval if calling 

internationally. There are no known performance impacts.

Delay between 

digits 

(milliseconds)

The speed with which digits are dialed when auto-

entering a meeting ID. The default value is 200 ms.

You may need to increase interval depending from where 

you are calling (for example, when calling internationally). 

There are no known performance impacts.
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Install Language File for WebEx PhoneConnect

To install a new localized language file for WebEx PhoneConnect, click Install 

Language File from the WebEx PhoneConnect Application Main window.

WebEx PhoneConnect supports localization of IP phone GUI displays for the 

WebEx PhoneConnect meeting browser and for alerts. Between releases, Cisco 

adds support for additional languages as they become available. You can update 

the WebEx PhoneConnect application with a new language using the Install 

Language File option after the new language file is installed and the new language 

is selected in Configuration Assistant, all of the WebEx PhoneConnect IP phone 

screen menus will use the new language.

Before you begin, you must first localize the UC500 to the desired region and 

language (Configure > Telephony > System > Region), then download the 

corresponding WebEx localization file for the new language.

NOTE: WebEx PhoneConnect does not support the UC500 phone override 

localization feature. WebEx PhoneConnect only displays the default language 

selected.

Clear WebEx Site 

Data

Click Clear WebEx Site Data to remove all WebEx site 

data from the UC500.

This does not affect the WebEx service site or account 

information; it only removes the WebEx PhoneConnect 

application settings and site data stored on the Cisco 

UC500. The PhoneConnect application is removed from 

all users phones.

This may be needed, for example, in situations where the 

wrong site data is imported onto the UC500, the WebEx 

site changes, the WebEx site is no longer active, or where 

demonstration site data must be removed from the 

system.

Setting Description
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Follow these steps to add a new language for WebEx PhoneConnect.

STEP 1 In the File to install field, browse to the language file that you want to install and 

click Open.

STEP 2 Click Install. The new language file is moved to the Installed Language File(s) list. 

You can overwrite an existing language file, but you cannot delete an existing 

language file.

STEP 3 Click OK to deploy the language file to the CME localization directory and return to 

the PhoneConnect Application Main window.

You are prompted to restart the CUE module on the UC500.

STEP 4 To restart the CUE module on the UC500, open the Topology view, right-click on 

the UC500, and select the Restart CUE option from the menu.

The CUE restart can take from 10 to 15 minutes. During this time, voice mail, Auto 

Attendant, and other applications that require a connection to CUE are unavailable.

TimeCardView

This window appears when you select TimeCardView in the Applications list in 

the Smart Applications Manager window and click Configure.

IMPORTANT This section only covers TimeCardView setup and payroll server 

settings that can be managed through Configuration Assistant. For more 

information, see the documentation listed under TimeCardView Documentation, 

page 530.

TimeCardView is a time and attendance system for Cisco IP phone users 

connected to Cisco SBCS platforms.

• Overview

• TimeCardView Documentation

• SBCS Platform Requirements

• TimeCard Configuration

• Payroll Server Configuration



Applications
Application-Specific Configuration

530 Cisco Configuration Assistant SBCS Administrator Guide

18

Overview

TimeCardView automatically tracks employees’ working hours and enables 

supervisors to view employees’ real time status. It provides for online review and 

approval of timesheets and it can generate the reports supervisors and payroll 

specialists need via the Historical Reporting Client and export them to the .csv and 

.xls file formats.

TimeCardView enables employees to use a Cisco Unified IP phone connected to 

Cisco Unity Express to automatically track the hours worked (start shift, end shift, 

lunch, and breaks) and review hours for the shift, the day, the week, or the month.

Supervisors and payroll specialists use TimeCardView to set limits on the time 

employees can spend in any state, view their current shift status, and review and 

approve their timesheets.

Optionally, TimeCardView can be set up to interface with back-end accounting 

software such as Intuit’s QuickBooks so that timesheet data can be seamlessly 

transferred to the accounting system.

NOTE: TimeCardView is not supported on all Cisco IP Phone models. The 

maximum number of TimeCardView users is restricted to the maximum number of 

users that your Cisco SBCS platform supports.

TimeCardView Documentation

These TimeCardView guides are available on Cisco.com:

• For detailed information about configuring the TimeCardView application 

and managing users, see the TimeCardView 7.0 GUI Guide.

• End-user information and instructions are documented in the 

TimeCardView 7.0 for Users Quick Start Guide.

SBCS Platform Requirements

• Cisco Configuration Assistant (CCA) 2.0 or later

• UC500 Software Pack 7.0(3) or later

- Cisco IOS 12.4(20)T2 or later

- Cisco Unified Communications Manager Express (CME) 7.0 or later

- Cisco Unity Express (CUE) CUE 7.0.1 or later
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TimeCard Configuration

On the Time Card Configuration tab, configure TimeCardView application 

administration settings as described below. Click OK or Apply when you are 

finished making changes.

Setting Description

Maximum Sessions Maximum number of TimeCardView sessions, either 2 or 

8, depending on the platform.

The default is 2.

Notification Emails RFC-2822-compliant email address to use for 

application notification emails, for example, 

name@company.com.

Supervisor IP Phone 

Application Timeout 

(60 - 600 seconds)

Amount of time, in seconds, that elapses before the 

system automatically logs out the specified supervisor.

Employee IP Phone 

Application Timeout 

(60 - 600 seconds)

Amount of time that elapses before the system 

automatically logs out the specified employee.

Maximum Daily 

Work Duration 

(1 - 1440 minutes)

Number of minutes employees can remain in the work 

state.

Maximum Daily 

Overtime Duration 

(0 - 1440 minutes)

Maximum number of overtime minutes per day 

employees can work. If you change the default, do not 

forget to limit the number of regular working hours, 

otherwise employees cannot accrue overtime.

The default is 0.

Maximum Daily In-

Shift Work Duration 

(1 - 1440 minutes)

Number of minutes employees can remain in the work 

state.

The default is 1440.

Maximum Daily 

Break Work 

Duration (1 - 1440 

minutes)

Number of minutes employees can remain in the break 

state.

The default is 1440.
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Payroll Server Configuration

On the Payroll Server Configuration tab, complete the fields as described below if 

you wish to integrate TimeCardView with Intuit Quick Books. Click OK when you 

are finished configuring server settings.

Maximum Daily In-

Shift Lunch Duration 

(1 - 1440 minutes)

Number of minutes employees can remain in the lunch 

state. The default is 1440.

Work Starts On Starting day of the work week. The default is Monday.

Setting Description

Quick Books Server Setup

Hostname QuickBooks payroll server. DNS name or IP 

address of the payroll server.

Port Port number of Quick Books payroll server. The 

default value is 57343.

Synchronization Schedules

Day of Week Day of week for scheduled synchronization of 

TimeCardView data with QuickBooks.

Default: Daily

Time of day (HH:MM 24-hr) Time of day for scheduled synchronization.

Default: (none)

Example: 23:00

Included Timesheets Whether to include all timesheets or only 

approved timesheets. Select All or Approved.

Default: All Timesheets

Setting Description
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Purge Schedules

Number of Days Between 

Purges

Minimum number of days between database 

purges.

Range: 1 - 365 days

Default: 90

Days to Keep Minimum number of days the system must keep 

data.

Range: 1 - 365 days

Default: 90

Setting Description
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Maintenance

This section covers these maintenance tasks that can be performed using 

Configuration Assistant:

• Cisco UC500 Software and Locale Packs

• View Software Version Information and Device Properties

• Software Upgrades

• Voicemail Upgrade (UC560)

• License Management

• Restart/Reset Devices

• How to Localize the UC500 (Non-US/English Locales)

• File Management

• Phone Load Management

See Backing Up and Restoring Device Configuration, page 109 for instructions 

on how to use the backup and restore features available from the Maintenance 

item on the feature bar.

Cisco UC500 Software and Locale Packs

Read these sections to learn more about UC500 software and locale packs:

• UC500 Software Packs

• UC500 Locale Packs

• Downloading U500 Software and Locale Packs
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UC500 Software Packs

UC500 Software Packs are large zip files that contain all necessary files for the 

UC500 Series platform and locale. The factory default locale for the UC500 is US/

English.

Separate UC500 software packs are provided for the Model UC520, UC540, and 

UC560 platforms. You must download the correct .zip file for your UC500 platform.

The UC500 software pack bundles all the necessary platform files together with 

all of the necessary language files and phone files for the default locale, which is 

US/English. The files are named UC5xx_8.2.0.zip.

A software pack zip file contains multiple TAR/archive files and other files for the 

component of the UC500, including the:

• Cisco IOS image for the UC500 platform

• Cisco IP phone firmware files

• Communications Manager Express (CME) support files

• Cisco Unity Express (CUE) voice mail software

• Factory default configurations for all SKUs

• Support files such as Basic ACD prompts and scripts, ringtones, and 

desktop images

• Factory default (US/English) locale files:

- Phone region and language files

- Voice mail language files

See the Release Notes for Cisco Configuration Assistant for compatibility and 

version information for UC500 software packs.

UC500 Locale Packs

UC500 Locale Packs can also be downloaded from this location. Locale packs 

contain the software needed to localize voicemail and phones (locales for Cisco 

Model 79xx, SPA525, SPA50x, and CP-52x phones).

This means that you only need to download one file to localize voice mail and all 

supported phone models.
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A locale pack can be provided when installing software on the UC500 via CCA in 

order to install an alternate language on the UC500. Up to two languages can be 

installed, an active language and an alternate language.

For more information, see Installing Software on the UC500, page 541.

Downloading U500 Software and Locale Packs

Use one of the following methods to download a UC500 software pack or locale 

pack:

• In CCA, choose Partner Connection > UC500 Software Downloads from 

the feature bar.

• Open a Web browser and go to this URL:

www.cisco.com/web/go/uc500swpk

Users who have a valid Cisco Service Contract are eligible to access current and 

future versions of software from Cisco (if made available by Cisco). Partners who 

have not purchased a Service Contract for the Cisco UC500 are eligible to 

download the current version of the UC500 software within 30 days of the product 

purchase from Cisco or an authorized Cisco Partner. This gives users a way to 

obtain a current version of software for the UC500 for the initial deployment of the 

product.

Access to software for this purpose requires a valid Cisco.com account. Any future 

software update (if made available by Cisco) beyond the 30-day period of initial 

purchase from distribution requires a valid service contract.

http://www.cisco.com/web/go/uc500swpk
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View Software Version Information and Device Properties

There are several locations where you can view version information for the SBCS 

software on the UC500, as well as firmware for connected devices.

• The System Status item on the Dashboard displays the Cisco IOS version.

• Choose Monitor > Telephony > Software Pack to view version information 

for the currently installed UC500 software package, including Cisco IOS, 

CME, and CUE version, supported phone firmware loads, and CUE status 

output.

• Right-click on a device in the Topology view to display device properties, 

including the hostname, IP address, MAC address, and software version (for 

example, Cisco IOS image) for the device.

When you right-click on an IP phone, you also see the phone type (model), 

status, phone user first and last name, button types, extensions, and button 

labels.

Software Upgrades

To open the Software Upgrade window, choose Maintenance > Software 

Upgrade from the feature bar.

• To learn more about upgrading software for devices that are part of your 

customer site such as switches, wireless access points, routers, or security 

appliances, see Device Firmware Upgrade, page 538.

• To learn more about upgrading the software on the UC500, see Installing 

Software on the UC500, page 541.

Device Firmware Upgrade

The Software Upgrade window appears when you choose Maintenance > 

Software Upgrade > Router/Switch/Security from the CCA feature bar.

To learn more about upgrading software on CCA-managed devices in the 

customer site, see these topics:

• Software Upgrade Window Information

• Procedures
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Software Upgrade Window Information

This table explains the columns in the Software Upgrade window.

Procedures

Before you begin, download the software image files that you want to install.

Follow these steps to install or upgrade software on devices in the CCA customer 

site.

STEP 1 In the Software Upgrade window, select one or more devices from the same 

platform.

STEP 2 Click Upgrade Settings.

STEP 3 Complete the settings Upgrade Settings window, and click OK to save your input. 

See Upgrade Settings, page 540.

STEP 4 If you want to upgrade more than one device type, repeat Steps 1 to 4 for each of 

the device types.

Column Explanation

Device Displays device icons and hostnames.

Upgrade Place a check in the Upgrade box to indicate the device 

or devices to be upgraded when you click Upgrade. You 

can select more than one device of the same type.

Device Type Displays the device type.

Current Version Displays the version of software currently installed on the 

device.

New Image Name Displays the name of the software image that you 

provided in the Upgrade Settings window. Only the 

filename appears, not the path.

Upgrade Status If you have not yet specified software upgrade settings, 

this field displays the message “Click the Upgrade 

Settings button to continue.”

When you begin the installation, this field displays 

upgrade status and progress messages. See Upgrade 

Status Messages, page 544 for details.
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STEP 5 Check the Upgrade box beside each device that you want to upgrade.

STEP 6 Click Upgrade to start the upgrade process.

STEP 7 Click Status to display the Software Upgrade Status window. This window 

displays the progress of the upgrade.

When the software upgrade process is completed for all selected devices, a 

confirmation dialog pops up. The status messages list which devices upgraded 

successfully and which devices did not. See Upgrade Status Messages, 

page 544.

STEP 8 Click OK. You are prompted to reload the successfully upgraded devices.

STEP 9 Choose Yes to reload; choose No if you do not want to reload the devices. The 

devices do not use the update until after it is loaded.

STEP 10 You can also click Reload Upgraded Devices to reload the selected devices after 

they have been upgraded.

All configuration changes are automatically saved to flash memory. After one 

minute, the devices are restarted, and the new image runs. You can then close the 

Software Upgrade window.

• You can manage the devices in the customer site as soon as they are 

restarted.

• You lose connectivity to a device when you restart it.

Upgrade Settings

This window appears when you select one or more devices in the Software 

Upgrade window and click Upgrade Settings. Use it to enter the upgrade settings 

for devices of the same platform.

Configure upgrade settings as described in this table. Click OK when you are 

ready to continue with the upgrade or click Cancel.

Setting Description

Device Read-only. Displays the selected device name.

Image Click Browse to locate the software image to use for the upgrade.
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Installing Software on the UC500

The UC500 Software Installation wizard appears when you choose Maintenance 

> Software Upgrade > UC500.

To learn more about preparing for a UC500 software installation, see these topics:

• UC500 Software Installation Wizard

• Preparing to Install Software on the UC500

• Upgrade Status Messages

!
CAUTION Cisco does not recommend that you perform software upgrades over a remote 

WAN connection. If the connection to the WAN is interrupted, the operation will fail 

and the system or device may become unusable.

Mode On some devices you can choose Standard or TFTP mode.

• In standard mode if the upgrade images are stored locally.

• In remote TFTP server mode, the software images for the 

upgrade are stored remotely. To upgrade using remote 

TFTP server mode, you need a dedicated TFTP server on a 

UNIX workstation or on another PC. You can run any third-

party TFTP application on the remote server.

If you choose Remote TFTP Server,

• In the Image File field, enter the full path and filename of 

the Cisco IOS image.

• In the TFTP Server IP Address field, enter the IP address 

of your TFTP server.

You can select multiple site members and upgrade their Cisco 

IOS images. To perform group upgrades, your TFTP server must 

handle multiple requests and sessions simultaneously.

Setting Description
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UC500 Software Installation Wizard

Using the UC500 Software Installation wizard, you can:

• Install a UC500 software pack

This is the preferred way to install and upgrade UC500 software. When 

using this method, choose All when choosing upgrade settings. The UC500 

software pack includes Cisco IOS, CUE, related CME phone loads, scripts for 

Auto Attendant and Basic ACD, US/English locale and language files for 

phones and voice mail, and support files.

• Install a UC500 locale pack

• Upgrade only the Cisco IOS software image on the UC500

• Upgrade only the CUE voice mail software on the UC500

NOTE: When downloading a specific CUE or Cisco IOS image from Cisco.com, 

use the tar version of Cisco IOS images and a CUE package file for CUE voice mail 

software.

Follow the onscreen instructions in the wizard to install the software.

Preparing to Install Software on the UC500

To avoid software installation and upgrade failures and other issues, read this 

section carefully and verify that the system is ready for the installation or upgrade 

by performing these tasks.

• Verify that your PC meets the requirements for using CCA. See System 

Requirements, page 17.

• If you have a dual NIC (network interface card) on the PC running 

Configuration Assistant, make sure that only one of the interfaces is 

enabled.

• Turn off FTP/TFTP services running on your PC.

Before upgrading, disable any third-party TFTP servers running on your 

local PC. The embedded TFTP server in CCA is used to transfer images and 

files from your PC to the device to be upgraded. Only one TFTP server at a 

time can access the TFTP port.

On the PC running CCA, open a command window and execute the 

command netstat -a to see if any FTP or TFTP services are running. You 

should not see port 21, 69, FTP, or TFTP in the output. If there are, shut down 

those processes or services.
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If there are no third-party TFTP services running, try restarting your PC to 

release TFTP ports that may still be in use from a prior CCA session.

• Ensure that the PC has obtained a DHCP address from the UC500 and the 

default gateway is set correctly.

On the PC running CCA, open a command window and execute the 

command ipconfig /all. The Default Gateway IP address shown in the 

output should be obtained from the UC500 (the default value is 

192.168.10.1). 

• Any firewall software installed on the PC running CCA should be configured 

to allow TFTP and FTP access to and from the UC500. 

A firewall running on your PC can potentially block the connection between 

the CUE module on the UC500 and CCA, which can result in an upgrade 

failure.

If you disable the firewall running on the PC while performing an upgrade, 

be sure to re-enable it after the upgrade.

• Verify the CUE interface status. To do this, choose Troubleshoot > CUE 

Diagnostics > CUE Connectivity Diagnostics from the feature bar and 

click Check Status. You should see the line “Integrated-Service-
Engine0/0 is up, line protocol is up” in the “show interfaces” 

section near the top of the output if the CUE interface module is running.

Software Upgrade Status

This window appears when you select a device and click Status in the Software 

Upgrade window. The window shows detailed messages as they are generated 

from the device during an upgrade.

If there is insufficient space on the device to install the new image, a message with 

a link to the File Management window appears. You can use the File Management 

window to manage your file systems, and, if necessary, to delete old images to 

make space for new images.
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Upgrade Status Messages

This table explains upgrade status messages.

Voicemail Upgrade (UC560)

The UC560 platform supports upgrade of the Voicemail Compact Flash from the 

factory default size of 2 GB to 4 GB or 8 GB to increase voice mail storage 

capacity. After the compact flash is replaced and the UC560 is restarted, you are 

prompted to install voice mail software and language files on the new Voicemail 

Compact Flash.

Message Explanation

Click the Upgrade Settings 

button to continue

The Upgrade Settings window must be 

completed before the device can be upgraded.

Click the Upgrade button 

to upgrade the device

All the parameters are set for the device to be 

upgraded.

Reload started for the 

device

The device is reloading after a successful 

software upgrade. Even after the reload is 

completed, this message appears until you 

refresh the window.

Software upgrade was 

successful

The upgrade completed successfully.

Software upgrade failed The upgrade failed. See the Status window for 

more information.

IMPORTANT If a UC500 upgrade fails, verify 

that you have performed all the tasks listed in 

the Preparing to Install Software on the 

UC500, page 542.

Software upgrade in 

progress

The upgrade for the devices is in process.

Uploading the image The image is being uploaded to the device.

Verifying the image The device is verifying the image.
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See these sections for more information:

• Preparing for a Voicemail Upgrade

• Replacing the Voicemail Compact Flash on the UC560 and Performing a 

Voicemail Upgrade

Preparing for a Voicemail Upgrade

Before performing a voicemail upgrade:

• If you have a dual NIC (Network Interface Card) on the PC running 

Configuration Assistant, make sure that only one of the interfaces is 

enabled.

• Any firewall software installed on the PC running CCA should be configured 

to allow TFTP and FTP access to and from the UC500.

• Shut down any third-party TFTP or FTP servers running on the PC running 

CCA.

• If there are no third-party TFTP services running, try restarting your PC to 

release TFTP ports that may still be in use from a prior CCA session.

• If the UC500 is not in factory default state:

- Save the running configuration to the startup configuration. See 

Applying and Saving the Configuration, page 47.

- Back up the current UC500 configuration and Backing Up and 

Restoring Device Configuration, page 109.

• Make sure you have downloaded the latest UC500 software pack for the 

UC500 platform (for example, UC560-8.2.0.zip or later) to the PC running 

CCA. The software pack contains the latest CUE voice mail software 

(SCUE*.zip file).

• If you require a locale, other than US/English, or want to install files for an 

alternate locale, you must also download the appropriate UC500 locale 

packs. See UC500 Locale Packs, page 536.

To download UC500 locale packs, go to:

https://supportforums.cisco.com/docs/DOC-9829.

• If desired, download copies of custom files from the UC500 flash to our PC 

using the CCA File Management window (Maintenance > File Management. 

See File Management, page 558.

https://supportforums.cisco.com/docs/DOC-9829


Maintenance
Voicemail Upgrade (UC560)

546 Cisco Configuration Assistant SBCS Administrator Guide

19

Replacing the Voicemail Compact Flash on the UC560 and Performing a 

Voicemail Upgrade

A larger capacity Voicemail Compact Flash for the UC560 can be ordered from 

Cisco as a spare (UC500-8GB = for the 8-GB flash and UC500-4GB = for the 4-GB 

flash).

WARNING Before installing a new Voicemail Compact Flash on the UC560, you must save and 

back up the configuration on the UC560 and then power down the UC560. Failure 

to do so can cause the system to become inoperable or result in data loss.

To replace the Voicemail Compact Flash on the UC560 and perform a voicemail 

upgrade using CCA, perform these steps.

STEP 1 Make sure that you have performed the tasks listed in Preparing for a Voicemail 

Upgrade, page 545.

STEP 2 Power down the UC560.

STEP 3 Locate the Voicemail Compact Flash slot and remove the existing Voicemail 

Compact Flash.

STEP 4 Insert the new compact flash in the Voicemail Compact Flash slot.

STEP 5 Power on the UC560.

STEP 6 With the PC running CCA connected to the LAN side of the UC500, launch CCA 

and connect to the UC560.

CCA detects that a new Voicemail Compact Flash is installed, displays a message 

informing you that there is no CUE voice mail software installed, and asks you if 

you want to install it.

• If you choose Yes, the UC500 Software Installation wizard appears.

• If you choose No or close the window, you can always reopen it from the 

feature bar by choosing Maintenance > Software Upgrade > UC500.

Because the new Voicemail Compact Flash does not have any software or data on 

it, voicemail features are not available on the system until you install the voice mail 

software.

STEP 7 Follow the onscreen instructions in the UC500 Software Installation wizard to 

install voice mail software and language files. When asked to choose an 

installation option, choose Voicemail Software.
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The upgrade process takes approximately 30 minutes.

CCA performs a restore from the most recent voicemail backup after the software 

installation completes.

STEP 8 To verify that the voice mail software installation completed successfully

• Open the Voicemail window (Configure > Telephony > Voicemail) and 

verify that the available voicemail storage data reflects the increased 

capacity.

• Make calls, leave voice mail messages, and retrieve messages to verify that 

the voice mail system functions as expected.

• Retrieve existing voice mail to verify that old voice mails are accessible as 

expected.

STEP 9 Save the configuration (Configure > Save Configuration).

STEP 10 Back up the new configuration (Maintenance > Configuration Archive, Backup).

.

License Management

To manage licenses, choose Maintenance > License Management from the 

feature bar.

License management options differ between UC520 and UC540 platforms. These 

options are discussed in more detail in these sections:

• Overview, page 547

• License Types, page 548

• UC520 License Management, page 549

• UC540 and UC560 License Management, page 550

Overview

Cisco Software Licensing is supported on the UC500 Series platforms so that they 

can be modified in the field. For example, a system licensed for 8 users that 

physically supports 16 users can be upgraded to a 16-user license. Licenses can 

also be downgraded.
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IP phones are registered, based on the availability of a license for each phone. On 

UC520 platforms, when a system license is downgraded due to license expiration 

or by configuration by the user and the number of registered phones exceeds the 

user license count, the system reloads.

These software licensing features are available:

• For the UC520 platform, evaluation, extension, permanent, and grace-

period licenses are supported.

• For UC540 and UC560 platform, evaluation and permanent licenses are 

supported. The UC540 and UC560 platforms support PAK (Product 

Authorization Key) license upgrades.

• Installation and expiration events are managed by the licensing 

infrastructure.

License Types

Configuration Assistant supports four types of licenses, which are described in 

this section.

License Type Description

Evaluation 

License

Evaluation licenses are non-node locked, metered licenses 

that are bundled with a Cisco IOS image and valid for a limited 

period of time. The license is used only when there is no 

permanent, extension, or grace-period licenses for a feature. 

You must accept the EULA (End User License Agreement) 

before using this license.

Every time you connect to or refresh the network, 

Configuration Assistant notifies you of the status of a 

temporary license by using the Event Notification window. You 

are also notified if the license for any feature expires within 10 

days or less, and the system recommends that you install a 

permanent license.

Permanent 

License

Permanent licenses are node-locked licenses with no 

associated usage period, issued through the Cisco licensing 

portal. For UC520 platforms, you must accept the EULA as 

part of the installation of the license.
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UC520 License Management

To view license information or install a license, choose Maintenance > License 

Management on the feature bar.

This table lists and describes UC520 licenses information displayed in this 

window.

Extension 

License

UC520 only. Extension licenses are node-locked metered 

licenses, issued through the Cisco licensing portal. For UC520 

platforms, you must accept the EULA as part of the installation 

of the license.

Grace-Period 

License

UC520 only. Grace-period licenses are node-locked metered 

licenses, issued through the Cisco licensing portal as part of 

the permission ticket to rehost a license. These licenses are 

installed on the device as part of the rehost operation. You 

must accept the EULA as part of the rehost operation for this 

type of license. 

License Type Description

Setting Description

Device/Feature Displays available devices and currently installed 

user licenses.

Device ID Read-only. Displays the unique device identifier for 

the UC520. For example: UC520W-FXO-

K9:FFH104001MR.

Current Capabilities Current number of user licenses installed on this 

UC520.

Maximum Capabilities Maximum number of user licenses supported for 

this UC520 SKU.

License Type License can be permanent, evaluation, extension, or 

grace period.
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To install an evaluation license, follow these steps: 

STEP 1 In the License Management window, click on the UC500 device for which you 

want to view or install the evaluation license.

STEP 2 From the Action list for the device, select Evaluation License.

STEP 3 Click Apply or OK to install the licenses. The related fields are updated.

To install a permanent or an extension license, follow these steps: 

STEP 1 From the Action list for the device, choose Select License File. The Upload 

License File dialog appears.

STEP 2 Click Browse to navigate to the location of the license file, then click OK. See 

Upload License File, page 555.

To cancel a license upgrade, click Cancel before you click Apply or OK. The 

installation is canceled, and the original license status appears.

STEP 3 Click Apply or OK to install the license. The related fields are updated.

When the licenses are successfully installed, the Capabilities column updates to 

reflect the additional licenses.

UC540 and UC560 License Management

Software licensing on the UC540 and UC560 platforms supports the Software 

PAK (Product Authorization Key) mechanism for license upgrades. For details, see 

the next section, License Management Actions, page 551.

Expiry Period For permanent licenses, Lifetime is always 

displayed for the Expiry period.

For evaluation Licenses, the Expiry Period is the 

amount of time remaining until the evaluation license 

expires.

Action Available options include None or Select License 

File.

Setting Description
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This table lists and describes UC540 licenses information displayed in this 

window.

License Management Actions

This window appears when you select a UC540 or UC560 in the License 

Management window, select a license, and click Manage.

Setting Description

Device/Feature Displays available devices and currently installed 

licenses. UC540 and UC560 device licenses are 

listed as Pro User License.

Device ID Read-only. Displays the unique device identifier for 

the UC540 or UC560 device.

For example: UC540W-FXO-K9:FFH104001MR.

Current Capabilities Current number of licenses installed on this UC540 

or UC560.

Maximum Capabilities Maximum number of licenses supported. 

For the UC540, this is 40. 

The UC560 supports up to 138 user licenses.

License Type For the UC540 and UC560, this can be Permanent or 

Evaluation. Licenses can be either Active or Inactive.

Expiry Period For permanent licenses, Lifetime is always 

displayed for the Expiry period.

For evaluation Licenses, the Expiry Period is the 

amount of time remaining until the evaluation license 

expires.

Action For active licenses, click Manage to open the 

License Management Details window, where you 

can install, upgrade, transfer, activate, and 

deactivate licenses. See License Management 

Actions, page 551.
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Overview

The UC540 platform ships from the factory with 8 permanent licenses installed 

and active; the UC560 platform ships with 16 permanent licenses installed and 

active. These factory-installed licenses cannot be transferred, revoked, or 

modified.

The maximum number of user licenses for the UC540 platform is 40. For the 

UC560, the maximum number of user licenses is 138. Additional licenses can be 

added in sets of 8 using a Product Authorization Key (PAK) or added through a 

license file. If the maximum number of licenses are already installed, the upgrade 

license from a PAK and install license options are disabled.

The configuration fields displayed in this window vary, depending on the license 

management action you choose. These actions can be performed:

• Upgrade License Using a PAK (Product Authorization Key), page 552

• Transfer License To or From This Device, page 553

• Install License From File, page 555

• Activate or Deactivate Evaluation License, page 555

Upgrade License Using a PAK (Product Authorization Key)

Choose the Upgrade License Using PAK (Product Authorization Key) option if 

you want to install additional licenses using a PAK. This option is unavailable if the 

maximum number of licenses are already installed.

The SWIFT (Software Infrastructure and Fulfillment Technology) database is 

contacted and updated when licenses are upgraded.

To install an upgrade license using a PAK, follow these steps.

STEP 1 In the Actions section of the window, choose Upgrade License Using a PAK 

(Product Authorization Key).

The Device ID at the top of the window displays the unique ID for this UC540 

device.

STEP 2 In the Action Details section of the window, complete settings as described 

below.
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STEP 3 Click OK to close the License Management Actions window and return to the 

License Management window.

Transfer License To or From This Device

Choose Transfer License to or From This Device if you want to:

• Revoke and remove licenses from this UC540 or UC560 device and save 

them to a file, or

• Transfer previously saved licenses to another UC540 or UC560 device.

When you remove licenses from a UC540 or UC560:

• The licenses are stored in a file on the PC running Configuration Assistant.

• The location is displayed in the License Management Actions window. 

When you transfer the license to a different UC540 or UC560 make sure that file is 

present on the PC running Configuration Assistant. Use the same PC to remove 

and transfer the licenses or copy the saved license file to same location on the PC 

to be used for the license transfer.

The SWIFT (Software Infrastructure and Fulfillment Technology) database is 

contacted and updated when licenses are revoked and transferred.

To remove licenses from one UC540 or UC560 for transfer to another UC540 or 

UC560, follow these steps.

Settings Description

Cisco.com User Enter your Cisco.com user ID.

Cisco.com Password Enter your Cisco.com password.

Email Address Enter a valid email address. This is the address to 

which notification emails from SWIFT are sent.

Number of PAK to install Select the number of PAKs (Product Authorization 

Keys) to install from the drop-down list; from 1 to 3 

for the UC540 or from 1 to 8 for the UC560.

PAK-1 to PAK-3 (UC540)

PAK-1 to PAK-8 (UC560)

Enter the Product Authorization Key for each 

license to be installed.
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STEP 1 In the Actions section of the License Management Actions window, choose 

Transfer License To or From This Device.

STEP 2 In the Action Details section of the window, complete settings as described 

below.

STEP 3 When you click OK, the system connects to the SWIFT database and revoke the 

license. The license is removed from the UC540 or UC560 and saved to a file on 

the PC running Configuration Assistant.

The location of the file on the local PC is displayed in the License Management 

Actions window.

To install a previously saved license transferred from another UC540 or UC560, 

follow these steps.

STEP 1 In the Actions section of the window, choose Transfer License To or From This 

Device.

STEP 2 In the Action Details section of the window, complete settings as described 

below.

Settings Description

Cisco.com Username Enter your Cisco.com user ID.

Cisco.com Password Enter your Cisco.com password.

Email Address Enter a valid email address. This is the address to 

which notification emails from SWIFT (Software 

Infrastructure and Fulfillment Technology) are sent.

Transfer Type Choose Remove License and Save for Transfer.

Settings Description

Cisco.com Username Enter your Cisco.com user ID.

Cisco.com Password Enter your Cisco.com password.
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STEP 3 Click OK to install the license and close the License Management Actions window. 

You are returned to the License Management window.

Install License From File

Choose Install License File if you want to manually install a license using a license 

file.

To install a license from a file, follow these steps.

STEP 1 In the Actions section of the window, choose Install License from File.

STEP 2 In the Action Details section of the window, click Browse and locate the license 

file to install, then click OK. See Upload License File, page 555.

STEP 3 Click Apply or OK to install the license and close the License Management Actions 

window.

Activate or Deactivate Evaluation License

To activate or deactivate a license choose Activate Evaluation License or 

Deactivate Evaluation License, then click OK. No other information is required.

Upload License File

The Upload License File dialog appears when you are managing licenses on a 

UC520 and choose Select a License File from the Actions drop-down list in the 

License Management window.

Click Browse to navigate to the location of the license file on your system, then 

click OK to upload the license file.

The license file will have a .lic or .xml extension.

Transfer Type Choose Transfer Previously Saved License.

Choose the license to install from the Discovered 

Licenses drop-down list menu. When discovering 

licenses, Configuration Assistant looks only in the 

location in which the license was previously saved.

Settings Description
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Restart/Reset Devices

To open the Restart/Reset window, choose Maintenance > Restart/Reset from 

the feature bar.

Overview

You can restart devices in your customer site or reset them to their factory 

defaults.

• Restarting a device saves the active configuration file and starts it again. A 

reconnect to CCA will occur after a restart. A device is not accessible while 

it is being restarted, and connectivity is interrupted briefly between the 

device and its end stations.

• Resetting a device restores the settings that it had when it was new from 

the factory. After a device is reset to factory default, you can use one of the 

device setup wizards to establish the configuration or re-configure the 

device manually.

NOTE: When resetting a device, the DHCP server might assign a new IP address 

to a reset device. If this happens, the CCA Topology view shows that the device is 

unreachable. Right-click on the device in the Topology view and choose Add to 

Site to re-add the device to its customer site with its new IP address.

Procedures

To restart or reset a device in your customer site, follow these steps:

STEP 1 In the Restart/Reset window, select the device you want to restart or reset.

STEP  2 Choose one of these steps:

• Check the Restart option.

• Check the Reset to Factory Defaults option.

• Check both options.

STEP  3 Click OK.
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To Restart CUE

For the UC500, you can also choose to restart the Cisco Unity Express module 

only. Voice mail, Auto Attendant, and other telephony applications run on the CUE 

module.

!
CAUTION You should only restart the CUE module if instructed to by Cisco TAC to address a 

specific issue or if required as part of a related operation in Configuration Assistant, 

for example, forcing a re-read of installed language files for the Cisco WebEx 

PhoneConnect application.

A CUE restart can take from 10 to 15 minutes. During this time, voice mail, Auto 

Attendant, and telephony applications such as Cisco WebEx PhoneConnect and 

TimeCardView are unavailable.

To restart the CUE module, choose Home > Topology to open the Topology view, 

right-click on the UC500 icon in the Topology view, and choose Restart CUE from 

the menu.

TIP To access CUE diagnostic and troubleshooting tools, go to Troubleshoot > 

Telephony Diagnostics > CUE Diagnostics > CUE Connectivity Diagnostics. For 

more information, see CUE Connectivity Diagnostics, page 612.

How to Localize the UC500 (Non-US/English Locales)

The default system locale for the UC500 is US/English.

To localize the UC500, phones, and voicemail for a different locale, perform these 

steps.
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STEP 1 Download the latest UC500 software pack if needed, and download the UC500 

locale packs for the desired locales.

See Downloading U500 Software and Locale Packs, page 537.

NOTE SF/SG Series switches requiring a firmware upgrade must be rebooted to 

factory default. This will resolve a known issue where Cisco 7900 series 

phones fail to display the correct phone language after the UC500 is 

localized for different locales.

STEP 2 To install the software and locale packs, choose Maintenance > Software 

Upgrade > UC500 and follow the onscreen instructions.

See Installing Software on the UC500, page 541.

STEP 3 In the Outgoing Dial Plan window, choose the numbering plan locale that 

corresponds to the desired locale or upload a custom, localized dial plan.

See Outgoing Dial Plan, page 451.

File Management

To manage the file system on the compact flash for the UC500 or the file system 

for other Cisco IOS devices, choose Maintenance > File Management from the 

feature bar.

TIP The Flash Usage item on the Dashboard view provides information about the 

percentage of used and available storage on the compact flash. To open the 

Dashboard, choose Home > Dashboard from the feature bar. You can remove 

phone loads from the flash to free up space, if needed. See Phone Load 

Management, page 563.

Overview

From the File Management window, you can

• View the file systems of any Cisco IOS devices while the devices are 

connected to a live network

• Perform basic file management operations on these file systems
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• Delete files from the flash

For example, when performing a software upgrade, you might have 

insufficient space to install the new image, and therefore you might need to 

delete the old image to make room for the new image

• Upload and download files to and from the flash

Procedures

The File Management window has two tabs:

• Overview

• Files

Overview

This table explains the columns in the Overview tab.

Column Explanation

Device/File 

System 

Lists the devices selected and the file systems on those 

devices.

Status Status for a file system can be any one of these:

• Blank—No status to report.

• Squeeze Needed—There are deleted files on a class B 

file system.

• Squeeze in Progress—Currently purging files marked 

for deletion.

• File System in Use — File system information is 

unavailable. Click Refresh to try again.

• File System Full—There is no free space left in the file 

system.

• File System Empty—There are no files in the file system.

• File System is Read-only—The file system is locked 

and cannot be modified. This is often due to a physical 

switch setting on a compact flash card.
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Files

This table explains the columns on the Files tab. 

Uploading, Downloading, and Deleting Files on the Flash

Capacity Size of the file system rounded to the nearest megabyte (MB).

Free Space Number of megabytes free in the file system, rounded to the 

nearest MB.

% Free 

Space 

Percentage of the total file system that is unused.

Files Number of files on the file system. Directories on Class C file 

systems and deleted files on Class B file systems are counted 

as files.

Column Explanation

Device/File 

System

Lists the devices selected and the file systems on those devices. 

Below each file system is a list of directories and files.

Squeeze This action is available only when there is a deleted file on a 

device with a Class B file system. Check the box provided to 

permanently remove deleted files from the file system. The 

check box is not available if the file system is read-only or if 

there are no deleted files on the file system.

Size Lists the sizes of individual files in kB.

Type Lists the file type of individual files, if available. Common file 

types would include System Image, Cisco IOS Image, and 

Configuration.

Modified Lists the file modification date and time.

Delete Check the box for a file to select it for deletion. If the file is in a 

Class B file system and a file is already marked for deletion, the 

box is checked.

Restore Appears only for devices that have Class B file systems with 

deleted files. Check the boxes to select which files to undelete.

Column Explanation
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You can upload and download files to and from the compact flash on the UC500 or 

other CCA-managed Cisco IOS devices. For example, you can upload custom 

ringtone files, phone desktop images, music on hold files, custom Auto Attendant 

scripts, or support files as directed by Cisco Support. You can download copies of 

files on the flash to your local machine to archive them or to upload them to 

another device.

IMPORTANT CCA uses a built-in FTP service to transfer files between your PC 

and the compact flash on the UC500 or other CCA-managed Cisco IOS devices. 

You must disable any other third-party FTP services running on your PC before 

you can transfer files. If there are no third-party FTP services running, check the 

firewall and network security settings on your PC to make sure that FTP traffic is 

allowed between the PC and the device or try restarting your PC.

To upload a file from your local machine to the compact flash on a Cisco IOS 

device, follow these steps.

STEP 1 In the File Management window, select the Files tab.

STEP 2 In the Device/File System tree, select the device and navigate to the location on 

the flash where you want to upload the file.

Make sure that you upload the file to the correct location on the flash. For example, 

Music on Hold audio files are uploaded to the flash:\media directory. For more 

information, see the Cisco Unified CME documentation on Cisco.com.

STEP 3 Click Upload.

To download a copy of one or more files from the compact flash on a Cisco IOS 

device to your local machine, follow these steps.

STEP 1 In the File Management window, select the Files tab.

STEP 2 In the Device/File System hierarchy, select a device and navigate to the folder on 

the flash that contains the file or files you want to download.

STEP 3 Click on the names of the files that you want to download to select them.
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You can use the WIndows CTRL-Left mouse button and Shift-Left mouse button 

keyboard shortcuts to select multiple files.

The Download button is not active until you select at least one file.

STEP 4 Click Download.

To delete one or more files from the compact flash on a Cisco IOS device, follow 

these steps.

!
CAUTION Do not delete the system boot image or any of these files on the UC500 flash: 

vlan.dat, config.txt, env_vars, private_config.txt, and system_env_vars.

STEP 1 In the File Management window, select the Files tab.

STEP 2 In the Device/File System hierarchy, navigate to the folder on the flash that 

contains the folder or files you want to delete.

STEP 3 Check the box in the same row as the file or folder that you want to delete.

You can select more than one file or folder to delete. When you select a folder, all 

files in the folder and its subfolders will be deleted.

STEP 4 Click Apply.

STEP 5 If you want to permanently remove the file from a Class B file system, perform a 

squeeze operation on the file system where the file exists.

STEP 6 Follow these steps to restore a file that has not been permanently deleted by a 

squeeze operation:

a. Check the box in the same row as the file that you want to restore.

b. Click Apply.

STEP 7 Follow these steps to squeeze a Class B file system:

a. Check the box in the same row as the file system that you want to squeeze.

b. Click Apply.
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When squeezing a file system, if there are files in it marked to be restored, those 

files are restored before the squeeze operation. Files marked for deletion are 

removed before the squeeze operation. Squeeze operations can take several 

minutes.

Phone Load Management

To access phone load management options, choose Maintenance > Phone Load 

Management.

• Overview

• Delete Phone Loads

• Upload Phone Loads

• Drag-and-Drop Phone Upgrades (SPA500 Series, SPA300 Series, 6900 

Series, and Selected 7900 Series IP Phones)

Overview

From the tabs on the Phone Load Management window, you can:

• Replace or add phone loads to the UC500 compact flash by specifying a 

UC500 software pack. The phone loads are extracted from the software 

pack and uploaded to the UC500.

• Remove phone loads from the compact flash on the UC500 to optimize 

space on the flash.

• Replace a specific phone load by deleting the version that is currently on 

the system and then uploading a newer version.

In order to upload phone load files to the UC500, make sure that you have disabled 

any third-party TFTP or FTP servers running on the PC that is running 

Configuration Assistant.

Delete Phone Loads

When you choose the Delete Phone Loads tab, all phone loads on the UC500 flash 

are displayed. in the list.

• A checkbox is displayed in the Select column for all phone loads available 

on the UC500 flash.
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• Phone loads that are not in use on the system are checked and can be 

safely deleted.

• Phone loads that are in use are unchecked.

To delete a phone load, follow these steps.

STEP 1 Click on the row in the table for that phone load to highlight it.

STEP 2 Make sure that checkbox in the Select column for that phone load is checked.

Click Delete.

STEP 3 Repeat the above steps to delete additional phone loads.

As you delete phone loads, the Flash space available fields update to reflect flash 

usage after the deletion.

STEP 4 Click OK when you are finished deleting phone loads.

Upload Phone Loads

To upload phone loads to the UC500, follow these steps.

STEP 1 Click Browse and locate the UC500 software pack (.zip file) that contains the 

phone loads you want to upload., for example UC520-7.0.3.zip or UC540-
7.1.1.zip.

After you have selected the UC500 software pack file, CCA analyzes the phone 

loads in the software pack and the ones in use on your system.

When the software pack analysis completes, the list of phone loads available in 

the specified image are displayed. Phone loads that are already in use on your 

system are selected for upload.

Click the checkbox in the Select column to select or deselect phone loads from 

the list of those to be uploaded.

NOTE: The 521_524 phone loads for CP500 phones cannot be deselected. You 

must upgrade to the latest firmware for these phones to function correctly.

STEP 2 Click Upload to upload the selected phone loads to the UC500.

STEP 3 Click OK to close the Phone Load Management window.
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Drag-and-Drop Phone Upgrades (SPA500 Series, SPA300 Series, 6900 

Series, and Selected 7900 Series IP Phones)

The drag-and-drop phone load upgrade method can be used to upgrade firmware 

for the following IP phones:

• Cisco Model 6901, 6911, 6921, 6941, and 6961 IP phones (Model 6945 is 

not supported)

• Cisco SPA500 Series IP phones (including SPA525G and SPA525G2)

• Cisco SPA300 Series IP phones

• Cisco Model 7940, 7960, 7975, 7970, 7971, 7945, 7965, 7942, 7962, 7941, 

7961, 7931, 7911, and 7906 IP phones

These guidelines and notes apply to drag-and-drop phone load upgrades:

• This upgrade method is supported only the phones listed above. CCA 

displays a message if it does not recognize the file format of the phone load 

file.

• For most Cisco Model 79xx phones, you do not have to extract the files from 

the .zip archive. For Cisco SPA500 Series and 300 Series phones, you must 

extract the .bin file from the archive before dragging and dropping it onto 

the topology. Cisco Model 7921 and 7925 phone loads are packaged in .tar 

files that you can drag-and-drop onto the UC500 icon.

• You cannot drag and drop more than one file at a time.

• Phone loads are copied into the flash:phones/ directory on the UC500 

flash and placed under the appropriate subdirectory for the phone model. 

For example: flash:phones/525 or flash:phones/5x5.

• After the upgraded firmware is downloaded, it can be managed through the 

Phone Load Management window in CCA.

To upgrade Cisco IP phones using the drag-and-drop method, follow these steps.

STEP 1 Download the phone software from Cisco.com. A Cisco.com login is required.

STEP 2 Launch CCA and connect to the customer site or UC500 device.

STEP 3 Choose Home > Topology to open the Topology View if it is not already open.

STEP 4 On the PC running CCA, locate the phone firmware file that you downloaded from 

Cisco.com. For example: spa525g-7-4-3.bin.
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STEP 5 In the Topology View, use the mouse to drag the phone load (.zip or .bin) file from 

your PC and drop it onto the UC500 icon.

If CCA recognizes the file as a valid phone load, a pop-up dialog displays and you 

are prompted to upload the file.

STEP 6 Click Upload. The dialog displays the upload and upgrade progress.

After the upgrade is applied, you are prompted to restart all affected phones.

To restart a phone using CCA, open the Topology View, right-click on the phone 

icon, and choose Reboot.
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Monitoring

Read this section to learn about reports and diagnostic information that can be 

monitored for devices in a customer site. To access system monitoring options, 

choose Monitor from the feature bar.

These report categories and monitoring tools are available:

• Network

• Security

• Telephony

• Inventory

• Health

• Event Notification

• System Log

• System Messages

• Crash Log

• Multisite Status

Network

To access network status monitoring options, choose Monitor > Network from the 

feature bar. These network monitoring reports and tools are available:

• Port Statistics

• Bandwidth Graphs

• Link Graphs

• Wireless Usage
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• T1/E1/BRI Status

• DNS and Hosts

Port Statistics

To access Port Statistics, choose Monitor > Network > Port Statistics from the 

feature bar.

Port Statistics are available for Cisco ESW500 Series switches and Cisco CE520 

switches only.

From the Port Statistics window, you can display port information such as 

statistics on link performance, dropped packets, and total errors. To see a 

condensed, graphical view of port statistics, use the Bandwidth Graphs window.

• To see these statistics for the ports on a given device, select the device from 

the Hostname list.

• To refresh the statistics, click Refresh.

• To clear the statistics for all the ports on the selected device, click Clear 

Counters.

• To save the report to a local drive, click Save Report. In the window that 

appears, you select a folder for storing the report.

This table explains the data on each of the tabs: Overview, Transmit Detail, and 

Receive Detail.
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Tab Column Explanation

Overview Interface Port interface name (for example, on an 
ESW-540-8P switch, the interfaces are 
numbered g1 through g9.

Port Description ESW500 switches only. Text description for this 
port, if configured on the switch.

Transmit Rate The current transmit rate in Mbps. It includes 
the transmission of bad packets and 
retransmission because of collisions in half-
duplex operations.

Receive Rate The current receive rate in Mbps. It includes the 
data bytes of bad packets, discarded packets, 
and no-destination packets.

Transmit 
Bandwidth 
Usage

The percentage of the bandwidth usage for 
transmission, based on the current transmit rate 
and actual speed.

Receive 
Bandwidth 
Usage

The percentage of the bandwidth usage for 
reception, based on the current receive rate 
and actual speed.

Transmit Packet 
Rate

The current transmit rate of well-formed 
packets. It includes unicast, multicast, and 
broadcast packets.

Receive Packet 
Rate

The current receive rate of well-formed 
packets. It includes unicast, multicast, and 
broadcast packets.

Transmit 
Multicast/
Broadcast 
Packet Rate

The current transmit rate of well-formed 
multicast and broadcast packets. It excludes 
unicast packets.

Receive 
Multicast/
Broadcast 
Packet Rate

The current receive rate of well-formed 
multicast and broadcast packets. It excludes 
unicast packets.

Total Discarded 
Packets

The total number of packets discarded from 
both transmission and reception.
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Overview Total Packets 
with Errors

The total number of packets with errors from 
both transmission and reception.

Transmit 
Packets

Interface Port interface name (for example, on an 
ESW-540-8P switch, the interfaces are 
numbered g1 through g9.

Port Description ESW500 switches only. Text description for this 
port, if configured on the switch.

Unicast The total number of well-formed unicast 
packets transmitted by a port. It excludes 
packets transmitted with errors or with 
multicast or broadcast destination addresses.

Multicast The total number of well-formed multicast 
packets transmitted by a port. It excludes 
packets transmitted with errors or with unicast 
or broadcast destination addresses.

Broadcast The total number of well-formed broadcast 
packets transmitted by a port. It excludes 
packets transmitted with errors or with unicast 
or multicast destination addresses.

Total Collision The total number of packets transmitted 
without error after having 1 to 15 collisions. It 
includes packets of all destination address 
types and excludes packets discarded 
because of insufficient resources or late 
collisions.

Excessive 
Collision

The total number of packets that failed to be 
transmitted after 16 collisions. It includes 
packets of all destination address types.

Late Collision The total number of packets discarded 
because of late collisions detected during 
transmission. It includes all transmit packets 
that had a collision after the transmission of the 
packet's 64th byte. The preamble and SFD are 
not included in the frame's byte count.

Tab Column Explanation
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Receive 
Packets

Interface Port interface name (for example, on an 
ESW-540-8P switch, the interfaces are 
numbered g1 through g9.

Port Description ESW500 switches only. Text description for this 
port, if configured on the switch.

Unicast The total number of well-formed unicast 
packets received by a port. It excludes packets 
received with errors, with multicast or 
broadcast destination addresses, or with 
oversized or undersized packets. Also 
excluded are packets discarded or without a 
destination.

Multicast The total number of well-formed multicast 
packets received by a port. It excludes packets 
received with errors, with unicast or broadcast 
destination addresses, or with oversized or 
undersize packets. Also excluded are packets 
discarded or without a destination.

Broadcast The total number of well-formed broadcast 
packets received by a port. It excludes packets 
received with errors, with unicast or multicast 
destination addresses, or with oversized or 
undersize packets. Also excluded are packets 
discarded or without a destination.

Discarded The total number of packets discarded 
because of insufficient receive bandwidth or 
receive buffer space, or because the 
forwarding rules stipulate that they not be 
forwarded.

Tab Column Explanation
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Bandwidth Graphs

From the Bandwidth Graphs window, you can see an estimate of the traffic flowing 

through the device you choose from the Hostname list. Bandwidth Graphs are 

available for CE520 switches only.

To display a bandwidth graph for a CE520 switch, take any of these actions:

• Right-click a site member in the Front Panel view and choose Bandwidth 

Graphs from the popup menu.

• Right-click or double-click a site member in the Topology view and choose 

Bandwidth Graphs from the popup menu.

• Select a site member in either view, and choose Monitor > Network > 

Bandwidth Graphs on the feature bar.

Overview

For a selected Catalyst Express 500 switch, a bandwidth graph gives you these 

estimates:

• How much of its bandwidth is being used, starting at the time the graph 

appears.

Receive 
Packets

Alignment 
Errors

The total number of packets received with 
alignment errors. It includes all the packets 
received with both a FCS error and a non-
integral number of bytes.

FCS Errors The total number of packets received with FCS 
errors. It excludes undersized packets with FCS 
errors.

Collision 
Fragments

The total number of frames of less than 
64 bytes that have an integral number of bytes 
and bad FCS values.

Undersize 
Packets

The total number of packets received of less 
than 64 bytes that have good FCS values.

Oversize 
Packets

The total number of packets received of more 
than 1518 bytes that have good FCS values.

Tab Column Explanation
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• How much of its bandwidth was used, in the past minute, hour, day, or 

2-week period.

Procedures

The window has these tabs:

• Time Series, which shows the percentage of bandwidth utilized, starting at 

the time the window appears.

• Trends, which shows the percentage of bandwidth utilized in the past 

minute, hour, day, or 2-week period.

Time Series

You can manipulate the graph on this tab by:

• Selecting the type of graph displayed

• Changing the increments on the x-axis

• Changing the polling interval

• Scrolling the x-axis

Selecting the Type of Graph to Display

From the Type list, click Line or Bar to select a type of graph. In a line graph, data 

points are connected by a line. In a bar graph, data points are denoted by the 

height of bars.

Changing the Increments on the X-Axis

By default, the time increments on the x-axis are 2 minutes apart. To make them 

closer together or farther apart, click the Zoom buttons.

Changing the Polling Interval

At a regular interval, Configuration Assistant queries the managed devices to 

gather device and link-utilization data. This interval is called the graph polling 

interval. To set it, open the Preferences window, click the General tab, and choose 

a value for the Graph Polling Interval field.

NOTE: When the traffic level on a device drops dramatically, you do not see a 

change in the graph for at least 15 minutes, regardless of the setting for the graph 

polling interval.
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Scrolling the X-Axis

You can use the scroll bar at the bottom of the graph to scroll left and review past 

data points that have moved off the graph. You can then scroll right to return to the 

most recent data.

NOTE: The graph is updated each time the device is polled. You can change the 

polling interval (the frequency for collecting the data) by selecting and using the 

Preferences window.

Trends

The graph on this tab is about past bandwidth utilization. Therefore, you see 

historical data when you open this tab-by default, the device's bandwidth data for 

the past 60 seconds. By clicking the trend buttons on the tab, you can also see 

data for the past 60 minutes, 24 hours, or 14 days. The data always appears as a 

bar graph. The intervals on the x-axis are fixed for each trend graph; you can 

lengthen or shorten them only by clicking a different trend button.

Link Graphs

Link Graphs are available for Cisco ESW500 Series switches, CE520 switches, 

SF 200/300, and SG 200/300 Series switches.

To display a link graph, one end of the link must connect to a port on a member 

device. You cannot display a link graph between candidate devices.

To display a link graph, take either of these actions:

• Choose Monitor > Network > Link Graphs on the feature bar.

• Click a link in the topology view and choose Link Graphs from the popup 

menu.

NOTE: You can change the graph polling interval by selecting and using the 

Preferences window.

Overview

A link graph shows the:

• Percentage of bandwidth being used

• Number of bytes transmitted and received

• Number of packets transmitted and received (differentiated into broadcast/

multicast packets and unicast packets)
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• Total errors and packets dropped

From the Link Graphs window, you can:

• Select the Type of Data Displayed

• Select the Type of Graph Displayed

• Change the Increments on the Axes

• View a Long Span of Data

Procedures

To select a port other than the one in the Interface field, overtype the port number, 

use the scroll buttons, or click the port selection icon. If you choose the last option, 

the Select Interface window opens to show the front panel of the device. Select a 

port by clicking it; then click OK. See Select Interface, page 577.

Select the Type of Data Displayed

To select a type of data, click % Utilization, Transmitted/Received Packets, 

Packet-Forwarding Methods, or Packet Drops and Errors in the Data list. The 

results of each selection are described in this table:

Data Type Results

% Utilization Displays the percentage of bandwidth being used on 

the port that corresponds to the link. For example, if the 

bandwidth of the link is 100 Mbps, and 20 Mb is 

consumed at a time, the graph plots 20% at that instant.

Transmitted/

Received Packets

Displays two graphs: Transmitted (red) and Received 

(blue).

The Bytes Transmitted graph displays the number of 

bytes transmitted on the port that corresponds to the 

link.

The Bytes Received graph displays the total number of 

bytes received on the port that corresponds to the link.
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Select the Type of Graph Displayed

From the Type list, click Line, Bar, Stack Bar, Area, or Stack Area to select a type 

of graph. The appearance of each type is described in this table.

Packet-Forwarding 

Methods

Displays two graphs: Broadcast/Multicast Packets (red) 

and Unicast Packets (blue).

The Broadcast/Multicast Packets graph displays the 

number of broadcast and multicast packets received 

on and transmitted to the port that corresponds to the 

link.

The Unicast Packets graph displays the number of 

unicast packets received on and transmitted to the port 

that corresponds to the link.

Packet Drops and 

Errors

Displays two graphs: Total Errors (blue) and Total 

Packets Dropped (red).

The Total Errors graph displays the total number of 

packets with errors that have accumulated on the port 

since the counters were last reset.

The Total Packets Dropped graph displays the total 

number of packets that were dropped on the port 

corresponding to the link. Packets are dropped 

because of a lack of buffers or bandwidth or because 

of user-configured packet filtering on the device.

Graph Type Appearance

Line Data points are connected by a line.

Bar Data points are denoted by the height of bars.

Stack Bar Multiple bar graphs, each of a different color, are stacked 

one upon another.

Area Data points are connected by a line, and the area under 

the line is filled in.

Data Type Results
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Change the Increments on the Axes

By default, the time increments on the x-axis are 2 minutes apart. To make them 

closer together or farther apart, click the Zoom buttons.

Check Log Scaling if you want the increments on the y-axis to scale upward 

logarithmically rather than arithmetically.

View a Long Span of Data

Use the scroll bar at the bottom of the graph to scroll left and review past data 

points that have moved off the graph. You can then scroll right to return to the most 

recent data.

NOTE: The graph is updated each time the device is polled. You can change the 

polling interval (the frequency for collecting the data) from the Preferences 

window.

Select Interface 

This window appears when you click a switchport icon in a Configuration 

Assistant window. It displays the front panel of a selected switch. Use the window 

to select an interface on the switch.

Follow these steps:

STEP 1 Click on the interface you want to use.

Interfaces that you cannot select are grayed out.

STEP 2 Click OK. You return to the Configuration Assistant window you were using, and 

the number of the selected interface appears in the Interface field.

Wireless Usage 

To view a wireless usage report, choose Monitor > Network > Wireless Usage 

from the feature bar.

Status information for wireless clients is only available for these devices:

Stack Area Multiple area graphs, each of a different color, are stacked 

one upon another.

Graph Type Appearance
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• Cisco UC500 platforms and Cisco SR500 Series Secure Routers with an 

embedded access point.

• Cisco AP521 autonomous access points.

• Cisco AP541N Dual-band Single-radio access points.

Wireless LAN controller status is not shown.

Choose a wireless device from the Hostname list menu.

The Wireless Usage report displays the following information for each connected 

client:

• MAC address

• Name

• IP address

• VLAN number

• SSID (secure site identifier)

• Key management type

• Encryption type

• Data rate, in Mbps

• Signal strength, in dBm, for clients connected to AP521 and built-in UC500 

access points

• RSSI (received signal strength indication), for AP541N access points

The RSSI indicates the RF (Radio Frequency) signal strength for clients 

connected to AP541N access points. A value from 1 to 100 is displayed.

• Packets in/out

• Bytes in/out

T1/E1/BRI Status

If a T1/E1 or BRI interface is present on the system, choose Monitor > Network > 

T1/E1/BRI Status from the feature bar to view output of Cisco IOS commands 

such as show isdn status and show controller for BRI, T1, or E1, depending on the 

available interfaces.
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DNS and Hosts

To view the output of the show hosts command for the customer site choose 

Configure > Monitor > Network > DNS and Hosts. The output includes the DNS 

hostname and domain of the UC500 or SR500 and the IP addresses of the primary 

and secondary DNS servers.

Security 

To access monitoring options for network security, choose Monitor > Security 

from the feature bar. Expert mode security reports are listed and described below.

These reports are text-based and are generated from Cisco IOS command output.

NOTE:  These reports are primarily intended to aid the Small Business Support 

Center (SBSC) in resolving issues with Cisco SBCS deployments. Expert 

knowledge of Cisco IOS and the command-line interface is required to effectively 

interpret the data presented in these reports.

Security Report Description

EZVPN Client and Server Displays output of show crypto commands for 

obtaining information about current IKE security 

associations, EasyVPN remote configuration, 

settings used by current SAs, active VPN 

sessions, and encryption accelerator statistics.

Site-to-Site VPN Status Displays output of show crypto commands for 

obtaining current IKE security associations, 

active VPN sessions, settings used by current 

SAs, active VPN sessions, and encryption 

accelerator statistics.

SSL VPN Status Displays output of show tcp and show webvpn 

commands for obtaining information about TCP 

connection endpoints, SSL VPN user sessions, 

and SSL VPN tunnel statistics.

To display SSL VPN user session information for 

a specific user, enter the username and click 

Query.
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VPN Status

The VPN status window appears when you choose Monitor > Security > VPN 

Status from the feature bar.

EasyVPN

From this tab, you can monitor the status of EasyVPN tunnels.

Choose a device to be reported from the Hostname list. The report entries are 

automatically populated.

SSL VPN

From this tab, you can monitor status of SSL (secure socket layer) VPN tunnels.

Firewall Displays output of show access-list and show 

ip inspect session commands.

NAT Displays output of show ip nat and show ip 

route commands for obtaining information about 

NAT statistics, IP routes, and NAT translations.

VPN Status See VPN Status, page 580.

VPN Status Description

UP-ACTIVE Up and active.

UP-IDLE Up, but there is no activity.

UP-NO-IKE Up, but there is no IKE (Internet Key Exchange).

DOWN-NEGOTIATING Down, but the device is negotiating the connection.

DOWN Down.

Security Report Description



Monitoring

Telephony

Cisco Configuration Assistant SBCS Administrator Guide 581

20
 

Telephony

To access monitoring options for telephony features, choose Monitor > 

Telephony from the feature bar. Expert mode telephony reports are listed and 

described below.

These reports are text-based and are generated from Cisco IOS and CUE 

command output.

NOTE: These reports are primarily intended to aid the Small Business Support 

Center (SBSC) in resolving issues with Cisco SBCS deployments. Expert 

knowledge of CUE, Cisco IOS, and the command-line interface is required to 

effectively interpret the data and output presented in these reports.

Telephony Report Description

Phones and 

Extensions

SCCP Phones. Displays read-only internal configuration 

information and status for SCCP phones and extensions, 

including tag, MAC address, phone type, username, 

button assignment, phone template in use, IP address, 

phone load being used, and status.

Extensions. For each extension, displays the DN tag, 

internal extension number, line type, label, username, 

COR incoming, trunk type, and channel status. If 

configured, the intercom number and intercom label are 

also displayed. Intercom numbers begin with an 

alphabetic character (for example, A502).

SIP Phones. Displays read-only internal configuration 

information and status for sip phones and extensions, 

including tag, MAC address, phone type, username, 

button assignment, COR incoming, IP address, phone 

load being used, and status.

Extensions. For each extension, displays the DN tag, 

internal extension number, line type, label and username.
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Hunt Groups Displays internal configuration information for hunt 

groups, including the tag, pilot number, type, members, 

timeout settings, and destination for No Answer Forward 

To.

Search Groups by Member. Enter an extension number 

or a series of numbers separated by a comma to find out 

to which hunt group, or groups, an extension number 

belongs.

Call Blast Groups Displays internal configuration information for hunt 

groups, including the tag, pilot number, type, members, 

timeout settings, and destination for No Answer Forward 

To.

Search Groups by Member. Enter an extension number 

or a series of numbers separated by a comma to find out 

to which call blast group or groups an extension number 

belongs.

Choose a group and click View Configuration Summary 

to display CLI summary information for the selected call 

blast group.

TFTP Server Files Displays filename information for TFTP server files 

stored on the flash. If applicable, the name of the device 

that owns the file and the filename alias are also listed.

Dial Peers Displays internal configuration information for POTS and 

VoIP dial peers configured on the system.

POTS. For POTS dial peers, the information includes the 

tag number, port, description, destination pattern, 

incoming destination, translation profile name, forward-

digits value, and trunk preference.

VoIP. For VoIP dial peers, the information includes the tag 

number, description, destination pattern, voice class, 

session target, DTMF relay, and codec.

Translation 

Profiles

Displays internal configuration information for translation 

profiles and translation rules and provides an option for 

testing translation rules.

Telephony Report Description
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SIP Trunk Status Displays output of show sip-ua commands for SIP 

service status, registration, timers, and statistics.

Phone Template For the selected IP phone template, displays internal 

template properties for softkeys and button layout.

This information is read-only; templates cannot be edited 

using Configuration Assistant.

Voicemail Status When you select a voicemail status report, Configuration 

Assistant displays a Progress dialog as the connection to 

the Voicemail system on the CUE module is opened and 

command output is collected. These text-based 

voicemail status reports are available:

System. Displays the output of show commands for 

obtaining information about clock and time zone 

statistics, privileges assigned to configured groups, 

versions of software an applications, purchased licenses 

for the system, and installed software packages.

Voicemail. Displays the output of show voicemail 

commands for obtaining information about configured 

mailboxes and current storage status, default values for 

all mailboxes, and voicemail usage statistics.

Calendar. Displays schedules and holidays configured 

for the system in text format.

Others. Displays the output of commands for obtaining 

information about currently configured applications, 

configured auto-attendant greeting prompts, script 

filenames, and currently configured trigger types.

DSP Status The DSP Status report displays detailed show command 

output for DSP hardware, DSP farm, groups, errors, and 

active/signaling voice DSP.

Software Pack The Software Pack report displays software package 

and component version information, compact flash 

usage, CUE status, and supported phone types for the 

currently installed UC500 software package.

Version information for UC500 software packages prior 

to 7.0.0 is not available.

Telephony Report Description
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Inventory

To display an inventory report for a customer site or a single device, choose 

Monitor > Inventory.

The inventory report for a customer site displays device types, serial numbers, IP 

addresses, and software releases for the site. You can also choose a single device 

for which you want to view inventory details.

The information in this window is read-only. For each device in the customer site, 

the inventory contains:

• Hostname

• Device type

• Serial number

• Hardware version number (Version ID)

• MAC address

• IP address

• Installed software revision

• System location

• System uptime (length of time that it has been operating)

If you did not assign a hostname to a switch in the site, a hostname of

switch-<number> is automatically assigned. The number shows the order in 

which the switch was added to the site.

Click Details to view details for a specific device. See Inventory Details, 

page 585.

Click Refresh to update the display.

Extension Mobility 

Status

The Extension Mobility Status report displays Extension 

Mobility Phones, Extension Mobility Status output, Phone 

Profile and Current User Profile information. This 

information is read-only; to configure these settings see 

Extension Mobility, page 324.

Telephony Report Description
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Inventory Details

This window appears when you select a device with routing capability and click 

Details in the Inventory window.

The window displays information for the device by component, description, part 

number, hardware revision, PCB (printed circuit board) serial number, and product 

number. The description gives the details of the component. The part number is 

the order number of the component.

If you know that a change has occurred and you want to see the change, click 

Refresh. Configuration Assistant re-samples the components and redisplays the 

details when components are removed or added.

Health

You can monitor a number of device health measurements to avoid downtime and 

to ensure that your network is running efficiently. The measurements tell you about 

the utilization of bandwidth, PoE (Power over Ethernet), the CPU, and memory, and 

about device temperature and the percentage of packet errors.

To check the health measurements, choose Monitor > Health from the feature bar.

In addition to the health measurements, Configuration Assistant has features that 

focus on the use of specific resources:

• For information about PoE utilization, choose Configure > Ports > Switch 

Port Settings.

• For information about bandwidth utilization over time, choose Monitor > 

Network > Bandwidth Graphs.

• For information about link utilization over time, choose Monitor > Network > 

Link Graphs.

• For more information about packet errors, choose Monitor > Network > 

Port Statistics.

Use the window to see up to five devices that have the highest measurements in 

the categories that you choose to monitor. Click the bars in the window to display 

additional.

For even more information, click Details to open the Health Details window. See 

Health Details, page 586.
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Health Details

This window appears when you click Details in the System Health window 

(Monitor > Health). For a graphical display of this information, choose Home > 

Dashboard.

When you finish with the window, click OK.

The Health Details window has these tabs:

• Overview

• Bandwidth Utilization

• Packet Errors

• PoE Utilization

• Temperature

• CPU Utilization

• Memory Utilization

Overview

The Overview tab shows the overall measurements for each of the categories that 

you monitor on all the devices in the network to which the categories apply. This 

table explains the columns on the tab.

Column Explanation

Hostname The hostname of a standalone device or the 

hostnames of the devices in your community

Bandwidth Utilization The average bandwidth used to receive and transmit 

packets as of the last polling interval

Packet Errors The overall (input and output) percentage of packets 

in error

PoE Utilization The percentage of PoE wattage in use

Temperature The temperature in Celsius

CPU Utilization The percentage of CPU utilization in the last 

5 seconds
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Bandwidth Utilization

The Bandwidth Utilization tab shows the percentage of bandwidth being used to 

receive packets, the percentage to transmit packets, and the average of the two.

You can open the Bandwidth Graphs window to see how the bandwidth of a 

device is being used over time. The Link Graphs window shows which ports have 

the most traffic.

Packet Errors

The Packet Errors tab shows the percentage of device input and output packets 

that are in error and an overall error percentage.

PoE Utilization

For devices that support PoE (Power over Ethernet), the PoE Utilization tab shows 

the percentage of PoE wattage in use, the total wattage, used wattage, and 

available wattage. If you are adding access points and IP phones to your network, 

connect them to devices that show a low PoE utilization.

Temperature

For devices that can measure temperature precisely, the Temperature tab shows 

in Celsius the current temperature, the overheating threshold, and the critical 

threshold. For other devices you see that the temperature is OK, Normal, Faulty, or 

N/A, indicating that the precise current temperature, overheating threshold, and 

critical threshold are not sensed.

CPU Utilization

The CPU Utilization tab shows, by device, the percentage of CPU capacity in use 

in the last five seconds, one minute, and five minutes.

Memory Utilization

The Memory Utilization tab shows the percentage of memory in use and the 

number of total, used, and free megabytes.

Memory Utilization The percentage of memory being used

Column Explanation
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Event Notification

The Event Notification window appears when you take any of these actions:

• Click an event icon on the status bar or in the Topology view.

• Choose Monitor > Event Notifications the feature bar.

• Click the Event Notification icon on the toolbar.

Overview

An event is a network condition or management event that the Configuration 

Assistant detects and wants you to know about. These are examples of events:

• VLAN conflicts

• UC500 license expiration

• Usage activity sent

To make you aware of an event, Configuration Assistant displays a popup 

message. It also puts a clickable event icon on the status bar and in the Topology 

view, beside the device on which the event occurred. When your mouse pointer 

touches an event icon in the Topology view, you see a summary of the event.

The appearance of the icon depends on the type of the event. Event types differ 

by number; the smaller the type number, the greater the need to take action.

If Configuration Assistant detects multiple events, you see icons for all of them in 

the Topology view. On the status bar, you see the icon for only the most urgent 

event.

The Event Notification window gives you a full description of events that were 

detected in your network. You use the window to:

• Tell the Configuration Assistant that you are aware of the event.

• Ask the Configuration Assistant to take action, if possible.

• Turn off the Alert LED on switches.

Procedures

The Events tab in the notification window is where you can view descriptions of all 

the events in your network, acknowledge your awareness of them, and use the 

Configuration Assistant to resolve them (if possible).
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To see a subset of event information, click Filter, and use the Notification Filter 

window. See Notification Filter, page 589.

Click OK when you are done with the window.

This table explains the information on the tab.

Notification Filter

This window appears when you click Filter in the Event Notification window. Use it 

to limit the types of events that appear in that window.

Follow these steps:

STEP 1 Under Types, uncheck the boxes for the event types to be filtered out. Events of 

these types do not appear in the Event Notification window.

STEP 2 Click Set Defaults if any box is unchecked and you want all the boxes to be 

checked again.

Column Explanation

Type Denotes how urgent it is to resolve the event. The lower the 

type number, the more urgent the need to resolve it.

Time The time when the event occurred.

Event 

Description

A brief description of what occurred. When you select an 

event, a longer description appears below the list of events.

Resolvable Yes - if the Configuration Assistant can resolve the event, No -

if it cannot. You ask the Configuration Assistant to resolve an 

event by highlighting it and clicking Resolve. The 

Configuration Assistant then opens a window for resolving 

the event.

Acknowledged Boxes that you check to show your awareness of events. If 

you click Acknowledge All, you acknowledge all the events 

at once. When an event is acknowledged, its event icon dims.

Device The device involved in the event.
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Click OK when you finish with the window.

System Log

The System Log report displays the output of the show log command.

System Messages

From the System Messages window you can view the messages issued by 

devices in a customer site.

To access the System Messages window, choose Monitor > System Messages 

from the feature bar.

Procedures

Follow these steps to view and filter system messages:

STEP 1 From the Hostname list, select a device whose messages you want to view, or 

select All Devices to see the messages that are issued by all the devices in the 

community.

STEP 2 Click a column heading of the table to sort the messages according to your 

interest. By default the messages are sorted by severity.

STEP 3 To see details about a particular message, select its row in the table. The message 

details appear in the area below the table.

STEP 4 Optional: Click Filter to open the System Messages Filter window, where you can 

specify the criteria for limiting the messages that appear. See System Messages 

Filter, page 591.

STEP 5 Optional: Click Save Report to save the window contents in a file in comma-

delimited format. The default filename has a time stamp to make it unique.

STEP 6 Click OK when you finish with the window.
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System Messages Filter

This window appears when you click Filter in the System Messages window. Use 

it to limit the number of messages that appear in that window.

To filter system messages, follow these steps.

STEP 1 Under Severity Levels, uncheck the boxes for the severity levels to be filtered out. 

Messages with these severity levels do not appear in the System Messages 

window.

STEP 2 Click Set Defaults if any box is unchecked and you want all the boxes to be 

checked again.

Click OK when you finish with the window.

Crash Log

The Crash Log Viewer window appears when you choose Monitor > Crash Log.

From the Crash Log Viewer window, you can download crash information files 

from the UC500 and save them to a file on your local machine in a standard text 

format. The displayed crash messages list is sorted in chronological order (sorted 

by date-time). The saved file can then be sent to Cisco Support for analysis or 

troubleshooting. After downloading the crash message files, you have the option 

to delete them from the UC500 flash.

The following fields are on the Crash Log Viewer screen:

Field Name Description

Filename Read-only. The name of the crash file.

Date Read-only. The date/time when the crash occurred.

Size Read-only. The size in bytes of the crash file.
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Multisite Status

You must be directly connected to a LAN port on the UC500 or SR520-T1 secure 

router to view multisite status.

The Multisite Status report displays the output for the show crypto session detail 

Cisco IOS command. This command lists all active Virtual Private Network (VPN) 

sessions and the IKE (Internet Key Exchange) and IPsec SAs (Security 

Associations) for each VPN session.

See Multisite Status Monitoring, page 491.
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Troubleshooting

Configuration Assistant provides several tools for troubleshooting your system:

• Circuit Diagnostics (T1 Loopback)

• Network Diagnostics

• Telephony Diagnostics

• CUE Connectivity Diagnostics

• Security Diagnostics

• Generic Debugs

• IOS Exec Commands

• CUE Exec Commands

• Generating a System Troubleshooting Log

• Links and Connectivity (CE520 Switches)

Circuit Diagnostics (T1 Loopback)

To access the T1 Loopback diagnostic tool for troubleshooting the T1 circuit, 

choose Troubleshoot > Circuit Diagnostics > T1 Loopback.

This diagnostic is only available on a UC500 with a T1 voice interface or an 

SR520-T1 router with a T1 WAN connection.

Overview

Use the T1 Loopback diagnostic to perform a local or remote loopback test on a 

T1 circuit.
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On UC500 platforms with a T1 interface, you can also perform a Bit Error-Rate Test 

(BERT). In order to initiate a BERT, the T1 connection must be up and a far-end loop 

must be present on the circuit. If it is not, BERT options are unavailable.

During normal operation, the BERT errors (last) field should remain at 0. If bit-rate 

errors are observed, contact the service provider or Telco who provides the T1 

circuit.

The BERT diagnostic is not available for SR520-T1 platforms.

Procedures

To perform a loopback diagnostic, follow these steps.

STEP 1 Select a host from the Hostname list.

STEP 2 Choose the T1 interface. In most cases, only one interface is listed.

STEP 3 Choose a Loopback Type from the drop-down list.

Available loopback types vary, depending on whether you are running the 

diagnostic on a UC500 platform or an SR520-T1 secure router and whether or not 

an FDL (Facilities Data Link) type is set.

On the UC500, these Loopback types are available:

• Diag

• Local Line

• Local Payload

• Remote IBOC

• Remote ESF Line (if the FDL Type is set to ansi, att, or both)

• Remote ESF Payload (if the FDL Type is set to ansi, att, or both)

On the SR520-T1, these loopback types are supported:

• Local

• Remote

• Payload

STEP 4 Optionally, choose an FDL Type. Available types are ansi (ANSI T1.403), att (AT&T 

TR54016), both, or none set.
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The FDL Type setting enables additional remote loop testing capabilities by 

sending out-of-band signaling information between sites connected over a T1 

circuit.

STEP 5 Click Loop Up create the loopback on the circuit.

The Summary message displayed above the output window indicates the loop 

status (looped at the local end, looped at the remote end, or no loop detected).

You can click Clear Counters to zero out and reset the test counters.

STEP 6 To initiate a BERT, while the loop is up, follow these steps.

a. Choose a Pattern. Available options are All 0’s, All 1’s, 2^11-1, Alternating 0’s 

and 1’s, 2^20 QRSS, 0.151, and 2^15-1 QRW.

b. Set the test interval, from 1 to 14400 minutes.

c. Click Start BERT Test.

d. Click Abort Current BERT Test to stop the test.

Click Refresh to refresh interface and BERT test data.

BERT data, when present, is always displayed at the top of the output window. 

BERT data remains in the output window until you click Clear Counters.

STEP 7 Click Loop Down to remove the loop.

If the loop is still up when you close this window, you are prompted to remove any 

existing loops. You should remove the loops unless you need to leave the loop 

active for extended testing.

Network Diagnostics

Configuration Assistant provides several diagnostic tools:

• Ping

• Trace

• DHCP Bindings

• System Status

• WAN Debug Log (SR520-T1)
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Ping

To access the Ping diagnostic, choose Troubleshoot > Network Diagnostics > 

Ping from the feature bar.

The ping diagnostic is a very common method for troubleshooting the 

accessibility of devices.

Overview

It uses a series of Internet Control Message Protocol (ICMP) echo messages to 

determine: 

• Whether a remote host is active or inactive

• The round-trip delay in communicating with the host

• Packet loss

The ping diagnostic first sends an echo request packet to an address, then waits 

for a reply. The ping is successful only if: 

• The echo request gets to the destination, and

• The destination is able to get an echo reply back to the source within a 

predetermined time (called a timeout). The default value of this timeout is 

two seconds on Cisco routers.

Procedures

To run a ping test, follow these steps.

STEP 1 Choose a source interface (either the default WAN interface, or an internal 

interface/IP address).

To test site-to-site VPN connectivity, choose an internal interface such as VLAN1.

STEP 2 Enter a destination IP address or hostname.

STEP 3 Click Go.

The output of the ping command indicates whether the test was successful 

(> 50% packets transmitted) and the average, minimum, and maximum round trip 

times.
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Trace

To access the Trace diagnostic, choose Troubleshoot > Network Diagnostics > 

Trace from the feature bar.

Overview

The trace diagnostic (based on the Cisco IOS traceroute command) allows you to 

determine the path a packet takes in order to get to a destination from a given 

source by returning the sequence of hops the packet has traversed.

The trace terminates when the:

• Destination responds

• Maximum TTL (time-to-live) count is exceeded

• Maximum number of hops (30) is reached

• Trace is cancelled

The results of the trace are displayed in a table. The output for each hop displays 

the hop counter, the IP address and hostname associated with that hop, and the 

average latency in milliseconds.

Procedures

To run the trace diagnostic:

STEP 1 Enter the destination hostname or IP address.

STEP 2 Click Go.

DHCP Bindings

To access DHCP diagnostics, choose Troubleshoot > Network Diagnostics > 

DHCP Bindings from the feature bar.

The DHCP Bindings diagnostic displays the dynamically assigned IP addresses on 

the system.

Manual bindings cannot be cleared. You can only clear automatic bindings.

The output displays the IP address, hardware address (MAC address), and lease 

expiration date/time.
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Procedures

STEP 1 Choose one of these options:

• Click Release Selected Binding to clear the selected DHCP binding.

• Click Release All Bindings to clear all DHCP bindings.

• Click Read Bindings to refresh the list.

STEP 2 Click OK to close the window.

System Status 

To view system status, choose Troubleshoot > Network Diagnostics > System 

Status from the feature bar. This information can also be viewed in the System 

Status window on the Dashboard (Home > Dashboard).

The System Status window displays this information for managed devices at the 

customer site:

• Hostname

• Device type

• WAN IP address

• Subnet mask

• Gateway

• DNS server IP addresses

• Cisco IOS version

• Uptime (time elapsed since last system reset)

• Timestamp of last update

WAN Debug Log (SR520-T1)

The WAN Debug Log window appears when an SR520-T1 secure router is 

present in the customer site and you choose Troubleshoot > Network 

Diagnostics > WAN Debug Log from the feature bar.
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Overview

The WAN Debug Log feature enables you to capture Cisco IOS debug information 

while troubleshooting a T1 WAN connection issue for the SR520-T1 Secure Router. 

You can also use this tool to gather SR520-T1 WAN configuration and connection 

status data. The information is collected in text log files and bundled into a .zip 

archive file. The Cisco IOS debug facility and show commands are used to gather 

the information.

!
CAUTION Enabling collection of WAN debug information is resource-intensive and can 

significantly degrade performance; therefore, only enable WAN debugging for 

short periods of time and avoid peak usage periods, if possible. 

For this reason, all WAN debugging is disabled when you close the WAN Debug Log 

window or close Configuration Assistant. If Configuration Assistant closes 

unexpectedly, WAN debugging is disabled the next time Configuration Assistant is 

launched.

Procedures

To generate a log of show command output only: 

STEP 1 In the WAN Debug Log window, click Browse and choose a log file directory.

STEP 2 Click Generate Troubleshooting Log.

You do not have to choose any WAN debug options or enable debugging.

A text log file is created in the specified directory; no zip file is created. This log 

includes the output of WAN debug-related show commands. A progress bar 

displays while the log is generated.

STEP 3 Click OK to close the window when the log is generated.

To enable debug, and collect both show command output and WAN debug data, 

follow these steps.

STEP 1 In the WAN Debug log window, click Browse and choose a log file directory.

STEP 2 Check the T1 checkbox to collect T1 WAN debug information.

STEP 3 Click Apply Debug to enable debugging.
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STEP 4 Reproduce the issue on your network.

STEP 5 Click Generate Troubleshooting Log.

A .zip file is created in the specified log file directory. This log includes the output 

of WAN debug-related show commands and all of the WAN debug data. A 

progress bar displays while the log is generated.

STEP 6 Click OK to close the window when the log is generated.

STEP 7 Turn off (uncheck) all WAN debugging and click OK to close the window.

All WAN debugging is disabled automatically when you close the window.

Telephony Diagnostics

Configuration Assistant provides these voice diagnostic tools:

• Dialplan Test

• Voice Debug Log

• Phone Debug Log

• SIP Trunk Diagnostics

• PCM Capture

• SCCP Analog Phones

Dialplan Test

To access dial plan test diagnostics, choose Troubleshoot > Telephony 

Diagnostics > Dialplan Test from the feature bar.

Use the Dialplan Test diagnostic tool to view how the dial plan routes inbound and 

outbound calls to and from the specified port or extension on the system. You can 

perform two types of dial plan tests:

• Outbound Dial Plan Test

• Inbound Dial Plan Test

NOTE: Dial plan tests do not involve active calls.
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Outbound Dial Plan Test

The outbound dial plan test shows how outbound calls are handled by the 

outgoing dial plan.

The test checks the permissions for the source extension (user or shared line), the 

destination number translations, and the possible routes (the outgoing interfaces 

on the router) for the call.

Given a user extension and a destination number, the voice configuration on the 

router is examined and the following call data is displayed: 

• Whether the call is allowed

• The actual number forwarded to destination

• All potential interfaces, along with their preference

• The outgoing interfaces shown in the test output include SIP trunks, if any 

are configured

• For an SIP trunk, the SIP server IP is displayed

To perform an outbound dial plan test, follow these steps.

STEP 1 Click the Outbound tab in the Dial Plan Test window.

STEP 2 Choose a User/Shared Extension from the drop-down list.

STEP 3 Enter the destination number for the outbound call.

The destination number can be an internal extension number or an external 

number (local, long distance, or international). It can contain up to 20 digits.

For external numbers, the number specified must include all necessary access 

codes such as the PSTN access code for external calls, long distance access 

code, area code, country code (for example 011) or international dialing code.

STEP 4 Click Get Dial Plan Details.
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Inbound Dial Plan Test

For incoming calls, given an analog FXO port or a DID number, the inbound dial 

plan test shows how the call is routed and basic information about the destination 

extension.

The output indicates whether a matching destination was found and displays the 

destination extension number and extension type (for example, user, analog 

phone).

To perform an inbound dial plan test, follow these steps.

STEP 1 Click the Inbound tab in the Dialplan Test window.

STEP 2 Select Analog FXO Port or enter a DID Number for the incoming call.The DID 

number is typically an E.164 format number, for example, 16905552222.

STEP 3 Click Find Destination.

Voice Debug Log

The Voice Troubleshooting log feature enables you to capture Cisco IOS debug 

information while troubleshooting a specific scenario or issue. You can also use 

this tool to gather voice-related device configuration data and voice state data. 

The information is collected in text log files and bundled into a .zip archive file.

Overview

The IOS debug facility and show commands are used to gather the information. 

You can specify one or more of these types of voice debug data to collect: 

• Dial plan

• Voice ports

• IP phones (SCCP)

• VoIP (SIP)

• VoIP (H323)
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!
CAUTION Enabling collection of voice debug information is resource-intensive and can 

significantly degrade performance. Only enable voice debugging for short periods 

of time and avoid peak usage periods, if possible. 

For this reason, all voice debugging is disabled when you close the Voice 

Troubleshooting Log window. If Configuration Assistant closes unexpectedly, voice 

debugging is disabled the next time Configuration Assistant is launched.

Procedures

To generate a log of show command output only: 

STEP 1 In the Voice Troubleshooting Log window, click Browse and choose a log file 

directory.

STEP 2 Click Generate Troubleshooting Log.

You do not have to choose any voice debug options or enable debugging.

A text log file is created in the specified directory; no zip file is created. This log 

includes the output of voice-related show commands. A progress bar displays 

while the log is generated.

STEP 3 Click OK to close the window when the log as been generated.

To enable debug, and collect both show command output and voice debug data: 

STEP 1 In the Voice Troubleshooting log window, click Browse and choose a log file 

directory.

STEP 2 Select one or more types of voice debug data to collect.

STEP 3 Click Apply Debug to begin generating debug information.

STEP 4 Reproduce the issue on your network.

STEP 5 Click Generate Troubleshooting Log.

A .zip file is created in the specified log file directory. This log includes the output 

of voice-related show commands and all of the voice debug data. A progress bar 

displays while the log is generated.

STEP 6 Click OK to close the window when the log is generated.
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STEP 7 Turn off (uncheck) all voice debugging and click OK to close the window.

All voice debugging is disabled automatically when you close the window.

Phone Debug Log

The Phone Debug Log window appears when you choose Troubleshoot > 

Telephony Diagnostics > Phone Debug Log.

Overview

The Phone Debug log feature enables you to capture Cisco IOS debug information 

while troubleshooting a scenario or issue on a specific phone or group of phones.

You can also use this tool to gather voice-related device configuration data and 

voice state data for the selected phone or phones. The information is collected in 

text log files and bundled into a .zip archive file.

!
CAUTION The Cisco IOS debug facility and show commands are used to gather the 

information. Enabling collection of phone debug information is resource-intensive 

and can significantly degrade performance. Only enable phone debugging for 

short periods of time and avoid peak usage periods, if possible. 

For this reason, all phone debugging is disabled when you close the Phone Debug 

Log window. If Configuration Assistant closes unexpectedly, voice debugging is 

disabled the next time Configuration Assistant is launched.
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Procedures

To generate a log of show command output only: 

STEP 1 In the Phone Debug Log window, click Browse and choose a directory for the log 

file.

STEP 2 Click Generate Troubleshooting Log.

You do not have to choose any phones or enable debugging.

A text log file is created in the specified directory; no zip file is created. This log 

includes the output of voice-related show commands. A progress bar displays 

while the log is generated.

STEP 3 Click OK to close the window when the log as been generated.

To enable debug, and collect both show command output and voice debug data: 

STEP 1 In the Phone Debug Log window, check the Enable option for each phone you 

wish to include in the debug log.

STEP 2 Click Browse and choose a log file directory.

STEP 3 Select one or more types of voice debug data to collect.

STEP 4 Click Apply Debug to begin generating debug information.

STEP 5 Reproduce the issue on your network.

STEP 6 Click Generate Troubleshooting Log.

A .zip file is created in the specified log file directory. This log includes the output 

of voice-related show commands and all of the voice debug data. A progress bar 

displays while the log is generated.

STEP 7 After the log is generated, turn off (uncheck) debugging for all phones and click OK 

to close the window.

All phone debugging is disabled automatically when you close the window.
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SIP Trunk Diagnostics

The SIP Trunk Registration window displays Toll Fraud Protection status, SIP 

registration information and provides diagnostic tools for troubleshooting SIP trunk 

registration problems. When SIP trunk registration fails, the voice system is down 

and users are not able make and/or receive calls over the trunk. To access this 

window, choose Troubleshoot > Telephony Diagnostics > SIP Trunk 

Diagnostics.

For more information, see these topics:

• SIP Trunk Toll Fraud Protection

• SIP Registration Information

• SIP Trunk Diagnostics (Check Status, Rebuild Lists, Ping Registrar, 

Reset Registrar)

SIP Trunk Toll Fraud Protection

Introduction

CCA has implemented a number of measures to mitigate the threat of toll fraud by 

both internal and external parties when SIP Trunk is being used.

Internal parities include IP Phone users that reside within the UC500 system.  

External parties include users on foreign systems that may try to host the UC500 

system to make fraudulent calls and have to those calls charged back to the 

customer's UC500 system.

CCA SIP Trunk enables Toll Fraud Protection by default.  This is the recommended 

setting and assumes that the SIP Service Provider is able and willing to provide all 

IP addresses or DNS names in use on their network.  Additionally, a reachable DNS 

Server must be configured to resolve any DNS names used.

DISCLAIMER: Even when Toll Protection is enabled as recommended, it is not 

guaranteed that toll fraud or abuse by both internal and external parties will not 

occur.

SIP Trunk Toll Fraud Protection Measures

1. Firewall on the WAN Interface.

Prevent call from being relayed illegally over the PSTN.  CCA SIP trunk 

automatically adds all servers and additional IP addresses defined in the SIP Trunk 

UI to the access list for the Firewall on the WAN Interface if that Firewall on the 

WAN Interface has been enabled.
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2. Inbound Calls to Known Numbers Only

CCA SIP Trunk configuration only allows calls to a specific incoming DID number 

range, as defined under Incoming Dial Plans.   Calls to all other DID numbers are 

terminated or blocked by SIP Trunk configuration.  Note that this does not impact 

calls forwards or transfers as the initial call is still targeted to a known number.

3. Voice Source Group

Prevent calls from being relayed illegally over the VoIP network. All IP addresses 

need by internal VoIP network (includes both H323 and SIP protocols) are 

detected and added to the internal access list for the CCA Voice Source Group.  

Additionally, all IP addresses servers and additional IP addresses defined in the 

SIP Trunk UI are added to the external access list for the CCA Voice Source Group.   

The CCA Voice Source Group additionally manipulates incoming numbers so that 

they are undialable until the source IP address from the call setup request has 

been verified by these lists.

This solution has been in place in CCA for many releases of the UC500 Software 

package.  With most recent UC500 Software packages, a similar solution was 

added and enabled by default.  This solution relies on known list of IP addresses, 

including those configured on the Voice Service IP Authentication Trusted List.  

When CCA SIP Trunk is enabled, this feature is bypassed so that the Voice Source 

Group continues to be used.

SIP Trunk Diagnostics

The status of Toll Fraud Protection measures may be checked using the CCA 

utilities found in Troubleshoot > Telephony Diagnostics > SIP Trunk Diagnostics. 

The "Check Status" utility produces output, and at times recommendations, that 

may be used to determine whether the "Rebuild Lists" utility should be used.  

Especially in cases where DNS names have been previously configured, the 

"Rebuild Lists" utility may address cases when DNS names entered in SIP Trunk UI 

now resolve to IP addresses different from the IP addresses they resolved to 

when initially configured.

SIP Registration Information

The following SIP registration information is displayed:

• Whether or not the SIP trunk is enabled

• Name of the SIP trunk provider configured in the SIP Trunk window. This can 

be one of the CCA-supported providers or the generic SIP trunk provider.
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• SIP registration model used for the selected SIP trunk provider. The 

registration model can be one of the following:

- The service provider registers the main number for the Outgoing Caller 

ID.

- The service provider registers all DIDs using the same username and 

password.

- The service provider registers DIDs using different usernames and 

passwords. User credentials for each DID are entered under Configure 

> Telephony > Ports and Trunks > SIP Trunk.

- The service provider does not register DIDs (registration is not required).

• IP address or hostname of the SIP registrar server, if configured in the SIP 

Trunk window.

• IP address or hostname of the outbound SIP proxy server, if configured in 

the SIP Trunk window.

SIP Trunk Diagnostics 
(Check Status, Rebuild Lists, Ping Registrar, Reset Registrar)

These SIP Trunk Registration diagnostics are provided.

SIP Trunk 

Registration

Description

Devices

Hostname Select the desired Hostname from the pull down menu.

Details Read only. Displays the values that are used to configure the 

system to support the trunk provider. This may include 

values such as Template, Voice Codec, DTMF Method, RTP 

Payload, Fax Protocol, DID registration, Transcoding 

Requirement status.

Toll Fraud Protection

Check Status Click to verify toll fraud protection status.

Rebuild Lists Click to rebuild the access lists based on current data.

Registration
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PCM Capture

The PCM Capture window appears when you choose Troubleshoot > Telephony 

Diagnostics > PCM Capture.

Ping Registrar Click Ping Registrar to check connectivity with the SIP 

Registrar server that is configured in the SIP Trunk Window.

Depending on the output returned by the ping test, this could 

indicate DNS hostname resolution failure, problems with 

network settings, firewall or ACL issues preventing traffic 

from reaching the server, or an unreachable host.

Reset Registrar When you click Reset Registrar, the following actions are 

taken:

• CCA reconfigures and resets the SIP registrar server. 

When the registrar server is reset, the timers and retry 

counters for the SIP User Agent in Cisco Unified CME 

are reset. This also allows SIP registration to be 

restarted without resetting the UC500.

• If a domain name is specified for the SIP registrar 

server, CCA reconfigures the internal voice source 

group and ACLs for the CBAC firewall on the UC500. 

This can resolve problems that occur if the IP address 

for the registrar server that is added to the ACLs at 

the time of configuration is different than the IP 

address of the registrar server at the time of 

registration.

After you reset the registrar server and allow time for 

registration with the service provider, you can check SIP 

registration status by going to the SIP Trunk Status window 

(Monitor > Telephony > SIP Trunk Status). The registered 

status in the SIP Register panel of the window should 

display “yes” if the SIP trunk has registered successfully.

The SIP trunk attempts to register immediately. However, 

depending on the provider, it may take several hours for 

calls to start going through again after the SIP trunk has 

successfully registered.

SIP Trunk 

Registration

Description
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From this window, you can troubleshoot voice quality or audio issues by 

generating a PCM (pulse code modulation) capture for a specific voice port, as 

instructed by Cisco support.

Follow these steps to reproduce the problem call scenario.

STEP 1 Make sure that there is enough room on the UC500 flash to create the PCM 

capture. To do this, choose Home > Dashboard and look at the Flash Usage 

window.

STEP 2 Try to reproduce the problem call scenario.

STEP 3 When you have the call set up, examine the output in the Active Call Table and 

Voice Port Call Status Summary panels to determine the voice port for the PCM 

capture, as directed by Cisco Support.

The Active Call Table displays the output of the show call active voice brief 

command, and the Voice Port Call Status Summary displays the output of the 

show voice call sum command.

For example, if the output in the Active Call Table displays the following for the call 

set up between extension 201 and extension 209 and extension 201 is 

experiencing the problem, then voice port 50/0/10 would be used for the PCM 

capture.

1227 : 26 1118849120ms.1 +2710 pid:20006 Answer 201 active
dur 00:00:06 tx:131/31280 rx:130/31200
Tele 50/0/10 (26) [50/0/10.0] tx:2620/2620/0ms g711ulaw
noise:0 acom:0 i/0:0/0 dBm

1227 : 27 1118849600ms.1 +2220 pid:20034 Originate 209 active
dur 00:00:06 tx:130/31200 rx:130/31200
Tele 50/0/18 (27) [50/0/18.0] tx:2600/2600/0ms g711ulaw
noise:0 acom:0 i/0:0/0 dBm

STEP 4 In the Voice Port field, enter the port identifier that you want to perform the 

capture on (for example, 50/0/10.

STEP 5 Click Begin.

When you click Begin:

• CCA issues these commands to set the capture buffer and specify the 

destination file for the capture (the file pcm.dat on the UC500 flash).

voice hpi capture buffer 5000000
voice hpi capture destination flash:pcm.dat
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• The system begins writing PCM data to the file pcm.dat on the UC500 flash.

STEP 6 When you are ready to stop the capture, click End and Save.

STEP 7 Save the pcm.dat capture file.

After you save the file, it is removed from the flash. The size of the capture file 

varies, depending on the actions performed on the call.

SCCP Analog Phones

The SCCP Analog Phone window appears when you choose Troubleshoot > 

Telephony Diagnostics > SCCP Analog Phones.

Feature access codes enable users of SCCP-controlled analog phones to be able 

to access certain phone features by dialing codes (for example, **1 to set Call 

Forward All on the phone). 

When the UC500 device is in factory default configuration, the voice initialization 

process removes the stcapp feature access-code command.

From this window you can enable or disable stcapp feature-access codes.

• When Enable stcapp feature access codes is unchecked, feature access 

codes are configured through the fac commands under telephony-
service only. This is the recommended setting.

• When Enable stcapp feature access codes is checked, the stcapp 
feature access-codes command is configured in addition to the fac 

commands under telephony-service. However, enabling this setting results 

in conflicts among feature codes, since codes 5, 6, 7, and 8 are configured 

differently by these commands. The output of the following show 

commands illustrates the conflict.

UC_540# show stcapp feature codes

stcapp feature access-code
malicious call ID (MCID) ***
prefix **
call forward all **1
call forward cancel **2
pickup local group **3
pickup different group **4
meetme-conference **5



Troubleshooting
CUE Connectivity Diagnostics

612 Cisco Configuration Assistant SBCS System Administrator Guide

21

pickup direct **6
forward-to-voicemail **7
cancel call waiting **8

UC540# sh telephony-service fac

telephony-service fac standard
callfwd all **1
callfwd cancel **2
pickup local **3
pickup group **4
pickup direct **5
park **6
dnd **7
redial **8

CUE Connectivity Diagnostics

The CUE Diagnostics window appears when you choose Troubleshoot > CUE 

Diagnostics > CUE Connectivity Diagnostics.

Before you run CUE diagnostics:

• Make sure that Telnet is enabled on the UC500. When using CCA, Telnet is 

always enabled.

• A firewall running on your PC can potentially block the connection between 

the CUE module on the UC500 and Configuration Assistant. You may need 

to temporarily disable the firewall or configure the firewall to permit access 

to the CUE module while performing CUE diagnostics.

The CUE Connectivity Diagnostics window provides tools for troubleshooting and 

diagnosing problems related to the CUE module on the UC500. The Cisco Unity 

Express (CUE) voice mail system and UC500 applications such as TimecardView 

reside on the CUE module on the UC500.

From this window, you can:

• Check connectivity between the PC running CCA and the CUE module and 

view the output of CUE exec mode commands in a console window.

• Execute one or more of the following Recovery Tasks to put the module in a 

known state to resolve CUE issues (for example, continuous reboot or 

software upgrade failures):
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- Reload CUE

- Change to boot loader mode

- Boot CUE from image on UC500 flash

• Generate a CUE logs to troubleshoot low-level problems on the CUE 

module.

To learn more about CUE diagnostic options, see these sections:

• Checking Status, page 613

• Generating Logs, page 613

• Performing Recovery Tasks, page 614

Checking Status

When you click Check Status, CCA attempts to open a Telnet connection to the 

CUE module to check the general health of the module. Depending on the CUE 

module status, different output is displayed:

• If CUE is booting when this button is clicked, boot progress output is shown 

in the console.

• If CUE is up and in exec mode, the show tech-support command is issued 

and the output is shown in the console.

• If the CUE is in boot loader mode, the show config command is issued and 

the output, which includes config parameters, is shown in the console.

• If the CUE session cannot be established, the appropriate error message is 

displayed in the console.

Generating Logs

The Generate Logs button is only enabled if CUE is up and is in exec or config 

mode.

When you click Generate Logs, CCA gathers debug information from the CUE 

module and creates a .zip archive containing all of the generated log files. These 

logs are collected:

• install.log

• syslog.log

• atrace_save.log

• debug_server.log
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• sshd.log

• postgres.log

• klog.log

• messages.log

• shutdown_installer.log

You are prompted to specify a default log directory for the .zip file.

Performing Recovery Tasks

Choose a recovery tasks and click OK.

!
CAUTION You should only perform Recovery Tasks on the CUE module if instructed to by 

Cisco Support to address a specific issue. 

A CUE reload can take from 10 to 15 minutes. 

When performing CUE recovery tasks, voice mail, Auto Attendant, and telephony 

applications such as Cisco WebEx PhoneConnect and TimeCardView are 

unavailable.

Recovery Task Description

Reload CUE The CUE interface is reset and progress is 

shown as the CUE is booting up in the 

console.

Put CUE in Bootloader This option attempts to put CUE in boot 

loader mode. This is useful for putting CUE 

into a known state so that you can examine 

the boot configuration and then attempt to 

boot CUE from the image in the CUE flash.

Boot CUE form Image on Flash This option is only available if CUE is in boot 

loader mode. The image on the CUE flash is 

used to boot CUE, and progress is shown in 

the console.
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Security Diagnostics

Cisco Configuration Assistant provides these security diagnostic tools:

• Firewall/NAT Debug Log

• VPN Debug Log

Firewall/NAT Debug Log

The Firewall/NAT Debug Log window appears when you choose Troubleshoot > 

Security Diagnostics > Firewall/NAT Debug Log.

Overview

The Firewall/NAT Debug Log feature enables you to capture Cisco IOS debug 

information while troubleshooting a security scenario or issue for the UC500 

platform and SR500 Series secure routers. You can also use this tool to gather 

firewall and NAT (network address translation) configuration and status data. The 

information is collected in text log files and bundled into a .zip archive file. 

The Cisco IOS debug facility and show commands are used to gather the 

information. You can specify one or more of these types of security-related debug 

data to collect: 

• NAT

• Firewall

• URL filtering

!
CAUTION Enabling collection of security debug information is resource-intensive and can 

significantly degrade performance. Only enable security debugging for short 

periods of time and avoid peak usage periods, if possible. 

For this reason, all security debugging is disabled when you close the Firewall/NAT 

Debug Log window or close Configuration Assistant. If Configuration Assistant 

closes unexpectedly, all debugging is disabled the next time Configuration 

Assistant is launched.
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Procedures

To generate a log of show command output only: 

STEP 1 In the Firewall/NAT Debug Log window, click Browse and choose a log file 

directory.

STEP 2 Click Generate Troubleshooting Log. 

You do not have to choose any firewall or NAT debug options or enable 

debugging.

A text log file is created in the specified directory; no zip file is created. This log 

includes the output of firewall and NAT-related show commands. A progress bar 

displays while the log is generated.

STEP 3 Click OK to close the window when the log is generated.

To enable debug, and collect both show command output and security debug 

data: 

STEP 1 In the Firewall/NAT Debug log window, click Browse and choose a log file 

directory.

STEP 2 Select the type of security debug data to collect.

STEP 3 Click Apply Debug to begin generating debug information.

STEP 4 Reproduce the issue on your network.

STEP 5 Click Generate Troubleshooting Log.

A .zip file is created in the specified log file directory. This log includes the output 

of firewall and NAT-related show commands and all of the security debug data. A 

progress bar displays while the log is generated.

STEP 6 Click OK to close the window when the log is generated.

STEP 7 Turn off (uncheck) all firewall and NAT debugging and click OK to close the 

window.

All firewall and NAT debugging is disabled automatically when you close the 

window.
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VPN Debug Log

The VPN Debug Log window appears when you choose Troubleshoot > Security 

Diagnostics > VPN Debug Log.

Overview

The VPN Debug Log feature enables you to capture Cisco IOS debug information 

while troubleshooting a VPN issue for the UC500 platform and SR500 Series 

secure routers. You can also use this tool to gather VPN configuration and status 

data. The information is collected in text log files and bundled into a .zip archive 

file.

The IOS debug facility and show commands are used to gather the information. 

You can specify one or more of these types of VPN-related debug data to collect:

• EZVPN

• Site-to-site VPN (IPsec)

• SSL VPN (CLientless)

• SSL VPN (Full Tunnel)

If SSL VPN (Full Tunnel) is selected, choose an ACL, then enter a Web VPN 

user name. The ACLs listed are the ones that are configured on the router.

!
CAUTION Enabling collection of VPN debug information is resource-intensive and can 

significantly degrade performance. Only enable VPN debugging for short periods 

of time and avoid peak usage periods, if possible. 

All VPN debugging is disabled when you close the VPN Debug Log window or 

close Configuration Assistant. If Configuration Assistant closes unexpectedly, VPN 

debugging is disabled the next time Configuration Assistant is launched.

Procedures

To generate a log of show command output only: 

STEP 1 In the VPN Debug Log window, click Browse and choose a log file directory.

STEP 2 Click Generate Troubleshooting Log. You do not have to choose any VPN debug 

options or enable debugging.
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A text log file is created in the specified directory; no zip file is created. This log 

includes the output of firewall and NAT-related show commands. A progress bar 

displays while the log is generated.

STEP 3 Click OK to close the window when the log is generated.

To enable debug, and collect both show command output and VPN debug data:

STEP 1 In the VPN Debug log window, click Browse and choose a log file directory.Select 

the type of VPN debug data to collect.

• EZVPN

• Site-to-site VPN (IPsec)

• SSL VPN (Clientless)

• SSL VPN (Full Tunnel). Choose an ACL (access list) from the drop-down 

menu or enter a Web VPN user name. 

STEP 2 Click Apply Debug to begin generating debug information.

STEP 3 Reproduce the issue on your network.

STEP 4 Click Generate Troubleshooting Log.

A .zip file is created in the specified log file directory. This log includes the output 

of VPN-related show commands and all of the security debug data. A progress bar 

displays while the log is generated.

STEP 5 Click OK to close the window when the log is generated.

STEP 6 Turn off (uncheck) all VPN debugging and click OK to close the window. All VPN 

debugging is disabled automatically when you close the window.
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Generic Debugs

The Generic Debugs window appears when you choose Troubleshoot > Generic 

Debugs from the feature bar.

For information about how to view additional command-based diagnostic 

information, see IOS Exec Commands, page 620 and CUE Exec Commands, 

page 620.

Overview

From the Generic Debugs window, you can: enter one or more Cisco IOS debug 

commands, one per line, to execute on the device. When the debug data is 

collected, you can view the debug output in your default text editor and save it to a 

file or search the output for specific information.

Certain resource-intensive debug commands are excluded from this window. 

Configuration Assistant displays a message if you enter any of these commands 

or if the command you enter is invalid.

The output is stored in a 5 MB ring buffer. When the amount of data exceeds 5 MB, 

the oldest data is overwritten with the newest data.

To collect generic debug information:

STEP 1 Enter IOS debug commands to execute on the device, one per line.

STEP 2 Click Begin to begin collecting information.

STEP 3 Reproduce the scenario or issue in the network.

STEP 4 Click End to stop collecting debug data.

STEP 5 After you have collected the data, you can:

• Click Search to search debug output in the output area of the window. The 

command window displays only the output of each command; it does not 

echo the commands as they are executed.

• Click Save and Show Debug Output to view collected debug output in your 

default text editor and save it to a file.

• Click Clear List to reset the debug command list and enter different 

commands or enter commands in a different order.
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STEP 6 Click OK to close the window. All debugging is disabled when you close the 

window. If Configuration Assistant closes unexpectedly, all debugging is disabled 

the next time Configuration Assistant is launched.

IOS Exec Commands

To view output of IOS exec mode commands, choose Troubleshoot > IOS Exec 

Commands.

From the IOS Exec Command window, you can simultaneously display the output 

of up to four Cisco IOS exec mode commands. The commands can be selected 

from a list or entered manually.

• To display output for a single command, choose a Cisco IOS exec command 

from the list or manually enter the command, and click Run.

• To display output for multiple commands, choose the number of panels to 

display (1, 2, or 4). Enter or select each command and click Run to display 

the output in a new panel. If all panels are in use, the output for the next 

command that you run overwrites the output for the oldest command.

• Click Clear Panels to clear all open panels.

• Click Refresh to update the information displayed in each panel.

• To find text, listed within the opened panel(s), enter the desired text in the 

search field and click Search. Matching text will be highlighted for each 

opened panel.

• To save the display output data of the opened panel click Save a Copy. On 

the proceeding window enter the desired file name, select the desired 

destination folder on your PC, then click Save.

CUE Exec Commands

To view output of CUE exec mode commands, choose Troubleshoot > CUE Exec 

Commands.
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From the CUE Exec Command window, you can simultaneously display the output 

of up to four CUE exec mode commands. The commands can be selected from a 

list or entered manually.

• To display output for a single command, manually enter the command and 

click Run.

• To display output for multiple CUE exec mode commands, choose the 

number of panels to display (1, 2, or 4). Enter each command and click Run 

to display the output a new panel. If all panels are in use, the output for the 

next command that you run overwrites the output for the oldest command.

• Click Clear Panels to clear all open panels.

• Click Refresh to update the information displayed in each panel.

Generating a System Troubleshooting Log

Perform these steps to collect troubleshooting information from within 

Configuration Assistant to assist the Cisco TAC in helping to resolve issues.

You can select either a UC500 or an SR500 as the device, if a customer site is 

configured.

STEP 1 From within CCA, select Help > Support Information from the menu at the top of 

the main window.

STEP 2 In the Support Information window, click Troubleshooting Log.

STEP 3 Click Browse and choose any folder on your PC for the log file directory.

STEP 4 In the Hostname field, select the UC500 or SR500 device in the community.

STEP 5 Click Generate Log.

Configuration Assistant collects the required log and configuration files required 

for troubleshooting.

This process can take up to 5 minutes. The log file is created in the folder 

specified in step 3.

STEP 6 Attach this log file to your Cisco Technical Assistance Center (TAC) case for 

technical support.
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The log filename and format is UC5x0_MAC address_Date_Time_tac_logs.zip.

Links and Connectivity (CE520 Switches)

To test the links or connectivity problems in a system with a CE520 switch, choose 

Links and Connectivity from the feature bar.

Overview

From the Links and Connectivity window, you can discover these types of issues 

in your network:

• No connectivity between a source device and a destination device.

• No cable or a faulty cable connected to the port.

• Mismatch in the port speed settings on a link.

• Network connectivity issues between two devices in the network, for 

example, a host and a server.

NOTE The connectivity test is only supported on copper Ethernet 10/100/1000 ports.

Procedures

To test a link, follow these steps.

STEP 1 Select Link (Service Disruptive) from the Test Type list.

STEP 2 Select a hostname from the Hostname list.

STEP 3 Select an interface from the Interface list, or click the icon beside the Interface 

field, and select an interface on the device that is displayed.

STEP 4 Click Start to start the test.

If there are any errors on the link, the error message description and the 

recommendation appear in the Results area. If there are no errors, a message 

stating that there are no errors is displayed.
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To resolve a link problem, click the Fix It button. You can only fix a speed mismatch 

problem by using Configuration Assistant.

To test the network connectivity between two devices, you must provide the 

source IP address of one device and the destination IP address of the other 

device. The test results show whether there is connectivity between the devices.

To test the network connectivity between two devices:

STEP 1 Select Connectivity from the Test Type list.

STEP 2 In the Source IP address field, enter the source IP address of one of the devices.

STEP 3 In the Destination IP address field, enter the destination IP address of the other 

device.

Click Start to start the test. The message description and the recommendation 

appear in the Results area.
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SIP Phones

Two types of SIP Phones are supported:

• SIP Phones CP-8961, CP-9951, and CP-9971.

• CiscoMobile-iOS clients on the Apple iPhone (Cisco Jabber).

Features supported by SIP Phones are:

• Call Blast Group

• AA

• Dial-by-name

• Voicemail

Limitations

The following limitations apply to Cisco Jabber:

• Cisco Jabber application acts as a standalone phone and  cannot be paired 

with a desk phone.

The following limitations apply to SIP Phones:

• SIP phones on UC500 are not supported across H323 trunks. CCA multisite 

manager uses H323 trunks and hence SIP phones are not supported across 

Multisite.

• SIP phones are not supported in teleworker mode or at a remote site.

• SIP phone will not auto-register. It must be added via the user and phone 

Add button. In addition, the MAC address of the phone must be entered 

manually.

Users and Extensions

This section explains how to configure settings for users, phones, and extensions 

that are listed under the Configure > Telephony > Users and Extensions on the 

feature bar.
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These topics are covered:

• Users and Phones - (SIP Phones)

• Cisco Jabber (Apple iPhone Client)

Users and Phones - (SIP Phones)

To open the Users and Phones window, choose Configure > Telephony > Users 

and Extensions > Users and Phones from the feature bar.

See the following sections for more information on configuring the options on each 

of the tabs in the Users and Phones window:

• User Extensions - (SIP Phones)

• Configuring Phone Button Assignments - (SIP Phones)

User Extensions - (SIP Phones)

To access configuration settings for User Extensions, choose Configure > 

Telephony > Users and Extensions > Users and Phones and select the User 

Extensions tab.

Follow the instructions in this section for adding, editing and deleting phones.

TIP Left-click and drag with the mouse on column headers on the User 

Extensions tab to rearrange the columns in the view. You can also left-click on the 

column header in the view to sort the data in ascending or descending order.

Adding, Editing, and Deleting Phones

You can add unregistered phones and configure their settings. Later, when the 

phone is plugged in, it will receive the configuration.

For step-by-step instructions, see these sections:

• Adding a Phone

• Editing a Phone

• Deleting a Phone
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Adding a Phone

You can add a phone and pre-configure its settings before it is physically 

connected to the system.

To add a phone and associate a user with the phone, follow these steps.

STEP 1 In the Users and Phones window, click the Add button at the bottom of the 

window.

STEP 2 Configure these settings for the new phone.

Field Description

Phone Information

MAC Address Enter the MAC address for this SIP phone.

NOTE: For a CiscoMobile-iOS device, this number is user-

defined; however, it must match the number assigned to this 

device in the CiscoMobile client (Cisco Jabber) and is 

prepended with “SEP” on the client side. For example, a valid 

MAC address entry here might be 123412341234, but on the 

CiscoMobile client it should be SEP123412341234.

Phone Type Choose the SIP phone model from the drop-down list.

When you select a Phone Type, the Button Assignment tab 

updates to display the correct number of rows for the model 

you select.

Expansion 

Module

Disabled. Set to None at all times.

Preferred 

Codec

Set to G711ulaw at all times.
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Permissions This setting specifies the type of outgoing calls that can be 

placed from this phone. Permission levels are defined in the 

outgoing dial plan (Configure > Telephony > Dialplan > 

Outgoing Dial Plan, and select the Outgoing Call Handling 

tab). Choose one of the following:

• Unrestricted. Can place outgoing calls to the PSTN 

without any restrictions.

• Internal. Can place outgoing calls only by dialing 

internal and emergency numbers. Restricted from 

placing all other calls.

• Local. Can place outgoing calls only by dialing local, 

internal, and emergency numbers. Restricted from 

placing local plus, domestic long distance, or 

international calls.

• Local plus. Can place outgoing calls by dialing local, 

internal, and emergency numbers plus additional local 

numbers as defined in the outgoing dial plan.

• National. Can place outgoing calls only by dialing 

national long distance, local, internal, and emergency 

numbers. Restricted from placing national plus 

numbers and international calls.

• National plus. Can place outgoing calls only by dialing 

national long distance, local, internal, and emergency 

numbers, plus additional numbers as defined in the 

outgoing dial plan. Restricted from placing 

international calls.

• International. Can place outgoing calls by dialing 

internal, local, national long distance, emergency, and 

international numbers.

Field Description
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Allow Video 

Calls

Choose whether to allow video calls for this phone.

NOTE: The CP-8961 phone does not support video calls:

• When Allow video calls is checked, Cisco Unified 

Video Advantage (CUVA) is enabled for this user’s 

phone.

• When Allow video calls is unchecked, video calls are 

not allowed for this phone.

By default, Allow video calls is initially un-checked.

User Information

Last Name Phone user last name. The last name is displayed in the 

directory and used for Auto Attendant Dial-By-Name service.

First Name Phone user first name. The first name is displayed in the 

directory and used for Auto Attendant Dial-By-Name service.

User ID User ID for this phone user. This ID is used when logging in to 

Cisco Unity Express User Options web pages to change 

phone settings.

For a mobile client, this ID is also used for authentication 

purposes.

Password Password for this SIP Phone and is mandatory.

This password is used by the phone user to log on to Cisco 

Unity Express User Options web pages to change phone 

settings. The password applies only to the Cisco Unity 

Express GUI, and the IMAP (Internet Message Access 

Protocol).

For a mobile client, this password is also used for 

authentication purposes.

Field Description



SIP Phones
Users and Phones - (SIP Phones)

630 Cisco Configuration Assistant SBCS Administrator Guide

A

STEP 3 Click OK.

Editing a Phone

After you have added a phone, follow the steps in this section to edit phone 

settings.

When the User Extensions tab is initially selected, it displays a list of all user 

phones. The MAC address, phone model, first extension, user first and last name, 

and the user ID are displayed for each phone.

To edit phone settings, follow these steps:

STEP 1 Click on a phone to select it, then click the Edit button at the bottom of the window 

to display its details. You can also double-click on a phone in the list to open its 

details for editing.

STEP 2 Edit settings as needed. For information about phone settings configured here, see 

Adding a Phone, page 627.

STEP 3 Click OK to send the configuration to the device.

Phone Button Assignments and Speed Dials

Button 

Assignments

For each button you want to configure on the phone, select a 

Button Type.

You must choose a Phone Type before you can configure 

Button Assigments.

The Button <#> area of the page displays the settings that 

must be configured for the selected Button Type.

For detailed information about the types of buttons that can 

be assigned to each type of button and their associated 

settings, see Configuring Phone Button Assignments - (SIP 

Phones), page 633.

Speed Dials Click the Speed Dials tab to configure speed dials for the 

phone. For more information, see Speed Dials - (SIP 

Phones), page 631.

Field Description
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Deleting a Phone

To delete one or more phones, follow these steps:

STEP 1 Unplug the phones to be deleted.

STEP 2 Choose Configure > Telephony > Users and Extensions > Users and Phones 

from the feature bar.

STEP 3 In the Users and Extensions window, click on the phones that you want to delete.

STEP 4 Click Delete. All selected phones are deleted.

Speed Dials - (SIP Phones)

NOTE IMPORTANT: Speed dials are supported for only the CP-8961, CP-9951, and 

CP-9971 phones.

For information about configuring personal speed dials on user’s phones, see 

these sections:

• Overview

• Procedures

Overview

NOTE Speed dial soft-key is not supported.

NOTE Speed dial for Cisco Jabber (CiscoMobile-iOS) is accomplished by using the 

Favorite button in the Cisco Jabber application.

Only 5 feature buttons are available for the CP-8961 and CP-9951 phones. They 

are used for both Normal Line and Speed Dial. As a result total Normal Line plus 

Speed Line cannot exceed 5 for the CP-8961 and CP-9951 phones.

Similarly, there are 6 feature buttons available for the CP-9971 phone and the total 

Normal Line plus Speed Line cannot exceed 6 in this case.
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Procedures

To add, edit, or delete speed dials, for individual phones, follow these steps.

STEP 1 Choose Configure > Telephony > Users and Extensions > Users and Phones 

from the feature bar.

STEP 2 To configure speed dials for a regular phone user, select the User Extensions tab in 

the Users and Phones window.

STEP 3 Click in a row of the table to select a phone for which you want to configure speed 

dials.

You can sort phones in the list by extension, phone type, first name, last name, user 

ID, or MAC address.

STEP 4 Click Edit. The Edit Phone window appears.

STEP 5 In the Edit Phone window, select the Speed Dials tab.

STEP 6 On the Speed Dials tab, follow these steps to add a speed dial.

a. Click on the row that corresponds to the speed dial button number that you 

want to add or edit.

b. In the Number field, enter a phone number exactly as the user would dial it, 

including an access code for external dialing or site dialing prefix, if needed.

East Asian double-byte characters are not supported with speed dials. 

The Number field accepts these characters: digits 0-9, A, B, C, D, #, * and +. 

The non-digit characters can be used for security access or other systems that 

a customer may have at their site.

c. In the Label field, enter a label to identify the speed dial button on the phone 

display.

STEP 7 Continue adding speed dial buttons as needed.

STEP 8 Click OK when you are finished.

STEP 9 The affected phones are restarted automatically. SIP Phones that are in use are 

restarted after the current call completes.
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STEP 10 To delete a speed dial, follow these steps.

a. Click on the row that corresponds to the speed dial button number you want to 

delete.

b. In the Number field, manually delete the phone number.

c. In the Label field, manually delete the data.

STEP 11 Click OK when you are finished.

The affected phones are restarted automatically. SIP Phones that are in use are 

restarted after the current call completes.

Configuring Phone Button Assignments - (SIP Phones)

For information on the types of buttons that can be configured on the phone and 

detailed information about Button <#> settings (where <#> stands for button 

number), see the following section:

• Normal Extension, page 633

Normal Extension

When you configure a phone button as a Normal extension, a single extension is 

assigned to the button.

To configure Button <#> section for a Normal extension button, follow these steps.

STEP 1 Choose Configure > Telephony > Users and Extensions > Users and Phones 

and select the User Extensions tab.

STEP 2 Click on a phone in the list to select it, then click the Edit button to display its 

configuration details.

STEP 3 Select the Button Assignments tab.

STEP 4 Choose a button number.

STEP 5 In the Button <#> section, configure settings for the extension as described 

below.
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Field Description

Button Type Only the Normal line is supported.

Parameters Tab

Extension Enter the desired extension number for this line.

Button Label Enter the desired label for this button.

Enable 

Voicemail

Click to enable (checked) or disable (unchecked).

When the Mailbox option for a Normal line is checked, a 

personal mailbox is created for this extension. Only one 

personal mailbox can be created per user.

The mailbox and its contents are not deleted when you re-

associate the mailbox to a different extension.

Block 

Restricted 

Numbers

To prevent the user from calling the restricted (blocked) 

numbers configured in the outgoing dial plan, check the Block 

Restricted Numbers check box.

Call Forward 

Busy

Transfer calls to this extension when this line is busy. Click in 

the field and enter an extension to change the setting.

Call Forward 

No Answer

Transfer incoming calls to this extension if there is no answer. 

Click in the field and enter an extension to change the setting.

CFNA 

Timeout, 

seconds

Number of seconds before unanswered calls are transferred to 

the Call Forward No Answer destination.

The default is 20 seconds.

IMPORTANT If this extension is a member of a Call Blast 

Group, the CFNA Timeout value you set here must be greater 

than the Timeout value configured for the Call Blast Group. For 

example, if the Timeout value for the Call Blast Group that the 

extension belongs to is 10 seconds, set the CFNA timeout for 

the extension to at least 11 seconds. Alternatively, you can 

lower the Timeout value for the Call Blast Group. See Call Blast 

Groups, page 385.

Call-Forward 

Unregister

Number to forward call when phone becomes unregistered as 

in the case when a mobile phone goes out-of-range.
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STEP 6 Click OK.

Cisco Jabber (Apple iPhone Client)

For information on the Cisco Jabber, refer Cisco Jabber Application Notes at

https://supportforums.cisco.com/docs/DOC-24508

PSTN 

Number

Read-only field that displays the PSTN number that is mapped 

to this extension in the incoming dial plan, if configured.

To map DID numbers to internal extensions, choose Configure 

> Telephony > Dial Plan > Incoming, select the Direct Dialing 

tab, and configure settings under Direct Dial to Internal 

Extensions.

Field Description

https://supportforums.cisco.com/docs/DOC-24508


SIP Phones
Cisco Jabber (Apple iPhone Client)

636 Cisco Configuration Assistant SBCS Administrator Guide

A



B

Cisco Configuration Assistant SBCS Administrator Guide 637

 

Where to Go From Here

Cisco provides a wide range of resources to help you and your customer obtain 

the full benefits of Cisco Configuration Assistant and the Cisco Smart Business 

Communications System (SBCS).

Cisco Configuration Assistant

Cisco Configuration Assistant 
Product Page

www.cisco.com/go/configassist

Cisco Configuration Assistant Technical 
Documentation

www.cisco.com/en/US/products/ps7287/
tsd_products_support_series_home.html

Cisco Configuration Assistant Out-of-
Band Configuration Guidelines 

http://www.cisco.com/en/US/partner/products/
ps7287/prod_installation_guides_list.html

Cisco Small Business

Cisco Partner Central for Small Business 
(Partner Login Required)

www.cisco.com/web/partners/sell/smb

Cisco Small Business Home www.cisco.com/smb

Cisco Small Business Support

Cisco Small Business Support Community www.cisco.com/go/smallbizsupport

Cisco Small Business Support and 
Resources

www.cisco.com/go/smallbizhelp

Phone Support Contacts www.cisco.com/en/US/support/
tsd_cisco_small_business 
_support_center_contacts.html

Cisco Small Business Firmware Downloads www.cisco.com/go/smallbizfirmware

Select a link to download firmware for Cisco Small 
Business Products. No login is required.

Downloads for all other Cisco Small Business 
products, including Network Storage Systems, are 
available in the Download area on Cisco.com at 
www.cisco.com/go/software (registration/login 
required).

http://www.cisco.com/go/configassist
http://www.cisco.com/en/US/products/ps7287/tsd_products_support_series_home.html
http://www.cisco.com/web/partners/sell/smb
http://www.cisco.com/smb
http://www.cisco.com/go/smallbizsupport
http://www.cisco.com/go/smallbizhelp
http://www.cisco.com/en/US/support/tsd_cisco_small_business_support_center_contacts.html
http://www.cisco.com/go/smallbizfirmware
http://www.cisco.com/go/software
http://www.cisco.com/en/US/partner/products/ps7287/prod_installation_guides_list.html
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Cisco Smart Business Communications System and Components

Cisco UC500 software packages and 
localization files
(Cisco.com Login Required)

www.cisco.com/go/uc500swpk

Cisco Smart Business Communications 
System

www.cisco.com/go/sbcsresources

Cisco Unified Communications 500 Series www.cisco.com/go/uc500resources

Cisco SPA500 Series IP Phone www.cisco.com/go/spa500phones

Cisco SPA300 Series IP Phones www.cisco.com/go/300phones

Cisco Unified IP Phones 7900 Series www.cisco.com/en/US/products/hw/phones/
ps379/

Cisco AP541N Access Point www.cisco.com/go/ap500resources

Cisco SA500 Security Appliance www.cisco.com/go/sa500resources 

Cisco ESW500 Series Switches www.cisco.com/go/esw500resources

Cisco PVC2300 (Audio/PoE) and 
WVC2300 (Audio/Wireless-G) Business 
Internet Video Cameras

www.cisco.com/go/smallbizcameras

Cisco Secure Router SR500 Series www.cisco.com/go/sr500 

Cisco Smart Business Communications 
System Feature Reference Guide

www.cisco.com/go/sbcsfeatures

License Notices

Open Source License Notices www.cisco.com/go/osln

The Open Source License Notice for CCA 3.0 is 
located on the CCA software download page on 
Cisco.com.

http://www.cisco.com/go/uc500swpk
www.cisco.com/go/sbcsresources
http://www.cisco.com/go/uc500resources
http://www.cisco.com/go/spa500phones
http://www.cisco.com/en/US/products/hw/phones/ps379/
http://www.cisco.com/go/ap500resources
http://www.cisco.com/go/sa500resources
http://www.cisco.com/go/esw500resources
http://www.cisco.com/go/smallbizcameras
http://www.cisco.com/go/sr500
http://www.cisco.com/go/sbcsfeatures

http://www.cisco.com/go/osln
http://www.cisco.com/go/300phonesresources
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A

AAA Authentication, authorization and accounting. Pronounced “triple-A.”

ABR Area border router. A router that is located on the border of one or more 

OSPF areas and that connects the areas to the backbone network. ABRs are 

considered to be members of both the OSPF backbone and the attached 

areas. Therefore, they maintain routing tables that describe both the 

backbone topology and the topology of the areas.

access point A device that serves as a center point in a wireless network or as a 

connection point between wireless devices and a wired network. See also 

autonomous access point and LAP (lightweight access point).

access port A port that carries the traffic of one virtual LAN (VLAN). Contrast with trunk 

port.

access VLAN VLAN that is used by a switch for data traffic. See also native VLAN and 

voice VLAN.

address aggregation A routing protocol feature that breaks major network addresses into 

aggregates representing numerically contiguous groups of addresses 

known as a supernets. This feature automatically suppresses the 

advertisements of more specific networks on a chosen interface.

advertising The router process of sending routing and service updates at intervals so 

that other routers can maintain a table of usable routes.

address mask A bit combination used to describe which part of an address refers to the 

network or the subnet and which part refers to the host. See also IP address 

and subnet mask.

administrative speed The speed of a link as specified by the administrator. If the administrator 

specifies auto as the speed, the actual speed is determined through auto-

negotiation.

AES Advanced Encryption Standard. A block cipher that can encrypt and 

decrypt data using keys of 128,192, or 256 bit.



Glossary

Cisco Configuration Assistant SBCS Administrator Guide 640

C
 

B

AES CCMP Advanced Encryption Standard-Counter Mode with Cipher Block Chaining 

Message Authentication Code Protocol. An encryption protocol that uses 

AES. The CCMP algorithm produces a message integrity code that provides 

data origin authentication and data integrity for the wireless packet.

AP manager interface An interface that is used for all Layer 3 communications between a WLAN 

controller and LAP (lightweight access points) after the access points have 

joined the WLAN controller.

ARP Address resolution protocol. An Internet protocol that is used to map an IP 

address to a MAC address.

area A group of adjacent routers that share OSPF link-state updates. It is 

identified by a number known as an area ID.

ATM Autonomous transfer mode. The international standard for cell relay in which 

multiple service types (such as voice, video, or data) are conveyed in fixed-

length (53-byte) cells. Fixed-length cells allow cell processing to occur in 

hardware, thereby reducing transit delays. ATM is designed to take 

advantage of high-speed transmission media, such as E3, SONET, and T3.

auto-negotiation The ability of linked ports to determine each other's characteristics and to 

choose the best communication method.

autonomous access 

point

A fully featured standalone access point that does not require a WLAN 

controller to operate. Compare with LAP (lightweight access point.

AWP Alternatively wired ports. Two physical ports that operate as a single logical 

port. Usually one port uses a fiber SFP connector and the other port uses a 

copper RJ-45 connector.

BOOTP Bootstrap protocol. The protocol used by a network node o determine the IP 

address of its Ethernet interfaces to affect network booting.
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CAC Call Admission Control. A process of regulating voice quality by limiting the 

number of calls that can be active on a particular link at the same time. CAC 

does not guarantee a particular level of audio quality on the link, but it does 

allow you to regulate the amount of bandwidth consumed by active calls on 

the link.

CAS Channel-associated signaling. The transmission of signaling information 

within the voice channel. CAS signaling often is referred to as robbed-bit 

signaling because user bandwidth is being robbed by the network for other 

purposes.

CCKM Cisco Centralized Key Management. A protocol that supports time-sensitive 

applications such as wireless voice over IP (VoIP). CCKM uses a fast re-

keying technique that enables clients to roam from one access point to 

another without going through the controller.

CDP Cisco Discovery Protocol. A protocol that a device uses to advertise its 

existence to other devices and to receive information about other devices on 

the same LAN or on the remote side of a WAN.

CEF Cisco Express Forwarding. An advanced Layer 3 switching technology for IP. 

CEF optimizes network performance and scalability for networks with large 

and dynamic traffic patterns, such as those associated with the Internet, 

web-based applications, and interactive sessions.

CGMP Cisco Group Management Protocol. A protocol that reduces the flooding of 

IP multicast packets by limiting the transmission of these packets to clients 

that request them. End stations become clients by sending join messages to 

join a CGMP group; they send leave messages to leave the group.

clientless mode Provides secure access to private web resources and access to web 

content.

customer site A group of devices that is managed through the IP addresses of its 

members. Switches, routers, wireless access controllers, and autonomous 

access points can be members.
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default gateway A node in a network that serves as both an exit point to another network and 

an entry point from another network.

delay dial The originating end seizes the line and waits 200 ms to see if the far end is 

on-hook. If so, the originating end then outpulses digits. If the far end is off-

hook, the originating end waits until the far end is on-hook before outpulsing 

digits. 

destination-based 

forwarding

The forwarding of a packet by a port group based on the packet's 

destination address. Contrast with source-based forwarding.

DHCP Dynamic host configuration protocol. A mechanism for dynamically 

allocating IP addresses so that addresses can be reused when hosts no 

longer need them.

DID Direct Inward Dial. A service offered by telephone companies that enables 

callers to dial directly to an extension on a Private Branch Exchange (PBX) or 

packet voice system without the assistance of an operator or automated call 

attendant. This service makes use of DID trunks, which forward only the last 

three to five digits of a phone number to the PBX or router/gateway.

digest authentication A process for SIP trunks and phones that allows challenge of the identity of a 

SIP user agent (UA) when the UA sends a request. (A SIP user agent 

represents a device or application that originates a SIP message.)

DMZ Demilitarized zone. A buffer zone between the Internet, and your private 

networks. It can be a public network typically used for Web, FTP, and email 

servers that are accessed by external clients on the Internet. Placing these 

public access servers on a separate isolated network provides an extra 

measure of security for an internal network.

DNS Domain Name Service. An Internet service that translates domain names, 

which are composed of letters, into IP addresses, which are composed of 

numbers.

domain name The familiar, easy-to-remember name of a host on the Internet that 

corresponds to its IP address.

dynamic address A MAC address that is learned on a port. It is stored in the address table and 

lost when the switch reloads. The first MAC address that is learned when 

port security is enabled becomes a dynamic secure address. See also static 

address.
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dynamic routing Routing that adjusts automatically to network topology or traffic changes. 

Also called adaptive routing.

EANA Equal Access North American. One of four common forms of CAS signaling; 

the others are groundstart, loopstart, and E&M.

EAP Extensible Authentication Protocol. An authentication method in which an 

access point assists a wireless client device and a RADIUS server to 

perform authentication and to derive a dynamic WEP key.

EIGRP Enhanced Interior Gateway Routing Protocol. A Cisco version of IGRP that 

provides superior convergence properties and operating efficiency and 

combines the advantages of link-state protocols with those of distance-

vector protocols.

E&M One of four common forms of CAS signaling; the others are loop start, 

ground start and EANA.

endpoint A SIP terminal or gateway. An endpoint can call and be called. It generates 

and/or terminates the information stream. 

EtherChannel A group of Fast Ethernet or Gigabit Ethernet ports that acts as a single 

logical port for high-bandwidth connections between switches or between 

switches and servers. If a port within an EtherChannel fails, traffic previously 

carried over the failed port transfers to the remaining ports within the 

EtherChannel.

Ethernet management 

port

The Ethernet management port is a Layer 3-capable host port to which you 

can connect a PC. The Ethernet management port can be used instead of 

the switch console port for network management. This port should be used 

only to manage the switch. The Ethernet management port supports the Port 

settings and IP Address features in Cisco Configuration Assistant.

EZVPN Easy VPN. A centralized VPN management solution based on the Cisco 

Unified Client Framework. A Cisco Easy VPN consists of two components: a 

Cisco Easy VPN remote client, and a Cisco Easy VPN server.

failover The transfer of responsibilities to a standby switch.
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Fast Leave A multicast routing feature that speeds up the removal of a multicast group 

from a router. When a member leaves a group, Fast Leave searches for other 

members of the group (devices receiving IP multicast packets from a 

particular port on the switch). If there are no other members on the port, the 

switch removes the port from the group. If there are no other ports in the 

group, the switch notifies the routers connected to the VLAN to delete the 

entire group.

firewall A router or access server, or several routers or access servers, designated 

as a buffer between any connected public networks and a private network. 

A firewall router uses access lists and other methods to ensure the security 

of the private network.

FTP File Transfer Protocol. Part of the TCP/IP protocol stack, used for transferring 

files between hosts.

GBIC Gigabit Interface Converter. A transceiver that converts electric currents 

(digital highs and lows) to optical signals and optical signals to digital electric 

currents. The GBIC is typically used in fiber-optic and Ethernet systems as 

an interface for high-speed networking. The data transfer rate is 1 Gigabit 

per second (1 Gbps) or more.

graph polling interval The frequency with which Configuration Assistant queries the members of a 

customer site to obtain device- and link-utilization data throughout the 

device group. This information is used to update link graphs and bandwidth 

graphs. See also health polling interval, LED polling interval, and network 

polling interval.

GRE Generic Routing Encapsulation. A tunneling protocol that encapsulates a 

variety of protocol packet types inside IP tunnels, creating a virtual point-to-

point connection to devices at remote points over an IP network. With this 

technology, GRE encapsulates the entire original packet with a standard IP 

header and GRE header before the IPsec process. Then, IPsec views the 

GRE packet as an unremarkable IP packet and performs encryption and 

authentication services, as dictated by the IKE negotiated parameters. 

Because GRE can carry multicast and broadcast traffic, it is possible to 

configure a routing protocol for virtual GRE tunnels. The routing protocol 

detects loss of connectivity and reroutes packets to the backup GRE tunnel, 

thus providing high resiliency.
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groundstart One of four common forms of T1 CAS signaling. It is primarily an analog 

signal that can be used on FXS, FXO, or any analog port; the others are 

EANA, and E&M.

health polling interval The frequency with which Configuration Assistant queries the devices in a 

customer site to obtain measurements of the utilization of device resources 

and device temperatures. See also graph polling interval, LED polling 

interval, and network polling interval.

home network The network on the server side of a VPN tunnel. For example, a guest at a 

hotel might connect a PC to the hotel network to download a file stored on a 

server physically located on the guest's corporate network. The connection 

is established from the hotel network through the Internet to the corporate 

network by using a VPN tunnel. In this example, the hotel network is the 

remote network and the corporate network is the home network. 

hunt group Number of telephone lines that are associated together by the telephone 

company central office or a PBX system. When a call comes in to a hunt 

group, it cycles through the group of lines until it finds one that is not busy, 

then it rings that phone (or extension, if it is a PBX system).

HSRP Hot Standby Routing Protocol. A protocol that provides high network 

availability and transparent network topology changes. It creates a device 

group with a lead device that services all the packets sent to a hot standby 

address. The lead device is monitored by others in the group; if it fails, one of 

the other devices inherits the lead position and the hot standby address.

HWIC High-Speed WAN Interface Card. A wireless LAN interface card in the HWIC 

form-factor that provides integrated access point functionality in Cisco 

devices with routing capability.

ICMP Internet Control Message Protocol. A network layer Internet protocol that 

reports errors and provides other information relevant to IP packet 

processing.

IGMP Internet Group Management Protocol. A protocol used between hosts and 

routers on the LAN to determine which multicast groups the hosts belong to.
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IGMP snooping The examination by a Layer 2 switch of some Layer 3 information in an IGMP 

packet sent from a host to a router. The switch determines from its findings 

whether to add or remove member ports.

IGRP Interior Gateway Routing Protocol. An Interior Gateway Protocol that 

addresses issues associated with routing in large, heterogeneous networks.

IKE Internet Key Exchange. A key management protocol standard used in 

conjunction with IPsec and other standards. IPsec can be configured without 

IKE, but IKE enhances IPsec by providing additional features, flexibility, and 

ease of configuration for the IPsec standard. IKE provides authentication of 

the IPsec peers, negotiates IPsec keys, and negotiates IPsec security 

associations.

Immediate Leave A multicast routing feature that speeds up the removal of a multicast group 

from a router. When a member indicates that it wants to leave the group, 

Immediate Leave removes the member port from the group at once.

immediate start The originating end seizes the line by going off-hook and, without waiting for 

a response, it begins to outpulse digits. 

inside interface The first interface that connects the device to your internal, trusted network 

protected by a security appliance. 

IP address A 32-bit address assigned to hosts using TCP/IP. It belongs to one of five 

classes (A, B, C, D, or E) and is written in four octets separated by periods 

(dotted decimal format). Each address consists of a network number, an 

optional subnetwork number, and a host number. The network and 

subnetwork numbers together are used for routing, and the host number is 

used to address an individual host within the network or subnetwork. A 

subnet mask is used to extract network and subnetwork information from the 

IP address.

IP phone A full-featured telephone that provides voice communication over an IP 

network.

IPsec A framework of open standards that provides data confidentiality, data 

integrity, and data authentication between participating peers. IPsec 

provides these security services at the IP layer. IPsec uses IKE to handle 

negotiation of protocols and algorithms based on local policy and to 

generate the encryption and authentication keys to be used by IPsec. IPsec 

can be used to protect one or more data flows between a pair of hosts, 

between a pair of security gateways, or between a security gateway and a 

host.

ISL Inter-Switch Link. A Cisco-proprietary protocol that maintains VLAN 

information as traffic flows between switches and routers.
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keysystem A small-scale telephone system designed to handle telephone 

communications for a small office of 1 to 25 users. Keysystems can be either 

analog or digital. In a keysystem each phone is able to answer any incoming 

PSTN call on any line. When multiple calls are present within the system at 

the same time, each call is visible and can be directly selected by pressing 

the corresponding line button on an IP phone.

LACP Link Aggregate Control Protocol. The protocol that supports the IEEE 

802.3AD specification for bundling physical interfaces together to form a 

single logical interface.

LED polling interval The frequency with which Configuration Assistant polls the ports in a 

customer site</a> and displays changes in the LED colors of ports. See also 

graph polling interval, health polling interval, and network polling interval.

lightweight access 

point

An access point that cannot act independently of a WLAN controller. The 

WLAN controller manages the AP configurations and firmware. No individual 

configuration of these access points is necessary. They handle only real-

time MAC functionality and leave non-realtime MAC functionality to be 

processed by the WLAN controller. This architecture is referred to as the 

split MAC architecture. Compare with autonomous access point.

link state protocol A type of routing protocol</a> that maintains a map of the internetwork, 

allowing it to see alternate routes or parallel paths for load balancing. OSPF 

is an example of this protocol type. Contrast with distance-vector protocol.

link-state protocol A type of routing protocol that maintains a map of the internetwork, allowing 

it to see alternate routes or parallel paths for load balancing. OSPF is an 

example of this protocol type. Contrast with distance-vector protocol.

local span A SPAN session in which all the source and destination ports are on the 

same switch. Contrast with remote SPAN.

loopstart One of four common forms of T1 CAS signaling, but it is primarily an analog 

signal that can be used on FXS, FXO, or any analog port; the others are 

groundstart, EANA, and E&M.
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MAC Media Access Control. The lower of the two sublayers of the data link layer 

defined by the IEEE. The MAC sublayer determines access to shared media, 

such as whether token passing or contention is used.

MAC address The standardized data link layer address that is required for every port or 

device that connects to a LAN. Other devices in the network use these 

addresses to locate specific ports in the network and to create and update 

routing tables and data structures. MAC addresses are 6 bytes long and are 

controlled by the IEEE.

management interface The default interface for managing a device. Media Access Control. The 

lower of the two sublayers of the data link layer defined by the IEEE. The 

MAC sublayer determines access to shared media, such as whether token 

passing or contention is used.

multicast routing A routing technique that allows copies of a single packet to be passed to a 

selected subset of all possible destinations. Contrast with unicast routing.

MWI server The SIP MWI (message waiting indicator) server is a proxy server that relays 

SIP MWI messages.

NAT Network Address Translation. A mechanism for reducing the need for 

globally unique IP addresses. NAT allows an organization with IP addresses 

that are not globally unique to connect to the Internet by translating those 

addresses into globally routable IP addresses.

native VLAN The VLAN that carries untagged packets from an IEEE 802.1Q trunk port. See 

also access VLAN and voice VLAN.

network EAP An authentication method in which the access point assists a wireless client 

device and the RADIUS server to perform authentication and to derive a 

dynamic WEP key.

network polling interval The frequency with which Configuration Assistant polls the members of a 

customer site to determine the status of the device group and the existence 

of new members. See also graph polling interval, health polling interval, and 

LED polling interval.
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network port A port to which the switch forwards all VLAN traffic with unknown 

destination addresses; this process helps to prevent flooding to all the ports 

in a VLAN.

notification name The name of a collection of information that specifies types of system 

events and an email address to which notification of these events is sent.

NTP Network time protocol. A protocol that ensures accurate local time-keeping 

with reference to radio and atomic clocks located on the Internet.

open authentication An authentication method that allows any device to authenticate and then 

attempts to communicate with the access point.

open authentication 

with EAP

An authentication method in which the access point forces all client devices 

to perform EAP authentication before they can join the network.

OSPF Open Shortest Path First. A link-state protocol that imposes no limit on hop 

count, propagates routing changes instantaneously, supports variable-

length subnet masks, and allows for load balancing based on the actual cost 

of the link. It also compartmentalizes networks into smaller regions called 

areas, which limits the traffic caused by link-state updates.

outside interface The first interface, usually port 0, that connects to other untrusted networks 

outside the security appliance; a WAN or the Internet. 

PAT Port address translation. Conserves addresses in the global address pool 

by allowing source ports in TCP connections or UDP conversations to be 

translated. Different local addresses then map to the same global address, 

with port translation providing the necessary uniqueness. Global pool 

addresses are always used before a PAT address is used.

pickup group Allows administrators to associate pickup groups with individual IP phones, 

making it easier for phone users to answer, or pick up, a call that is ringing on 

a different extension or telephone number.

PBX Private branch exchange. Digital or analog telephone switchboard located 

on the subscriber premises and used to connect private and public 

telephone networks. 
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PKI Public-Key Infrastructure. A system of certification authorities (CAs) and 

registration authorities (RAs) that provides support for the use of asymmetric 

key cryptography in data communication through such functions as 

certificate management, archive management, key management, and token 

management. Alternatively, any standard for the exchange of asymmetric 

keys. This type of exchange allows the recipient of a message to trust the 

signature in that message, and allows the sender of a message to encrypt it 

appropriately for the intended recipient. See key management.

PPPoE Point-to-Point Protocol over Ethernet. PPP encapsulated in Ethernet frames. 

PPPoE enables hosts on an Ethernet network to connect to remote hosts 

through a broadband modem.

PoE Power over Ethernet. A technology that provides power to connected 

devices through the data cables rather than by power cords.

polling interval See graph polling interval, LED polling interval, and network polling interval.

preshared key An authentication method offered in IPsec. Preshared keys allow for one or 

more clients to use individual shared secrets to authenticate encrypted 

tunnels to a gateway using IKE (Internet Key Exchange). Preshared keys are 

commonly used in small networks of up to 10 clients. With preshared keys, 

there is no need to involve a certification authority for security.

privilege level A number that determines the level of Configuration Assistant access that is 

granted to a user. Level 15 grants read-write access; levels 1 to 14 grant 

read-only access.

PSTN Public switched telephone network. General term referring to the variety of 

telephone networks and services in place worldwide.

QoS Quality of Service. Refers to the capability of a network to provide better 

service to selected network traffic. The primary goal of QoS is to provide 

priority including dedicated bandwidth, controlled jitter and latency 

(required by some real-time and interactive traffic), and improved loss 

characteristics.
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RADIUS Remote Authentication Dial-In User Service. A database for authenticating 

modem and ISDN connections and for tracking connection time.

remote network The network on the client side of a VPN tunnel. For example, a guest at a 

hotel might connect a PC to the hotel network to download a file stored on a 

server physically located on the guest's corporate network. The connection 

is established from the hotel network through the Internet to the corporate 

network by using a VPN tunnel. In this example, the hotel network is the 

remote network and the corporate network is the home network.

remote span A SPAN session in which the source ports are located remotely from the 

switch containing the destination port. Contrast with local SPAN.

RIP Routing Information Protocol. The most common Interior Gateway Protocol in 

the Internet. It uses a hop count as a routing metric.

root port The switch port with the best path to the root switch.

root switch The switch selected to be the center of a spanning-tree topology. All data 

flow across the network is from the perspective of this switch. 

routable interface A routed port or an SVI.

routing protocol A set of rules and conventions for gathering information about available 

networks, such as the distance or cost to reach them, and determining the 

routing path for a packet.

secure address A MAC address that is forwarded to only one port per VLAN. Secure 

addresses are retained even when the switch reloads. See also dynamic 

address and static address.

secure port A port for which a user-specified action occurs whenever an address-

security violation occurs.
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SDP 1. Session Description Protocol. A protocol for defining information needed 

to establish multimedia transport over IP. SDP transmits information such as 

session announcement, session invitation, transport addresses, and media 

types. For example, in a SIP call, SDP messages indicates if NTE is used, 

which events to send using NTE, and the NTE payload type value. 

2. Secure Device Provisioning. Deploys PKI (public key infrastructure) 

between two end devices, such as a Cisco IOS client and a Cisco IOS 

certificate server. 

SFP Small form-factor pluggable. A field-replaceable laser optical transceiver 

module. SFP modules provide Gigabit uplink connections to other switches.

SFTP SSH File Transfer Protocol. SFTP is part of SSH and is always enabled on 

the router. A user with the appropriate level can copy files to and from the 

router by using SFTP.

shared authentication An authentication method in which the access point sends an unencrypted 

challenge text string to any device attempting to communicate with it. If the 

challenge text is correctly encrypted, the access point allows the requesting 

device to authenticate.

SIP Session Initiation Protocol. Enables call handling sessions, particularly two-

party audio conferences. SIP works with Session Description Protocol (SDP) 

for call signaling. Using SIP, the router can support any SIP Voice over IP 

(VoIP) gateways and VoIP proxy servers.

SMTP Simple Mail Transfer Protocol. An Internet protocol that provides email 

services.

SNMP Simple Network Management Protocol. A protocol in TCP/IP networks that 

provides a means to monitor and control network devices and to manage 

configurations, statistics collection, performance, and security.

source-based 

forwarding

The forwarding of a packet by a port group based on the packet source 

address. Contrast with destination-based forwarding.

split tunneling Split tunneling allows VPN clients to communicate locally unencrypted. 

Users send only that traffic which is destined for the home network across 

the tunnel. All other traffic, such as instant messaging, email, or casual 

Internet browsing, is sent out to the Internet by using the local LAN of the 

VPN Client.

SPAN Switched Port Analyzer. A feature that is used to specify a set of ports (or 

VLANs) to be monitored. A copy of the traffic on these source ports is sent to 

a specified destination port. Typically, a user connects a network analyzer to 

the destination port to view the traffic on the source ports. See also local 

SPAN and remote SPAN.
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spanning tree protocol See STP.

static secure address A manually configured secure address that is stored in the address table 

and added to the running configuration. See also dynamic address</a> and 

sticky MAC address.

SSH Secure Shell. An application running on top of a reliable transport layer, such 

as TCP/IP, that provides strong authentication and encryption capabilities.

SSID Service set identifier. A code attached to packets on a wireless network to 

identify each packet as part of that network. All wireless devices attempting 

to communicate with each other must associate with the same SSID.

static route A route that is explicitly configured and entered into the routing table. Static 

routes take precedence over routes chosen by dynamic routing protocols.

STP Spanning Tree Protocol. A standardized technique for maintaining a network 

of multiple bridges or switches. When a network topology changes, STP 

prevents the creation of loops by transparently reconfiguring bridges and 

switches and placing ports in a forwarding or blocking state. Each VLAN is 

treated as a separate bridge, and a separate instance of STP is applied to 

each.

subnet mask A 32-bit address mask used in IP to show which bits of an IP address 

identify the network number, the subnetwork number, and the node number.

switch port A Layer 2-only interface that is associated with a physical port. It can be 

either an access port or a trunk port.

SVI Switch virtual interface. A VLAN with an assigned IP address that Layer 3 

devices use to access the VLAN. An SVI can be configured to route packets 

from one VLAN to another.

TCP Transmission Control Protocol. A connection-oriented transport layer 

protocol that provides reliable full duplex data-transmission. TCP is part of 

the TCP/IP protocol stack.

TCP/IP The common name for a suite of protocols that support the construction of 

worldwide internetworks.

Telnet A terminal emulation protocol for TCP/IP networks such as the Internet. 

Telnet is a common way to control web servers remotely.
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TFTP Trivial File Transfer Protocol. A simplified version of FTP that allows files to 

be transferred from one computer to another over a network, usually without 

the use of client authentication (for example, username and password).

TKIP Temporal Key Integrity Protocol. An encryption that defends against an 

attack on WEP in which the intruder uses an unencrypted segment called 

the initialization vector (IV) in encrypted packets to calculate the WEP key.

trunk port A port that carries the traffic of multiple VLANs. Contrast with access port.

tunnel A virtual channel through a shared medium such as the Internet, used for the 

exchange of encapsulated data packets.

UDP User Datagram Protocol. A connectionless transport layer protocol in the 

TCP/IP stack. UDP is a simple protocol that exchanges datagrams without 

acknowledgments or guaranteed delivery, requiring that error processing 

and retransmission be handled by other protocols.

unicast routing A routing technique that routes a packet to a single destination and uses a 

routing protocol to determine the path to that destination. Contrast with 

multicast routing.

virtual interface An interface that acts as the DHCP server placeholder for wireless clients 

that obtain their IP address from a DHCP server and that serves as the 

redirect address for the web authentication login window.

VLAN Virtual LAN. A logical rather than a physical LAN comprising workgroups 

drawn together for business reasons or for a particular project, irrespective 

of each member's actual location.

VPN Virtual Private Network. The same network security and privacy over a 

public infrastructure as would be provided over a private network. VPNs 

enable IP traffic to travel securely over a public TCP/IP network by 

encrypting all traffic from one network to another. A VPN uses tunneling to 

encrypt all information at the IP level.

VTP VLAN Trunking Protocol. A Layer 2 messaging protocol that maintains VLAN 

configuration consistency by managing the addition, deletion, and renaming 

of VLANs on a network-wide basis.
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VTP pruning The blocking of flooded broadcast, multicast, and unknown unicast traffic to 

VLANs on trunk ports that are included in the pruning-eligible list.

voice VLAN A VLAN that is used by a switch for voice traffic from IP phones. See also 

access VLAN and native VLAN.

WEP Wired Equivalent Privacy. An encryption that scrambles the communication 

between the access point and client devices to keep communication 

private. Both the access point and the client device use the same WEP key 

to encrypt and unencrypt radio signals.

wink start The originating end seizes the line by going off-hook. It waits for 

acknowledgement from the other end before outpulsing digits. This serves 

as an integrity check that identifies a malfunctioning trunk and allow the 

network to send a re-order tone to the calling party.

WINS Windows Internet Naming Service. A Windows system that determines the 

IP address associated with a particular network computer.

WMM Wireless Multimedia. A QOS enhancement for wireless LANs. WMM 

supports devices that meet the 802.11E QoS Basic Service Set (QBSS) 

standard. WMM enables differentiated services for voice, video, and best-

effort data to allow voice traffic to be handled before other traffic on the 

network.

WPA Wi-Fi Protected Access. A standards-based, interoperable security 

enhancement that increases the level of data protection and access control 

for wireless LAN systems. Using WPA key management, clients and the 

authentication server authenticate to each other by using an EAP 

authentication method, and the client and server generate a pair-wise 

master key (PMK). WPA uses TKIP for data protection and IEEE 802.1X for 

authenticated key management.

WPA2 Wi-Fi Protected Access 2. A standards-based, interoperable security 

enhancement that uses AES CCMP for data protection. WPA2 offers a higher 

level of security than WPA because AES offers stronger encryption than 

TKIP.

WPA-PSK Wi-Fi Protected Access-Pre-shared key. An authentication method that 

supports WPA on a wireless LAN where IEEE 802.1X-based authentication is 

not available. A pre-shared key is configured on both the client and the 

access point.
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WPA2-PSK Wi-Fi Protected Access 2-Preshared key. An authentication method that 

supports WPA2 on a wireless LAN where IEEE 802.1X-based authentication 

is not available. A preshared key is configured on both the client and the 

access point.
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